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Warranty 2

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of
one (1) year from the date of shipment. If any such product proves defective during this warranty period,
Tektronix, at its option, either will repair the defective product without charge for parts and labor, or will
provide a replacement in exchange for the defective product. Parts, modules and replacement products used
by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced parts,
modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period and make suitable arrangements for the performance of service. Customer
shall be responsible for packaging and shipping the defective product to the service center designated by
Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if
the shipment is to a location within the country in which the Tektronix service center is located. Customer
shall be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned
to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or
inadequate maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to
repair damage resulting from attempts by personnel other than Tektronix representatives to install, repair or
service the product; b) to repair damage resulting from improper use or connection to incompatible equipment;
¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE
AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Warranty 9(b)

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs
on the media will be free from defects in materials and workmanship for a period of three (3) months from the
date of shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will
provide a replacement in exchange for the defective medium. Except as to the media on which this software
product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in
materials and workmanship within a reasonable time thereafter, Customer may terminate the license for this
software product and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR
BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF
SUCH DAMAGES.
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Welcome Technical Support

Technical Support

Tektronix welcomes your comments about products and services. Contact Tektronix via mail, telephone,
or through the Web site. Click Contacting Tektronix ) for more information.

Tektronix also welcomes your feedback. Click Customer Feedback (see page 2) for suggestions for
providing feedback to Tektronix.

Several software enhancements are included to support your TLA product. Refer to the release notes on
the TLA Application CD for the latest information. You can also access the release notes by selecting:

Start > All Programs > Tektronix Logic Analyzer > TLA Release Notes

About Tektronix Logic Analyzers

The Tektronix family of logic analyzers consists of the TLA7000 Series Logic Analyzers and the
TLAS000B Series Logic Analyzers. The TLA7000 series offers the highest performance for today’s
demanding applications and consists of portable and benchtop modular mainframes with expansion
capability. Instrument modules include logic analyzers and serial analyzers. The TLAS000B offers

a selection of standalone logic analyzer instruments that make 500 ps-deep memory timing resolution
available to designers of today’s mainstream embedded systems. A full line of complementary support
products for popular processors and buses is available for the entire TLA family.

NOTE. Unless otherwise indicated, all references to the TLA5S000B Series Logic Analyzers apply to
both the TLA5000B and TLA5000 instruments.

Logic Analyzer Modules

The logic analyzer modules support the iLink tool set, which provide tools to take digital and analog
measurements through a single logic analyzer probe, display time-correlated views of digital and analog
waveforms, and analyze multi-signal buses and eye diagram validation. Logic analyzer modules also
feature MagniVu, an acquisition technology that enables each of the logic analyzer modules to offer

125 ps timing resolution on all signals. MagniVu technology gives you a high-resolution window into the
actual signal activity for each channel.

Serial Analyzer Modules

The serial analyzer modules provide tools to analyze serial buses using mid-bus or slot probes. Two
different serial analyzer modules are available with different types of probes. Both modules can be used
with PCI Express Generation 1 and Generation 2 serial buses.
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Customer Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us any
suggestions, ideas, or other comments you may have regarding the TLA Series Logic Analyzer.

Direct your feedback to us by email to:
techsupport@tektronix.com

In the subject field, please indicate TLA Customer Feedback.

Or FAX at (503) 627-5695, and include the following information:
® TLA Logic Analyzer

m TLA Application software version

® TLA modules (for example, TLA7BB4)

B Microprocessor or bus support package and version.

For specific information on your TLA Series Logic Analyzer, go to the System menu, select System
Properties, and click on the appropriate property page.

The following items are important, but optional:

B Your name

® Your company

B Your mailing address

= Your phone number

B Your FAX number

Enter your suggestion below. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

TIP. 1o copy the above information to your email text editor, right-click the mouse and click Copy. The
above information will be copied to the clipboard where you can paste it into any text editor.

To include screen shots of the user interface, press the Alt key and the Print Screen key simultaneously to
copy the image to the clipboard. Paste the image into Microsoft Paint and save the image as a .BMP file.
You can then attach the file to your email (depending on the capabilities of your email editor).



Getting Started Overview of Connection Choices

Overview of Connection Choices

You can connect to your instrument in three different ways: Remote Host, Remote Desktop, or Local.
In addition, you can choose to work offline, without connecting to the instrument, to modify setups
or view data files previously saved to your PC.

Connecting as a remote host allows you to control the instrument remotely, and then store the data locally
on your PC.

Remote Host mode is best for the following:
®  Connecting to an instrument over a LAN (must be using V5.0 software or above).

B Sending data to where the application is running.

NOTE. When you open the application on the remote computer, the analyzer name is shown in the title bar.
A TLA7016 is always connected as remote host because there is no internal computer in a TLA7016.

Connecting as a remote desktop means that you are running the application on the instrument from your
PC and storing the data on the instrument.

Remote Desktop mode is best for the following:
B Connecting site-to-site over a network.
B Troubleshooting from a remote location.

B Viewing data stored on the analyzer.

NOTE. You can use remote desktop to start the TLA Server, and then connect as remote host.

Connecting locally means that you are working directly on the analyzer.
Using Local if you want to do the following:
B Run the application and store data on the analyzer.

®m  Connect a printer to the analyzer.

Related Topics

Connect to a Networked Instrument (see page 5)
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Configuring your TLA7000 without a TL708EX (see page 4)

Configuring your TLA7000 without a TL708EX

Overview

Use this dialog box to change the configuration of your TLA system when you only have two mainframes
connected with a TekLink cable. You can change which TLA is the mainframe and which one is the
expansion mainframe using this dialog box. For TLA7016 instruments you can also open the Network
Properties dialog box from here.

TLA Configuration - tlasystem1

Mainframe and Expansion Corfiguration

* Mainframe: tiasystem1 (Exp 11lasystem?2 )
" Mainframe: tiasystem2 (Exp 11lasystem1 )

Metwork Properties

tlasystem1
tlasystemn? Metworlc Properties ... |

DK | Cancel |

NOTE. This dialog is only accessible if the system has no more than two TLA7000 mainframes connected
with a TekLink cable.

To use the TLA Configuration dialog box, perform the following steps:
1. Select Choose TLA from the File menu to open the TLA Connection dialog box.
2. Select an instrument, and then click the TLA Configuration button.
The TLA Configuration dialog box opens.
3. Select the desired configuration under Mainframe and Expansion Configuration.

4. To edit the network properties, select the TLA7016 instrument, and then click the Network Properties
button.

Related Topics

Connect to a Networked Instrument (see page 5)




Getting Started Connect to a Networked Instrument

Network Properties (see page 8)

Connect to a Networked Instrument

From the TLA Connection dialog box, select the instrument that you want to connect to and click the
Connect button. You can customize your startup by specifying whether to run power-on diagnostics and
whether to automatically connect to a selected instrument each time you login.

NOTE. If you choose to automatically reconnect to an instrument, the next time that you start the TLA
application, it will open in the offline mode.

To change your customized settings, select Choose TLA from the File menu. Note that the TLA Server
must be running on your instrument to populate the TLA Connection dialog box. To start the TLA Server,
click the TLA Server Control icon in the Windows system tray and select Start TLA Server. The TLA
Server does not run on your PC.

5 LA - Conmestion
i & & TLACobguaton.,

Tl Marma St Medsl [hagetizlion
B [etiine TLATDI2
o] In Use by Adrarierz,,  TLATONZ
128 181.110,935 TLATIS Fareste Desk [1F13)
R A702
1201813058 TLATONG P00 anwng’s desilF12)
4 1 >

A apolicaton st
[ Aot sy sacareecd b [Local]

[ Fuss Panwas an Bagnosdics, i

Connect l E Chaze |

A

If you want to view the configuration of your TLA system, select an instrument, and then click the TLA
Configuration button. (This button is not active until you have selected a TLA.)

TLA Configuration - 128.181.30.58

Frama Host Hama 1P Addreas
Merfeme  fe701B0c000C3cse. . 12E1201.30E3




Getting Started Network Search

The instruments that are listed in the TLA Connection dialoT box are determined by the network search

properties. You can change these properties by clicking the i | icon and entering your preferences

in the Network Search Preferences dialog box.

TLA MNetwork Search

Locate TLA systems on local subnat

Incleda theas hostnamas or |F in seamch
Add hostname or [P

Hostname or [P
1r.ej\:u.-.al':5

Ha 701 EqDO00E coe bek com
ala 125361 coa tek com

E Fieptace ALL with TLAS found on suhnet ]

Carnice I Search H Claze ]

A

TIP. If you do not know the host name or IP address, select the Locate TLA systems on local subnet check
box. This will find any TLA instrument that is connected to the same subnet as your host PC in the search.

What would you like to do next?

Learn About the LA Setup Window. (see page 13)

Learn About the LA Trigger Window. (see page 143)

Network Search

Use the Network Search dialog box to set the preferences for the search criteria that the Connection dialog

box uses. You can open this dialog box by clicking ) | in the Connection dialog box.
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TLA Network Search

Locate TLA systems on local subrat
Includs theas hostnames or [P in ssanrch
Add hostname or [P

Hestname of |P
fitznqualls

ta 701 Bglldld coe bek com
ala125361 cea tex com

[ Replace ALL with TLA% found on subnet ]

Cancel I Search ]I Close ]

A

1. Select Locate TLA systems on local subnet to include any TLA system connected to the same subnet as
your host PC in the search.

2. Select Include these hostnames or IP in search to include the instruments listed in the Hostname or IP
text box in the search. If you know the name of an instrument, you can add it directly by entering the
name in the Add hostname or IP text box and then clicking the Add button. This adds the instrument
to the search but not to the Connection dialog box. The instrument must be found in the search to be
added to the Connection dialog box.

3. To remove an instrument from the search, select it from the Hostname or IP text box, and then click
the Delete Selection button.

4. To update the Hostname or IP text box, click Replace All with TLAs found on subnet.

5. Click the Search button to search the subnet according to the criteria that you have set, and update the
Connection dialog box. When the search is completed, the Network Search dialog box closes and
the Connection dialog box is updated.

Related Topics

Connect to a Networked Instrument (see page 5)

Overview of Connection Choices (see page 3)
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Network Properties

Overview

Use the Network Properties dialog box to configure the Host Name and IP address of your networked
instruments.

Behavior

This dialog box appears when you click the Network Properties... button in the TLA Configuration dialog
box. The Default name is a combination of the TLA7016 Interface Module model number and the serial
number. Select Use the following Name to assign a unique name. The TLA7016 Interface Module will
attempt to get its [P address automatically when Obtain Address Automatically is selected.

NOTE. This dialog is only supported on TLA7016 mainframes.

TLA Network Properties - TLA7016

Product: TLATO 6, Serial Nurmber:

Heast M anme
) Default name [a7015) Lookup IP &ddvess |
%) U s= the fobowing Mame

[TLA70T6 |

“ou can get a network address automatically if your netveork
supports DHCP. Otherwize, vou must get an [P address fram your
retvanrk administratar,

(%) Obtain Address Automaticaly
0 Use the folowing Address

e e e M| ook st Mames
Subnet Mask: I 255 5. 0 . 0 I
Gateway: [152. 168. I




Getting Started Options of Powering On and Off

To Use
1. Select either Default name or enter one of your choosing in the Use the following Name text box.
2. Click the Look Up IP Address button to find an IP address.

3. To specify an IP address, select Use the following Address, and then enter the IP Address, Subnet
Mask, and Gateway.

Options of Powering On and Off

To power on the analyzer without the TLA application starting, perform the following steps:
1. Access the System folder using the following path: Program Files\TLA \System.

2. Click TLA700SU.bat and use your right mouse button to click Edit.

3. Enter the characters REM in front of the following line:

C:\ WINDOWS\COMMAND\START /MAX \TLA700.EXE.

You can set how you want the analyzer to power off through a program labeled Mainframe Utilities
located in the Windows Control Panel.

The utility also provides a screen dim mode where you can reduce the brightness by 60%. Refer to the
help provided with the utility for more information on both functions.

TIP. Access the Mainframe Utilities by clicking the Windows Start button, pointing to Settings and Control
Panel, and then clicking Mainframe Utilities.

Examine the Waveform

You can use the Waveform window controls to view and measure the waveforms. Here are some
suggestions for getting started:

®  Use the scroll bars to display data that is currently off-screen.

® Click d in the toolbar and select a mark to jump to.

m  Select Cursor 1 and drag the cursor handle to a new location. The handles shown along the top of the
display are for fine control; those at the bottom are for coarse control. Note the change in the cursor
time readouts in the Cursor toolbar.

- iview

®  Click the button to display an external oscilloscope waveform.

® Click the = MagniVu pution to display a MagniVu waveform.



Getting Started Viewing Other Types of Waveforms

® To zoom data, click and drag the mouse over the area that you want to zoom. The window will zoom
to the data when you release the mouse button.

B To increase the size of the area in which the data is displayed, select Full Screen from the View menu.

1
= Click = (Zoom Out) or ** (Zoom In) in the toolbar to change the horizontal scale.

B Select a waveform header and the whole row is highlighted, making it easier to view.

LA 1 A3
B Double-click (or any other waveform label). You can change the color and size
(size is also changeable directly) of the waveform in this property page. Click OK to complete the
changes and return to the Waveform window.

® Click the + on the waveform label to expand the waveform into the individual signal elements.

B Drag the split box (above the top arrow of the vertical scroll bar) down to display a second data area.
You can now view two different portions of the same acquisition memory.

TIP. If you are using a portable mainframe, use the front panel knobs to change the horizontal scale
and to scroll the data.

Viewing Other Types of Waveforms

10

Add the MagniVu version of the data at any time by clicking the “# MagniVu pytton or use the following
steps. (MagniVu Data (see page 368) is always acquired with your other data.)

1. Click & (Add Waveform) in the toolbar.

2. From the Data Source list, select LA1 - MagniVu.

3. Select a MagniVu waveform or group (for example, Mag A3), and click Add.
4. Click the Close button when you have finished adding waveforms.

When viewing LA groups, you can view the data as busforms or as magnitude waveforms by right-clicking
the mouse over a data label and selecting either Display Busform or Display Magnitude. You can also
expand the group into the individual busforms by clicking the + on the label.

Or,

=
1. Double-click the label of a signal waveform. (If you do not have a group waveform, click ~E | select

an LA Data Source, and choose a group to display. Confirm and exit the dialog box.)
2. From the Waveform Properties tab, click the Options button.
3. Select Busform or Magnitude, and click OK to close the Waveform Options dialog box.

4. Click OK. The waveform is displayed accordingly.



Getting Started Viewing a Magnitude Waveform Sample

Related Topics

Multi-Signal Magnitude LA Waveforms (see page 214)

Multi-Signal Busform LA Waveforms (see page 213)

Viewing a Magnitude Waveform Sample

e

N A

Click [ in the toolbar to start the New Data Window wizard.

Click Waveform and click the Next button.

Click Add Data Source.

Enter the following path into the File name box, or click browse to navigate to the SampleSystem.tla file:
C:\Program Files\TLA700\Samples\TLA700 Samples\Data Files\SampleSystem.tla

Click the Add button. The SampleSystem data source is added to the list of data sources.

Click LA under SampleSystem.tla and click the Next button.

Enter a name for the new data window or use the default name and then click the Finish button.
Choose one of the following procedures:

a. Right-click the mouse over any data label and select Display Magnitude.

Or

a. Double-click the new Down Count label.

b. Click Options and select Magnitude, click OK twice to close the dialog boxes.

¢. Click the Zoom buttons to view a sawtooth waveform. The waveform is a graphic representation
of counter data.

Examine the Listing Data

Here are some suggestions for viewing Listing window data:

1.

2.

Use the scroll bars to display data that is currently off-screen.

Click fﬁl in the toolbar and select Cursor 1.

Drag the cursor handle to a new location. The handles shown along the left of the display are for
fine control; those at the right are for coarse control. Note the change in the cursor sample number
and delta time readouts in the Cursor toolbar.

Click the toolbar Font buttons to change the display font size.

11



Getting Started Searching Selected Data

Drag the split box (beside the left arrow of the horizontal scroll bar) over to display a second data area.
You can now view two different portions of the same acquisition memory.

Double-click an address or data column label (for example, -). You can change the attributes
of the column in this property page.

From the Column property page, try loading a symbol file: click the radix button box, choose the
Symbolic radix, click the Symbol File button, and choose a symbol file.

Confirm and exit the property page.

Searching Selected Data

12

1.

2.
3.

Double-click a data entry in one of the columns of the Listing window. The data is now selected. Click

in the toolbar to copy the data onto the clipboard.

Click ® in the toolbar.

From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.

NOTE. 7o add a search definition from another data source, click the Load button to open the Load
Search dialog box.

9.

Click the Start from drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

Click the Search Options... button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

Type a Description of the search in the Description text box.
From the Search drop-down list, select the data source.

Paste the data that you copied from the Listing window into the appropriate text box in the Find area by
pressing CTRL+V (the paste shortcut key combination). You can use the same method for pasting
a quick entry into a trigger program definition.

Use the Group drop-down list to select the column from which you copied the data.

10.Click Search Forward. The logic analyzer displays the next instance of the specified data. Once

you have defined the search criteria, you can click the Search Forward or Backward toolbar buttons
for additional searches.
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LA Setup Window

The primary function of the Setup window is to configure the LA module for compatibility with the system
under test. Use this window to do the following tasks:

m  Set thresholds

®  Set global setup and hold sampling
B Specify signal groups

B Name signals

m  Select filter and analysis tools

To Use

1. From the TLA toolbar, click the Setup button, and then select your module, (for example LA 1, when
there is more than one LA module).

Specify the type of sampling (see page 14).

Set the memory depth (see page 27).

Specify the storage option (see page 25).

Associate meaningful signal names (see page 18) to probe channels.

Create meaningful groups (see page 22).

A S T o

Deskew the probes (see page 16).

NOTE. After defining the LA Setup window, you can immediately acquire data. To improve your acquisition
results, revise your Trigger window and adjust your data window properties.

Behavior

The LA Setup window and the associated Trigger window determines what data will be acquired. Each
module has a Setup window and Trigger window; they are set up individually and used separately for
their particular purposes. Configure the Setup window before the Trigger window; many of the Setup
window settings affect Trigger window selections.

TIP. To duplicate the current setup for another LA module, open to the File menu and click Save Module.

For quick access to the Setup window on the TLA7012 Portable Mainframe, press the Setup button on
the front panel. Continue to press the Setup button to cycle through all the acquisition module Setup
windows in the system.

13
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Base Signal

A memory storage location for acquisition data.

Prime Signal

An expanded memory location for high speed data acquisition. The logic analyzer creates prime
signals for storage when the speed of acquisition exceeds that available for base signals alone. Prime
signals have an exponent added to the base name.

Creating a prime signal increases the memory available and removes the base signal from the
Signal Mapping area.

Sampling

14

The logic analyzer supports two basic types of sampling: asynchronous and synchronous, each displayed
in its own tab on the sampling screen. A third type of sampling, custom sampling (see page 334) is
available only when a support package is loaded on the logic analyzer. The tab label includes the name
of the support package.

When you use asynchronous sampling, the logic analyzer generates its own clock signal at regular, fixed
intervals to sample data from the system under test. Acquisitions taken with asynchronous sampling are
often referred to as timing acquisitions, and are best viewed in the Waveform window.

When you use synchronous sampling, a clock from the system under test samples the signal. This clock
can be a fixed frequency, or it may be highly variable. Acquisitions taken with synchronous sampling are
often referred to as state acquisitions and are best viewed in the Listing window.

To Use
1. From the TLA toolbar, click the Setup button, and then select your module, (for example LA 1).
2. Click the Asynchronous, Synchronous, or support package tab.

3. Adjust the controls as needed for your situation.

NOTE. Sampling and state speeds will vary by module.

Microprocessor or Bus Support Package

A microprocessor or bus support package is a software application that allows the logic analyzer to
acquire and disassemble microprocessor data or data from a bus.

Some support packages include a hardware probe adapter that is attached directly to the
microprocessor in the system under test to capture microprocessor signals.

The LA Setup window shows which support package is currently installed.
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Synchronous Sampling: Define Single Clock

The default controls for the Synchronous tab establish global settings for setup and hold across all signals
in the module. You can identify a single clock from the system under test for your synchronous clock. You
can change the settings for individual signals in the Signal Mapping area (see page 18).

To Use

1. From the TLA toolbar, click the Setup button for your module.

Click the Synchronous tab.

If necessary, click the drawer arrow (<||||) to open the Define Single Clock panel.

Select the clock source from the Single Clock Source list.

LA

Adjust the Global Default Threshold. This setting should match most of the signals that you are
sampling with the current module.

6. Enter a maximum clock rate or the minimum clock period for your module.

Setting this value helps scale the T, and Ty, elements in the diagram. Enter a value that is likely to be
greater than your maximum clock rate; an accurate value is not needed.

7. Select the clock edge and adjust the busform to match your SUT setup and hold times. You can drag
the whole busform or just the edges.

Behavior

When you select the DDR check box, the logic analyzer automatically selects the appropriate sampling
points based on the Max Clock Rate and currently selected sample points. If you manually select two
points, the DDR check box is automatically selected.

Synchronous Sampling: Define Compound Clock

Use the Define Compound Clock controls to set up a compound synchronous clock. This is a global setting
for the module. You can change the settings for individual signals in the Signal Mapping area (see page 18).

To Use

1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. Ifnecessary, click on the drawer arrow (||[[>) to open the Define Compound Clock panel.

15



System Setup Deskew Panel

4. In the Master Sampler table, define the synchronous clock sources by selecting the clocks and qualifiers
from the drop-down list within each table cell. The graphic shows the resultant settings.

5. Adjust the Default Threshold. This setting should match most of the signals that you are sampling
with the current module.

6. In the Speed drop-down list box, select a bandwidth for the module you are using. If you select Max,
and reload a different module, the default setting uses the maximum speed of the module (only
available with TLA7000 series logic analyzer modules).

7. Set the Pipeline Delay for all acquired signals.

8. Enter the minimum clock period for your module.

Behavior

When you display the Define Compound Clock panel, the logic analyzer uses the default values you
assigned in the Define Single Clock panel, including Min Clock Period, T; and Ty, and the number
of sample points.

If you defined a DDR sampling structure in the Define Single Clock panel, the Sampler Definition area
indicates two sample points corresponding to the DDR definition. However, you will note that the
Compound Clock diagram differs significantly from the Single Clock diagram.

NOTE. To configure individual channels with varying numbers of sample points, use Compound Clocking
and then adjust each signal definition using the Signal Sampling Screen (see page 24).

Deskew Panel

16

Deskew allows you to compensate for propagation delays in your circuit traces that differ from your design
due to the location of the probe header. You can perform the deskew on all signals in the module by
clicking the Deskew button. You can also deskew individual signal groups (see page 17).

This procedure applies deskew to all signals in the module.
1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. Use the Search Range and Accuracy controls to adjust deskew settings for all signals for the connected
modules.

4. Click the Deskew button.

The logic analyzer displays the Deskew progress bar in the Status area during deskew.
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Group Deskew

This procedure deskews selected signals within a defined group based on parameters you set in the
Deskew panel. After you make any changes to selected signals in the group, the Global Values check box
will be cleared. This indicates that these signals will not track changes to the parameters in the Global
Sampling diagram.

1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. In the Group Management area, adjacent to the Signal Mapping area, create and name a signal group

(see page 22).

4. In the group card, click the Local Sampler Definition thumbnail —l;(_ in the group card header to open
the Signal Sampling screen.

5. In the Signal Sampling screen, verify that the signals that you want to deskew are highlighted in
the Signal tree.

6. Click the Deskew button to deskew the highlighted signals in the group.
The logic analyzer displays the Deskew progress bar in the Status area during deskew.

To return signals to the global value, select the Use Global Values check box.

Behavior

Before deskew, the logic analyzer displays all of the signals in the local Setup and Hold diagram on top
of one another. After the deskew, the logic analyzer displays the signals as a fuzz band in the Setup
and Hold diagram.

Related Topic

Signal Sampling Screen: Adjusting Setup and Hold Values (see page 24)

17
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Fuzz Band

The logic analyzer displays signals as a fuzz band within the Setup and Hold diagram. The display
shows the signal frequency as a temperature gradient where the warmer or brighter colors represent a
higher density of signals. The cooler or darker colors represent areas where fewer signals overlap.
Click an area in the fuzz band to select a signal from the tree. You can adjust the Setup and Hold
values for the selected signal or move the signal within the fuzz band.

176 ps |E|v T: Th [Ops =

Signal Mapping Area

The Signal Mapping area allows you to view the physical resources of the module. It also provides
a centralized area for viewing signal activity, signal type and characteristics, sampling configuration,
and base and prime signal participation.

Use the Signal Sampling screen to configure the threshold, polarity, type, and the sampling definitions for
individual signals. Access the Signal Sampling screen either through the right-click menu (by clicking the
activity indicator in a channel cell for the signal), or by clicking the Local Sampler Definition thumbnail

—;(_ next to the probe section header

Behavior

The Signal Mapping area is a collection of cells organized into a two-dimensional matrix. The columns
represent the probe leads (consisting of probe sections in a 7 — 0 order, plus the clock and qualification
leads). The rows represent probe sections, with adjacent rows representing paired probe sections. Columns
and rows cannot be individually sized, and header cells cannot be renamed.

The Signal Mapping area may display logical signals that have no physical counterpart (such as status
bits or static bits).

18
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Sampling Definition Thumbnails. When a module is sampling in synchronous sampling mode or custom
sampling mode, the Thumbnail column displays images representing the sampling definition of the probe
signals. In addition to identifying the characteristics of the probe section sampling characteristics, the
thumbnail is a button used to display the Signal Sampling screen.

NOTE. The logic analyzer does not display thumbnails in the asynchronous sampling mode.

Click the thumbnail image to open the Signal Properties screen where you can set the sampling offsets for
base and prime signals.

Thumbnail type Description
_/— —\_ Basic sampling, rising or falling edge, single sample point
= - Compound sampling, one or more rising or falling edges, no
qualifier
Same as above with additional sample point
o/ oljs\c
.—. Basic sampling, rising or falling edges, two sample points
Compound sampling, one or more rising and falling edges,
x o no qualifier
F = Compound sampling, one or more edges with one or more
_/_IJ _\_D qualifiers.
= Compound sampling, one or more rising and falling edges,
)'{ o one or more qualifiers
Varies (variable sampling), signals in a group or section have
D_I;(E;:! different sampling characteristics

The clocking figure may have any of the images shown above;
the rising edge shown for illustration purposes only

By default, the displayed thumbnail corresponds to the Global Sampling Definition. When you change
an individual signal sample point (either manually or as a result of the deskew function), the thumbnail
displays the Varies image, indicating that at least one signal in the section has a different sample point.

Thumbnails appear for base signals and group cards and are not available for prime signals, status bits,
or custom sampling contexts.

Probe Section Header

The logic analyzer uses the Probe Section Header to identify base (true sources) and prime (cloned data
streams from the base source) signals.

The Probe Section Header displays the name of the probe section (A0, Al, A2). Base probe sections (true
sources) display the name left-justified in the header cell.

19
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Signal Mapping Area

Prime probe sections (data streams cloned from the base source) are labeled with the base name and an
exponent (A0!, A02). The labels are right justified in the header cell. Prime probe sections are always
placed sequentially below their Base probe section (A0 is followed by A0!, A02).

Signal Column Header

Each probe lead is assigned a cell below its signal number. The Signal column header is a display item
only and has no interactive behavior.

Clock / Qual Header

Two columns identify the clock and qualification lead for each probe section that has one of these
additional leads. The left column permanently displays the resource name, for example CK0(), and the
right column contains the Channel / Signal cell. The Channel / Signal cell initially shows the resource
name, but you can enter your own name. For probe sections that do not have a clock, qual, or both,
both cells in the column are disabled.

Group Participation Bar

Running horizontally across the top of each Signal cell, is a color-pattern bar that indicates how signals
participate in a selected group or multiple groups. The following table shows examples of two adjacent
cells.

Appearance Description

E107) . E1(6) I Default appearance. The channels do not participate in any group.

DEACK ] Deack e | Group participation. The signals participate in the currently selected group.

Multiple group participation. The signals participate in the current selected

- 1
BRPT O CLROUT group and at least one other group.

Other group participation. The signals participate in a group other than the

addr 31 addr 30
o selected group.

Activity Indicator

The rightmost region of a base Channel / Signal cell displays activity information and a means to modify
the operating characteristics of the signal. Instead of activity indicators, polarity indicators are displayed
for prime signals, status bits, static bits, or custom signals using the crossbar (custom storage signals).
Although you cannot change most of the operating characteristics of these types of signals, you can still
change the polarity by right-clicking the polarity indicator and by selecting the Invert Signal Polarity from
the right-click menu.

The following table shows examples of the polarity indicators and activity indicators.
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Signal Mapping Area

Appearance Description
D3(6) I Normal, high polarity. The indicator appears as a vertical bar in the upper cell.
a2(5) Normal, low polarity. The indicator appears as a zero in the lower cell.
o
o Inverted, low polarity. The indicator appears as a zero in the upper corner.
A2(E) Similarly for the inverted, high polarity, the indicator appears as a vertical bar
in the lower cell.
Transitioning signal.
DU g 950

Click the green and yellow activity indicator to display the Signal Sampling panel, where you set the signal

threshold value and polarity.

Static and Status Bits

These are additional signals that you can use in group definitions for triggering.

Related Topic

Group Management Area (see page 22)
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Group Management Area

22

Use the Group Management area to organize the probe signals to match the configuration of the system
under test. Depending on your application, match the signal groups (see page 28) to the address and
data buses, or match the signal groups to other signals of interest. Each signal group is displayed as an
individual group card with a group name and grid. Group cards contain additional elements, such as an
activity indicator and thumbnail to help you define signal properties within the signal group.

To Use

1. From the TLA toolbar, click the Setup button for your module.

2. To create a new group, click the + icon at the top of the Group Management area.
a. Enter a group name for easy identification.

b. In the Signal Mapping area, select individual signals or entire probe sections, and then drag and
drop the signals to the group card.

¢. To rearrange the order of signals within a group, drag and drop them from one location to another
within the group card grid. Alternatively, right-click the mouse and select Reverse Signal Order
to change the MSB-LSB order of the signals.

3. After creating multiple group cards, you can rearrange them by dragging and dropping them in the
Group Management area.

4. Click the thumbnail or the activity indicator in a group card to access the Signal Sampling screen (see
page 24) to adjust signal thresholds or to adjust the setup and hold requirements for signals.

NOTE. Activity indicators and thumbnails might not display depending on the sampling you have defined.

5. Expand and collapse group cards to make room for more cards on the screen using the right-facing
arrow in the upper left corner of the group card.

Behavior

You can create any number of group cards. Each group can contain any combination of module signals;
you are not restricted from mixing or repeating signals from various groups.

Groups are used in other displays and setup controls, such as the Waveform and Listing windows, and
the Trigger window. The order of the groups in this table determines the presentation order of groups in
other parts of the application.
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Support Packages

If a microprocessor support package is loaded, the signal groups are already defined. You should not
change or delete these groups; doing so can lower the accuracy of disassembly analysis. However, you still
have the option of adding and deleting new groups.

Related Topic

Signal Mapping Area (see page 18)

Group Name

Each group must have a unique name. When you use the same name as a previous group, the
application prefixes your name with a number. For example, if you try to name a group, MyGroup,
and another group already exists with the that name, the application will redisplay your group name
as 1:MyGroup.

You can use the default name, or you can enter another name as long as it is unique. The names
will appear in the Listing and Waveform windows. There is no limit to the number of groups you
can create.

Signal Sampling Screen: Setting Thresholds

Use the Signal Sampling screen to set the probe signal characteristics appropriate to your system under test.

To Use

1.
2.
3.

From the TLA toolbar click the Setup button for your module.
In the Signal Mapping area, select one or more cells.

Click the Activity Indicator in one of the selected cells. Alternatively, from the right-click menu,
select Signal Sampling.

Confirm the signals you want to work with are highlighted in the Signal tree. Clicking an item removes
the existing highlighting. (Press and hold CTRL+Click or SHIFT+Click to highlight multiple items in
the Signal tree.)

Use the slider or Preset controls to set threshold values for the highlighted items.

Click Normal or Inverse to set the polarity for the highlighted items.

NOTE. If you highlight a prime signal in the Signal tree, no corresponding threshold control becomes
available (no slider highlights in the threshold graph). Prime signals do not have thresholds.
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Behavior

Changes you make to the threshold are immediately applied to the signals that you highlighted in the
Signal tree.

NOTE. You can highlight a different set of signals from the "selected" set of signals (the signals you
selected in the Signal Mapping area).

Use one of the buttons adjacent to threshold graph to assign the threshold value to more signals than the
ones you’ve highlighted. For example, if you have highlighted only one signal in the tree, (and you have
several "selected") click the Selected Signals button to assign the threshold to the selected set of signals.
Similarly, click the Probe Sections button to assign the threshold to all signals in a probe section to which a
highlighted signals belongs. The buttons are arranged top to bottom in increasing scope.

NOTE. Not all buttons will be enabled for all types of highlighting and selecting. Depending on your
module type, you might have fewer or more buttons available.

Related Topic

Signal Sampling Screen: Adjusting Setup and Hold Values (see page 24)

Signal Sampling Screen: Adjusting Setup and Hold Values

24

Use the Signal Sampling screen to adjust setup and hold times for signals at the local (probe section or
group) level when working with synchronous or custom sampling.

To Use
1. From the TLA toolbar, click the Setup button for your module.

2. Select the Synchronous tab (or custom sampling if you want to adjust signals for a loaded support
package).

3. Click the Local Sampler Definition thumbnail —I;(_ in the probe section column in the Signal Mapping
area or in the group card to open the Signal Sampling screen (the image on the thumbnail differs
depending on your setup).

4. Click to select a signal in the tree (CTRL or SHIFT to select multiple signals) in the Signal tree.
Alternatively, you can click on the busform in the clocking diagram. Repeated clicking on a busform
will cycle through the signals in the order they are displayed in the Signal tree.

5. Adjust the local setup and hold values for your signal by dragging the Setup or Hold indicators,
dragging the entire busform, or by entering specific values in the boxes.
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When you select more than one signal (within the same sample or across samples) the logic analyzer
displays an open selection outline around each of the signals.

Interactions Between Global and Local Sampling Definitions

When you first open the Signal Sampling screen, the default settings are based on the global default
values. When you change a local setting, the setting is no longer affected by changes that you make at
the global level.

If you work in a local context and you change the global settings, any local settings that you have not
manually changed will be updated to the global settings. To reestablish the local value connection with the
global values, click the Use Global Values check box. The check box affects the T and Ty, values of the
current highlighted signals in the Signal tree. The check box is disabled when no signals are highlighted.

Related Topics
Signal Sampling Screen: Setting Thresholds (see page 23)

Group Deskew (see page 17)

Highlighted vs. Selected Signals

In the sample tree structure below, signals C2(3), C2(2), and C2(1) were selected and highlighted
when you first opened the Signal Sampling screen. Any changes that you made to the highlighted
signals were automatically applied.

[ ¢z When you click signal C2(5), the signal becomes highlighted while signals
C2(3), C2(2), and C2(1) remain selected, but not highlighted. Any changes

247 that you make in the Signal Sampling screen will be applied to highlighted
26 signals, in this case, just C2(5). This gives you the flexibility to change
(g signals by highlighting them without having to close and reenter the Signal
c2|:4]| Sampling screen.
23 Highlighting and selection apply to both sides of the Signal Sampling
screen: changing thresholds and changing setup and hold times. In the
2(2) case of thresholds, the threshold slider highlights based on which signals
C2(1) you have highlighted. When you move the slider, only the highlighted
czim) signals are affected.

When used with thresholds, the highlighted signals determine which
buttons on the left side of the Signal Sampling screen become available for
changing thresholds.

Acquisition Options

The acquisition options determine the data to store. The options that are available depend on the sampling
type that you specify.
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To Use

Acquisition Options

1. From the TLA toolbar, click the Setup button for your module.

. Select your sampling type (synchronous, asynchronous, or custom).

2
3. Select Samples to store only the samples you acquire (default).
4

. Select 63-Sample Blocks to store 31 samples before your stored sample and 31 samples after your
stored sample. (Use conditional storage in Trigger to store only events of interest).

5. Select Samples + Glitches (Asynchronous) or Samples + Violations (Synchronous) to store both

the acquired sample and glitch or violation data.

Behavior

Sampling type

Acquisition options and resulting data

Asynchronous

Samples - stores samples only

63-Sample Blocks - stores blocks of data around each
stored sample

Samples + Glitches - stores both signal and glitch data

Synchronous

Samples - stores samples only

63-Sample Blocks - stores blocks of data around each
stored sample

Samples + Violations - stores both samples and setup &
hold data

NOTE. Selecting Samples + Glitches or Samples + Violations decreases the maximum memory depth by

half and decreases the maximum sampling speed.

Related Topics
Sampling (see page 14)

LA Setup Window (see page 13)

63-Sample Blocks Mode (see page 162)

Samples + Violation Storage Mode

The Samples + Violation storage mode captures both setup and hold violation data and regular data
for each signal. This mode limits memory depth to half of the memory depth.
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Samples + Glitches Storage Mode

The Samples + Glitches storage mode captures both glitch data and regular data for each signal. This
mode limits memory depth to half of the maximum depth and limits the sample period to 4 ns or
greater for TLA7000 Series logic analyzer modules and TLAS000B Series logic analyzers.

Sample Storage

Use the Samples per Signal setting to specify the total number of samples acquired for each signal by
the logic analyzer.

To Use
1. From the TLA toolbar, click the Setup button for your module.

2. In the Setup window, use the slider to set the Samples per Signal.

Behavior

For a given number of samples, there is a trade-off between the sample rate and the sample duration, and
the time period over which samples are taken. A faster sample rate provides a more detailed record of
a shorter sampling duration.

If you do not require the maximum number of samples, select a lesser value. This will improve the
response time for search and zoom operations.

NOTE. Selecting Samples + Glitches reduces the available memory by one half. You can double the
available memory by increasing the sample rate below a certain value in Asynchronous sampling. In
Synchronous sampling, you can double the available memory by increasing the maximum clock rate of
the SUT clock rate by reducing the clock period.

Related Topics
Selecting Memory: A General Approach (see page 90)

Acquisition Options (see page 25)

Merged Module Synchronous Sampling

If you use synchronous sampling with a merged module formation and you use a single clock source, you
only need to connect the clock lead from the master module to the clock source.

This condition is also true for qualifier lines.
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Related Topic
Merge Modules Properties (see page 372)

Highlight Signal Names Dialog Box

Use this dialog box to highlight signals by name.
1. From the toolbar, open the Setup menu and select your module.
2. In the signal mapping area, right-click and select Highlight Signal Names.

3. In the Highlight Signal Names dialog box, enter the text you want to find. For example, enter RESET
to highlight any signal name that contains RESET.

NOTE. You can enter multiple strings, separated by spaces. The space-separated strings are logically
ORed. That is, the name that matches any one of the strings will be highlighted.

4. Select the highlight criteria.
5. Click OK.

Grouping

Group cards list the signals that make up each group. Use the group cards to do the following:
m Create arbitrary collections of signals by dragging them from the Signal Mapping area.

You can type the signal name in an empty cell in the group card grid. You can also type the signal name
in the Keystroke Entry field.

B Arrange the signals in order of significance by clicking and dragging them within the group card; the
Keystroke Entry field automatically updates when you rearrange signals.

m Establish operating conditions on the logical groups to establish proper operating conditions of the
logic analyzer.

B Provide the appropriate logical relationship to the system under test.
There are several ways to delete signals within a group card:

B Delete the signal name from the Keystroke Entry field.

m Select a signal name within a cell and delete it.

m Select one or more signals and press the Delete key.

B Select an individual signal and drag it to another group or to the Signal Mapping area.
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When you delete a signal from a group card, the signals on the least-significant bit side of the deleted
signal move to fill the gap created by the deleted signal.

Keystroke Entry Field

Use the Keystroke Entry field to enter valid expressions for signals in the group card. You can enter
hardware section notation variants (such as A3, A2(), E1(0—4)) as well as logical names. The field
automatically updates the section notation to individual hardware names. The field also applies logical
names to signals, if they are available, such as when your logic analyzer has a bus support loaded.

iCapture Analog Feeds

Use the iCapture Analog Feeds dialog box to assign a digital data signal to a TLA7000 Series logic
analyzer module analog output.

You can assign data signals in the following ways:
®  Select an individual channel; then assign it to an analog output channel.
m  Select a group of channels; then select the analog output channels to which you want them assigned.

The Physical Module field, which is located at the top of the dialog box, allows you to select which logic
analyzer module channels you want to direct to an oscilloscope.

NOTE. iCapture Analog Feeds are only available in TLA7000 Series logic analyzer modules.

To Use

From the TLA toolbar, click the iCapture button.

Behavior

Under Analog Output Attenuation, select an attenuation level based on the amplitude of the signals being
assigned. 5X Attenuation is best suited for small amplitude, high-performance signals for improved signal
to noise ratio. Please note that waveforms displayed on your oscilloscope will be displayed at twice their
normal height because the attenuating factor is 5X and not 10X.
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iCapture Analog Feeds @@
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After selecting which module contains signals that you want to output, you use the contents of Select
Channels to choose one or more specific signals to use as feeds for analog outputs. Select Channels
contains a drop-down list that you can use to choose the manner in which digital signals are displayed.

The drop-down list provides the following display options:

® By Group. This displays signals organized by group. Only groups that are defined in the LA Setup
window can be displayed using this option. In addition, a group can only be expanded if it contains
signals from the selected physical module.

B By Probe. This displays signals that are alphanumerically organized by individual signal. All signals
are displayed when this option is selected, regardless of whether they are part of a group that is defined
in the LA Setup window.

m By Name. This displays signals by name assigned to them from the LA Setup window. Signals that
have not been assigned custom names are not listed when using this selection.

Selecting Individual Signals

After you have chosen a digital signal to output, you can assign it to an analog output signal by clicking a
signal button under Assign To. You can confirm that the digital signal was correctly routed by reviewing
the analog feed assignment information under Current Routing.
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Selecting Groups

When you select multiple digital signals to output, you can assign them to one or more analog output
signals by selecting the check boxes associated with the target signals. If you are interested in more
digital signals than you have analog outputs, use the Analog Feed Cycling buttons to cycle the selected
digital signals through the selected analog outputs. You can additionally direct the system to exclude
signals assigned to unchecked outputs, which guarantees that signal assignments to unselected outputs are
preserved. To do so, select the check box labeled Exclude signals assigned to unchecked outputs.

NOTE. The system reassigns digital signals only when the assigned digital signal is a member of the
signals that you specified for output in Selected Channels and the analog output signal to which the
digital signal is assigned is not selected.

If one or more of the selected digital signals are already assigned to an analog output, those signals are
highlighted under Select Channels. As you feed digital signals to the selected analog output signals, this
highlighting changes to reflect current signal routing.

Use the following Analog Feed Cycling buttons to cycle the selected digital signals to the selected
analog output signals.

i Assigns up to the first four (depending on number of analog output signals selected) digital
signals to the selected analog output signals.

[ Assigns the selected digital signals to the selected signal outputs in groups equal to the number
of signal outputs selected. The order in which the digital signals are assigned is from the bottom of
the list to the top.

__* | Assigns the selected digital signals to the selected signal outputs, in groups equal to the
number of signal outputs selected. The order in which the digital signals are assigned is from the top of
the list to the bottom.

#* | Assigns up to the last four (depending on the number of analog output signals selected) digital
s1gnals to the selected analog output signals.

The Current Routing group box displays read-only details about the assignment of individual data
signals to analog outputs and the oscilloscope input signals to which they are physically connected. It
additionally provides a System Inter-probing button that you can click to reassign oscilloscope destination
of data signals.

TIP. To acquire the best possible signal-to-noise ratio on live waveforms through the analog probe outputs,
use an external oscilloscope when the logic analyzer acquisition is idle.

The iCapture Analog Feeds dialog box retains the signal assignment settings for each TLA7000 Series
logic analyzer module represented in the System window. When using Analog Feed Cycling, you can
assign signals using one of the previously described control buttons, then close the dialog box. Later, when
you reopen the dialog box, you can resume assigning digital signals to analog outputs. However, if you
change either the setup of groups or any signal names, signal assignment settings will return to defaults
the next time the dialog box is opened.
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When using the logic analyzer’s demultiplexing capabilities to acquire digital data, the analog output data
may not match the digital data. The analog output connector always gets the signal directly from what is
present at the probe tip. For a demultiplexed destination signal, the digital data comes from the demux
source signal and not from the probe tip. Looking at the LA Setup dialog box signal grid, you can easily
tell which analog output signals will not match the digital data: Demultiplexed destination signals (pink
background) and signals forced to 1 or 0 (yellow background) will not match.

Related Topics

System Inter-Probing (see page 51)

Changing Signal Routing (see page 67)

Setting Up Analog Feeds (see page 64)

Filter Definitions Dialog Box
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From the toolbar, click the Filters button for your module.

Overview

Use this dialog box to display and manage all filters in the logic analyzer.

Behavior

The dialog box displays all modules and filters currently used by the logic analyzer. Use the tree controls
to expand and collapse the filter contents of the modules. Modules are listed first, followed by any loaded
data sources, and then the filters. Loaded data sources consist of a file name and a module name (for
example, System1.tla:LA-1).

To Use

Manage the filters using the toolbar buttons at the top of the dialog box, the right-click menu, or the
keyboard. By selecting a module in the dialog box, you can attach a new filter to the module, load an
existing filter, or paste a new filter using the clipboard contents and attach it to the module. By selecting a
filter, you can cut, copy, paste filter contents, load another filter’s contents from the Load Filter Dialog
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Box (see page 34), or you can view or edit the filter’s contents through the Define Filters dialog box
(see page 33).

Define Filter Dialog Box

Overview

The logic analyzer normally displays all data acquired by the probes from the target system. Frequently,
it displays data that you are not interested in. You can use data filters to display only the data that you
want to see in the data window.

Use filters to do the following:

m Hide specific data. For example, you can define a filter to hide data when all of the data in a group
is equal to FFFF.

®m  Show specific data. For example, you can define another filter to show data from a specific address.

B Color specific data. For example, you can define a filter to display data to another address with a
specified color.

Behavior

Filters are made up of clauses and events and are very similar to trigger
definitions. Use the drop-down list located at the upper left corner
of each clause to select an action for each clause. All clauses in the filter are evaluated beginning with the first

M Define Filter - LA 1 - Filter

Module - Fiter: ||_,:,, 1 - Filtar v | [#]Enable this Filter

Description: |

(shaw  w | When ([CKO OR E3(7]) OR Timestamp]

[Goo 9] [0 v|[- vl ~ED
|C|':ar:n=| ‘V‘: E3{7) v||1 -
| (o] [rmestame (v |[= vi[zs | e ?

Then hide all remaining data,

[ oox | | cance || apoly Load Filter... | | Hep

clause.
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When you select a Show or Hide action, you can fill in the event fields by using the drop-down lists or
text boxes to define the event that you want to either show or hide.

When you select a Color action, a color options button appears where you can click the color options for
your filter. After you select the color options, you can fill in the event fields to further define the data that
you want to filter for the specific event.

You can edit events and clauses by clicking the mouse at the right-end of the clause and either placing the
mouse over the indicator or right-clicking the mouse to display a context-sensitive menu.

Filters are saved as part of the module setups. You can load filters when you need them. You can also edit
and rename filters. When you apply a filter to a data window, the filter name is appended to the data label
(for example LA1: FilterA: A3 indicates that FilterA is attached to the A3 group of module LA1).

To Use

Use this dialog box similarly to the trigger window by defining events and clauses for the filter. By default
the filter is enabled if it is not enabled, click the Enable this Filter check box.

Load Filter Dialog Box
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Overview

Use this dialog box to load filter contents from any current or saved module setups.

Behavior

This dialog box loads filter contents from any saved module setup files or system setup files. The load
operation replaces all settings in the selected filter (specified in the title bar). If no filter is selected, the
load operation creates a new filter and attaches it to a module.

When a module setup name or system setup name appears in the File Name text box, all modules and
filters associated with that setup are listed in the center of the dialog box. If a module has a filter attached,
you can select and load that filter.

To Use

Enter a module setup or a system setup name in the File Name text box or click the Browse button to locate
a module or system setup file. Select a filter from the setup to enable the Load button; click the load button
to load the filter. You can also double-click the filter to automatically load the filter.

NOTE. Ifyou load a filter that uses groups or signals that are not included with the module, the events will
be discarded. A message box will display, explaining what happened.




System Setup Load Filter Browser Dialog Box

Related Topic
Load Filter Browser Dialog Box (see page 35)

Load Filter Browser Dialog Box

Use this dialog box to find TLA module or system setup files that contain filters. This dialog box is similar
to the standard Open Dialog Box. The main exception is that the Content area describes whether the
module has any filters defined.

Use the dialog box to browse the file system for filters. After you select a file name and click the Open
button, the dialog box closes and adds the file name to the File Name field of the Load Filter Dialog

Box (see page 34).

TIP. If you don t see the file that you want, make sure that the file is a valid TLA module setup file or
system setup file. These files have the .tla suffix.

Applying Filters

When you apply a filter to a data window, the filtered data appears as a data source. The filter name is
appended to the data source name in a data window. Define the filter before you can apply it to a data
window.

1. In the Listing window, click the column name; in the Waveform window, click a waveform name.
2. Right-click the mouse and elect Apply Filter followed by the filter name.

You can add a new column or waveform with filtered data by clicking the Add Column or Add Waveform
icons and selecting a filtered data source:

=
1. In the Listing window, click i (the Add Column icon); in the Waveform window, click e (the
Add Waveform icon), .

2. In the new dialog box, select a data source that contains filtered data. For example, LA1:Filterl.
3. Select the data group that contains the filtered data.
4. Click the Add button followed by the Close button.

Color Options Dialog Box

Use this dialog box to control the color of groups in the data window.
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Select a filter in the Filter Definitions dialog box and then click to open the filter.
Select Color from the filter definition.

Click the button to the right of the drop-down list to open the Color Options dialog box.

L A

Determine whether you want to use separate colors for an individual group or the same color for
all groups.

5. Click the color button to select the foreground and background color from the color matrix.

In addition to using a basic color, you can click More Colors... at the bottom of the color selection
box to define custom colors.

6. Click OK to close the dialog box.

Signal Import and Export Formats

The Signal import and export uses a structured text file format to organize the import and export
information. Only formatted text files can be processed by the parser.

The import or export file is separated into multiple lines by EOL (EOL can be CR, LF, or CRLF). During
importing or exporting, the parser processes one line at a time. The following lines are allowed in the file:

Comment Lines (see page 40)

Control Lines (see page 41)

Information Lines (see page 43)

Click Sample File (see page 38) to view an Import/Export file.

Related Topics
Signal Setup Import Dialog Box (see page 38)

Signal Setup Export Dialog Box (see page 37)

Signal Setup Import Behavior (see page 36)

Signal Setup Import Behavior
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Be aware of some of the behavior of the logic analyzer when it imports signal setup files:

B The logic analyzer detects the delimiters used in the imported file. Therefore it is important to use
only one delimiter in the file. If you need to embed the delimiters in a signal name or group name,
enclose the name with quotes.

m The import operation will update the signal setup parameters related to the selected fields. For example,
if a user-defined signal name is selected, the old name will be replaced by the new name without any
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warnings. Similarly, if there are two lines in the imported file setting for the same signals, the second
line receives the new name.

B The import operation will not change the signal setup parameters related to unselected fields. A skipped
field (an empty field name between two delimiters) acts as an unselected field.

®  User-defined signal names must be unique. If an imported user-defined signal name exists, the two
signals will exchange their user-defined names (for example, if you have A0(0):A and AO(1):B, and
you set AO(1) to A, the result will be A0(0):B and AO(1):A).

B [f an imported file contains a definition for a signal that does not exist, the definition will be ignored
and a warning message will be saved in the error log file. You may experience this when importing a
file to a narrow module.

B  If an imported file does not contain definitions for all the signals of the logic analyzer, the definitions of
the missing signals remain unchanged. This may happen when you import a file to a wide module.

m  The parser processes one line at a time. It will stop processing on any unrecognizable line and then
display an error message.

®  All warning and error messages will be written to a file named ImportExportError.log in the same
location as the import file.

Signal Setup Export Dialog Box

Overview

Use this dialog box to export signal setups to a text file. The setups can then be imported by another
logic analyzer.

Behavior

This dialog box allows you to save the setups to a text file listed in the Export Path box. You can also click
the Browse button to save the file to a folder of your choosing. You have the choice of exporting individual
signal information or group information by selecting the appropriate Export Selections. If you select
Export Signal Information, you can specify the type of information that you want to export by selecting
one or more of the check boxes. You can select one of four field delimiters to separate the fields within the
file; an empty field is represented by two consecutive field delimiters in the file.

Any warning or error messages are saved in a log file in the same location as the exported file.

To Use

Select Export Signal Setup... from the File menu. Specify a file name and the path to the file. Use the
other selections in the dialog box to define the signal information and delimiters. Click the Export button
to export the file.

37



System Setup Signal Setup Import Dialog Box

Related Topics
Signal Setup Import Dialog Box (see page 38)

Signal Import and Export Formats (see page 36)

Signal Setup Import Behavior (see page 36)

Signal Setup Import Dialog Box

Overview

Use this dialog box to import signal setups from a saved location.

Behavior

This dialog box allows you to specify the signal setup information that you want to import. Specify the
file location in the Import Path box or click the Browse button to browse the file system for the file. The
setups are normally saved in a text file.

Select the Automatically detect from file to import all fields from the import file. Select Custom options to
specify the fields that you want to import by selecting one or more custom options. If you try to import

a field that does not exist in the import file, the logic analyzer will display a warning message. Click

the Import button to import the setups. Warning and error messages are saved in a log file in the same
location as the imported file.

To Use

Select Import Signal Setup... from the File menu while the Setup window is active. Locate the import file,
specify the import options in the dialog box, and then click the Import button.

Related Topics
Signal Setup Export Dialog Box (see page 37)

Signal Import and Export Formats (see page 36)

Signal Setup Import Behavior (see page 36)

Sample Signal Setup File

The following file shows an example of the different parts of a Signal Import/Export file.

[11117777777777777777777777777777777777777777777777777/7777/777777/7777/7/7777/
// TLA Signal Import/Export File
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// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Version: 1.0.001

// (Field Delimiter: <Tab>)
[17777777777777777777777777777777777777777777777777777777777777777777/77/77777
[177777777777777777777777777777777777777777777777777777777777777777777/77/77777
// Remove all user-defined signal names

//+ResetAl1Signals

//

// Remove all groups

//+RemoveAllGroups
[I1177777777777777777777777777777777777777777777777777777777777777777777777777

LI1177777777777777777777777777777777777777777777777777777777777777777777777/77
// Signal definition format

//+SignalFormat : HwName UserName Polarity Compare
IIT177777777777777777777777777777777777777777777777777777777777777777777777777
C0(7) NMI - TRUE

CO(6) IGNNE# - TRUE

CO0(5) EADS# - TRUE

C0(4) SRESET - TRUE

C0(3) HOLD - TRUE

C0(2) KEN# - TRUE

C0(1) LOCK# - TRUE

C0(0) RDY#= - TRUE

Q3 Q3 - TRUE
Q2 Q2 - TRUE
Ql Q1 - TRUE
Q0 Q0 - TRUE

CK3 CLK - TRUE
CK2 RDY# - TRUE
CK1 BRDY# - TRUE

CKO BRDYC# - TRUE
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II1177777777777777777777777777777777777777777777777777777777777777777777777777

// Group definition format
//+GroupFormat : GroupName ChannelList

II1177777777777777777777777777777777777777777777777777777777777777777777777777

Data D31 D30 D29 D28 D27 D26 D25 D24 D23 D22 D21 D20 D19 D18 D17 D16 D15 D14
D13 D12 D11 D10 DY D8 D7 D6 D5 D4 D3 D2 D1 DO

Control BLAST# AHOLD HLDA BOFF# M/I0# D/C# W/R# SMIACT#
DataSize BS8# BS16# BE3# BE2# BEl# BEO#

Misc CLK= ADS#

Cache KEN# EADS# FLUSH#

Misc2 BREQ# INTR LOCK# PLOCK# RDY#= BRDY#= BRDYC#= HOLD IGNNE# FERR# RESET
SRESET NMI

Comment Lines

40

All lines starting with "//" are treated as comments, unless the very next character is a *+’, which signifies a
control line. The "//" can also be used to initiate a comment on the end of "non-comment" line. In this
case, a delimiter is needed before the "//", all text between the "//", and the end of the line is treated as a
comment (ignored by the parser). Examples of using comments lines are shown below:

LI11777777777777777777777777777777777777777777777777777777777777777777777777
// TLA Signal Import/Export File

// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Version: 1.0.001

// (Field Delimiter: <Tab>)

LI71777777777777777777777777777777777777777777777777777777777777777777777777

Related Topics
Control Lines (see page 41)

Information Lines (see page 43)

Sample Signal Setup File (see page 38)

Signal Setup Import Behavior (see page 36)
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Control Lines

All lines starting with "//+" are treated as control lines. This special character sequence is used to mark
instructions to the parser. Each word in a control line is considered as a keyword, which can be recognized
by the parser. Only delimiters and predefined keywords are allowed in a control line. Each control line
signifies a structure, which is used to organize the information in the following information lines.

The first keyword in a control line specifies the name of the defined structure. The keywords after
the structure name specify the names of the structure items. Currently, there are four structure names
available, ResetAllSignals, RemoveAllGroups, SignalFormat, and GroupFormat. The keywords
are not case sensitive.

ResetAllSignals

This keyword works as a command to remove all user-defined signal names as shown in the following
example:

L11177777777777777777777777777777777777777777777777777777777777777777777777777
// Remove all user-defined signal names.

//+ResetAllSignals
[17177777777777777777777777777777777777777777777777777777777777777/7/7777777777

RemoveAllGroups

This keyword works as a command to remove all of the groups.
LI177777777777777777777777777777777777777777777777777777777777777777777777777777777
// Remove all groups.

//+RemoveAl1Groups
LI177777777777777777777777777777777777777777777777777777777777777777777777777777777

SignalFormat :

This is a structured line containing the following fields: HWName, UserName, Polarity, Threshold, and
Compare.

HWName. This is the hardware name of the signal. It is required in all SignalFormat structures. The
hardware name of the signal should never be empty in the information lines. For normal acquisition
signals, the syntax is the hardware pod name followed by the signal number enclosed in parentheses, (for
example, AO(1) or A0(2)). The syntax for clock and qualifier signals is the type identifier "CK " or " Q"
respectively, followed by a number (for example, CK0, CK1, QO, or Q1). This field is not case sensitive.

UserName. This is the user-defined name of the signal. This field is case sensitive. The user name should
be unique among signals; otherwise the latest defined name will replace the pre-existing name. The user
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name cannot contain embedded spaces, commas, or tabs. The TLA application allows semicolons in
names. When using semicolons as delimiters, embed the name and the delimiter within double quotes
("sample;name"). Similarly, if you want to embed "//" in the name, the name and the "//" symbol must
be enclosed in double quotes.

Polarity. This is the polarity of the signal. The values for this field are + and -.

Threshold. This is the threshold voltage of the signal. The syntax is the voltage value and the unit, (for
example, 2.5V, or 100mV). This field is not case sensitive.

Compare. This field contains the compare enable/disable information of the signal. Values for this field
are TRUE and FALSE. This field is not case sensitive.

[111777777777777777777777777777777777777777777777777777777777777777777777777777/7/7/777/77
// Signal definition format
//+SignalFormat: HWName UserName Polarity Threshold Compare

LIT17777777777777777777777777777777777777777777777777777777777777777777777777777777777771
C1(7),RESET,-,1.5V,TRUE

GroupFormat
This is a structured line containing the following fields: GroupName and SignalList .

GroupName. This field defines the group name. This field is case sensitive. The group name must be
unique; otherwise the later-defined name replaces the previous-defined name. The group name must not
contain embedded tabs. When using delimiters with the name, embed the group name and the delimiter
within quotes (""sample name").

SignalList. This field is a list of signal names assigned to the group. This field is case sensitive. The
names can be user-defined names or probe-based names. When using probe-based names, there are several
ways to specify the signals. For individual signals, the syntax is the hardware pod name followed by the
signal number enclosed in parentheses (for example AO(1) or A0(2)). Groups of contiguous signals can be
specified using a range of signal numbers within the parentheses (for example, A0(7-0) or A1(3-5)). When
you want to specify all signals in a hardware pod, you can use a shorthand notation using an empty pair of
parentheses (for example, AO() or A1()). The syntax for clock and qualifier signals is the type identifier
"CK " or " Q" respectively, followed by a number (for example, CK0, CK1, QO0, or Q1). Multiple signals
or groups must be separated by delimiters. Embedded spaces are not allowed.

The number of the names is unlimited. The parser reads the delimiter-separated names until it finds an EOL
character or a "//" sequence. You can break a long line into several lines by adding a delimiter followed by
the °\’ character before you add each EOL character. The parser treats those lines as a single line.

[11177777777777777777777777777777777777777777777777777/777777777777/777777/7/777/
// Group definition format

//+GroupFormat:GroupName SignalList

LIT177777777777777777777777777777777777777777777777777777777777777777777777777

control,BLAST,AHOLD,HLDA,BOFF,M/I0,D/C,W/R,SMIACT
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pata,D31,D030,D29,D28,D27,D26,D25,D24,D23,D22,D21,D20,D19,D18,D17,D16, ,\
p15,p14,p13,p012,D011,D10,D9,D8,D7,D6,D5,D4,D3,D2,D1,D0

Address,A00),A10,A20,A30

Related Topics
Comment Lines (see page 40)

Information Lines (see page 43)

Sample Signal Setup File (see page 38)

Signal Setup Import Behavior (see page 36)

Information Lines

Lines not starting with "//" or "//+" are treated as information lines. An information line can be separated
into several fields by a pre-defined delimiter. The orders of the fields are declared in the control line
defined earlier. For more information, see the Sample File. (see page 38)

Related Topics
Control Lines (see page 41)

Comment Lines (see page 40)

Sample Signal Setup File (see page 38)

Signal Setup Import Behavior (see page 36)

Serial Analyzer Setup Window

The Setup window provides access to all controls needed to configure the serial analyzer module to capture
data from a particular serial data stream or link.

A dedicated status area at the top of the window provides basic status information for the current link.
Controls at the left side of the window define the link, define the reference clock, and to specify how to
store data.

43



System Setup Status Area

The signal activity indicators in the Setup window provide a visual indication of the signal activity at the
probe. The module always acquires data and updates the status indicators. The legend items in the status
area near the top of the Setup window describes the various signal states.

Status Area

44

The status area is located near the top of the serial analyzer Setup window. It provides status information
for the Setup window and includes the following components:

B Text messages

B Command buttons

B Channel activity indicator legend
B Link status readout

Text messages provide informational, warning, or violation messages about the status of the Setup window
and the module. Some messages include an Acknowledge button. These messages appear when you
make a change to the analyzer settings that may require your further interaction. Click the Ack button to
dismiss the message.

The signal activity indicator legend defines the signal status of the signals and the system under test (SUT)
clock signals. The following table lists the possible values and their indication.

Indicator Meaning Description
No signal No signal activity and none was
expected
M S, Missing signal No signal activity. The signal is

connected to a lane on the system
under test and a signal is expected.

Signal Signal activity. A symbol lock was not
achieved.
Data signal Signal activity. The serial analyzer has

achieved symbol lock. In case of the
SUT clock, a valid clock was detected
at the front panel connector.

If the indicators appear different than what you expect, this could indicate a possible problem with the
probe or the signals at the system under test. The legend is always on the screen unless another status
message is displayed.

The right side of the status area shows key information about the current condition of the link. The top
readout displays the link width during the previous update interval and the bottom readout displays the
transfer rate. The readout displays “Link not Trained” when the link is not trained or when no signals are
active. If the link width changes during the update interval, the readout displays “Varies.”
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Autoset Status

When a link has trained, the serial analyzer can detect the training results for each lane. When this occurs,
the serial analyzer displays a status message along with the Ack button and the Autoset button. When you
click the Autoset button, the serial analyzer automatically completes the following setups for the link:

®  Link direction
B Link width. The highest lane number among the trained lanes plus one.

m  Channel-to-lane associations. The Setup window displays the associations with lines connecting
from the lanes to the activity indicators.

B Channel polarity

The serial analyzer can only detect changes in the transfer rate when Transfer Rate is set to Track Training.
If the Transfer Rate is set to one of the fixed rates, the serial analyzer cannot detect the signals at the link
when they train to a different rate. These changes are reported in the status area.

To disregard the changes and dismiss the status message, click the Ack button.

Left Side Control Area

The Left-side controls configure the behavior of the serial analyzer. The area contains three groups of
controls: the link definition group, reference clock source group, and the link data storage group.

Link Definition Group

The name of the link appears on the tab at the upper left side of the control area. You can rename the
link by clicking text and entering a new name.

Select one of the Acquire buttons to identify the upstream and downstream lanes for capturing data. The
selection that you make impacts the appearance of the signal-lane assignment area on the right side. For
example, if you acquire downstream data, the upstream signal-lane assignments become unavailable.

Select the maximum link width from the drop-down list. The link widths depend on the other settings in
the Link Definition group, such as the number of signals in the module and the Acquire selections. It is a
good idea to select the largest width to which the link can train because the link can down-train during
operation. If the serial analyzer detects changes that may require further user interaction, it displays

a message in the status area.

Select the transfer rate from the drop-down list. Use Track Training when you want the serial analyzer to
watch the TS1 an TS2 training sequences to determine the transfer rate that the link is trying to establish
or to anticipate and to follow any rate changes.
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Reference Clock
The serial analyzer can synchronize its reference clock to one of two sources.

Select Recovered from Data to synchronize the serial analyzer with a clock signal embedded in the data
signal.

Select SUT to use an external clock from the system under test and then select one of the clock rates from
the drop-down list. The serial analyzer receives the clock signal from the external clock cable connected to
the system under test.

Data Storage Area

Use the Data Storage area to specify the data format and the amount of data to acquire and the type of
filtering. The data volume is expressed in terms of symbols per lane with a maximum of 32 M symbols
per lane.

Use the Trig Pos control to specify where the trigger will appear in memory (1% accuracy within the
data record).

In addition to specifying the amount of data to acquire, you can also filter data during an acquisition cycle.

Use the filters from the drop-down list or define your own by clicking B (the Define Filter button). The
filtering applies to both upstream and downstream data and does not restrict any triggering.

Use the Define Filter function to define a filter that meets your needs. After you create a filter, you can
save it for future use. The new filter appears in both the upstream and downstream lists. The last filter that
you use becomes the selected filter in the lists.

Channel-Lane Assignment Area
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The Channel-Lane Association area of the serial analyzer Setup window provides controls for making
logical connections between module signals and the logical lanes of the Listing and Waveform windows.
The area consists of graphical representations of the module bordered by the upstream and downstream
lanes. The downstream and upstream lanes provide connection points to the module.

Connector groups (of four Channel Activity Indicators) represent the connectors on the front of the serial
analyzer. Each group has four signals consisting of a signal emblem, a polarity indicator, and two signal
connection points (one on each side of the emblem). The SUT Clock emblem shows the activity of the
clock when you select the SUT clock as the reference clock source.

Use the polarity indicators to change how the serial analyzer senses the differential signal on a signal. The
plus and minus signs represent the normal or inverted polarity. The buttons show the last trained value
after you click the Autoset button. However, the values do not automatically track training.

When the probes are connected to the system under test, the appearance of the emblems represent the
status of the signals at the probe tips. Refer to the legend at the top of the Setup window to understand
the signal status.
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The easiest way to connect the lanes to the module connectors is to click the Autoset button after the serial
analyzer has detected training. You can also manually connect the lanes to the module connector by
clicking the mouse on a lane and dragging a line to the desired module connector.

Setting Up External Oscilloscope Communication

The iView External Oscilloscope Setup wizard provides instructions to connect your Tektronix logic
analyzer to an external Tektronix oscilloscope, enabling communication between the two instruments.

® [fthe external oscilloscope that you are adding does not appear in the list, then the logic analyzer does
not have the files necessary to support your model of external oscilloscope. In this event, go to the
Tektronix Web site and download the latest external oscilloscope support files.

®  After you complete the process of adding your external oscilloscope to the logic analyzer system, you
can set up your oscilloscope from the logic analyzer System window.

®  You can specify horizontal and vertical settings on external oscilloscope. In addition, if the external
oscilloscope is triggering the TLA, you can specify the trigger settings on the external oscilloscope.

iView Setup Window

Overview

A Setup window is available to assist you in verifying, changing, and testing the external oscilloscope
settings.

Before acquiring and displaying a waveform, you can first establish a connection between your Tektronix
Logic Analyzer and external oscilloscope using the Add iView External Oscilloscope setup wizard.

To Use

To access the setup wizard from the System menu, click Add iView External Oscilloscope. Then step
through the external oscilloscope setup process, following the provided directions that guide you through
physically connecting the analyzer, choosing both your GPIB address and where to display your external
waveform data, and initializing the system trigger.

The Connections tab contains diagrams that help you to confirm that your logic analyzer and external
oscilloscope are physically connected correctly. Diagrams are available for confirming the physical
connection of both your logic analyzer and your specified external oscilloscope. Click the TLA
Connections button to display the logic analyzer diagram, or click the TDS Connections button to display
the diagram for the external oscilloscope that you specified in the setup wizard.

To open the iView Setup window from the System window, click the iView Setup button.
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Related Topic

Troubleshooting Connections (see page 48)

Troubleshooting External Oscilloscope Communication

If you experience difficulty in establishing communication between your logic analyzer and external
oscilloscope, the following checklist will assist you in identifying and correcting the problem.

Diagnostic Checklist
m s your external oscilloscope turned on?

® Is the GPIB configuration on your external oscilloscope set up correctly? (See your oscilloscope’s
online help.)

B Are your cable connections securely attached?
B Did you select the correct model number for the external oscilloscope to which you are connecting?

Use the Back button to return to the window where you specified the external oscilloscope model
number and make changes as necessary.

B Have you correctly connected the cables between your logic analyzer and external oscilloscope?

Use the Back button to return to the windows that describe the proper cable configuration between
your logic analyzer and external oscilloscope. Alternatively, you can cancel the setup wizard and
begin the setup process again.

® Ifyou specified the external oscilloscope GPIB address instead of letting the setup wizard automatically
detect it for you, did you correctly select the GPIB address where your external oscilloscope is
set to communicate?

Use the external oscilloscope user interface to ensure that the GPIB address you selected in the setup
wizard agrees with the GPIB address at which the external oscilloscope is set to communicate.

Once you correct the communications problem, the error message will disappear when you press the
Next button to establish communication.

Signal Routing from the Logic Analyzer

Overview

Use the Route from LA dialog box to send probe data from a logic analyzer signal to the currently selected
oscilloscope signal. To display the Route from LA dialog box, select Route from LA from the right-click
menu associated with a selected oscilloscope signal waveform.

48



System Setup Signal Routing to the Oscilloscope

To D50 1 - Channeld

From Feed Through |nter-probe Connector

[ Sygtem |nter-probing. . ]

] ] [ Apply ] [ Cancel ] [ Help

Behavior

The Route from LA dialog box displays the currently defined inter-probe connection and the feed for the
oscilloscope signal. This item cannot be selected and is displayed for information only. If no inter-probe
connection is defined for the oscilloscope channel, the field is empty.

To Use

Click the System Inter-probing button to change the contents of the scroll list by adding or changing
the connection to the logic analyzer.

Click the Select Channel button to select a new logic analyzer channel to feed the inter-probe connection
to the oscilloscope channel. This button is made available when an inter-probe connection is defined.

Related Topics
Signal Routing to the Oscilloscope (see page 49)

Routing a Signal from a Logic Analyzer Output (see page 66)

Routing a Signal to an Oscilloscope Input (see page 66)

Signal Routing to the Oscilloscope

Overview

Use the Route to DSO dialog box to send probe data from the selected logic analyzer signal to one of the
oscilloscope channels. To display the Route to DSO dialog box, select Route to DSO from the right-click
menu associated with a selected LA signal waveform. The Route to DSO right-click menu item is only
enabled if the selected waveform is a TLA7000 Series logic analyzer signal.
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Behavior

The Route to DSO dialog box provides a list of oscilloscope channels that have inter-probe connections
defined to the logic analyzer. If no inter-probe connections are defined, the list is empty. If the oscilloscope
list contains the desired LA signal, then that list item is picked by default.

The check box named Add waveform to view is unchecked by default because the waveform view
typically contains waveforms for the oscilloscope of interest. Selecting this check box and clicking OK
will add a waveform of the selected oscilloscope destination to the view.

To Use

Select an oscilloscope channel and click OK to feed the logic analyzer signal to the inter-probe connection
attached to the oscilloscope channel.

Click the System Inter-probing button to change the destination list contents by adding or deleting the
connections for the logic analyzer.

Related Topics
Signal Routing from the Logic Analyzer (see page 48)

Routing a Signal from a Logic Analyzer Output (see page 66)

Routing a Signal to an Oscilloscope Input (see page 66)
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System Inter-Probing

Overview

Because the TLA application cannot sense probe physical connect/disconnects, it is unable to manage
logic analyzer or oscilloscope mapping automatically. Therefore, you can use the System Inter-probing
dialog box to manually specify which connectors between the logic analyzer and oscilloscope are fitted
with probe connections.
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Behavior

When an inter-probing connection is created, the oscilloscope signal name changes to reflect the logic
analyzer signal that is feeding it. The signal name is visible in both the DSO Setup channel tabs and as the
waveform element label. The rule that the system uses for generating the DSO signal name is to make

it identical to the LA signal name. The system also automatically adjusts the time alignment dialog to
incorporate whatever signal path delay is determined for the oscilloscope individual signal. The delay is a
single time value, based on both the cable length and the particular path of the logic analyzer signal feed.

NOTE. Your ability to use the LA Setup, Time Alignment, and Waveform windows depends on correct
set up and maintenance of system inter-probing.
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To Use

To create an inter-probing connection, click either an oscilloscope or logic analyzer signal button.
The system responds by changing the cursor to the shape of a probe connector. Then click a button
corresponding to the opposite end of the connection to establish the connection. Upon establishing an
inter-probing connection, the cursor changes back to the normal shape.

NOTE. Ifyou click anywhere other than on a legal endpoint for the connection, then no connection is made
and the cursor changes back to the normal shape.

To delete a system inter-probing connection, click either endpoint button of the existing connection. When
a connection is deleted, the oscilloscope signal name changes to the normal default and the oscilloscope
individual signal time alignment is set to zero.

Related Topic
Setting Up Analog Multiplexing (see page 55)
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Loading Saved Setups to an LA module

5.

. In the System window, click the LA Setup button.

From the File menu, select Load Module.

Click Browse to search for the system or module with the setup you want. You can also enter the
path in the File name text box.

Select the file and click Open; the Load Module dialog box appears with a list of modules in the
saved file.

Select the module you want and click Load.

If the setup does not load, refer to Load System Options Dialog Box (see page 363) for a list of possible
problems.

Merging Modules

Before you can merge modules in the application, modules must be physically connected as described in
the TLA Series Logic Analyzer Installation Manual.

Follow these rules and restrictions when merging modules:

TLA7BB2 (68-channel) modules can be merged. For other modules, 102 channel and 136 channel
modules can be merged.

TLA7Bxx modules cannot be merged with TLA7Lx, TLA7Mx, TLA7Nx, TLA7Px, TLA7Qx, or
TLA7Axx modules.

TLA7Axx/TLATNAx modules cannot be merged with TLA7Lx, TLA7Mx, TLA7Nx, TLA7Px,
TLA7Qx, or TLA7Bxx modules.

TLA7Nx modules can be merged together, or with either TLA7Px or TLA7Qx modules.
TLA7TNx, TLA7Px and TLA7Qx modules cannot be merged with TLA7Lx and TLA7Mx modules.
Any combination of TLA7Axx and TLA7NAx modules (up to five) can be merged.

Modules containing different memory depths can be merged but will default to the shallowest memory
depth being used.

The maximum merged combinations are five TLA7Bxx modules, five TLA7Axx modules, five
TLA7NAx modules, three TLA7Nx/Px/Qx modules, or two TLA7Lx/Mx modules. The graphic shows
how to orient modules in a multiple module merge.
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The number of channels in the master module must be equal to or greater than the number of channels
in the modules with which it is merged. If there is a second slave module, the first slave must have
greater than or equal to the number of channels in the second slave module. Slave 3 cannot have more
channels than the master, slave 1, or slave 2. Slave 4 cannot have more channels than the master,
slave 1, slave 2, or slave 3.

Modules cannot be merged between a mainframe and an expansion mainframe; merged modules must
be in the same physical mainframe.

To merge a module to an established merged set, the established merged set must first be unmerged
through software. Only unmerged modules can be used to create a merged configuration.

Use the following steps to merge logic analyzer modules.

1.
2.

From the System menu, click System Configuration.

Click the Merge Modules tab.

. Click the merge button. El{l The button closes and the module icons become one to indicate that the

modules are merged.

Click the OK button

Related Topics

Merge Modules Properties (see page 372)

Calibrating Modules (see page 59)

Saving LA Setups
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In the System window, click the LA Setup button.
From the File menu, click Save Module.
Select the folder.

Enter the file name if you want a new name.
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5. Enter any comments you want to save with the file.

6. Click the option button associated with the save option you want: Save All Data, Save Only
Unsuppressed Data, or Don’t Save Data

7. Click Save.

Setting Up Analog Multiplexing

1. From the LA Setup window, click the iCapture button. The system responds by displaying the iCapture
Analog Feeds dialog box.

NOTE. Analog multiplexing is available only in TLA7000 Series logic analyzer modules.

2. Specify signal routing between the LA module’s ANALOG PROBE OUTPUT connectors and both the
DSO module’s and external oscilloscope’s Analog IN connectors (as applicable).

3. Set up signal routing from the LA probe input channel to the LA module’s ANALOG PROBE
OUTPUT connectors.

4. Click the following links to complete the analog multiplexing setups.

Setting Up System Inter-Probing (see page 65)

Setting Up Analog Feeds (see page 64)

Changing Signal Routing (see page 67)

The following figure depicts the logical process of setting up analog multiplexing.

Establishing a Logical Connection
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Use the following procedure to establish a logical connection between your logic analyzer and oscilloscope
from the Setup window.

1. Connect probe from the channels on system under test to the Tektronix Logic Analyzer.
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2. Establish logical connections between the logic analyzer and the DSO, using the System Inter-probing

(see page 51) dialog box.

3. Determine which channels to route from the logic analyzer input to the Analog Output, using the
Analog Feeds (see page 29) dialog box.

Reconfiguring an Existing Logical Connection
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Alternately, you can use the following procedures to reconfigure the logical connection between your logic
analyzer and oscilloscope from the Waveform window.

Reconfigure logical connections from the logic analyzer to the oscilloscope:
1. Right-click the waveform label associated with a digital waveform being routed to the oscilloscope.

2. Select Route To DSO (see page 49) from the shortcut menu to display the Route to DSO dialog box.

3. Use the Route to DSO dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.

Reconfigure logical connections from the oscilloscope to the logic analyzer:

1. Right-click the waveform label associated with an analog waveform being routed from the logic
analyzer.

2. Select Route from LA (see page 48) from the shortcut menu to display the Route from LA dialog box.

3. Use the Route from LA dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.
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Acquisition Overview

Overview

When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring data
individually, according to their trigger programming.

Starting and Stopping an Acquisition

In the Control bar, click Run to start an acquisition or press the Run/Stop button on the front panel. The
Tek icon on the right animates while the logic analyzer runs. Point at this icon with the mouse to display a
tool tip showing the analyzer status.

There are two ways to acquire data: Single-run or Repetitive mode. Within Repetitive mode, you can
specify the following three conditions:

B Save Module and Data
B Stop if Compare with Reference is Equal or Not Equal
m  Stop After N Acquisitions

When comparing acquisition data against reference data, you can view the results in either a Listing
window or in a Waveform window.

Single-Run Mode

In Single-run mode, the logic analyzer automatically stops acquiring and displays data when it fulfills the
setup conditions. Use Single-run mode to find and display a specific event.

During acquisition, the logic analyzer monitors the data, looking for the events you specified in the Trigger
windows. When the specified events occur, the logic analyzer responds according to the selections you
made in the Setup and Trigger windows.

Repetitive-Run Mode

In Repetitive-Run mode, the logic analyzer keeps acquiring data until you click Stop or until it fulfills the
stop conditions.

You can use Repetitive-Run mode as follows:

®  To observe the same waveform or listing for a period of time

m To stop after a set number of acquisitions for a period of time and look for differences
After each acquisition you can have the logic analyzer do the following tasks:

B Save the system or module setups and data
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®m  Export the data to separate files or overwrite the same file
B Compare the acquisition data against data in another LA module or a saved LA module file

B Open a file or execute a set of defined tasks after the acquisition is complete. For example, you can
execute a command such as sending email or paging you that the logic analyzer has stopped.

Select Repetitive Properties from the System menu to select the different options for the Repetitive mode.

NOTE. You can minimize the time between acquisitions by specifying compare conditions under the LA
Setup window, deleting (not just minimizing) all data windows, and then starting the logic analyzer.
When the logic analyzer fulfills the compare conditions, you can create a new data window with the New
Data Window wizard to view the data.

Related Topics
Setup Window (see page 13)

Compare Definition Dialog Box (see page 190)

Specifying Multiple Acquisitions

From the System menu, click Repetitive Properties.
Select the Stop After check box.
Enter the number of acquisitions to execute.

Click OK.

 » b=

TIP. Click the button to the right of the Run button to set the repetitive run mode. O

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic
Repetitive Properties Dialog Box (see page 191)

Opening a Document or Program after an Acquisition

1. From the System menu, click Repetitive Properties.
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Calibrating Modules

Select the Open: <Name of program or document> check box.

Click the Open button.

In the Open dialog box, click the Browse button to locate the document or application you want to open.
Specify any arguments and file locations, if needed.

Click OK to close the Open dialog box.

Click OK.

Calibrating Modules

ook wPN

Save your system before performing calibration. Calibration invalidates acquired data.
From the System menu, click Calibration and Diagnostics.

Click the Self Calibration tab.

Select the module or modules to calibrate.

Click Run. Calibration time can take up to several minutes to complete, depending on the type of
modules chosen.

If the calibration fails, refer to the service manual for that particular module or contact your local Tektronix
service center.

Related Topics

Self Calibration Properties (see page 371)

Technical Support (see page 1)

Calibrating Probes

For a DSO module:

1.
2.
3.

In the System window, click the DSO Setup button.
Click a channel tab.

Attach probes that you want to calibrate to the PROBE COMPENSATION output through a dual-male
BNC adapter and Probe-cal Adapter board.

NOTE. Passive or unknown probes are not calibrated.

1.

Click Probe Cal.
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Developing Custom Color Schemes

2. Click Calibrate Chan < n> to calibrate the probe attached to the selected channel.

3. Click Calibrate All to calibrate the probes attached to all channels that can be calibrated.
The channel number and probe calibration status for each probe are displayed in the dialog box.
For an external oscilloscope:

Use the Vertical menu on the external oscilloscope to calibrate the probes.

Developing Custom Color Schemes

With the System active, go to the System menu and select Options.

Click the Colors tab.

Select the element you want to change.

Select a color for the element. This will be the default.

Click Save Scheme. Enter a new name; you cannot save changes to a default color scheme.

Click OK.

AU R

Related Topic
Changing Defaults (see page 86)

Comparing Data
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You can use the logic analyzer to compare acquired data against saved reference data. You can use color to
highlight the results in the Listing or Waveform window.

1. Decide which signals to compare and set them up in groups in the LA Setup window.

2. Go to a Listing or Waveform window and add the groups to that window.
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Comparing Data

C g : . 1 Define Compare .
3. In the Listing or Waveform window, click 111 (the Define Compare button) in the TLA
toolbar to open the Define Compare dialog box.

a.

b.

€.

Select the Enable Data Compare box, if it is not already selected.

Select a reference data source from the list, or click Add Data Source to add reference data from a
saved file.

Select one of the following compare regions:
= Use All Data Possible: Compares the entire acquisition against the reference data.

- Partial Data around Ref Begin: Compares a specified number of samples after the beginning
of the reference data.

- Partial Data around Ref Trigger: Compares a specified number of samples before or after the
trigger mark in the reference data.

Specify the data alignment.

Align the data with respect to the beginning of memory or to the trigger location. You can also
specify the number of samples to offset the data.

Click OK to close the dialog box.

4. Click (the properties toolbar button) in the Listing or Waveform window.

a.

b.

C.

Select either the Listing or Waveform window tab.
Select the color for memory differences (Acq != Ref).

If you want to display that the acquisition data equals the reference data (memory equalities),
select Acq = Ref and the desired color.

Click OK.

5. Click Run to perform an acquisition.

The compare data (memory differences or equalities) will be highlighted in the regions of the display
window that you specified in the Define Compare dialog box.

Follow these guidelines for comparing data:

B Acquisition modules and reference modules must be the same width.
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® You cannot compare glitch data, disassembler group data, MagniVu data, or oscilloscope data. You
can compare only the main logic analyzer data.

B Although you cannot compare disassembler group data directly, you can compare the raw,
nondisassembled data by using groups as defined in the Setup window. Add the groups in a Listing
window.

Specifying Stop Conditions for Compare Operations

1. From the System menu, click Repetitive Properties.
2. Select the Stop criteria.

3. Specify additional parameters as needed for your application, such as executing a program after
meeting stop conditions or saving information to a file.

4. Click OK.

NOTE. Select Enable Compare in the Compare Definition dialog box to stop the acquisitions when the
compare conditions are met.

TIP. Click the button to the right of the Run button to set the repetitive run mode. O

Related Topic
Repetitive Properties Dialog Box (see page 191)

New Histogram Data Page

Use to specify the data source for the new Histogram window:

1. Click Data from an LA in the system to use data from a currently installed logic analyzer or from a
saved logic analyzer.

2. Click the No data to create an empty Histogram window; you can add the data later.

3. Click Next.

New Histogram Options Page

Use to select specific data options for the new Histogram window:

1. Select a data source. The data source can be from a logic analyzer or from saved TLA files.
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2. Select a group or counter/timer from the selected logic analyzer.

3. Click Next.

Related Topic

Data Source Properties (see page 221)

Select Axis Type

Overview

Use this page to specify the X-axis and Y-axis for the empty Graph window.

Behavior
For either axis, you can select one of the following:
= Sample Number. Use the drop-down list to select Begin, Trigger, or End.

B Row Number. This selection is the same as the Sample Number but does not include any gaps due
to filtering.

® Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.
®H  Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the
window, you can use the Graph Window (see page 307) to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without
creating a new Graph window.

To Use

Select the axis type and click the Finish button to finish the wizard.

Related Topic
Add Series Dialog Box (see page 313)
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Axis Type Wizard

Overview

Use the Axis Type wizard to add a data series to an empty graph window. The wizard appears when
you click the Add Series toolbar button or select Add Series from the Edit menu in an empty Graph
window. It allows you to select the data source for the Graph window and then specify the X-axis and
Y-axis types for that data source.

In an empty Graph window, click the Add Series toolbar button to start the wizard.

New Source Data Page

Use to specify the data for the new Source window:
1. Select An existing Listing window to use data from an existing Listing window.
2. Select the No Listing window to create an empty Source window; you can add the data later.

3. Click Next.

New Source Options Page

Use to select specific data options for the new Source window:

1. Select a Listing window, data source, and listing column. The Source window will use the data from
these selections.

2. Select a symbol file to use.

3. Click Next.

Related Topic

Source Data Properties (see page 239)

Setting Up Analog Feeds

Analog feeds functionality allows you to assign multiple digital signals to the DSO using multiple analog
channel outputs. You can access the iCapture Analog Feeds dialog box from the LA Setup window by
clicking the iCapture button.
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Setting Up System Inter-Probing

NOTE. Analog feeds functionality is only available in TLA7000 Series logic analyzer modules.

Use the following procedure to set up this functionality from the iCapture Analog Feeds dialog box.

1.

Select the LA module containing digital signals that you want to route to a DSO from the Physical
Module list box.

Select an analog output attenuation level.

From the Select Signals list box, choose a method of displaying signals: By Group - lists groups as
defined in the Setup window. By Probe - lists signals by the probe name. By Name - alphabetically
lists signals by their name.

Select the digital signals that you want to route through analog outputs to the DSO.
Select the check boxes associated with the analog outputs, located under Analog Feed Cycling.

Click a button in the Analog Feed Cycling group box to assign the selected signals to the selected
outputs, in groups equal to the number of outputs selected.

Optionally select the check box labeled Exclude signals assigned to unchecked outputs.

Click the System Inter-probing button to display the System inter-probing dialog and select the DSO
inputs to which the signals will be routed.

Related Topics

Setting Up System Inter-Probing (see page 65)

Signal Signal Routing (see page 67)

Analog Feeds (see page 29)

Setting Up System Inter-Probing

Only TLA7000 Series logic analyzer modules, DSO modules, and external oscilloscopes can be displayed
in the System Inter-probing dialog box. If a TLA7000 Series logic analyzer module and either a DSO
module or external oscilloscope exist but none are available, the dialog box can still be opened but is empty.

1.
2.

From the System menu, click System Inter-probing to display the System Inter-probing dialog box.

Click an LA, DSO or external oscilloscope channel button to begin the inter-probing connection. The
system responds by changing the cursor to the shape of a probe connector.

Click a channel button corresponding to the physical connection at the opposite end of the probe to
establish the probe connection. Upon establishing an inter-probing connection, the cursor changes
back to its normal shape.
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Routing a Signal from a Logic Analyzer Output

NOTE. Ifyou click the mouse anywhere other than on a legal endpoint for the connection, no connection is
made and the cursor changes back to its normal shape.

4. Repeat steps 1 and 2 for each LA module-to-DSO module or external oscilloscope physical connection
that you want to specify.

TIP. To remove an inter-probing connection, click one of its endpoints or use the Delete button.

You can use the Clear All button to remove all probe connections simultaneously.

Routing a Signal from a Logic Analyzer Output

1. From the Waveform window, right-click the waveform label associated with the oscilloscope to which
you want to route the digital signal.

2. In the right-click menu, click Route from LA. The Route from LA dialog box displays.
3. Click the Select Channel button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying signals.

5. Choose the signal to route to the oscilloscope.

Related Topic

Routing a Signal to an Oscilloscope Input (see page 66)

Setting Up System Inter-Probing (see page 65)

Routing a Signal to an Oscilloscope Input
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1. From the Waveform window, right-click the waveform label associated with the logic analyzer module
from which you want to route the digital signal.

2. In the right-click menu, click Route to DSO. The Route to DSO dialog box displays.

3. Select the logic analyzer signal that you want to send to the oscilloscope.
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Changing Signal Routing

NOTE. No logic analyzer signals display in the Route to DSO dialog box until you set up logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. When you want to add a new waveform to the waveform window containing the rerouted signal, select
the check box labeled Add waveform to view.

Related Topic
Routing a Signal from a Logic Analyzer Output (see page 66)

Setting Up System Inter-Probing (see page 65)

Changing Signal Routing

Use the following procedure to change digital signal routing from either a DSO channel input or a logic
analyzer output that is displayed on the Waveform window.

Routing from the LA

1. Right-click the label of the DSO channel waveform.

2. From the right-click menu, click Route from LA. The Route from LA dialog box displays.
3. Click the Select Signal button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying signals.

5. Choose the signal to rout to the oscilloscope.

Routing to the Oscilloscope

1. Right-click the label of the LA waveform.

2. From the right-click menu, click Route to DSO. The Route to DSO dialog box displays.
3. Click the Select Signal button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.
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Edit Protocol Files

4. Select a method of displaying signals.

5. Choose the signal to route to the oscilloscope.

Related Topics
Setting Up System Inter-Probing (see page 65)

Setting Up Analog Feeds (see page 64)

Edit Protocol Files

1. To open a protocol for editing from the Stack Definition pane, do one of the following:
= Double-click the protocol you want to edit. The protocol is displayed in the Protocol Editor pane.
- From the Protocol Editor pane select the File menu, and then select Open Protocol.

2. Type your changes directly in the Protocol Editor pane.

TIP. Use the Replace function to help you locate and replace text.

1. From the Protocol Editor pane, select the Edit menu and then select Replace.... The Replace dialog
box opens.

Type the text you want to change in the Find What text box.
Type the new text in the Replace with text box.

If the text is case sensitive, select the Match case check box.
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Click Replace to replace the next instance of the text in the Find What text box with the new text in
the Replace text box. Click Replace All to replace all instances. Click Find Next to find the next
instance but not replace the text.

Editing the Protocol Window Properties

68

Follow these steps to edit the Protocol Window Properties:

1. Place the cursor in the Protocol window and click View > Properties to display the Protocol Properties
dialog box.

Click the About Data tab to view the current data source information.
Click the Protocol window tab to adjust the display settings of the Protocol window.

Click the Column tab to adjust the column settings in the Packet view.

A N

Click the Color tab to adjust the color settings in the Decode View.



How to

Edit Relations Between Protocols

6. Click the Marks tab to adjust the properties for the marks that you placed.
7. Click the Framer options tab to set the port address and packet identifier for framing the packets.
8. Click OK.

Related Topic

Protocol Window Properties (see page 275)

Edit Relations Between Protocols

. In the Stack Definition pane, right-click the protocol for which you want to edit the relations. The

Protocol shortcut menu appears.

. From the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,

displaying the Relations tab.

. To remove any protocol from the Current Relations list, select the protocol, and then click the Remove

button.

. To add any protocol to the Current Relations list, select the protocol you want to add from the Available

Protocols, and then click the Add button.

. Click Up or Down to determine the order of the relations, and then click OK.

. If you specify the Type of Relation as Single Parameter or Raw Data, enter hexadecimal values

preceded by Ox or binary values preceded by Ob. For example, to enter the 3 in hexadecimal, enter
0x3; to enter it in binary, enter 0b0011.

Edit Stack Files

1. To open an existing stack file, select Open Stack from the File menu.
2. In the Open dialog box, select the stack to open and click OK.
3. To see how to edit the stack files, click the following links:

To Replace a Protocol from the Stack (see page 294)

To Remove a Protocol in the Stack (see page 292)

To Define a Protocol in the Stack (see page 292)

To Modify Relations Between the Protocols in the Stack (see page 69)
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How to Editing a Tool on the Tools Menu

Editing a Tool on the Tools Menu

. From the System menu, click Options and then click the Tools tab.

In the User-Defined Tools box, select the tool that you want to edit.

w o=

Perform one or more of the following actions:
®  To move the tool up one position in the menu, choose the Move Up button.
= To move the tool down one position in the menu, choose the Move Down button.

B To change the menu text, command line (tool path and file name), command-line arguments, or the
initial directory, click the Edit button and then type the new information in the appropriate text box.

m  To specify a letter in the menu title as an accelerator key, precede that letter in the Menu Name box
with an ampersand. The first letter in the title is the accelerator key by default.

Related Topics
Removing a Tool from the Tools Menu (see page 70)

Adding a Tool to the Tools Menu (see page 134)

Removing a Tool from the Tools Menu

To remove a tool from the Tools menu:
1. From the System menu click Options, and then click the Tools tab.

2. In the User-Defined Tools box, select the tool you want to delete and click the Delete button.

Related Topics
Editing a Tool on the Tools Menu (see page 70)

Adding a Tool to the Tools Menu (see page 134)

Editing Symbol Files

You can edit any symbol file supplied by the support package. It is best to make a copy of the file and
then edit the copy.

NOTE. Do not change signal assignments. If you do so, the disassembler may not function correctly.
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Exporting Data from a Protocol Window

Most support packages provide two types of ASCII symbol files: pattern and range. Make a copy of the
type you need and edit it using an editor.

NOTE. Save the symbol file as ASCIL. If saved in any other format, the symbol file cannot be used.

Related Topics

Symbol Tables (see page 341)

Color Properties (see page 377)

Exporting Data from a Protocol Window

Follow these steps to export data from Protocol window

1. Place the cursor in the Protocol window, and select Export... from the Data menu to display the Export
Data dialog box.

2. In the Export Data dialog box, specify the file name and location that you want to export data to.

3. Under Export Range, select either Packet View or Decode View, and then select the export range.

4. If you want to include the Hex View, select the Append Hex View check box.

5. If you selected Packet View, you should also select the export options, including the delimiters you
want to use.

6. Click Save.

Related Topic

Export Data Dialog Box (see page 278)

Exporting Data from a Listing Window
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In the System window, click the Listing window icon.

From the File menu, click Export Data.

In the Export Data dialog box, select the folder you want to export data into.
Enter a name for the exported file.

Click Options to specify the format options.

Select one of the Export ranges.

Click Save.
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How to Exporting Histogram Data

NOTE. Use a Tab or Semicolon as a delimiter when exporting data from a Listing window. If a Space
or Comma is chosen as a delimiter, the timestamp values are erroneously exported from the Listing
window in picoseconds without units.

Exporting Histogram Data

In the System window, click the Histogram data window icon.

From the File menu, select Export Histogram.

In the Export Data dialog box, select the folder you want to export data into.
Enter a name for the exported file.

Determine how many rows of data you want to export and click the appropriate button.

LA D

Click Save.

NOTE. Click Options to change the field delimiters or to change how the bounds will be exported.

Loading a Saved System

1. From the File menu, click Load System.
2. Navigate to the directory where you saved your system.

3. Select the file and click Open.

NOTE. The saved system must exactly match the current system in order for all parts of the system to
load. If the saved system does not match, you can load parts of the saved system using the Load System
Options dialog box.

The current version of software can load files saved under older versions of software.

Related Topics
Saving a System (see page 78)
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Loading Portions of a Saved System

Load System Options Dialog Box (see page 363)

Loading Portions of a Saved System

1.
2.
3.
4.

From the File menu, click Load System.
Navigate to the folder where the saved file is located.
Click Options. The Load System Options dialog box opens.

Click a Saved System module and drag the module to a compatible module in the current system.
Reference data sources and data windows in the saved system load automatically.

NOTE. The icon itself will not drag. The cursor will change to a drag cursor. If you attempt to drag a
saved module to an incompatible current module the cursor changes to a no drop shape.

5.

Click OK.

Related Topic

Open Options (see page 363)

Loading a Saved Module
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From the System window, click the Setup or Trigger button of the destination module.
From the File menu, click Load Module.

Navigate to the directory where you saved your file.

Select the file name and click Open.

Select the module you want to load in the Load Module dialog box.

Click Load.

Adding a Data Source to an Active Listing Window

1.
2.
3.

In the System window, click the appropriate data window icon.
From the Edit menu, click Add Column.

Select the Data Source or click Add Data Source if the source is not listed.
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How to Loading an LA Module with Saved Trigger Settings

4. Select the columns and click Add.
5. Click Close.

TIP. Click m to open the dialog box.

Loading an LA Module with Saved Trigger Settings

1. In the System window, click the LA Trigger button.

2. Click the =T button, located in the trigger toolbar.

3. From the Load LA Trigger dialog box, click the Browse button to search for the trigger file. Then click
a filename from the displayed file listing to show all modules in the selected file.

NOTE. Alternatively, you can enter the path name to the desired trigger program.

4. Click the Open button to select the file. The Load LA Trigger dialog box lists the modules included in
the saved file. You can select only the module that contains the LA trigger settings.

5. Click Load.

When a trigger program is not compatible with the current setup (for example, different groups), perform
the following adjustments, when necessary:

m  Groups that are used in group events are matched by name. If a match cannot be found, the event
defaults to the first available group.

®m Restored values are left-truncated or left-extended with don’t cares (XXXX ....) for word events;
left-extended with zeros for range events.

B Channels used in channel events are matched by name. If a match cannot be found, the events are
matched by probe name. If a match is still not found, the trigger event defaults to the first available
channel.

® Restore event values that are set by group (for example, Setup & Hold or Word events) by matching
groups by name. Groups in the current module that are not found in the trigger program being loaded
are assigned default settings. Settings for groups not defined in the current module are discarded.

m The Arm Module actions that cannot be present because of target module conflicts are changed to
Do Nothing actions.

®  Word event definitions are merged with existing word event definitions. If word event definitions
have the same names as the current word event definitions then the new definitions will replace the
previous ones.

®  Channel groups in word events are matched by name. The restored values are left truncated or left
extended with don’t care values.
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Adding MagniVu Data to a Listing or Waveform Window

Channel groups in word events in the current module, that are not found in the trigger program being
loaded, are assigned default don’t care values.

Settings for groups in word events not defined in the current module are discarded.

Transition event definitions are merged with existing transition event definitions. If transition event
definitions have the same names as the current transition event definitions, then the new definitions
will replace the previous ones.

Channel groups in transition events in the current module, that are not found in the trigger program
being loaded, are enabled by default.

Settings for groups in transition events that are not defined in the current module are discarded.

Adding MagniVu Data to a Listing or Waveform Window

. In the System window, click the appropriate data window icon.

From the toolbar, click i (the Add Column icon) or e (the Add Waveform icon).

From the Data Source list, click MagniVu (see page 368). If the source you want is not listed, click Add
Data Source and add the one you want to the list.

Select the required columns or waveforms.
Click Add. The column or waveform appears in the data window.

Click Close.

TIP. To quickly display MagniVu data, clic

k= MagniVu ;, she data window. Click the button again to

remove the MagniVu data from the window.

Loading Source Code Symbol Information
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In the System window, click the Source data window icon.

From the Edit menu, click Properties.

Click the Data properties tab.

Click the Symbol File button to locate a symbol file in the file system.

Choose the symbol file.

Verify that the file information in the File Contents box shows that the Type is Range.
Click Open.

Click OK.
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How to Loading Filters

The new symbol file with source code is loaded in the Source window.

TIP. Click &' in the Source window to open the Properties dialog box.

You can also load the symbol file from the Symbols dialog box, which is accessible from the System menu.

Loading Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Click the o button to open the Load Filter dialog box.

3. Enter a file name and path in the File Name box for the LA module or system setup that contain the
filters that you want to load. You can also click Browse to browse the file system.

4. Select the filter from the Load Filter dialog box.
5. Click the load button to load the filter to the LA module.

Moving to a Mark (Go To)

In the System window, click a Waveform or Listing window icon to open the window.
From the Edit menu, click Go To.

In the Go To dialog box, select the Mark option.

Select the mark from the available list.

Click OK.

LA O o

Related Topics
Adding a Mark to a Data Window (see page 137)

Moving Marks (see page 137)

Modifying the Location of Cursors Using the Overview Markbar

1. In the System window, click a waveform or listing icon.

2. Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.
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How to Changing the Position of Cursors

Related Topics
Adding a Mark to a Data Window (see page 137)

Sending Stacked Marks to the Back (see page 137)

Changing the Position of Cursors

1. In the System window, click the Waveform or Listing window icon.

2. Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the cursor to
the new location.

Alternate Method
1. In the System window, click a Waveform or Listing window icon.
2. From the View menu, click Cursor Toolbar if the cursor toolbar is not displayed.

3. Enter the cursor position using either the C1: or C2: cursor spin box.

Related Topics
Adding a Mark to a Data Window (see page 137)

Moving Marks (see page 137)

Sending Stacked Marks to the Back (see page 137)

Print Dialog Box

Use to print the current active window. You can print hard copies of the current data windows and
setup windows. Depending on the window, you can specify the print range and the number of copies.
You can also print to a file.

When printing Listing, Source, and Waveform windows, you can print data between two marks, such as
the trigger point and one of the data cursors. You can cancel printing at any time by pressing the ESC key.

From the File menu, click Print.

Related Topics
Exporting Data from a Listing Window (see page 71)
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Save Dialog Box

Exporting Histogram Data (see page 72)

Save Dialog Box

Use to save the system or a logic analyzer module to a file. A system file includes the setup information,
the trigger program, and acquired data from all modules (if you select Save Acquired Data). It also
includes all data windows and any links to data sources that were added.

A saved logic analyzer module file includes the setup information, the trigger program, and acquired data
from the current logic analyzer (if you select Save Acquired Data).

Saved system and module file names have a .tla file name extension. The initial default location for
saved files is C:\My Documents.

To open the Save dialog box from the File menu, click either Save System As or Save Module As.

Related Topics
Loading a Saved System (see page 72)

Loading a Saved Module (see page 73)

Loading an LA Module with Saved Trigger Settings (see page 74)

Saving a System
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You can save system setups to a saved system file

Go to the File menu and click Save System.

To save a system and change the name, do the following:

1. From the File menu, click Save System As.

Navigate to the directory where you want to save the system.
Go to File Name and enter the name you want.

Enter any comments you want to include.
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Select the Save all Acquired Data option if you want the data (including measurement statistics)
to be included with the file.

6. Click Save.
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Saving a Module

Saved System File

A saved system file contains the setup and trigger program information needed to automatically
set up the logic analyzer with all installed modules. This file can also contain acquired data from
the modules.

Saving a Module

Click a module icon in the System window, then go to the File menu and click Save Module.

To save a module and change the name, do the following:

AU S o

From the File menu, click Save Module As.

Navigate to the directory where you want to save the module.

Go to File Name and enter the name you want.

Enter any comments you want to include.

Select the Save all Acquired Data option if you want the data to be included with the file.
Click Save.

Saving Repetitive Acquisition Data

1.
2
3
4.
5
6
7

From the System menu, click Repetitive Properties.

. Select the Save check box.

. In the list associated with the Save check box, select Export Data.

In the From list, select a data window (this selection is only available with Export Data).

. Enter a file name or click Browse to specify the location and file name.
. Select whether to overwrite the existing file or to create a new file for each acquisition.

. Click OK to close the dialog box and save your settings.

The data will be saved in an ASCII file with the .txt extension under the specified file name.

|
TIP. Click the button to the right of the Run button to set the repetitive run mode. 1O

Related Topic

Repetitive Properties Dialog Box (see page 191)
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Saving Repetitive Module Setups and Data

Saving Repetitive Module Setups and Data

From the System menu, click Repetitive Properties.

Select the Save check box.

In the list associated with the Save check box, select Save Module and Data.
In the From list, select a module.

Enter a file name or click Browse and specify the location and file name.

Select whether to overwrite the existing file or to create a new file for each acquisition.
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Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic

Repetitive Properties Dialog Box (see page 191)

Saving Repetitive System Setups and Data
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From the System menu, click Repetitive Properties.

Select the Save check box.

In the list associated with the Save check box, select Save System and Data.
Enter a file name or click Browse and specify the location and file name.

Select whether to overwrite the existing file or to create a new file for each acquisition.
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Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, you can delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

Related Topic

Repetitive Properties Dialog Box (see page 191)
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Setting the Search Options

Setting the Search Options

The Search Options dialog box defines the action that you want the logic analyzer to take when the
search is successful. Access the Search Options dialog box from the Search Options... button in the
Define Search dialog box.

To create a new mark upon a successful search:

1.
2.

Select the Create new mark at point found check box.

Use the existing Mark Name Prefix or enter a new one in the Mark Name Prefix text box.

NOTE. When a new mark is created, the Mark Name Prefix and a numeric suffix are appended to the mark
to ensure that the new mark is unique.

Searching for Specifics in a Listing or Waveform Window

In the System window, click the appropriate data window icon.
From the Data menu, click Define Search, and then select Search.

From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.

NOTE. 10 add a search definition from another data source, click the Load button to open the Load
Search dialog box.
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Click Start from the drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

Click the Search Options... button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

Type a Description of the search.
From the Search drop-down list, select the data source.
Use the drop-down lists under Find to select the criteria for which you want to search.

Right-click in the Search event area to open a menu where you can cut, copy, or paste events.
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Searching for Source Data

NOTE. You can add and delete sources and enable or disable searches with the short cut edit menu.

10.Click either the Search Fwd or Search Back button. The first occurrence is marked according to
how the Search Options are set up.

TIP. Click B 10 open the dialog box.

Related Topic
Searching for Source Data (see page 82)

Searching for Source Data

82

In the System window, click the Source data window icon.
1. From the Data menu, click Define Search.

2. Click either All Files to search all files identified by the symbol file, or select This File to search
the current file.

3. Enter a text pattern.

4. Click Search Fwd or Search Back. The first occurrence is marked by the active cursor.

NOTE. You can search for any text pattern including leading and embedded white space; trailing white
space is ignored.

The search operation follows the order of files as listed in the Source File properties tab. When you search
for data in all files, and one or more of the files cannot be found, the Source File Locator dialog box
displays, asking you to specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box shows the status of
the search. You can let the search continue, or you can click Abort to stop the search.

TIP. Click i) to open the dialog box.

You can copy text to use as a search pattern from the Source window and paste it into the Source Window
Search Definition dialog box.

Related Topic

Searching for Specifics in a Listing or Waveform Window (see page 81)




How to Searching in the Protocol Window

Searching in the Protocol Window

Follow these steps to search for a data packet or a message pertaining to the packet:

1. Place the cursor in the Protocol window and click Data > Define Search to display the Search dialog box.
2. Select a protocol from a list of protocols. Use the drop-down list to select a protocol.

3. Select the fields to search from the Fields text box.

4. Select operation used to compare field values from the Operation group box.

5

. Specify the value and the format for the selected field. The packets that have the specified values
are searched for in the Packet View.

S

Select either the << Back or Forward >> button to search before or after the current cursor position.

7. Clear the Enable Fields selection to search the packets based on the selected protocol.

Related Topic
Protocol Search Dialog Box (see page 278)

Setting the Waveform Style

1. In the System window, click the Waveform window icon.

2. Double-click the label of the LA waveform whose options you want to set.

NOTE. The Options selection is not available if you select a waveform with only one channel.

Click Options.
To display LA waveforms as a busform, click Busform.

To display LA waveforms as magnitude waveforms, click Magnitude.

AR

If you selected Magnitude, select whether you want acquisition data interpreted as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as
signed decimal, so that the readouts will display the correct information.

Related Topics

Setting Waveform Options (see page 125)

Setting the Waveform Limits (see page 84)
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How to Setting the Waveform Limits

Showing Waveform Readouts (see page 120)

Setting the Waveform Limits

1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.

3. Click Options.

4. If you want the waveform limits locked to the DSO setup, click Lock to Setup.

5. If Lock to Setup is not checked, set the maximum and minimum value to display in the waveform.

The Max and Min values correspond to the top and bottom of the waveform range.

Related Topics
Setting Waveform Options (see page 125)

Setting the Waveform Style (see page 83)

Showing Waveform Readouts (see page 120)

Determining the Data Source of the Selected Waveform

In the System window, click a Waveform window icon.
Double-click the label of the waveform about which you want to view attributes.

If not selected, select the waveform you want to change from the waveform list.
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View the source of the waveform from the Source field, which is located in the upper-left corner
of the Waveform tab.

5. Click Cancel.

Source is only available when a single waveform is selected.

Related Topics
Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 85)

Changing the Color of the Selected Waveform (see page 119)

Controlling Whether a Waveform is Visible (see page 121)
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How to Selecting the Radix of Busform Readouts

Selecting the Radix of Busform Readouts

In the System window, click a Waveform window icon.
Double-click the label of the waveform whose attributes you want to change.
If not selected, select from the Waveform list the waveform you want to change.

From the Radix list, select the waveform radix.

A

Click OK.

Related Topics
Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)

Determining the Data Source of the Selected Waveform (see page 84)

Controlling Whether a Waveform is Visible (see page 121)

Changing the Zoom Options

You can change the zoom options by changing the system preferences.

To change the zoom options, select Options from the System menu. Under the Preference tab, click the
Click & Drag Zoom option to display a drop-down list with the following selections:

B Zoom Immediately
®  Show Context Menu

®  Show Rectangle Only

Zoom Immediately

This is the default setting. To zoom data in a Waveform window, click and drag the mouse over the area
that you want to zoom. The window will automatically zoom after you release the mouse button. If you
click and drag from the left to the right, the window zooms to the selection. If you click and drag from the
right to the left, the window repeats the previous zoom operation.

When you zoom data in a Listing window, a right-click menu appears after you click and drag the mouse.
The right-click menu gives several choices where you can copy text, bitmaps, move cursors to the edge of
the rectangle, show, or suppress data.
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How to Setting the Default Trigger Tab

Show Context Menu

Use this setting to show the right-click menu as soon as you click and drag the mouse over the zoom area.
Select one of the choices from the right-click menu.

Show Rectangle Only

Use this setting to draw a rectangle by clicking and dragging the mouse. You can then resize the rectangle
so that you can focus on the data of interest. Right-click the mouse to display a right-click menu with
several options for handling the data inside the rectangle.

NOTE. You cannot suppress or show oscilloscope data. The Suppress and show selections only function
for logic analyzer data.

Setting the Default Trigger Tab

1. From the System menu, click Options to display the Options dialog box.
2. Click the Defaults tab.
3. Click the Trigger Window Style field and then select the desired trigger tab from the list box.

Changing the Start-Up Default Settings

1. From the System menu, click Options.
2. Click the Defaults tab.

3. Click the option and change the setting.
4. Click OK.

The settings here are used as defaults when creating a new data window.

Changing the Color of a Graph Mark

In the System window, click the Graph data window icon.
Double-click the mark that you want to change to open the Marks property page.

Click the Color button and select a new color.

0w b=

Click OK.
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How to Changing the Data Series Range

Changing the Data Series Range

1. In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property pages.
Click the Series Data tab.
Enter new values for the minimum and maximum data range setting for each axis.

Click OK.

A

Changing the Graph Drawing Style

1. In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property page.
Click the Series Format tab.

Select the series type.

A

Use the drop-down lists in the Line section of the property page to change the line style, color, and
thickness. Use the drop-down lists in the Data Points area of the property page to change the data
point style, color, and thickness. The graphic in the property page provides a brief example of what
your changes will look like.

6. Click OK to close the property page.

Changing the Graph Window Properties

1. In the System window, click the Graph data window icon.

2. Click = in the toolbar of the Graph window to open the Graph window property pages.
3. Click the Graph Window tab.
4. Make the changes that you want to the:

= QGraticule

Select Show Graticule check box. You can set the color, style, and thickness using the drop-down lists.
If you want to hide the graticule, clear the Show Graticule check box.

= Xand Y axis
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How to PG Run Properties Dialog Box

Enter new values for the minimum and maximum data range setting for each axis. If desired, enter
an new label for each axis.

= Axis readout

Select the Show Readout check box. Select the color for the readout from the Color drop-down list. If
you do not want the readout to display, clear the Show Readout check box.

- Background color
Click the Background color button at the bottom of the property sheet and select a background color.
5. Click OK.

PG Run Properties Dialog Box

The Pattern Generator Run Properties dialog box selections determine if the TLA Start button will start
and stop the pattern generator (PG) modules.

The When the TLA Runs list box selections are:
= Ignore PG. Do not start or stop the pattern generator modules.

m Start PG after TLA. When the TLA start button is pressed the LA modules will start before the
pattern generator modules.

m  Start PG before TLA. When the TLA start button is pressed the pattern generator modules will
start before the LA modules.

The two check box options are:

= Stop PG when TLA stops. When this box is checked the pattern generator modules will be forced to
stop after all LA modules are finished acquiring data.

If this box is not checked the system will wait for all LA and PG modules to complete before indicating
that the system (PG and LA modules) are stopped.

m If repetitive run, restart at each iteration. Normally the pattern generator will run once and stop
even in repetitive mode.

If this box is checked, the pattern generator will be restarted each iteration (Repeat count).

Waveform Properties

Overview

Use the Waveform tab to setup, change, or view the properties of a waveform. The properties displayed in
the Waveform tab depend on the waveform that you select in the Waveform window.

88



How to

Waveform Window Properties

Behavior

The following are properties that are common to all waveforms, regardless of whether you choose an
individual waveform, a waveform group, or an individual waveform within a waveform group:

H Waveform: lists the label that displays in the Waveform window. You can select a different waveform
from the list. The list contains the names of all waveforms in the active window. The initial waveform
is the selected waveform or the first waveform if no waveform is selected. The list box is empty
if multiple waveforms are selected.

B Height: controls the height of the waveform. Height can range from 10 to 500 pixels. The default
height of waveforms is fixed at 18 pixels.

To Use

To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Individual Waveform Properties (see page 209)

Group Waveform Properties (see page 208)

Individual Waveform Properties within a Waveform Group (see page 211)

Waveform Window Properties

Overview
Use to format the current Waveform window.
B Acq != Ref determines if data differences will be displayed during data compare operations.

B Acq = Ref determines if data equalities will be displayed during data compare operations.

Behavior
To display differences and equalities, define a valid data reference and enable the comparison.

B Show Graticule determines if a graticule will be displayed. Graticule color determines the color of
the graticule.

®  Show Violations determines if glitches or setup and hold violations will be displayed. Violation color
determines the color of glitches and violations. Glitches or setup and hold violations must be stored
before they can be displayed.

B Background determines data area background color for the active data window.

89



How to

Selecting the Sample Size: A General Approach

® Color Scheme determines the named color scheme for the active data window.

B Snap cursors/marks to transition edges allows you to place the cursors or marks quickly on a transition
edge.

When you select a new color scheme, the color of all waveform data window elements reset to the new
color scheme (All color selections in this dialog box will change to the colors defined by the new color
scheme).

To Use

To change Waveform Window properties from the System window, click a Waveform window icon,
double-click a waveform label and then click the Waveform Window tab. You can also access this tab
from the toolbar, menu bar, or from the right-click menu on the waveform label.

Related Topics

Changing Waveform Window Properties (see page 120)

Waveform Tab (see page 88)

Changing Waveform Properties (see page 119)

Waveform Options (see page 216)

Color Settings (see page 377)

Making Violations Visible (see page 122)

Selecting the Sample Size: A General Approach
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To make the most effective use of memory, use sample suppression to limit the number of samples acquired.
From the LA Setup window follow these steps to set the sample size:

1. Select the desired number of samples.

2. Click the Suppress button in the toolbar to activate the Sample Suppression dialog box.

3. Make a selection in the dialog box to limit the number of samples initially displayed after each
acquisition.

For example: Show 1024 Samples around trigger.

During data acquisition memory is filled up to the selected depth (maximum in this case). After acquisition
only 1024 samples will be delivered to all data displays.

If the acquisition you are looking for is not visible, show more samples using the Show dialog box or
right-click menu in the Listing or Waveform window. This can be done without reacquiring data.

If too much data is delivered to all data displays, remove samples using the Suppress dialog box or
right-click menu in the Listing or Waveform window.
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Storing LA Module Setup and Hold Violations

Related Topics

Suppress Samples Dialog Box (see page 200)

Sample Storage depth (see page 27)

Storing LA Module Setup and Hold Violations

. Select the LA Setup window.

Select synchronous sampling or if you have previously loaded a support package, use the Custom
sampling selection.

. Select the Samples + Violations (Setup and Hold) storage option.

NOTE. When you select the maximum acquisition length under the Samples storage and you change to
Setup and Hold storage, the logic analyzer changes the acquisition length to half the original.

If you use synchronous sampling, adjust the global setup T and hold T, values in the sampling area of
the LA Setup window.

You can adjust the values of individual groups or signals in the Signal Sampling screen.

If you use Custom Sampling, adjust values in Signal Sampling screen.

Setting up Transitional Storage for the LA Module

1.
2.
3.
4.
5.

6.

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click Transitional from the Storage list box, located in the trigger toolbar.
Click the Change Detect button.

From the Change Detect dialog box, select the groups in which you want the logic analyzer to detect a
change in state for the transitional storage.

Click OK.

When you start the logic analyzer, the logic analyzer module will begin storing data when it detects a
change in any one of the selected groups.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not prevent
acquisition. Value settings closer to the top of the list override later settings.

On TLA7000 Series logic analyzer modules and TLA5S000B Series mainframes, the first transition state
indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). One way to avoid triggering on a
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Storage Definition Dialog Box

false first transition indication is to set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.

TIP. An easy method for setting up a transitional storage trigger is to load one of the EasyTrigger
programs (Store on all transitions, Store on signal transitions, or Store on group transition). If necessary
you can modify the program from the PowerTrigger tab.

Storage Definition Dialog Box

Overview

Use this dialog box to define the condition when storage occurs after Conditional storage is selected in the
Trigger window toolbar. This dialog box defines an If event the same way as does the Clause definition
dialog box. The Then action stores a sample; this action cannot be changed.

To Use

To open the Storage definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Set Storage to Conditional and click the If/Then button in the Storage state.
A few things to keep in mind when using this dialog box:

®  Counter and timer events are not available in storage definitions.

Violation Storage is not available for Prime signals.

Storage Definition is not available from the EasyTrigger tab.

Snapshot events are not available in storage definitions.

Related Topic
Clause Definition Dialog Box (see page 163)

LA trigger Event Table (see page 167)

Storage Selection for an LA Module (see page 140)

Triggering a Logic Analyzer Using the Trigger Tab Page
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Use the Trigger tab page to quickly add one of the following trigger programs:



How to Adding a State to a Trigger Program

Channel edge

Bus Value
Glitch

® Trigger on Anything

Channel Value

Multi-Group Value

Setup and Hold

To use the Trigger tab page, do the following:

1. From the data window, click the Trigger tab page.

2. Drag a trigger from the Add Trigger group box to the waveform that you want to trigger on.
3. Edit the trigger expression under Trigger Details in the Trigger tab page.

4. Click Run.

Adding a State to a Trigger Program

1. In the System window, click the LA Trigger button.
2. Click the PowerTrigger tab.
3. From the Edit menu, click Add State.

NOTE. The state is added after the currently selected state. If a state is not selected, then the state is
added as the last state.

-
-+

TIP. Add State is also available on the toolbar of the Trigger window. | %®

Defining If/Then Clauses in a Trigger Program

In the System window, click the LA Trigger button.

. Click the PowerTrigger tab.

1.
2
3. Click the If/Then button of the clause you want to edit.
4. Make changes in the If/Then clause dialog box.

5

. Click OK.
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Defining Multiple Transition Recognizers

On TLA7000 Series logic analyzer modules and TLA5S000B Series mainframes, the first transition state is
always false. On TLA700 Series logic analyzer modules the first transition state always shows a transition
indication (even if there are no probes plugged in). One way to avoid triggering on a false first transition
indication is to set the first state to "If Anything Goto Next State". This will consume a state, but will
ensure that there is no false triggering on the first transition indication.

If transitions are used as events, there will be a false indication of a transition. The first state needs to be
set up as "If Anything Then Next State."

Defining Multiple Transition Recognizers
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In the System window, click the LA Trigger button.
Click the PowerTrigger tab.
Click the corresponding If/Then button of the state clause you want to define.

In the event definition drop-down list box, click Transition and specify the related transition condition.

A S A

Optionally, from the Clause Definition dialog box, click the Add button to specify additional transition
events.

b

Click the Define Transition button to display the Transition Definition dialog box.

7. Click the Add button to add a new transition definition and specify the groups in which transition
events will be monitored.

NOTE. You can add as many transition event definitions as you want within the Transition dialog box.
However, you can only use eight events of any kind within an event clause. The events that are selected
when you close the Transition dialog box are used in the event clause.

8. In the event definition drop-down list box, click Transition and specify the related event action.

9. Optionally, click the Define Transition button to define a unique transition name.

NOTE. You can define up to 16 trigger events and two counters or timers for a given trigger setup.

TIP. An easy method for defining multiple transition recognizers is to load the Trigger on Nth occurrence
of edge from the Easy Trigger programs. If necessary, you can modify the program from the PowerTrigger
tab.

Related Topics
Add Transition Dialog Box (see page 159)

Transition Definition Dialog Box (see page 158)




How to Selecting Signals for an LA trigger Channel Event

Selecting Signals for an LA trigger Channel Event

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.

Click the If/Then button of the clause you want to edit.
Select Channel in the first box of the If section.

Click the Select Channel button.

AU

Do one of the following:

= Double-click the desired group in the Select Signals dialog box and select the signal.
= Click By Probe and select the signal.

- Click By Name and select the name of the signal you assigned in the Setup window.

7. Click OK.

Selecting When to Store Data

1. In the System window, click the LA Trigger button.
2. Click the PowerTrigger tab.

3. Specify the desired storage mode in the Storage box, which is located in the LA Trigger dialog box
toolbar. Refer to Data Sample Storage Selections (see page 150) for definitions of the storage modes.

NOTE. This functionality is only available when defining trigger programs using the PowerTrigger tab.
Otherwise, the Storage box is disabled.

Positioning the Trigger

1. In the System window, click the LA Trigger button.

2. Position the trigger using one of the following methods available from the trigger toolbar:

B Move the Trigger Pos slider until the desired percentage of data before the trigger shows in the text field.
m  Enter the desired percentage in the text field.

B Use the controls in the list box to reach the desired percentage.
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Triggering an LA Module on a Glitch

NOTE. Only Asynchronous sampling allows glitch selection. Glitch storage is not available with Prime
signals.

1. In the TLA toolbar, click the Trigger button for your module.

Click the EasyTrigger tab.

Locate the Trigger on glitch EasyTrigger program under Simple Events.
Click the Define Glitches button.

Select the groups for which you want to detect a glitch.

Click OK.

AN o

TIP. An easy method for setting up a glitch trigger program is to drag-and-drop a glitch trigger into the
Waveform or Listing window from the Trigger tab page. Then make any necessary changes to the trigger
expression, under Trigger Details, to set up the trigger.

Triggering an LA Module on a Setup and Hold Violation

NOTE. Setup and hold violation storage is unavailable when using Prime signals. Violations can only be
selected with synchronous or custom sampling. Custom is available when a support package is loaded.

1. From the LA Setup window select synchronous sampling. If you have previously loaded a support
package, the Custom selection is correct.

Open the LA Trigger window.

Click the EasyTrigger tab.

Select the Trigger on group setup & hold violation program from the Simple Event list.
Click the Define Violation button to display the Setup and Hold Event dialog box.
Select the groups for which signals that you want to detect a setup and hold violation.
Enter the values in the corresponding group setup and hold boxes.

Click Close.

o A U S
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TIP. An easy method for setting up a setup and hold violation trigger program is to drag-and-drop a Setup
and Hold trigger from the Trigger tab page into a Waveform or Listing window. Then make any necessary
changes to the trigger expression, under Trigger Details, to set up the trigger.

Related Topics
Loading an LA with Saved Trigger Settings (see page 74)

Using the Trigger Tab Page (see page 92)

Triggering an LA Module on Timer Values

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.
Click the corresponding If/Then button of the clause you want to edit.

Click Timer in the If section of the Clause Definition dialog box.

U

Select the specific Timer.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not
available as an action or event.

6. Select the operation.
7. Select the value.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

Related Topic
Triggering an LA Module on Counter Values (see page 97)

Triggering an LA Module on Counter Values

1. In the System window, click the LA Trigger button.
2. Click the PowerTrigger tab.
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3. Click the corresponding If/Then button of the clause you want to edit.
4. Click Counter in the If section of the Clause Definition dialog box.

5. Select the specific counter.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not
available as an action or event.

6. Select the operation.
7. Select the value.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

Related Topic
Triggering an LA Module on Timer Values (see page 97)

Triggering an LA Module on an Internal Signal

1. In the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.

4. Click Signal in the If section of the Clause Definition dialog box.

5. Select the signal.

6. Select the signal logic level.

7. Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

8. Click OK.

Related Topics

Internal Signaling (see page 154)

Trigger Action Signal Restrictions (see page 155)

Module Arming Using an LA Module (see page 154)
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Triggering an LA Module on a Word Event

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Word in the If section of the Clause Definition dialog box.
Click the Define Word button.

Enter the word values for each group.

Click the box to the left of the group to enable or disable each group.
Click OK.
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Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

10.Click OK.

TIP. Define multiple word events by clicking Add in the Word Definition dialog box and assigning a name
to the definition. You can then select the definition from the Clause Definition dialog box directly.

An easy method for setting up a word event trigger is to load the Trigger on word value EasyTrigger
program. If necessary you can make modifications to the program from the PowerTrigger tab.

Triggering an LA Module on a Snapshot Event

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.

In the Clause Definition dialog box, If section, select Snapshot from the event selection list.
Click the Define Snapshot button.

Click the box to the left of the group to enable or disable each group.

Click OK.

A A o
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8. In the Then section of the Clause Definition dialog box click either:
= Trigger - to trigger the current module.
= Trigger All Modules - to trigger all modules, which is the same as a system trigger.

9. Click OK.

Triggering on Group Data Values

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Group in the If section of the Clause Definition dialog box.

Select the group.

Select the operation for word recognition. Valid selections are = and Is Not.

Enter the value to recognize.

e A O o

Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

TIP. An easy method for setting up a group data value trigger is to load the EasyTrigger programs
Trigger on group value. If necessary you can make modifications to the program from the PowerTrigger
tab. Alternatively, you can drag-and-drop a Multi-Group Value trigger from the Trigger tab page onto
a waveform. Then make the necessary selections in the trigger expression, under Trigger Details, to
set up the trigger.

Related Topic
Using the Trigger Tab Page (see page 92)

Triggering on Group Data Ranges

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.
Click the corresponding If/Then button of the clause you want to edit.

Lol

Click Group in the If section of the Clause Definition dialog box.
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Triggering an LA Module on a Single Channel

Select the group.

Select the operation for range recognition. Valid selections are:
<, <=, >, >=, Is In and Is Not In.

Enter the values for the range.

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

Click OK.

TIP. An easy method for setting up a group data value trigger is to load one of the EasyTrigger programs
(Trigger on group value outside of a range or Trigger on group value within a range). If necessary you can
make modifications to the program from the PowerTrigger tab. Alternatively, you can drag-and-drop a
Multi-Group Value trigger from the Trigger tab page onto a waveform. Then make the necessary selections
in the trigger expression, under Trigger Details, to set up the trigger.

Related Topic

Using the Trigger Tab Page (see page 92)

Triggering an LA Module on a Single Channel
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause that you want to edit.

Select Channel in the If section of the Clause Definition dialog box.

Click the Select Channel button to display the Select Channel dialog box.

Select both the selection method and the signal that you want to trigger on, and then click OK.
Select the operation.

Select the logic level.

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

10.Click OK.
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Triggering an LA Module on a Group

TIP. An easy method for setting up a single channel trigger is to load one of the EasyTrigger programs
(Trigger on signal low/high or Trigger on signal transition edge). If necessary you can make modifications
to the program from the PowerTrigger tab. Alternatively, you can drag-and-drop a Channel Value or
Channel Edge trigger onto a waveform from the Trigger tab page. Then make the necessary selections in
the trigger expression, under Trigger Details, to set up the trigger:

Related Topics

Signal Selection (see page 157)

Using the Trigger Tab Page (see page 92)

Triggering an LA Module on a Group
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1. In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Group in the If section of the Clause Definition dialog box.
Select the group.

Select the operation for group recognition.

Select the group value or pattern.
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Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as
a system trigger.

9. Click OK.

TIP. An easy method for setting up a group trigger is to drag and drop a Multi-Group Value trigger from
the Trigger tab page onto a waveform or listing window. Then make the necessary selections in the trigger
expression, under Trigger Details, to set up the trigger.

Alternatively you can load one of the EasyTrigger programs (Trigger on group value or Trigger on group
transition). If necessary, you can modify the program from the PowerTrigger tab.

Related Topic
Using the Trigger Tab Page (see page 92)
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Arming other Modules from an LA

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Select the event type in the If section of the Clause Definition dialog box.
Click Arm Module in the Then section of the Clause Definition dialog box.
Select the module you want to arm.

Click OK.
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Related Topics
Internal Signaling (see page 154)

Trigger Action Signal Restrictions (see page 155)

Module Arming Using an LA (see page 154)

Triggering other Modules from an LA

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.

Select the event type in the If section of the Clause Definition dialog box.

Click Trigger All Modules in the Then section of the Clause Definition dialog box.
Click OK.

AU S o A

NOTE. All trigger actions in the trigger program must be the same and can be either Trigger or Trigger
All Modules.

TIP. An easy method for triggering all modules is to load the EasyTrigger program Trigger all modules
when A occurs. If necessary, you can modify the program from the PowerTrigger tab.

Trigger All Modules

Trigger All Modules is the same as a system trigger.
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Troubleshooting LA PowerTrigger Programs

If you have problems with your PowerTrigger program, try these suggestions:

B Look at the trigger clauses. The clauses, although appearing to be evaluated simultaneously, have
precedence, and are given priority from top to bottom in the active state. Therefore, you will not trigger
when you think you should if you have a program like the following examples.

If Anything

Increment Counter 1

Else If Counter 1 > 5

Then Trigger

A trigger will never occur because the first clause is always true.
If counter 1 > 5

Then Reset Counter 1

And Increment Counter 2

Else if Counter 1 <=5

Then Increment Counter 1

Else if Counter 2 > 10

Then trigger

A trigger will never occur because counter 1 will either be >5 or <=5.

®H  Check for a bad probe lead: go to the Setup window and check the activity indicators for activity
at the probe tip.

B When setting up to trigger on group ranges, check that the signals in the group are assigned in
descending order in the Setup window. For example:

A3(7), A3(6), A3(4) or A3(7-0) is correct.
A3(6) A3(7), A3(4) or A3(0-7) is incorrect.

The values triggered on in the incorrect example will not be correct in the data windows. For example, if
the incorrect group above is in the range of FO to 70 the only possible values to cause a trigger would be FO
and 70. Values in the range of FO through 70 will not cause a trigger.

B Check that the probe order is correct. Verify that you have the correct probe or probe leads connected.

B Check the progress of the trigger program in the Status monitor to see which state may be causing the
trigger problem.

B On the TLA7000 Series logic analyzer modules and the TLA5000B Series mainframe, the first
transition state indication is always false. On TLA700 Series logic analyzer modules the first transition
state always shows a transition indication (even if there are no probes plugged in). One way to avoid
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triggering on a false first transition indication is to set the first state to "If Anything Goto Next State".
This will consume a state, but will ensure that there is no false triggering on the first transition indication.

Related Topics
Status Monitor Dialog Box (see page 366)

Troubleshooting Triggering (see page 338)

Timer Event Target Value Limit

The maximum value that can be entered as an event value limit is 2,000,000 seconds, which is about 23
days.

Actual ending timer values up to the full 104-day limit can be read from the hardware and displayed
in the status monitor.

The 23-day limit is imposed by the user interface in the If/Then dialog.

Data Measurement Types and Definitions: Count

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Count measurements

Pattern Match

C‘;_-.ﬂ!. — ZX?'

The number of occurrences of a specified group value.

Where Cra is the total number of occurrences of the matched pattern in the gated region.
X, is the pattern to match.
The total number of occurrences of the specified group value in the gated region is displayed in the Value column.
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Count measurements
Edge Count

o

Crpe = > X(LH)

The total number of signal edges (positive and negative).

Where r:-"*'i"-is the Edge Count.

X(LH) is an edge represented by a transition from Low to High.

X(HL) is an edge represented by a transition from High to Low.

The total number of signal edges in the gated region is displayed in the value column.
Cycle Count

Ceie = > LHLH
Cepe=Y HLHL

The number of signal cycles in the specified region. One cycle is defined as the time period between rising edge to next
rising edge or from a falling edge to the next falling edge.

Where Cqyee is the cycle Count.

Positive Pulse count
';.!.'.":? - Z ‘E‘HL

The number of positive pulses.

Where Cruse is the Positive Pulse Count.
The total number of positive pulses in the gated region is displayed in the Value column.

Negative Pulse Count

CPH:':E = Z HLH

The number of negative pulses.
Where Case is the Negative Pulse Count.

The total number of negative pulses in the gated region is displayed in the Value column.
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Data

Data Measurement Types and Definitions: Jitter

Count measurements

Violation Count

Ci'."-_:.":ei.‘-_:?: = Z V

The of number of group setup/hold violations or number of glitch violations in the gated region. Setup/Hold violations are only
available for synchronous sampling. Glitch violations are only available for asynchronous sampling.

Where Coresson is the Violation Count.
The total number of violations in the gated region is displayed in the Value column.

Violation Rate

R, =Cp.. /N(S)

L St ] R Bar e S )

Ratio of the number of group setup/hold or glitch violations (depending on the sampling) per number of seconds.

Where “:e:e- is the Violation Rate. #=::- is the number of violations in the gated region. N (S) is the number of seconds.

The rate at which violations occur in the gated region expressed as a fraction of total number of violation/seconds is
displayed in the Value column.

Measurement Types and Definitions: Jitter

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.
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Jitter measurements

Period Jitter
AR, =F. -F
The timing variation in the period measured in seconds.

AD
Where * is the Period Jitter.

F.tis the Period of the (n +1) Cycle.

‘pi-is the Period of the First Cycle.

The difference of the Maximum period measured minus the Minimum period measured in the gated region is displayed in the
Value column. This is also called peak-to-peak period jitter.

Cycle-to-Cycle Jitter
AP =F_.—P,
The timing variation in the period in adjacent cycles measured in seconds.

AP .
Where ~ * is the Cycle-to-Cycle Jitter.
.44 is the Period of the (n+1) Cycle.

% is the Period of nth Cycle.

The difference of the Maximum cycle-to-cycle jitter minus the Minimum cycle-to-cycle jitter in the gated region is displayed in
the Value column. This is also called peak-to-peak cycle-to-cycle jitter.

Data Measurement Types and Definitions: Minimum/Maximum

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms for each measurement.

Minimum/Maximum measurements

Group Min
Min( X)) = Lowest Value of Group

The minimum value the group values.The lowest value of the group in the gate region is displayed in the Value column.

Group Max
Max(X') = Highest Value of Group

The maximum of the group values.The highest value of the group in the gated region is displayed in the Value column.
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Data Measurement Types and Definitions: Time

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Time measurements

Frequency
F,=1/P,

Frequency is the reciprocal of the period of a signal measured in hertz (Hz).

Where F, is the Frequency and P, is the Period.

The average frequency of all cycles in the gated region is displayed in the Value column.
Period

"P;? = I:?—l o 'Irr“

Time it takes for a complete cycle in the gated region. Reciprocal of frequency, measured in seconds (s).
Where P, is the Period and T is the point in time of a Transition (Low to High or High to Low).

The average of all period measurements in the gate region is displayed in the Value column.

Positive Pulse Width

TIT T

Tr
I___f,:' T I_ L I_;'_a.'_'a.
n TEm "

The time duration of a positive pulse (low-high-low) measured in seconds (s).

Where " “ is the Positive Pulse Width.

“= is the point in time of the Transition from High to Low.

is the point in time of the Transition from Low to High.
The average of all positive pulse width measurements in the gated region is displayed in the Value column.
Negative Pulse Width

I;Fr?:— — I-?:L":' _ I-?::.'_

The time duration of a negative pulse (high-low-high) measured in seconds (s).

IF
Where * is the Negative Pulse Width.

is the point in time of the Transition from Low to High.

is the point in time of the Transition from High to Low.
The average of all negative pulse width measurements in the gated region is displayed in the Value column.
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Time measurements

Positive Duty Cycle
D =W /P,

The ratio of the positive pulse to the total signal period expressed as a percentage (%).
Where D, is the positive duty cycle.

"~ s the Positive Pulse Width.

k. is the Period.

The average of all positive duty cycle measurements in the gated region is displayed in the Value column.

Negative Duty Cycle
D, =W,/P

i)

The ratio of the negative pulse to the total signal period expressed as a percentage (%).
Where D, is the negative duty cycle.

e

T is the Negative Pulse Width.

5 is the Period.

The average of all negative duty cycle measurements in the grated region is displayed in the Value column.

Channel-to-Channel Delay
C‘hDﬂ = &‘L‘E?F'ﬂgé‘(/ IZTHD?SF.:?EQ:'.:S?! _ Tﬂ?se;r:?)

Time delay between the edges of two different signals measured in seconds (s).

Where ChD, is the Channel to Channel Delay. ~ - is the Transition (location of the type of edge selected in the Ul
using the drag and drop action) of the Destination Channel. This is indicated as the second channel selected during the
measurement setup. The average of the delay from the first edge of the type selected as the source to the first edge of the
type selected as the destination plus the delay from the second edge of the type selected as the source to the second edge
of the type selected as the destination...plus the delay from the nth edge of the type selected as the source to the nth edge of
the type selected as the destination for each pair of edges in the gated region is displayed in the Value column.

— Fies

= is the Transition of the Source channel. This is indicated as the first channel selected during the measurement setup.
The delay from the first edge of the type selected for each edge in the gated region is displayed in the Value column.

Using LA Data Measurements

To use LA data measurements follow these steps:
1. Add a new measurement.
a. To select a measurement, right-click on the signal or group header.

b. Select Add LA Measurement and then select the measurement you want to add.
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OR
a. Select the Setup page in the Measurements tab.

b. Click and drag a measurement item from Add Measurements to a signal or group in the data
window.

If a measurement is dropped onto any group, the measurement will be applied to all the signals in the group.
2. Define gating.
a. Select gating type from the Gate drop-down list on the Setup page.
b. Select Display to analyze the samples in the visible display.
c. Select Cursors to analyze the samples between Cursor 1 and Cursor 2.
d. Select Full Record to analyze all the samples.
3. Select mode for analysis.
= Select the Accumulate check box to add results to the existing measurement results.
OR

= Clear the Accumulate check box to clear previous results and update with new results.

NOTE. The results are accumulated when you click Run but not when you click Recalc.

4. Analyze the data.

Results and statistics are displayed in the Statistics page. To get new data, click Run. To recalculate
measurements, click Recalc.

Related Topic
Adding Dual Channel Measurements (see page 112)

Statistic Definitions for Data Measurements

Statistic Definition

Average The sum of the results calculated in the gated
region divided by the total number calculations. The
measurement is expressed in the same units as the data.

w(X)=X = % X,

AN pal Y.

Min Minimum of all the results calculated in the gated region.
Min(X)=LowestValueof X
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Statistic Definition
Max Maximum of all the results calculated in the gated region.

Mad X)) = HighestValue of X

Standard Deviation A statistical measure of the spread of results. Itis a measure
of variability expressed in the same units as the data.

StdDev(X) = o, = %\ Z(}f ~xf |

-

Population The number of times the measurement was performed in

Population(X)= N

Note: The samples or data considered for calculating the results for all the above measurements and statistics are bound by
the gated region. Gating options include display, cursors, and full record.

the gated region.

Adding Dual Channel Measurements

To add a dual channel measurement using drag and drop, do the following:
1. Select the Setup page from the Measurements tab.

2. Click and drag a measurement item from the Available Measurements list to the first channel. While
dragging to the first channel there is a tool tip that says on which channel the measurement is to be
dropped.

3. Drop the measurement button on the first channel. The tool tip will change to indicate the first channel
selected and that a second channel needs to be selected.

4. Click the channel header to select the second channel.

Copying Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

2. Double click the LA module that contains the filter that you want to copy. The filter list will expand to
show all filters attached to the selected LA module.

3. Select the filter and click the Copy button in the dialog box.
4. Select the LA module to which you want to copy the filter.
5. Click the Paste button.
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Creating Filters

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting
Filter Definitions... from the Data menu.

Creating Filters

Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.
Logic analyzers with filters attached to them have an expand and collapse button to the left of the name.
Select an LA module in the dialog box.

Click the New button to attach a new filter to the module.

Click the = button to open the Define Filter dialog box where you can define the filter contents.

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting
Filter Definitions... from the Data menu.

Opening Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.
2. Locate and double-click the LA module that contains the filter that you want to open.

3.
4

Select the filter.

. Click the Properties button to view and edit the filter contents in the Define Filter dialog box.

TIP. You can also open the Filter Definitions dialog box from the Listing or Waveform window by selecting
Filter Definitions... from the Data menu. Alternately, you can right-click a column label in the Listing
window or a waveform label in the Waveform window to display a right-click menu where you can access
the filters.

Adding Reference Data to a Listing Window

. Open a Listing window.
. Right-click anywhere inside the Listing window header area or data area and select Add Column.

1
2
3.
4
5

In the Add Column dialog box, click the Add Data Source button.

. Click Browse and search for the appropriate data source.

. After the source is added, select it in the Add Column dialog box.
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Adding an Opcode Mark

6. Select the desired columns and then click Add.
7. Click Close.

8. If necessary, select the new column in the header and drag the column to the desired location.

TIP. To delete a column from the Listing window, select the header and press the Delete key on the keyboard.

Adding an Opcode Mark

Occasionally, you might want to change the way the disassembler interprets a cycle type. Mark Opcodes
synchronizes the disassembler. Install a support package to use this feature.

1. In the System window, click the Listing window icon.

From the Edit menu, click Mark Opcode.

The pointer changes to a cross hair pointer.

Move the pointer to the data sample where you want to place an Opcode and click.

The Mark Opcode Dialog Box opens.

AN O

Double-click the Opcode type.

TIP. Move the pointer to the desired data sample and click the right mouse button. Select Mark Opcode.

Showing Qualification Gaps in a Listing Window
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In the System window, click the Listing window icon.
From the Edit menu, click Properties.
From the Properties dialog box, click the Listing Window tab.

Select Show Qualification Gaps.

R W b=

Click OK.

Gaps are shown in the display with a horizontal gray line above the first data after the gap.

TIP. Click to open the Properties dialog box.




How to Showing Glitches in a Listing Window

Showing Glitches in a Listing Window

In the System window, click the Listing window icon.

From the Edit menu, click Properties.

From the Properties dialog box, click the Listing Window tab.
Select Show Glitches.

A

Select the glitch color.
6. Click OK.

Glitches are shown in the display by highlighting the character in the sample containing the glitch. In
binary data the individual bit containing the glitch is highlighted.

NOTE. Select Samples + Glitches in the Storage Options box of the Setup window before making an
acquisition.

TIP. Click = 1o open the Properties dialog box.

To see the individual glitch bit, change the radix of the column to binary.

Going to a Specific Column

In the System window, click the Listing window icon.
From the Edit menu, click Go To.
Click Column.

Select the column.

A

Click Go To.

TIP. Click 24 to open the Go to dialog box.

Creating Symbol Files

1. Open any text processor application. For example: WordPad.
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Creating Symbol Files

2. Use lines beginning with a number sign (#) to indicate comments.

3. Enter a Symbol File Header (see page 117). Include the #+ characters at the beginning of the line.
4. Enter symbol names and values.

The following is an example of a simple pattern symbol file.

# Pattern symbol file

# TSF Format Type Display Radix File Radix

# —

#+ Version 2.1.0 PATTERN BIN BIN # Symbol Name Pattern Color
#
NUL X000 0000 sOoH X000 0001 @blue STX X000 0010 @white @red

The following is an example of a simple range symbol file.

# Range symbol file with function symbols

# TSF Format Type Display Radix File Radix oOffset
#

#+ Version 2.1.0 RANGE HEX HEX 00000000
#+ Function # Symbol Name Low High
#

displayBanner 006035ba 00603675
buildMenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

There are four different types of range symbols. For more information on these range symbols, click
the symbol type you are interested in:

Function Range Symbols (see page 343)

Variable Range Symbols (see page 344)
Source Range Symbols (see page 345)

Color range symbols (see page 354)

When you create range symbols avoid defining symbols where the ranges overlap within a given type,
such as function or variable because overlapping ranges can produce unexpected results.

Color is an effective means for conveying information that allows you to view your data more efficiently
and highlight items of interest. Symbol files provide an easy way to color-code samples in your
acquisitions to help distinguish various features of the data. When you set the group radix to Symbolic
in the data window property sheet and then pick a symbol file with color information in it, the group
values may be displayed in color in a Listing or Waveform window. The foreground color as well as the
background color of the data can be set by the symbol file.



How to Symbol File Header

For a detailed description of symbol file syntax, see TLA Symbol File Format (see page 350).

Related Topic
Symbols Dialog Box (see page 346)

Symbol File Header

Use header lines to help the logic analyzer identify the contents of a symbol file.

Pattern Symbol File Header

The header line of a pattern symbol table has the following form:

#+ <file format version> PATTERN <display radix> <file radix>
The file format version contains three fields:

B Major version number

B Minor version number

®  Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Oct, or Bin).

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern files
are Hex, Oct, or Bin.

Range Symbol File Header

The header line of a range symbol table has the following form:

#+ <file format version> RANGE <display radix> <file radix> <offset>
The file format version contains three fields:

B Major version number

B Minor version number

B Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Dec, Oct, or Bin).

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern
files are Hex, Dec, Oct, or Bin.
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Coloring Data

The offset is a 32-bit hexadecimal value added to the lower and upper bound of each range symbol read
from the file.

Coloring Data

From the Systems window, click the Listing window icon.
Double-click a column heading to display the Listing Properties dialog box.

Change the radix to symbolic.

Eal o

Click the Symbol File button to load a symbol tab with color symbols.

NOTE. You can use this column as a color source for other columns by double-clicking another column in
the Listing window. From the Listing Properties dialog box, click Same As in the Color group box.

Related Topics
Symbol Files (see page 341)

TLA Symbol File Format (see page 350)

Adding a Waveform
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1. In the System window, click the Waveform window icon.
2. From the Edit menu, click Add Waveform.

3. Select the Data Source. If the data source you want is not listed, click Add Data Source and select
your particular data source.

4. If you are adding a DSO or External Oscilloscope channel, Select the Channel and then click Add. If
you are adding a LA channel, select the Group, the Channel, and then click Add.

:I-h-l-
=

TIP. Click on the waveform toolbar to select a waveform to add.

From the front panel or from the waveform toolbar, click — iz

waveforms to the Waveform window.

to add external oscilloscope



How to Changing Waveform Appearance

From the front panel or from the waveform toolbar, click = MagniVu ¢, add MagniVu waveforms to the
Waveform window for those main timebase waveforms that are already displayed in the Waveform window.

Changing Waveform Appearance

1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform you want to change.

3. If not selected, select the waveform you want to change from the Waveform list.
4.

In the dialog box, select the desired waveform Color, Height, Offset, Radix, Readout Options, and
Waveform Measurements, and select whether to Use Polarity and Show the Waveform.

NOTE. Radix and Use Polarity are only available for logic analyzer waveforms. Offset is only available
for logic analyzer, DSO, and external waveforms that are included in a waveform overlay. Waveform
Measurements are only available for DSO and external waveforms.

Related Topics
Selecting the Waveform Color (see page 119)

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 85)

Determining the Data Source of the Selected Waveform (see page 84)

Controlling Whether a Waveform is Visible (see page 121)

Setting the Overlay Waveform Offset (see page 209)

Setting Up Waveform Measurements (see page 126)

Selecting the Waveform Color

In the System window, click a Waveform window icon.

Double-click the label of the waveform you want to change.

If not selected, select the waveform you want to change from the Waveform list.
From the Color drop down list, select the desired waveform Color.

Alternately, select "Same As" and choose another waveform to use as the color source.

AU S o

Click OK.
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Related Topics

Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 85)

Determining the Data Source of the Selected Waveform (see page 84)

Controlling Whether a Waveform is Visible (see page 121)

Displaying Waveform Readouts

1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.
3. Click Options.

4. If you want to show readouts, click Show Readouts.

5

. If Show Readouts is checked, set the color of the displayed readouts.

Related Topics
Setting Waveform Options (see page 125)

Setting the Waveform Style (see page 83)

Setting the Waveform Limits (see page 84)

Changing the Waveform Time Scale (Time/Division)

1. In the System window, click a Waveform window icon to open the window.
2. If the Waveform Toolbar is not displayed, click Waveform Toolbar from the View menu.

3. Using the Time/Div control, select the time per division or enter the time/div if the desired value
does not appear in the list.

The center of the screen remains fixed when time per division changes. You cannot display less than
two horizontal divisions.

Changing Waveform Window Properties

1. In the System window, click a Waveform window icon to open the window.
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From the View menu, click Properties.

Select the Waveform Window tab.

In the dialog box, select whether or not to show graticules and violations.

Click Show Compare to enable comparison of data.

Use the drop-down list to select the color of glitches, graticules, and background.

Select the desired Color Scheme.

Sl A T o

Select whether or not to snap cursors and marks to transition edges.

TIP. To quickly access the Properties dialog box, right-click in the Waveform window and select Properties.

Related Topics
Making Glitches Visible (see page 122)

Selecting the Glitch Color (see page 122)

Selecting the Graticule Color (see page 123)

Selecting the Background Color (see page 123)

Selecting the Active Data Window Color Scheme (see page 122)

Controlling Whether a Waveform is Visible

In the System window, click a Waveform window icon.

Double-click the label of the waveform whose attributes you want to change.

If not selected, select from the Waveform list the waveform you want to change.
Click the Show Waveform check box.

Click OK.

A

Related Topics

Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 85)

Determining the Data Source of the Selected Waveform (see page 84)

Changing the Color of a Waveform (see page 119)
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Selecting the Violation Color

In the System window, click a Waveform window data icon.
Double-click a waveform label.

Click the Waveform Window tab.

Click the violation color from the Show Violations color drop-down list.

Click OK.

LN e

Related Topics
Making Violations Visible (see page 122)

Changing Waveform Window Properties (see page 120)

Making Violations Visible

. In the System window, click a Waveform window data icon.

. Double-click a waveform label.

. Click the Show Violations check box.

1
2
3. Click the Waveform Window tab.
4
5. Click OK.

When the Show Violations box is checked, violations are displayed on all waveforms.

Related Topics
Changing Waveform Window Properties (see page 120)

Selecting the Violation Color (see page 122)

Selecting the Active Data Window Color Scheme

1. In the System window, click a Waveform window icon.
2. Double-click a waveform label.

3. Click the Waveform Window tab.

4

. From the Color Scheme drop down list, select the color scheme for the active window.
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Related Topics

Selecting the Glitch Color (see page 122)

Selecting the Graticule Color (see page 123)

Selecting the Background Color (see page 123)

Changing Waveform Window Properties (see page 120)

Selecting the Background Color

1.
2
3.
4
5

In the System window, click a Waveform window icon.

. Double-click a waveform label.

Click the Waveform Window tab.

. From the Background drop down list, select the background color.

. Click OK.

Related Topics

Selecting the Glitch Color (see page 122)

Selecting the Graticule Color (see page 123)

Changing Waveform Window Properties (see page 120)

Selecting the Active Data Window Color Scheme (see page 122)

Selecting the Graticule Color

1
2
3.
4
5

. In the System window, click a Waveform window icon.

. Double-click a waveform label.

Click the Waveform Window tab.

. From the Show Graticule color list, select the graticule color.

. Click OK.

Related Topics

Making Graticules Visible (see page 124)

Changing Waveform Window Properties (see page 120)

Selecting the Background Color

123



How to Making Graticules Visible

Making Graticules Visible

1. In the System window, click a Waveform window icon.
2. Double-click a waveform label.

3. Click the Waveform Window tab.

4. Click the Show Graticule check box.

5. Click OK.

When the Show Graticule box is checked, graticules are displayed on all waveforms.

Related Topics
Changing Waveform Window Properties (see page 120)

Selecting the Graticule Color (see page 123)

Changing the Size of a Waveform

Move the cursor over the lower part of the waveform label until it changes from a pointer to a resize cursor.
Click the left mouse button and drag to change the size of the waveform.

Alternate Method

1. In the System window, click the Waveform window icon.

2. To open the waveform Properties dialog box, double-click the label of the waveform you want to resize.
3. Click the Waveform tab.

4. Enter the size you want the waveform to be using the Height spin box.

5. Click OK.

This procedure changes the size of the waveform by changing the size of the labeled waveform track. The
size of the waveform is also affected by the vertical input range setting.

Jump Over Time Gaps in the Waveform Window

One way to jump over large time gaps in the Waveform window is to create a Listing window of the same
data as that of the Waveform window, and then lock the two windows together. As you move the cursor
through the Listing window, the cursor in the Waveform window will track and jump over the "dead" or
blank space between samples.
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Setting Waveform Options

1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform whose options you want to set.
3. Click the Options button.

From this dialog box you can:

®  Set whether to show readouts.

m  Set the waveform voltage limits.

® Set the style of logic analyzer waveforms.

m  Set the readout color.

Related Topics
Setting the Waveform Style (see page 83)

Setting the Waveform Limits (see page 84)

Showing Waveform Readouts (see page 120)

Viewing an LA Waveform in Magnitude Mode

In the Waveform window, right-click on any LA busform label and select Display Magnitude from the
menu.

NOTE. Magnitude mode is only available for LA busforms. Magnitude mode is not available for DSO
or External Oscilloscope waveforms.

Alternate Method

1. In the System window, click the Waveform window icon.
2. Double-click an LA waveform.

3. Click Options.

4. Click Magnitude.

5

. Click Signed data if you want to interpret the acquisition data as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as
signed decimal, so that the readouts will display the correct information.
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How to Scrolling Between Samples in a Waveform Window

6. If Lock to Setup is not checked, set the maximum and minimum values to display in the waveform.

7. Click OK twice and adjust the time per division to view the waveform.

Scrolling Between Samples in a Waveform Window

1. In the Waveform window, move the pointer to the center of the window.
2. Right-click the mouse and click either Go To Next Sample or Go To Prior Sample.
The Waveform window will scroll to the next or previous sample.

Use this method of scrolling over gaps in the waveform data where there are no data samples due to
clock or data qualification.

Selecting the DSO Horizontal Settings

For an external oscilloscope:
1. In the System window, click the External Oscilloscope Setup button, and then select the Setup tab.
2. Use the Depth Limit drop-down list to select the Memory Depth.

3. Use the Horizontal menu on the external oscilloscope to select the remaining horizontal settings.

Setting Up Waveform Measurements

1. In the System window, click the Waveform window icon.

g

Double-click the external waveform label for which you want to set up measurements, and then click
the Measurement Setup button.

Use the >> button to select up to three measurements from the Available Measurements list.
For each measurement type, select a Base-Top Determination method.

Select a Reference Level to use for the waveform measurements.

AR .

From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the Set
Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. Acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.
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Alternate Method

1. In the System window, click the Waveform window icon.

2. From the Waveform window, right-click the waveform label, and then click Add/Delete DSO
Measurements.

Use the >> button to select up to three measurements from the Available Measurements list.
For each measurement type, select a Base-Top Determination method.

Select a Reference Level to use for the waveform measurements.

SR

From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the Set
Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. Acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.

Related Topic

Removing Selected DSO Waveform Measurements (see page 127)

Removing Selected Analog Waveform Measurements

1. In the waveform Properties dialog box, select the waveform containing measurements that you want to
remove and click the Measurement Setup button.

2. Select the waveform measurement that you want to remove from the Selected Measurements list
box and click the Remove button (<<).

3. Click OK.

Related Topic
Selecting DSO Waveform Measurements (see page 126)

Taking Voltage Measurements

1. In the System window, click a waveform icon.

2. Select a waveform.
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Taking Delta Volts Measurements

Move Cursor 1 to the location on the waveform that you want to measure.
Read the voltage from the C1 readout on the Measurement toolbar.
Move Cursor 2 to another location on the waveform that you want to measure.

Read the voltage from the C2 readout on the Measurement toolbar.
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Read the voltage difference between the two waveform locations from the Delta readout on the
Measurement toolbar.

Related Topics

Taking Time Measurements (see page 129)

Taking Delta Time Measurements (see page 129)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 131)

Taking Delta Volts Measurements
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In the System window, click a waveform icon.
Select a waveform.
Move Cursor 1 to the first location on the waveform that you want to measure.

Move Cursor 2 to a second location on the waveform that you want to measure.
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Read the voltage difference between the two waveform locations from the Delta readout.

For LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and C2
values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0X7E).

Related Topics
Taking Voltage Measurements (see page 127)

Taking Time Measurements (see page 129)

Taking Delta Time Measurements (see page 129)

Taking Logic Analyzer Measurements (see page 131)
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Taking Time Measurements

Taking Time Measurements

1
2
3
4.
5
6
7

In the System window, click a waveform window icon.

. Select a waveform.

. Move Cursor 1 to the location on the waveform that you want to measure.

Read the time from the C1 readout on the Measurement toolbar.

. Move Cursor 2 to another location on the waveform that you want to measure.
. Read the time from the C2 readout on the Measurement toolbar.

. Read the time difference between the two waveform locations from the Delta readout on the

Measurement toolbar or from the Delta Time toolbar.

Cursor time is relative to the system trigger.

Related Topics

Taking Delta Time Measurements (see page 129)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 131)

Taking Delta Time Measurements

To take a single Delta Time measurement do the following:

1.

AR

In the System window, click a waveform window icon.

+.
Click the Add Delta Time toolbar button 2" if the toolbar is not already displayed. Note that you can

have as many Delta Time toolbars as you want.

Select a waveform.

Move Cursor 1 to the location on the waveform where you want the time measurement to start.
Move Cursor 2 to another location on the waveform where you want the time measurement to end.

Read the time difference between the two locations from the Delta Time toolbar.
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Taking Delta Time Measurements
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To lock the Delta Time do the following:
1. Click the drop-down list on the Delta Time toolbar button.

2. Select Lock Delta Time. This locks the cursors or marks in the Delta Time toolbar with respect to
delta time.
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Lock Delta time is disabled if either of the following is true:
® The data window is locked

B You have an unmovable measurement point selected for the delta time calculation such as System
Trigger

The delta time readout is negative when C2 precedes C1.

For an LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and
C2 values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0X7E).

TIP. You can take multiple Delta Time measurements by selecting different measurement points from the
Delta Time toolbar. Alternatively, you can add Delta Time toolbars to take additional measurements.
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Taking Logic Analyzer Measurements

Related Topics

Taking Time Measurements (see page 129)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 131)

Taking Logic Analyzer Measurements

1. In the System window, click a waveform icon.

Select a logic analyzer group magnitude, group digital, or digital waveform.

Move Cursor 1 to the location on the waveform that you want to measure.

Read the value of the logic analyzer waveform from the C1 readout on the Measurement toolbar.
Move Cursor 2 to another location on the waveform that you want to measure.

Read the value of the logic analyzer waveform from the C2 readout on the Measurement toolbar.
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Read the value of the difference in time between the two waveform locations from the Delta readout
on the Measurement toolbar.

Values for logic analyzer digital waveforms are binary 0 or 1.

Values for logic analyzer group magnitude and group digital waveforms are in the selected radix. The
delta values are blank if you use a symbolic radix.

Related Topics

Taking Time Measurements (see page 129)

Taking Delta Time Measurements (see page 129)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Selecting the Trigger Action and Target for an External Oscilloscope

1. In the System window, click the External Oscilloscope Trigger button.
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How to Adding Reference Data to a Waveform Window

2. Select the trigger event:

= Oscilloscope triggers — The external oscilloscope initiates the trigger

= TLA System trigger — The TLA System trigger initiates the oscilloscope trigger
3. Select the trigger action:

® Trigger oscilloscope only

Trigger TLA too

Adding Reference Data to a Waveform Window

1. In the System window, click the Waveform window icon.

From the Edit menu, click Add Waveform.

From the Add Waveform dialog box, click the Add Data Source button.
Click the Browse button and search for the appropriate source.

After the data source is added, select it in the Add Waveform dialog box.

AN S o

Select the desired waveforms.

TIP. Click " to open the Add Waveform dialog box.
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Running Extended Diagnostics

A o

You may want to save your system before running diagnostics. Extended diagnostics will invalidate
your acquired data.

Disconnect any probes attached to your instrument.

From the System menu, click Calibration and Diagnostics.

Click the Extended Diagnostics tab from the Calibration and Diagnostics dialog box.
Select the test or set of tests you want to run.

Click the option button associated with the Run mode you want to use: One Time, Continuous, or
Until Fail.

Click Run. If you selected Continuous or Until Fail, you can click on the Abort or Stop buttons to
stop the process.

If the diagnostics fail, you can refer to the service manual for the particular product, or contact your
local Tektronix service center.

Related Topics

Extended Diagnostics (see page 337)

Technical Support (see page 1)

Defining Reference Data

A
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Open a Listing or Waveform data window.
Click Define Compare in the TLA toolbar to open the Define Compare dialog box.
Click the Enable Data Compare check box.

Click the Add Data Source button, then select the reference module from the list or click Browse to
search for a saved LA module.

Click the Add button to add the data source to the Reference Data Source list.
Select a Reference Data Source from the list.

Define the parameters in the Compare Data Region.

Define the parameters for the Data Source Alignment.

Click OK.
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Customizing the System Tools menu

134

You can customize the Tools sub-menu of the System menu by adding, editing, and deleting menu items.
You can add frequently used utilities to the Tools menu and run them from within your TLA. To do this,
use the Tools page in the Options dialog box (accessed from the System menu).

To add a tool to the Tools menu

As an example, the following procedure demonstrates how to add the Windows WordPad accessory to
the Tools menu.

1.

0 » b

6.
7.

From the System menu, click Options and then click the Tools tab.

Click the Add button to bring up the Tool Properties Dialog.

In the Menu Name text box, type WordPad.

In the Command box, browse or type the path and name of the program, for example:
C:\program files\accessories\wordpad.exe

In the Arguments text box, type any arguments to be passed to the program.

In the Initial Directory box, type the file directory where the command is located.

If you want the program to run in a minimized window, check the Run Minimized box.

Once the tool appears on the Tools menu, to run the program, just choose it from the menu or click
on its button in the Toolbar.

Enclose quotes around arguments and commands with embedded spaces in the Tool Properties (App
Options) dialog box for the commands to work.

Related Topics

Editing a Tool on the Tools Menu (see page 70)

Removing a Tool from the Tools Menu (see page 70)




Data Window Information Adding a Data Source to an Active Waveform Window

Adding a Data Source to an Active Waveform Window

. In the System window, click a Waveform window icon.

From the Edit menu, click Add Waveform.

From the Data Source list, select a Data Source or click the Add Data Source button if the source is
not listed.

Click the Close button.

TIP. Click "€ 1o open the dialog box.

To quickly add MagniVu waveforms, click = MagniVul in the waveform window. Or press the MagniVu
button on the front panel. Click the button again to remove the MagniVu data from the window.

Opening a Saved Data Window

1.
2
3.
4
5

From the Window menu, click Load Data Window.

. Click the Browse button to search for the file, or enter a path to the desired file.

Enter a Window name or use the default.

. Once the file is found, click Open.
. Click OK.

NOTE. The saved data file must be a saved system file.

Creating an Overlay Waveform

In the System window, click the Waveform window icon.
Click the label of a waveform you want to include in an overlay waveform.

Drag the waveform label to the second waveform that you want included in the overlay waveform. As
you drag the waveform label, a drop marker displays at the left edge of the waveform label. Use this
drop marker to determine which waveform you will be selecting to form a waveform overlay.

In the Add Overlay Waveform Name dialog box, either enter a name and click OK or simply click
OK to use the default overlay waveform name. This name will be prepended to all waveform labels in
the overlay waveform.
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Related Topics
Overlay Waveform (see page 206)

Overlay Waveform Properties (see page 208)

Waveform Properties (see page 88)

Changing Waveform Properties (see page 119)

Locking Windows

1. In the System window, click a Listing, Waveform, Graph, or Protocol window icon.

From the View menu, select Lock Windows.

From the Lock Windows dialog box, select which windows to lock together.

Click either the No time offsets or Current time offsets option button.

If you select No time offsets, select which window is the reference in the Reference Window list.

Click OK.

AU i

NOTE. You can lock Listing, Waveform, Graph, and Protocol windows only.

Aligning Time of Correlated Data Sources

In the System window, click a Listing or Waveform window icon.
From the Data menu, select Time Alignment.

Perform the following steps for each data source:

Ll A S

Click OK.

Related Topics
Adding Reference Data to a Listing Window (see page 113)

Adding Reference Data to a Waveform Window (see page 132)
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Adding a Mark to a Data Window

From the Edit menu, click Add Mark. The mark appears at the center of the display and has default
properties.

NOTE. You cannot add a mark if you have not acquired data.

TIP. Use the right mouse button in the data area to add a mark at a particular sample.

Related Topic
Moving Marks (see page 137)

Moving Marks

1. In the System window, click the appropriate data window icon.

2. Select the mark handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.

NOTE. You cannot move begin, end, or trigger marks. If you drag a mark past the boundary of the data
area using a handle in the Data Area Mark bar, the data area scrolls to keep the mark in view. If you drag
a mark off-screen using its handle in the Overview Mark bar, the data area scrolls keeping the mark in
view. The mark in the Data Area Mark bar indicates that the mark is off screen with an arrow, such as

(o= s . :
5 if you scroll the data window, causing the mark to move off screen.

Related Topics
Sending Stacked Marks to the Back (see page 137)

Adding a Mark to a Data Window (see page 137)

Sending Stacked Marks to the Back

1. Select a mark you know is on top of another one.

2. From the Edit menu, select Send To Back.
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Data Window Information Going to a Specific Mark

TIP. Click the right mouse button on the mark and select Send To Back.

Going to a Specific Mark

In the System window, click the appropriate data window icon.
From the Data menu, click Go To.
Click the Mark option button.

Select the mark you want to display.
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Click the Go To button. The mark appears in the center of the display.

NOTE. When moving between marks in a Source window, the new mark may cause another source file
to load in the Source window.

TIP. In the data window, click 0 to open the name of the dialog box.

Click the right mouse button on a mark and click Go To.

Related Topic
Adding a Mark to a Data Window (see page 137)

Expand Signals

Expand Signals replaces all busforms in the selection set with their component signal waveforms.

After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Collapse Signals (see page 139)
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Collapse Signals

Collapse Signals replaces all signal waveforms with their container busform waveforms. Exactly one
instance of each busform is added, no matter how many signals are actually present in the selection set.
After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Expand Signals (see page 138)

Removing Data from a Listing or Waveform Window

1. Go to the data window where you want to remove a column or a waveform.
2. Select the column or waveform labels that correspond with the data you want removed.

3. Press the Delete key on the keyboard.

NOTE. Some columns or waveforms in the display may not be visible. This is generally true if a
microprocessor support package is in use. To verify that invisible columns or waveforms exist, open the
Properties dialog box and select the Column or Waveform tab. Check whether the Show Column or
Waveform option is selected for each column or waveform.

Removing Waveforms from an Overlay Waveform

1. In the System window, click the Waveform window icon.
2. Click the label of a waveform you want to remove from the overlay waveform.

3. Drag the waveform label to the boundary of the overlay waveform. As you drag the waveform label,
a drop marker displays at the left edge of the waveform label. Use this drop marker to position the
waveform label outside of the overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.
2. Double-click the waveform overlay to display the Waveform properties tab.

3. Click the label of a waveform you want to remove from the Overlay Waveforms list, and then use the
<< button to remove it from the overlay waveform.
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NOTE. You cannot remove waveforms from an overlay waveform using the Waveform properties tab,
unless they were added using the Waveform properties tab in the current session. If you attempt to do so,
selecting a waveform label from the Overlay Waveforms list prompts the system to disable the << button.

Storage

Overview

Storage refers to storing acquired data in memory. You can select storage modes that filter the data, discard
unwanted samples, and store only the data you want.

Storage Qualification

The trigger function block includes storage qualification that looks at sampled data. If the storage
conditions are met, a storage qualifier signal enables sampled data to pass into the acquisition memory as
qualified data. Any unqualified data samples are excluded.

Storage Options

The Storage Options pane in the Setup window controls storage, using individual storage actions specified
in If/Then clauses and the Storage box in the Trigger window toolbar.

NOTE. On TLA7000 Series logic analyzer modules and TLA5000B Series mainframes, the first transition
state indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). One way to avoid triggering on a
false first transition indication is to set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.

NOTE. When global storage is set up to use transitional storage, to ensure that a false transition is not
recorded, the first state must be "If Anything Then Next State".

Storage Selection for an LA Module

Use the Storage box to select the default storage (see page 140) rules for the module. The default storage
setting can be overridden by a storage action in a trigger clause definition.

The Storage box is located in the toolbar of the LA Trigger window.
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Related Topics
Clause Definition Dialog Box (see page 163)

Data Sample Storage Selections (see page 150)

Storing DSO Data in Memory

The acquisition memory works like a circular buffer, storing data samples until the entire memory is full.
After that, each new data sample overwrites the oldest existing sample.

This process continues until the trigger event is found and the post-trigger delay counter reaches the
specified value (based upon the trigger position selection), which stops the acquisition.

During the acquisition you can monitor the progress of the data storage process using the Status Monitor.

Displaying DSO Data
After storing the data you can display the acquired data in the data windows.
In the Waveform window the data is shown as analog waveforms.

In the Listing window the data is shown as a series of voltage values.

Waveform Cursors

Overview

Cursors in a waveform data window are vertical lines that mark time points in the data record. The two
cursors are always present, although they may be off-screen. Each cursor has a handle in the Data Area
Mark bar and in the Overview Mark bar.

To Use

To select a cursor or other data mark, click its handle in the Data Area Mark Bar or Overview Mark Bar.
Selecting a mark changes its color. To edit a data mark, select the mark and then use the Edit menu. You
can select a cursor or user mark handle and drag the mark to a new location. You can drag a cursor past
the boundary of the data area using a handle in the Data Area Mark bar. The data area scrolls to keep the
cursor in view. If you drag a cursor off-screen using its handle in the Overview Mark bar, the data area
scrolls to keep the mark in view. The cursor in the Data Area Mark bar indicates that the cursor is off
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screen with an arrow, such as % if you scroll the data window, causing the cursor to move off screen.
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Behavior

When you open a Waveform window, cursor Cl1 is active. The name of the active cursor is displayed in
bold text in the cursor bar. The active cursor is also displayed as a dashed line. Selecting a cursor handle or
changing the cursor position using the cursor bar readout makes the cursor the active cursor. Changing
the delta time readout changes the position of the inactive cursor.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. When
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.

If you drag a cursor past the boundary of the data area using a handle in the Data Area Mark bar, the data
area scrolls to keep the cursor in view. If you drag a cursor past the boundary using its handle in the
Overview Mark bar, the data area scrolls to keep the cursor in view. The cursor in the Data Area Mark bar
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indicates that the cursor is off screen with an arrow, such as % if you scroll the data window, causing
the cursor to move off screen.

Time per Division

142

Use the Time/Division dialog box to select the horizontal time per division scaling for the current
Waveform window. The list contains standard time per division values in a 1, 2, 5 sequence. You can also
enter a non-standard time per division value in the Custom box. This can be any number between the
minimum and maximum values shown in the list. The default value is the current setting.

You can change the time per division from a Waveform window or from the Time/Division dialog box. To
access the Time/Division dialog box from the View menu, click Time/Div.

Related Topic
Changing the Time per Division (see page 120)
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Trigger Tab Page

Overview

The Trigger tab page allows you to quickly and easily set up a trigger program. You can drag and drop
trigger programs directly from the Trigger tab page to a data window.

Behavior

The Trigger tab page is only active when a data window is active. Each data window has a unique
Trigger tab page. After dragging a trigger program to a data window, a trigger expression is displayed
under Trigger Details. The Undo Trigger and Redo Trigger buttons apply only to the current trigger
and the previous trigger. The Undo Trigger and Redo Trigger buttons are not active until you use a
drag and drop trigger setup.

To Use

Click any Trigger program button and drag it to the waveform or listing window. You can edit the trigger
expression using the controls on the Trigger tab page. The controls change depending on the trigger
expression.

Click the Undo Trigger button to restore the previous trigger setup. Click the Redo Trigger button to
restore the current drag-and-drop trigger setup.

Related Topics
EasyTrigger Programs (see page 183)

Triggering from the Trigger Tab Page (see page 92)

Trigger Window

Overview

The primary function of the Trigger window is for constructing a trigger program. You also use the Trigger
window to select how and when to store data; and to set the trigger position, which indicates the percentage
of samples that are stored after the trigger occurs.

If you have a TLA7000 Series logic analyzer module or a TLAS000B Series logic analyzer, you can
additionally use the Trigger window to defer execution of the trigger state machine until the main memory
prefill amount is met. In addition, you can set both the MagniVu storage rate and the amount of pretrigger
MagniVu data to store.
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Behavior

Before you acquire and display data, set up the LA module using the LA Setup and Trigger windows.
These windows determine what data will be acquired. Each module has its own Setup and Trigger
window, which are set up individually.

Configure the Setup window before the Trigger window, because some of the Setup window settings
affect Trigger window selections.

Trigger programs range from the simple to extremely complex. They are the key to logic analyzer
operation. One method for setting up a trigger program is to load a trigger program from the EasyTrigger
Program list. The trigger list, which is available from the EasyTrigger tab, contains simplified trigger
programs that hide many of the program implementation details, allowing you to focus on acquiring and
displaying data. You can then either view or alter the trigger program details from the PowerTrigger tab, as
necessary. Once you become familiar with trigger programming, you can also create trigger programs
without the help of predefined triggers from the EasyTrigger program list.

Click the following selections for further information:

® LA Triggers

B Trigger Program Structure for an LA Module

Trigger Window Structure
The Trigger window contains two tabs that summarize the trigger program to varying degrees.

The EasyTrigger tab contains a trigger program list, program controls, and both a description and graphic
example of the selected trigger program. The trigger list is categorized by trigger program function. Once
you have selected the trigger program that best fits your data requirements, click the trigger program to
display the underlying program controls. The program controls are a simplified representation of the
selected trigger program that allows you to select events and set event, timer, and counter values.

The PowerTrigger tab contains both an Overview section and a Trigger Detail section. The Overview
shows the general structure of the trigger program. The Trigger Detail summarizes activity within
individual program states. You can click the If/Then button in the Trigger Detail to access the Clause
Definition dialog box, which is where the actual trigger programming takes place.

You can specify which trigger tab is displayed when you start the TLA application. From the System
menu, click Options, and then click the Defaults tab. Click the Trigger Window Style field and then select
the desired trigger tab from the list box.

Click the following selections for further information:

® PowerTrigger Overview

®m PowerTrigger Detail

B (Clause Definition Dialog Box

®  Storage Selection for an LA Module

B Trigger Position for an LA Module

B MageniVu Trigger Position
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® MagniVu Storage Rate
B Force Main Prefill

To Use
To open the LA Trigger window, go to the System window and click the LA module Trigger icon.

To load a trigger program, click the EasyTrigger tab and then select a trigger program. The system
responds by loading the selected trigger program, replacing the previous window contents with new
program controls, program overview text, and a sample trigger graphic.

Related Topics
Loading an LA with Saved Trigger Settings (see page 74)

LA Setup Window (see page 13)

Adding a State to a Trigger Program (see page 93)

Trigger Programming Tips for an LA Module (see page 151)

System Trigger and Reference System Trigger Relationship (see page 165)

LA Triggers

Overview

The trigger identifies when to stop acquiring data. The trigger also identifies the data of interest. The
trigger position determines how much data to store before and after the event of interest. Triggers also
provide the main reference points in the acquired data. There are two types of triggers: system and module.

System Trigger (Trigger All)

The system trigger is an overriding command to all modules that causes them to stop looking for a trigger,
and to acquire their post-trigger data, regardless of whether they have been armed or have fulfilled their
own trigger conditions.

The system trigger is the primary reference point for the entire data acquisition. In data windows,
timing and location information is relative to the system trigger. The system trigger is identified in the
data windows by the large T mark, i

Module Trigger (Trigger)

The module trigger is local to a module. When a trigger occurs, the module continues to acquire data until
the specified amount of post-trigger data is acquired, and then stops. Module triggers are identified in the
data windows by the small T mark, =¥
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Related Topic
System Trigger Placement (see page 148)

System Trigger

146

Overview

The system trigger is a global trigger event that forces all untriggered modules or instruments to arm
immediately and trigger. Only one system trigger occurs per acquisition. When displaying data, the logic
analyzer uses the system trigger as the primary reference point for the acquisition. The data windows show
the system trigger and all module or instrument triggers. Module or instrument triggers can be forced by
the system trigger or specified by trigger programs.

The system trigger can be generated from any of several sources. Often, the system trigger is specified in a
trigger program. Any module or instrument can specify the system trigger as a trigger action (Trigger All
Modules). However, modules or instruments can also specify trigger actions other than system triggers,
and the system trigger does not have to originate from a module or instrument. The logic analyzer

can also accept a system trigger generated by an external source. External system triggers are input
through the SYSTEM TRIG IN connector. Regardless of the source of the system trigger, all modules

or instruments must respond.

Use the System Trigger dialog box to specify triggering for the overall system.

System Trigger Source

The following options allow you to change the trigger programs of all modules from one location. A brief
functional description follows each System Trigger Source option.

B Modules trigger independently - Trigger All Modules and Wait for System Trigger actions in all
trigger programs are changed to Trigger actions.

m  Systems triggered by this module - The trigger program of the selected module uses the Trigger All
Modules action, while all other programs will wait for the system trigger. Use the associated list
box to select which module triggers the system.

m  System triggered by the first module that triggers - Trigger actions in all programs are changed to
Trigger All Modules. If the system has an external oscilloscope, it is set up to wait for the system trigger.

B Modules trigger using the current custom setup - Enabled by default when your trigger setups do not
match one of the previous system trigger options.

NOTE. When you apply a system trigger option, your choice will only affect those modules that currently
have a trigger action. Logic analyzer trigger actions include Trigger, Trigger All Modules, and Wait for

System Trigger. DSO and external oscilloscope modules are always affected because all of their actions

result in triggering the module.
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System Trigger In/Out Connectors

System Trigger In/Out Connector check boxes reflect the current state of the System Trigger In and System
Trigger Out connectors, and can be used to both enable and disable them.

If an external scope is enabled, the options chosen in System Trigger Source can affect the values and
sensitivity of the System Trigger In/Out check boxes.

Designated System Trigger

It is not uncommon to have a condition in which the acquisition completed, but an explicit system trigger
did not occur. (This means that there was neither an external system trigger, nor a system trigger generated
internally by a module trigger program.) To ensure that a time reference exists for the acquisition, the
logic analyzer must designate a system trigger. If no system trigger is generated during an acquisition
(the modules are internally triggered), the logic analyzer designates the latest-occurring module trigger

as the system trigger.

NOTE. If an acquisition does not complete because one or more modules did not receive a trigger or did
not complete the post-trigger acquisition, then you can manually stop the acquisition by clicking the Stop
button. Clicking the Stop button effectively generates a system trigger and completes the acquisition.

Internal and External System Triggers

The system trigger is a latched event and it resets to a false state between acquisitions. The external
system trigger input uses real-time gating and is only active (capable of latching system triggers) during
the actual acquisition period.

The logic analyzer can also send an internally-generated system trigger out to the target system or to other
test equipment through the SYSTEM TRIG OUT connector. All the external signal inputs and outputs
operate at TTL levels. The connectors are located at the rear of the portable mainframe and at the front
of the benchtop mainframe.

Related Topics
Setting the System Trigger Source (see page 148)

Signal Properties (see page 375)

External Signal Selection (see page 367)
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System Trigger Placement

Overview

There is only one system trigger. Because the system trigger is the primary reference point for an
acquisition, all acquisitions must have a system trigger identified, even if you did not specifically include
one in your trigger program.

Behavior

It is not always obvious how the logic analyzer places the system trigger. The logic analyzer determines
the system trigger by one of the following:

B A system trigger occurs when the Stop button is clicked.
m Data windows usually have at most one system trigger plus one module trigger per module.

B [fa module initiates the Trigger All Modules action, then the system trigger is also the module trigger
for that module.

B [f only module triggers are generated, then the latest occurring module trigger is designated the system
trigger.

Related Topic

System Trigger and Reference System Trigger Relationship (see page 165)

Setting the System Trigger Source

1. From the TLA System toolbar, click the Elbutton. The system responds by displaying the System
Trigger dialog box.

2. Select a trigger option from the System Trigger Source group box.

3. If you chose to trigger the system from one module in the previous step, use the associated list box to
specify which module is used to trigger the system.

4. Ifyou have an external oscilloscope, the System Trigger In/Out Connector check boxes are disabled and
automatically set by the system, based on the system trigger source option that you choose. Otherwise,
you can optionally disable these connectors if they are not in use.

NOTE. To save these settings as part of your system setup, perform a Save System (see page 78) operation.
This step enables you to reload your saved system settings in a later session.
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Related Topic
System Trigger (see page 146)

PowerTrigger Overview

‘ Overview
u The Overview portion of the PowerTrigger tab primarily
R Cpema shows how the trigger program flows from one state to
g the next. The arrow leading to State 1 is marked Run if
S the module is not armed by another module. The arrow
is marked Armed By <name of module> if this module is
armed by another module.
Behavior
State 2 Arrows indicate the transfer of trigger program control
between states. Markers indicate system-level actions that
could occur if a clause in that state goes true. Use the
Ctate 3 trigger overview to check that states are connected. With
the gxceptlon of .Sta.te 1 , all stgteg must have an arrow
leading to them (indicating activation by another state), or
they will not execute.

These actions are all defined in the Clause Definition dialog box(es) for each state.

TIP. Double-click the State icon in the Overview to open the top-most clause definition for that state.

PowerTrigger Detail

Overview

The PowerTrigger tab shows a summary of clause settings within the states. To open the Clause Definition
dialog box, click the If/Then button. The following dialog box displays:

State 2 |Trigger on the very first tranzition |

Channel 43[F] Goez High
Then| GaTa3
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To Use

You can enter comments in the text box. This feature is controlled by the View menu State Comments
selection.

The PowerTrigger tab is part of the LA Trigger window, which you can open by going to the System
window and clicking the LA Trigger window icon.

NOTE. There is a clause summary for each clause defined.

TIP. For lengthy trigger programs, click the State icon in the Overview to jump to the corresponding
PowerTrigger properties.

Related Topics

PowerTrigger Overview (see page 149)

Clause Definition Dialog Box (see page 163)

Data Sample Storage Selections
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Data sample storage is selected in the LA Trigger window by using the Storage box in the toolbar. The
following selections are available for PowerTrigger data sample storage.

®  All. Store all samples.

You can exclude a sample from being stored by selecting the Don’t Store action in the Then statement of
the trigger clause. The trigger sample is always stored.

B None. Do not store samples.

You can explicitly store a sample by selecting the Store Sample action in the Then statement of the
trigger clause.

The following selections generate a special storage clause:
B Transitional. Store samples only if one of the specified groups changes state.

To select the groups, click Change Detect in the Trigger Detail.

NOTE. On TLA7000 Series logic analyzer modules and TLA5000B Series mainframes, the first transition
state indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). One way to avoid triggering on a
false first transition indication is to set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.

B Conditional. Store samples only if the storage clause is true.
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Program this clause in the same way as a regular trigger clause.

®  Start/Stop. Storage is controlled by the Start Storing and Stop Storing trigger actions in the Then
statement of the trigger clause.

Use the Start Storage/Stop Storage button in the Trigger Detail to select whether storage is initially
enabled. For example, if the button is set to Stop Storage, then the initial state is that no samples are
stored; storage will begin when the trigger action Start Storing occurs.

Trigger Position for an LA Module

Overview

The Trigger Position selects the amount of pretrigger data to store and determines the position of the
trigger in the data record.

Behavior

Once triggered, a module continues to acquire data until it fills a specified amount of memory. The total
memory depth that the module fills is set in the Memory Depth field in the Setup window. The Trigger
Position field determines the proportion of data that is stored before and after the trigger. For example, if
the Trigger Position is set to 10% and the module triggers, then the module continues to acquire data until
the remaining 90% of memory is filled.

NOTE. Under some conditions, the module cannot meet the pre-trigger data storage requirements. For
example, if a trigger occurs immediately, the module cannot meet the pretrigger data storage requirement
unless it was set to 0%.

To Use

Set the Trigger position for a LA module in the toolbar of the LA Trigger window using the Trigger
Pos control.

Related Topics
LA Triggers (see page 145)

System Trigger Placement (see page 148)

Trigger Programming Tips for an LA Module

®  Use the EasyTrigger program list
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When you create a trigger, start with the trigger program that is closest to your requirements and modify it.
® Create your own trigger program folder

Create a folder and save modules that have your own most-used trigger programs. Use the Comment box
to help you identify the trigger program later. To access previously saved trigger programs, click the i
button from the trigger toolbar, which displays the Load Trigger dialog box. Then click the Browse
button and navigate to your trigger program folder.

2 Check the Overview

After you create a trigger program, review the Overview pane on the PowerTrigger tab to ensure that all
states in the program are linked and that state actions, such as program triggers and arming signals, are
correctly placed.

®  Start and stop timers

Remember to explicitly start and stop PowerTrigger timers. They do not start and stop automatically.
® Use the Status Monitor to debug trigger programs

The status monitor displays the activity within each state.

m Trigger state references

Do not delete PowerTrigger states to which you reference Go To State actions unless you change the
reference to another appropriate state or delete the Go To action.

H Use event text that is always true

A PowerTrigger clause with an Anything event or another event that is always true, such as Group xyz
= XXXX, prevents any subsequent clauses from being evaluated. Such clauses should be considered as
default clauses; place them after all other clauses for a given state.

® Use range recognizers

When using range recognizers, the individual probe channels must be in hardware order; otherwise the
trigger program can cause unexpected results. Range recognizers will only be allowed to encompass
signals on the first three modules of a merged set.

m Use of complex trigger events

If you are unsure that a complex trigger event will occur, you should first use a broadly defined trigger
condition and then subsequently add events to narrow the search. If your trigger program is too narrowly
defined or over specified, the trigger program may not acquire the desire data or may never trigger.

m  Use of counters when using asynchronous sampling at fastest sampling rate

For TLA7000 Series logic analyzer modules and TLA5S000B Series logic analyzers, when using
asynchronous sampling and running at the fastest rate, a 2 ns delay is required to allow the counter event to
propagate through the system before the trigger state machine can respond.

Related Topic
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Range Recognizers and Hardware Order

When using range recognizers, the groups and signals must be in hardware order.

Groups must be used from the most-significant probe group to the least-significant group based on the
following order:

C3C2C1COE3E2E1E0A3A2D3D2A1 A0D1DO0 Q3 Q2Q1Q0CK3 CK2 CK1 CKO

Signals must be from the most-significant channel to the least-significant channel based on the following
order:

76543210

The above example assumes a 136-channel LA module. The missing channels in LA modules with
fewer than 136 channels are ignored. With merged modules, range recognition extends across the first
three modules; the master module contains the most-significant groups, while slave2 contains the
least-significant groups.

Related Topic
Signed Decimal Values (see page 153)

Signed Decimal Values

Signed Decimal Values can create confusing interpretations, especially when the listing display uses
signed decimal values.

The following is an example of a problem that can be caused when using signed decimal values in the
listing display in an If/Then statement:

If Group A3 < -128
Then Trigger

A3 is an 8-bit group, so it should never trigger since -128 is the smallest signed value possible; however,
-128 is also 80 Hex, so many values will cause the logic analyzer to trigger, all of which will appear as
larger values when displayed in the listing with a signed decimal radix.

In this example there is no way to program the range recognizer hardware to behave correctly and not
trigger.
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Module Arming Using an LA

Overview
Using the arm feature, you can use one module to control when another module begins acquisition.

When module A arms module B, this means that module B does not begin looking for a trigger until it
receives an arm signal from module A.

Behavior

Arming is done through PowerTrigger actions specified in the Clause Definition dialog box. A module
can arm any other module, and you can set up an arming relationship between more than one set of
modules. But only one module can arm another. The same arming action can, however, appear multiple
times within the same trigger program.

Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and
set signals.

For TLA700 Series logic analyzer modules, the trigger state machine is disabled when arming a module
and does not store data until the module is armed. For TLA7000 Series logic analyzer modules and
TLAS000B Series logic analyzers, the trigger state machine is also disabled when arming a module but
this does not restrict data storage. The current setting of the Storage list box, located in the Trigger
window, determines whether data is stored.

Related Topics
Signals Properties (see page 375) (External signals)

Clause Definition Dialog Box (see page 163)

Internal Signaling
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Overview

Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling take care that
the signals are correctly set and cleared, and that the trigger programs for all modules are compatible with
regard to signal usage. Also, set the correct internal signal attributes in the Signals tab.

Behavior

All LA modules can set and clear any of the four internal system signals. The DSO can monitor and set
but not clear any signal. The logical output of these signals can be used as an event in other modules’
trigger programs. You can also connect the internal signals to the External Signal In and External Signal
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Out connectors on the mainframe, so that you can use an external signal as a trigger event or send a
signal out when a trigger condition is met.

Internal Signaling is done through PowerTrigger actions specified in the Clause Definition dialog box.

NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules
and set signals.

Related Topics
Signals Properties (see page 375)

Clause Definition Dialog Box (see page 163)

Trigger Action Signal Restrictions (see page 155)

Internal Signal Selection

Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both
internal and external signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and
2, but operate at the slower TTL rate.

Signals 1 and 2. 162 MHz maximum (internal), 62.5 MHz maximum (at External Signal Out
connector)

Signals 3 and 4. 12.5 MHz maximum

Trigger Action Signal Restrictions

There are some differences between modules in how they handle triggers, arming and internal signals.

LA modules, DSO modules, and external oscilloscopes have different numbers of signal inputs and
outputs. As a result, their signaling capabilities are different.

Conceptually, a module has three inputs and three outputs, as shown:

Inpuls Oultpuls

System Tngger System Tngger
Arm Module Arm
Signal Signal
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In reality, the LA module has three inputs and two outputs, designated as shown:

Input=s Quipuls
System Tngger System Tngger
LA
Arm Module
Signal Signal
Arm

The DSO module has two inputs and a single output, as shown:

Inpuls Quipuls

System Tngger

DSO _
Arm Modulke | System Troger

Signal
Arm

The External Oscilloscope has one input and either zero or one output, as shown:

Inpuls Outpuls
System Tngger System Trigger
External
Oscillo-
scope

This shows why Arming and Signaling are mutually exclusive on both the LA and DSO modules, and why
a DSO module does not allow you to set a system trigger and an internal signal at the same time.

Related Topics
Internal Signal Selection (see page 367)
Module Arming Using an LA Module (see page 154)
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Signals Properties (see page 375)

Change Detect Dialog Box

Use this dialog box to select the groups that will detect a change in state for Transitional storage. Once
a change is detected in any of the selected groups, storage begins.

To open this dialog box, perform the following:

1. In the System window, click the Trigger button for the module.

2. Click the PowerTrigger tab.

3. Select Transitional in the Storage box, which is located in the toolbar.

4. Click the Change Detect button.

TIP. To detect a change on a single channel, you can define a signal in the Setup window as a group.

On TLA7000 Series logic analyzer modules and TLAS5000B Series mainframes, the first transition state
indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). One way to avoid triggering on a
false first transition indication is to set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.

You cannot use transitional storage if your PowerTrigger program is set up with Group Changes or
Channel Goes events.

When global storage is set up to use transitional storage, to ensure that a false transition is not recorded, the
first state must be "If Anything Then Next State".

Select Signal Dialog Box

Use the Select Signal dialog box to select a specific logic analyzer channel. You can use the following
options, available from the Select group box, to specify how the system displays signals in the dialog box.

By Group - displays signal organized by groups. Only groups that are defined in the Setup window can be
displayed using this option.

By Probe - displays signals that are alphanumerically organized by individual channels. All signals are
displayed when this option is selected, regardless of whether they are defined in the Setup window.

By Name - displays signals by the name assigned to them from the Setup window. Enter names for each
signal for names to display when using this selection option.
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Related Topics
Selecting Channels for an LA trigger Channel Event (see page 95).

Routing a Signal from a Logic Analyzer Output (see page 66)

Transition Definition Dialog Box

Use this dialog box to define transition events used in the Clause Definition dialog box. Each transition
event displays values for valid groups defined in the Setup window. The value of each group is compared
against live data.

You can disable the group in each transition event by removing the check mark adjacent to the group name;
this causes the transition event to ignore the data for the group. You can also disable or enable all groups
by clicking either the Clear All or Select All button. This either removes or adds check marks adjacent

to each group name. You can additionally rename the current transition event by clicking the Rename
button and entering a new transition name in the Rename group box.

Change the group radix (see page 166) for each group by selecting the desired radix at the bottom of the
dialog box.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.

To Use

Each transition event is identified by a unique name.

To open the Transition Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button or the clause you are interested in defining.
4

. Click Transition from the drop-down list available from the If section of the Clause Definition dialog
box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

Related Topics
Add Transition Dialog Box (see page 159)
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Defining Multiple Transition Recognizers (see page 94)

Add Transition Dialog Box

The Add Transition dialog box supplies words that are defined in the Transition Definition dialog box, and
are available for defining PowerTrigger Clause Definition If statements.

To Use

Use this dialog box to add a new transition event. Click Use Existing Transition as Template to copy the
settings from an existing word event.

To display the Add Transition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.
4

. Click Transition from the drop-down list available from the If section of the Clause Definition dialog
box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

6. Click the Add button to add a new transition event.

Related Topics
Defining Multiple Transition Recognizers (see page 94)

Transition Definition Dialog Box (see page 158)

Word Definition Dialog Box

Use this dialog box to define word events used in the Clause Definition dialog box. Each word event
displays values for valid groups defined in the Setup window.

The value of each group is compared against live data. You can disable the group in each word event by
removing the check mark adjacent to the group name; this causes the word event to ignore the data for the
group. You can also disable or enable all groups by clicking either the Clear All or Select All button. This
either removes or adds check marks adjacent to each group name.

You can change the group radix (see page 166) for each group by selecting the desired radix at the bottom
of the dialog box.

Each word event is identified by a unique name.
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To Use

To open the Word Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

Click Word from the drop-down list available from the If section of the Clause Definition dialog box.

o wd

Click the Define Word button in the If section of the Clause Definition dialog box to display the Word
Definition dialog box.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.

The Word Definition dialog box is also available from the EasyTrigger tab, depending on the program that
you select.

Add Word Dialog Box
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Overview

Use this dialog box to add a new word event. Click Use Existing Word as Template to copy the settings
from an existing word event.

Behavior

The Add Word dialog box supplies words that are defined in the Word Definition dialog box, and are
available for defining PowerTrigger Clause Definition If statements.

To Use

To open the Add Word dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.
4

. Click Word from the drop-down list available from the If section of the Clause Definition dialog box.
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5. Click the Define Word button in the If section of the Clause Definition dialog box to display the Word
Definition dialog box.

6. Click the Add button to add a new word event.

NOTE. The Add Word dialog box is also available from the EasyTrigger tab, depending on the program
that you select.

Detecting Violations

One of the logic analyzer’s most useful features is its ability to detect and trigger on both signal glitches
and setup and hold violations.

Glitches

A glitch is a signal that makes a transition through the threshold voltage two or more times between
successive acquisition samples. Because glitches are often signal transitions that occur intermittently, they
can cause circuit malfunctions that are extremely difficult to diagnose.

Although you could try using a very fast sample rate to ensure that you never miss any glitches, a better
solution is to use the glitch-detection feature. The logic analyzer can trigger on a glitch, either alone or in
combination with other signal events. This capability is useful for catching intermittent glitches that might
not occur very often or appear only when a particular operation is taking place.

You can capture noise spikes and pulse ringing using the glitch capture feature. The following figure
shows data captured by triggering on a glitch. In the Waveform window, a glitch captured by the logic
analyzer is indicated by a band of color.

Glitch mode affects the storage of glitches in memory, which allows you to display the glitches in the data
window. Selecting Glitch mode reduces the available memory depth by half.

Glitch storage is independent of glitch events. Therefore, you can trigger on a glitch even when you
are not storing glitches.

Clock[0] Ci: 0 CZ0 Delta: O

LA 1: Sample

L& 1: Clock[0)

LA 7 Input]d]

LA 7: Output]d]

AT Maagniviu: Sample

LA 1: Magnidu: C
LA 1: Magnidu D
LA 1: Magniviu: [
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Setup and Hold Violations

A setup and hold violation is a data signal that transitions within the setup and hold time period. You could
identify setup and hold violations by looking at each clock edge and reviewing all relevant data signals.
However, it is faster and reliable to use Setup/Hold triggering to identify violations.

First select the correct sampling mode to use either the glitch detection or the setup and hold violation
features. Choose asynchronous sampling to use glitch detection; choose synchronous sampling or custom
sampling to use setup and hold detection.

63-Sample Blocks Mode Details
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Overview

The 63-Sample Blocks mode provides the ability to acquire data before and after desired points and to
limit acquired data to a minimum, enabling you to analyze a very long time window. Circumstances under
which Blocks mode is useful include the following:

® Troubleshooting interrupt or subroutine calls and returns
® Troubleshooting DMA data transfers

B Troubleshooting certain types of hardware timing problems when using asynchronous sampling

Behavior

From the Setup menu, the Acquire mode can be set to Samples, Samples + Glitches, Samples + Violations,
or 63-Sample Blocks. In Samples mode, only the samples selected by the trigger actions and qualifications
are sorted. In 63-Sample Blocks mode, you store 31 samples before and after the target sample, or a block
of 63 samples centered on the point where the sample is normally stored.

The ability to use blocks acquisition with either state (synchronous sampling) or timing (asynchronous
sampling) allows you to use this feature for both software and hardware timing analysis.

In 63-Sample Blocks mode only signal data is stored.

If you store blocks, they will override other forms of data qualification.

All samples in the block are always stored if post-fill has not matched any of its limits.

B You cannot change block size; it is fixed in the hardware.

63-Sample Blocks Mode Example

The following example troubleshoots the stack operation on a microprocessor system during the start of an
interrupt routine that is repeatedly called, such as a video vertical retrace interrupt. In this example, the
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group name used for data is DATA. The signal names used for an interrupt and an instruction fetch strobe
are INTR and IFETCH, respectively.

This example checks the stack push operation by storing the start and end of every interrupt routine until
the analyzer memory is filled. You first set the storage control to None (do not save anything unless
explicitly stored in trigger states) and specify the trigger state machine as follows:

STATE 1: IF channel INTR goes low, THEN goto state 2.
STATE 2: IF group DATA = A333 AND channel IFETCH = 1, THEN store sample AND goto state 3.
STATE 3: IF group DATA = 0551 AND channel IFETCH = 1, THEN store sample AND goto state 1.

This trigger setup stores one sample at the instruction (A333) starting the interrupt service routine, and one
sample at the instruction (0551) ending the routine.

Since no trigger was set up in the example, set the trigger position to 100% and enable the status screen.
This will cause the memory to fill while waiting for a (never occurring) trigger. Then, after the memory is
full (state screen shows 0 remaining), you press the RUN/STOP button to force a manual trigger at the end
of memory. If MagniVu is displayed, the 1 us display is centered at the end of the regular data display.

In the Samples acquisition mode, only these instructions (A333 and 0551) are stored until memory is filled.
Unfortunately, this prevents you from seeing what happened in the stack push and pop at the start and end
of the routine. In the 63-Sample Blocks mode, because 31 samples before and 31 samples after each target
sample is stored, you can see the stack push and first few instructions at the start of the interrupt service
routine and the last few instructions and stack pop at the end of the routine.

Define Glitch Detection

Use this to select which groups should have glitch detection in the clause definition associated with a trigger
program. Once a glitch is detected in any of the selected groups, the glitch event condition has occurred.

Use synchronous sampling for the Glitch condition to appear in the If condition list. Otherwise, the
Samples + Violation option must be used.

For information on how to open the Glitch Detect dialog box, see Triggering a LA Module on a Glitch

(see page 96).

TIP. To detect a glitch on a single channel, define a signal in the Setup window as a group.

Clause Definition Dialog Box

Overview

Use this dialog box to define the If/Then clause (or Else If/Then) of your PowerTrigger program. The
clause definition contains the most vital part of the trigger state. (The trigger state is shown in the
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Overview pane of the LA PowerTrigger tab). It is in this dialog box that you define the condition for an
event to occur before an action can take place. You can have up to 16 clauses per state, depending on the
number and types of events monitored within a state.

The dialog box is divided into two parts, If and Then.

If

Use the first part to select the events you are interested in and the condition those events must meet
before any actions can take place.

For example, you may be interested in an address group reaching a certain value. The group is the event
and the value is the condition. After the condition occurs, the program executes the actions specified in
the Then part of the dialog box. For information on trigger events refer to LA trigger Event Table (see

page 167).

Then

Use the Then part of the clause to define the action that occurs after the If part is true. For example, after
the If condition is met, the action you might want is to trigger the module or trigger all modules. Some
actions interact with others and some actions can only be used under certain conditions. For information
on actions refer to LA Trigger Action Table (see page 168). Up to eight simultaneous actions can be
specified for a clause.

To open Clause Definition dialog box from the System window, click the LA Trigger button. Then click
the If/Then button or the Else If/Then button, located on the LA PowerTrigger tab.

Keep the following in mind when using this dialog box:

®m  Samples + Violations appear with synchronous or custom sampling. Samples + Glitches only appear
with asynchronous sampling.

B Events can be ANDed or ORed with each other. To add another event, click Add while an event is
selected. Click the first And button to change to the Or expression. You can have up to eight events.

B You can use an Anything or Nothing event as a placeholder. Anything is used when the events are
combined with And. Change the And to Or and the event changes to Nothing.

®  When using events you should be aware of the number of event resources available for a trigger
program. For more information, refer to LA Trigger Resources (see page 169).

Related Topics
Storage Definition Dialog Box (see page 92)

Signed Decimal Values (see page 153)
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Define Snapshot Dialog Box

Overview

TLA7000 Series logic analyzer modules and TLAS000B Series logic analyzers support the use of

a snapshot to capture a given data sample and compare it with data that the trigger state machine
subsequently processes. Based on criteria that you specify, the result of the snapshot comparison can cause
a predefined event to occur. You set up the snapshot using the Define Snapshot dialog box, which allows
groups to be included or excluded from the snapshot definition. By default, all groups are included.

Behavior

You can exclude a given group by removing the check mark adjacent to the group name. In addition,
you can exclude all groups by clicking the Clear All button, which removes check marks adjacent to
all group names.

Four types of events operate on the snapshot. At any given time, only one of these events is true:

B Snapshot equals the current sample - A snapshot has been previously loaded and it matches the current
data sample from the target system.

B Snapshot does not equal the current sample - A snapshot has been previously loaded and it does not
match the current data sample from the target system.

B Snapshot is not loaded - A snapshot has not been loaded or is still in the process of being loaded.

B Snapshot is loaded - A snapshot has been loaded and is ready to compare acquisition data.

NOTE. Use of a snapshot event requires both an additional dedicated word recognizer and a timer. If
either resource is unavailable, a warning message displays and the event type reverts to its previous value.

Related Topics
Triggering an LA Module on a Snapshot Event (see page 99)

Trigger Program Structure for an LA Module (see page 181)

System Trigger and Reference System Trigger Relationship

Overview

The system trigger is the primary reference point for the entire data acquisition. In data windows, timing
and location information is relative to the system trigger. There is only one system trigger per acquisition.
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Behavior

If you add reference data to your data window, you can also add the system trigger for this reference data.
In this case you have two system triggers in the display: The active system trigger and the reference system
trigger. You can tell the two apart by the marks that identify them.

The active system trigger is identified by a large yellow T mark: ¥ The reference system trigger is
shown as a gray T mark [r.

You may not be able to see the reference system trigger in some data windows. For example, you create
a reference system (Save System) that contains two LA modules, A and B. The time domain of both
modules’ acquired data do not overlap, and the system trigger is within module B’s time domain.

A data window created from module A will not contain a reference system trigger. If you open the Go

To dialog box, a reference system trigger will not be listed. However, because timing and location
information are relative to the system trigger, the Timestamp column of module A will be referenced to the
system trigger in module B.

Group Radix
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Use the group radix to display data in the LA Trigger window and in the Clause Definition dialog box in an
easy-to-read format. The following table lists common radixes used to view data.

Radix Valid characters
Binary 0,1,X

Octal 0-7, 8, X
Decimal 09, %

Signed decimal 09,-%
Hexadecimal 0-9, A-F, $, X
Symbolic Symbol name
Behavior

A Symbol name refers to a set of characters defined in a symbol file.

The X and $ characters normally appear in the Trigger window. An X represents any character, often
known as a "don’t care" character.

The X can represent a binary, octal, or hexadecimal value depending on the radix selection. The $ character
appears when you select a radix where the binary combination contains one or more X characters. The
following example shows how a binary combination with an X character displays in different radixes.

Radix Display Value when X=0 Value when X=1
Binary 10101X11 10101011 10101111

Octal 25% 253 257
Hexadecimal A$ AB AF
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Radix Value when X=0 Value when X=1
Decimal 171 175
Signed decimal -85 -81

Tip

To identify the contents of a $ character in the Trigger window, change the group radix to binary.

LA Trigger Event Table

The following LA trigger events are available in the If section of the PowerTrigger Clause Definition

dialog box.

Event Description Interactions

Word Tests the groups for the word values Uses one trigger resource across all
defined in the Word Definition Dialog defined groups.

Box (see page 159).

Group Tests a specified group for a specific Only one change detection event
value, a range of values, or a value (group or signal) is available in a
change. trigger program. Range recognizers

use three trigger resources per
group event. Word recognizers or
change detectors use only one trigger
resource.

Channel Tests the specified signal for a value Only one change detection event
or a value change. (group or signal) is available in a

trigger program. Each event uses one
trigger resource.

Snapshot Available only on TLA7000 Series Only one snapshot recognizer event
logic analyzer modules and TLA5000B is available in a trigger program. Uses
Series logic analyzers; compares two event lines and one timer.
the current acquisition sample with
a previously loaded sample in the
snapshot recognizer.

Transition Tests the specified group for the Cannot use the following within the
transition values defined in the same trigger clause: Group Changes,
Transition Definition Dialog Box (see Unchanged Group, Signal Goes,
page 158). Signal Doesn 't Go, and Transitional

Storage capabilities.

Glitch Detects glitches in groups. You must Only available with asynchronous
define the groups in which to detect sampling. Uses one trigger resource.
the glitch (see page 163).

S & H fault Tests setup and hold parameters as Only available as an event with

defined in the Setup & Hold violation
dialog box.

synchronous or custom sampling.
Uses one trigger resource.
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Event

Description

LA Trigger Action Table

Interactions

Counter and timer events

Tests the specified counter or timer
value.

Counter 1 and 2 events conflict with
Timer 1 and 2 events respectively.
They also conflict with their respective
counter and timer actions.

Signal Looks for one of the four system Only one signal event is available in
signals. a trigger program. Uses one trigger
resource.
Anything All sampled data makes this event Available with the AND conjunction.
true.
Nothing All sampled data makes this event Used as a placeholder with the OR

false.

conjunction.

NOTE. These event selections are also available from the EasyTrigger tab, depending on the EasyTrigger

program that you select.

Related Topics

Signals Properties (see page 375)

Clause Definition Dialog Box (see page 163)

LA Trigger Resources (see page 169)

LA Trigger Action Table

The following LA trigger actions are available in the Then section of the PowerTrigger Clause Definition

dialog box.
Action Description Interactions
Trigger Triggers the current module and When Trigger is used in the trigger

causes both MagniVu and main
memory postfill to begin.

program, Trigger All Modules cannot
be used.

Trigger All Modules

Also known as a System trigger. This
signal is also available at the System
Trigger Out connector.

When Trigger All Modules is used in
the trigger program. Trigger cannot be
used.

Wait for System Trigger Used for a module that does not Capable of receiving the following
trigger itself or any other module, three (mutually exclusive) trigger
but waits to be triggered by another actions: Trigger, Trigger all Modules,
module. or Wait for System Trigger.

Trigger Main Triggers the module, and causes main At most, one type of main triggering

memory postfill to begin.

can be used in the trigger program
(Trigger, Trigger Main, or Trigger
System)
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Action

Description

LA Trigger Resources

Interactions

Trigger MagniVu

Causes MagniVu memory postfill to
begin.

Trigger MagniVu can be used in
combination with one of the main
memory trigger actions (Trigger,
Trigger Main, Trigger System, or Wait
for System Trigger)

Snapshot Current Sample

Reloads the snapshot recognizer.

Snapshot is not available for event
recognition while the snapshot is
loading its sample.

Go To

Causes a change to a different trigger
state.

Use only one in clause definition.

Counter and Timer actions

Starts, stops, resets, clears,
increments, or decrements counters
or timers.

Counter 1 and 2 actions conflict with
Timer 1 and 2 actions respectively.
The actions also conflict with their
respective events.

Set and Clear Signal

Sets or clears one of the four system
signals.

Use only one in a trigger program.
Mutually exclusive with Arm Module
action.

Arm Module

Sends an Arm signal to another
module. The other module begins
running its trigger program.

Can only arm one module in a trigger
program, but actions can be taken
throughout the trigger program.
Mutually exclusive with Set and Clear
Signal actions.

Store Sample

Stores exactly one sample.

Not available in Start/Stop storage
mode.

Start and Stop Storing Begins or ends storing of samples. Available only in Start/Stop storage
Used in conjunction with Start/Stop mode.
storage mode in the Trigger window.

Do Nothing Used as a placeholder when defining Does not override other actions
a complicated trigger program. specified in a clause.

Don't Store Does not store this sample. Not available in Start/Stop storage

mode.
Related Topic

Signals Properties (see page 375)

Clause Definition Dialog Box (see page 163)

LA Trigger Resources

Overview

A trigger resource is a hardware constraint. Use trigger resources as tools to build a trigger program. A
trigger program can use up to 16 trigger resources.
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Behavior

A trigger resource can be used more than once in a trigger program. However some events use more than
one trigger resource. The following table lists the trigger events, the event operator, the number of trigger
resources, and resource restrictions for each trigger event.
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Event Operator Trigger resources and restrictions
Word =, Is Not 1 trigger resource
Group (word recognizer) =, Is Not 1 trigger resource

(range recognizer)

<, <=,>= > IsIn, Is Not In

3 trigger resources

(change detector)

Changes, Unchanged

1 trigger resource, one change
detector allowed in a trigger program,
not available when transitional storage
is used

Channel (word recognizer)

1 trigger resource

(change detector)

Changes, Unchanged

1 trigger resource, one change
detector allowed in a trigger program,
not available when transitional storage
is used

Snapshot

=, Is Not, Is Loaded, Is Not Loaded

2 trigger events and 1 timer event

Transition

Occurs, Doesn’t occur

1 trigger resource for each of the 16
available transition recognizers used.

Glitch

1 trigger resource, only available with
asynchronous sampling

S & H fault

1 trigger resource, not available with
asynchronous sampling

Counter

> <=

0 trigger resources, 2 counters or 2
timers

Maximum width 51 bits Maximum
sampling 250 MHz (TLA700
Series) 500 MHz (TLA7000 Sereis
and TLA5000B) Maximum count
2,251,799,813,685,246

Timer

> <=

0 trigger resources, 2 counters or 2
timers

Maximum width 51 bits Maximum
sampling 500 MHz (TLA7000 Series
and TLA5200B) Maximum time
2,000,000 s or 23 days Resolution
2 ns for TLA7000 Series and
TLA5000B

Signal (Signal In)

Is True, Is False

1 trigger resource, uses one of four
system signals

Anything/Nothing

EasyTrigger programs are designed to take into account resource limitations so that, in most cases, you do

not have to be concerned with resources.

0 trigger resources
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For TLA7000 Series logic analyzer modules and TLA5S000B Series logic analyzers, when using
asynchronous sampling and running at the fastest sampling rate, a 2 ns delay is required to allow the
counter event to propagate through the system before the trigger state machine can respond.

Related Topics
LA trigger Event Table (see page 167)

LA Trigger Action Table (see page 168)

Clause Definition Dialog Box (see page 163)

Trigger Action Signal Restrictions (see page 155)

Internal Signaling (see page 154)

Force Main Prefill

Overview

By default, the Force Main Prefill check box is selected, which defers execution of the trigger state
machine until the main memory prefill amount is met. Use the Memory Depth field, located in the LA
Setup window, to set the total memory depth that the module fills. Use the Trigger Pos slider or box,
located in the LA Trigger window, to set the main prefill amount that must be met before the trigger state
machine is activated.

Behavior

When you use Force Main Prefill functionality, you specify which data samples are stored by selecting the
desired sample type from the Storage drop-down list. Note that if you select either the None or Stop/Start
storage settings, the Force Main Prefill check box and related functionality become unavailable.

System triggers produced by other modules override force prefill functionality and immediately start
execution of the trigger state machine. An externally generated system trigger does not purge the force
prefill data samples stored in main memory. However, the TLA7000 Sereis logic analyzer modules or the
TLAS5000B Series logic analyzer stops acquiring further prefill data samples and begins acquiring postfill
data samples until main memory allocated for postfill data samples is filled.

NOTE. 7o change the default setting for Force Main Prefill, from the System menu select Options, and then
click the Defaults tab.

Related Topics
LA Triggers (see page 145)

LA Trigger Action Table (see page 168)

171



LA Trigger Information MagniVu

MagniVu

MagniVu functionality is designed to acquire data at a high sample rate so that you can see the timing

of signals in much greater detail. This is useful when you are debugging hardware and needing higher
resolution data samples for viewing events that change very quickly. Although the TLA7000 Series logic
analyzer modules and the TLAS5000B Series logic analyzer hardware supports storage at slower rates, data
sampling is always performed at the maximum PowerFlex MagniVu sample rate. MagniVu memory depth
is set to a fixed 16K.

Related Topic
LA Trigger Action Table (see page 168)

MagniVu Storage Rate
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Overview

This is the rate at which MagniVu data is stored in memory. By slowing the MagniVu storage rate, you
can stretch MagniVu memory over a greater span of time, providing a lower resolution data sample from
a greater time period.

Behavior

The MagniVu storage rate cannot be set slower than the effective main memory rate, according to 1X, 2X
or 4X modes. The available rates are:

B 8 GHz <> 125 ps
B 4 GHz <-> 250 ps
B 2 GHz <-> 500 ps
B 1 GHz<>1ns

The MagniVu storage rates are limited by the fastest storage rate of the main memory under 1X, 2X, and
4X modes. The slowest MagniVu Storage rate is half of the fastest storage rate of the main memory.

1X MagniVu storage selections 2X MagniVu storage selections 4X MagniVu storage selections

125 ps, 250 ps, 500 ps, 1 ns 125 ps, 250 ps, 500 ps 125 ps, 250 ps

NOTE. MagniVu storage rate adjustments do not affect setup and hold violation or glitch violation.
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MagniVu Trigger Position

Overview

The MagniVu trigger position, available with TLA7000 Series logic analyzer modules and TLA5000B
Series logic analyzers, selects the amount of pretrigger MagniVu data to store and determines the position
of the trigger in the data record. You can control the MagniVu trigger position independently of main
trigger position by a set of controls in the advanced toolbar.

Behavior

Once triggered, a module continues to acquire MagniVu data until it fills a specified amount of memory.
MagniVu memory depth is set to a fixed 16K. The Trigger Position field determines the proportion of data
that is stored before and after the trigger. For example, if the Trigger Position is set to 15% and the module
triggers, then the module continues to acquire data until the remaining 85% of memory is filled.

The MagniVu trigger position controls operate the same as the controls for main memory trigger position.
They consist of a slider control, an edit box, and a spin control positioned beneath the main memory trigger
controls. They behave like the main memory counterparts, except that the MagniVu trigger position is
constrained by the MagniVu storage rate as follows.

Storage rate Resulting trigger position constraint
125 ps 0% to 58%, in 1% increments
250 ps 0% to 79%, in 1% increments
500 ps 0% to 89%, in 1% increments
1ns 0% to 94%, in 1% increments

NOTE. MagniVu data acquisition starts prior to the run line and fills memory before any possible trigger
event. Therefore, there is no MagniVu forced prefill control.

Related Topics
MagniVu (see page 172)

LA Triggers (see page 145)

LA Trigger Action Table (see page 168)

Multiple Samples per Clock Trigger Programs

Some trigger programs that rely on multiple samples per clock require special attention to work properly.
In some situations, it may be necessary for a data value to be present on the probe input for two or more
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clock cycles for a word recognizer to detect it. In other situations, it may be necessary to use word
recognizers logically ORed together across the base and prime signals to detect a value.

When using multiple samples per clock, trigger programs only operate on the acquired data at normal
speed. In other words, when using multiple samples per clock, the current trigger machine state is
evaluated at the physical sample rate and not the logical sample rate.

To illustrate this point, consider the following two examples. In both examples, a minimum sample period
of 2 ns is assumed with asynchronous sampling.

Example 1 shows a situation where there are two samples per clock.

A3 Channels D3 Channels Timestamp
01 02 Ons
03 04 2ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored as the prime signal (D3"1), the instrument would not
have triggered, even though the value occurred on the A3 lines and was captured in the acquisition memory.

To reliably trigger on an event that only lasts for 1 ns, use two word recognizers: one to watch the base
signal, and the other to watch the prime signal. The following trigger will always catch the 02 pattern
using Two Samples per Clock mode: If Group A3 equals 02 or Group D3 equals 02, then Trigger.

If the desired event for triggering is present for at least 2 ns, then it follows that the base signals will always
capture the event. In this case, the trigger will work correctly in the Two Samples per Clock mode.

Example 2 shows a situation where there are four samples per clock.

A3 Channels A2 Channels D3 Channels D2 Channels Timestamp
01 02 03 04 Ons
05 06 07 08 2ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored as one of the prime signals, the instrument would not
have triggered, even though value occurred on the A3 lines and was captured in the acquisition memory.

To reliably trigger on an event that only lasts for 500 ps, use four word recognizers: one to watch the base
signal, and the others to watch the prime signal. The following trigger will always catch the 01 pattern
using Four Samples per Clock: If Group A3 equals 01 or Group A2 equals 01 or Group D3 equals 01
or Group D2 equals 01, then Trigger.

If the desired event for triggering is present for at least 2 ns, then it follows that the base signals will always
capture the event. In this case, the trigger will work correctly using Four Samples per Clock.

NOTE. You can use the Trigger on group match or the Trigger on signal match EasyTrigger Programs
(see page 183) located under Match Events on multiple samples per clock. You can set up this type of
triggering on a data value that you specify.
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Entering a Symbol Plus an Offset in a Trigger

In a group value field that has a symbolic radix you can directly type in a symbol with an offset. For
example you can type into that field:

MyFunction+55

The application software will parse the symbol and the number and redisplay the result. The software
takes the offset as a HEX number. As in other places where you type in numbers, you can force the
radix to be something else. For example:

MyFunction+\d10 ’decimal 10
MyFunction+\b1111 ’binary 1111
MyFunction+\033 ’octal 33

MyFunction+\haa *hexadecimal AA

Triggering Problems

When trigger program is not being satisfied, check the following:
m The trigger program is correct.
B Storage qualification is correct.

B The system under test or module does not have an exception or fault. The system or acquisition
module might have experienced a hardware or software exception or fault after the trigger condition
was satisfied.

B A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your clock connections.

If the previous suggestions do not fix the problem, try the following:
m Reload the support package to restore the logic analyzer to a default state.

m  Possible loading problems might be remedied by removing one or more of the protective sockets from
the probe adapter. These sockets might add enough additional capacitance or delay to your system
under test to affect it.

175



LA Trigger Information Triggering Problems

176



Serial Analyzer Trigger Window Serial Analyzer Trigger Window

Serial Analyzer Trigger Window

The serial analyzer Trigger window is similar to a Power Trigger window on a logic analyzer module. You
use it to construct a trigger program. The trigger program is made up of one or more trigger states. Each
state has one or more clauses. Each trigger state contains an area where you can enter a brief description of
the state. You can have up to eight trigger states in the trigger window.

Each clause has a trigger event section that specifies a trigger event that you are looking for. The second
part of the clause contains a trigger action section describing the appropriate action to take when the event
information has been satisfied. You can have up to eight trigger clauses per trigger state.

Some suggestions for using the Trigger window follow:
® Click \* to collapse the current trigger state to provide more room on the screen.
® Click .¥ to expand the current trigger state.

m Look for the \¥ or .*. to expand or collapse information in the current clause. They are indicators that
there may be more or less information to display on screen.

TIP. Configure the Setup window before the Trigger window, because the Setup window settings may
affect Trigger window selections.

Trigger Tool Bar

The trigger tool bar in the serial analyzer Trigger window has controls for common tasks. Icons at the left
side of the tool bar provide an easy means to do the following tasks:

= Click PF to set the default Trigger window.
= Click %7 to load a previously saved Trigger window.

= Click ¥ to save a Trigger window.

Use the On Run control to specify the storage control options. Select Start Storing to begin storing data
when you click the Run button. Select Don’t Store to not store data until the conditions have been met
in the trigger program.

Use the Store control to specify the amount of data to acquire. The data volume is expressed in terms
of symbols with a maximum of 32 M symbols. Use the Trig Pos control to specify where the trigger
will appear in memory (1% accuracy within the data record). Both of these controls perform the same
functions as in the serial analyzer Setup window.

177



Serial Analyzer Trigger Window Creating a Serial Analyzer Trigger Program

Creating a Serial Analyzer Trigger Program

Use the following guidelines to create a serial analyzer trigger program:

1.
2.
3.

Open the serial analyzer Trigger window.
In State 1, enter a meaningful description in the Description field.
In Clause 1, click Add Event, and select a trigger event from the drop-down list.

Depending on the event, additional controls will appear. Select the information that you want from the
drop-down lists. For some packets (such as TLPs, DLLPs, Sequences, or Link Events) you can click

to open a dialog box where you can further define the packet.

If necessary, click Add Event to add additional events to the current clause. You can logical OR or
AND the events.

In the action area of the clause, select an action from the drop-down list and then fill out the necessary
information to complete the trigger action.

If necessary, you can add additional clauses and states to complete your trigger program.

TIP. You can also add states, clauses, events, and actions by right-clicking the mouse.

Serial Analyzer Trigger Events
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The following table lists the serial analyzer trigger events.

Event Description
Anything Recognizes any data.
TLP Recognizes the presence or absence of a specific TLP. You can choose the TLP

from a list, or define a TLP.

DLLP Recognizes the presence or absence of a specific DLLP. You can choose the

DLLP from a list, or define a DLLP.

Sequence Recognizes a specific ordered set or symbol sequence. You can choose the

Sequence from a list, or define a Sequence.

Link Event Recognizes link events and link error signals. You can choose the Link Event

from a list, or define a Link Event and specify which lanes to monitor.

Timer Recognizes a specified timer value. You can have a maximum of four global

counters or timers.

Counter Recognizes a specified counter value. You can have a maximum of four global

counters or timers.

Signal In Recognizes a signal from another module.
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Defining Packets in Trigger Windows

The serial analyzer lets you define packets for triggering on PCI Express data. Click B in the Event
section of the trigger program to open a dialog box where you can define the event.

1. Enter a meaningful name for the packet or select one from the drop-down list.
If you select a packet from the list, a copy is automatically created.
2. Fill in the information as needed to define the packet.

3. To change the radix of a particular field, right-click the mouse in the field and then select a radix
from the right-click menu.

4. Click close to save the changes.

NOTE. The X and $ characters appear whenever you define a TLP, DLLP, or a symbol sequence Event.
An X represents any character, often known as a "don 't care" character. The X can represent a binary,
octal, or hexadecimal digit depending on the radix selection. The $ character appears when you select a
radix where the binary combination contains one or more X characters. 1o identify the contents of a $
character change the radix to binary.
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Trigger Program Structure for an LA Module

A trigger program is made up of one or more states (up to 16). Only one state is active at a time.

Each state is made up of one or more clauses. If there are more than four trigger event resources used in
a state, you can have up to four clauses per state. If there are four or fewer trigger event resources in a
state, you can define up to 16 clauses per state. However, if you use a snapshot recognizer as an event in
your clause definition, your use of clauses per state is restricted as follows (note that neither counters nor
timers are included as trigger resources).

B If you use a snapshot recognizer and more than two additional events, you can have up to two clauses
(and one counter or timer) per state.

m If you use a snapshot recognizer and no more than one additional event, you can have up to eight
clauses (and one counter or timer) per state.

During each clock cycle, all clauses within the active state simultaneously evaluate the acquired data. The
priority of evaluation of a clause is assigned from top to bottom. The If statement of a clause can contain a
single event, or it can contain multiple event conditions. When the correct event conditions occur, the logic
analyzer passes control to the actions specified in the Then statement. There are several actions to choose
from, including triggering the system, or transferring control of the trigger program to another state.

If multiple clauses are true in the same clock cycle, only the clause with the highest priority that goes true
will have its actions executed.

NOTE. Avoid using the If Anything event in the top-most clause of a state with multiple clauses. Successive
If-Then clauses will never become active. If you decide to use the If Anything event, it should be in the
last clause of a state.

PowerTrigger Tab

The Overview portion of the LA PowerTrigger tab shows the relationship between states.
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l] M Arrows indicate the transfer of trigger program control
' between states. Marks indicate system-level actions that
B PE e could occur if a clause in that state goes true. Use the
trigger Overview to check that all states are connected.
+ With the exception of State 1, all states must have an arrow
State 1 leading to them (indicating activation by another state),
or they will not execute. These actions are defined in the
Clause Definition dialog box.
Ctate 2 Trigger Detail
The Trigger Detail, located in the right portion of the LA
PowerTrigger tab, shows summary information about the
clauses within the states. For lengthy trigger programs, click
S the State icon in the Overview to jump to the corresponding
1] PowerTrigger details. Click the If/Then icon to open the
Clause Definition dialog box, for complete information about

the clauses for that state.

TIP. To check the progress of your trigger program during acquisition, click the Status button in the
toolbar to display the status monitor.

To track a sequence of events, create trigger programs with multiple states.

To simultaneously monitor different events, create trigger programs with states containing multiple
clauses. Each clause can carry out different actions when the events occur within each state.

Related Topics

Clause Definition Dialog Box (see page 163)

LA Trigger Event Resources (see page 169)

Trigger Clauses

Trigger clauses are made up of two parts: An If statement that defines the data events to search for,
and the Then statement which specifies the actions taken when the If statement is true.

Clauses contain the most important part of the trigger program; they specify the data and conditions
to look for. Clauses also define the relationship between the states by specifying when control is
passed from one state to another state.
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Event Conditions
Event conditions are a logical combination of trigger events within a single clause.

m If you set up a logical AND statement, all event conditions in the clause must be met before
the clause can execute the action.

® Ifyou set up a logical OR statement, any one of the event conditions can be fulfilled before
the clause can execute the action.

®  You cannot define both AND and OR statements, define one or the other.

Trigger States

Trigger states monitor and act on a sequence of data events. States break up the trigger program
into stages.

States make the trigger program easier to read and provide more program flexibility by providing a
method to define the program in greater detail. During acquisition, trigger program control passes
from one state to another. The contents of the active state are evaluated each clock cycle.

Each state contains up to 16 clauses.

EasyTrigger Program List

Overview

An EasyTrigger program list contains a collection of predefined trigger programs for the LA module. A
list of predefined trigger programs is available from the EasyTrigger tab of the Trigger window. These
predefined trigger programs are designed to hide program implementation details, allowing you to focus
on acquiring and displaying data. However, you can use the PowerTrigger tab to view the selected trigger
program’s inherent trigger states and related clauses that define the data event, and possible resulting
actions.

To Use

You can also use the predefined trigger programs as the basis for designing increasingly complex trigger
programs that meet your data requirements. Selecting a predefined trigger program from the EasyTrigger
tab and then displaying it using the PowerTrigger tab also allows you to modify the preexisting state
and clause definitions. After making trigger program modifications, you can save the resulting trigger
program to a specified folder for later reuse by clicking the button, which is available from the Trigger
window toolbar.

Symbol Meaning
A B, C Replaces Events
Range A A Range value
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Symbol Meaning
N A count (counter)
T A time (timer)

NOTE. When you use the PowerTrigger tab to make changes to a predefined trigger program, you can no
longer use the EasyTrigger tab to view the modified program. Attempting to do so will display a message
warning you that, if you proceed, your unsaved program changes will be lost. Only predefined trigger
programs can be viewed from the EasyTrigger tab.

After you become familiar with defining trigger states and related event and action clauses, you can use the
PowerTrigger tab to create new trigger programs that are specifically designed to your data requirements.

Related Topic
Loading a Trigger from the Trigger Tab Page (see page 92)
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Listing Window

Overview

Use the Listing window to view and evaluate acquisition data. This window displays the acquired data
as a result of what you specified in Setup and Trigger windows. To open a Listing window from the
Window menu, click Listing.

Columns

Data is presented as tabular text in columns. There are several types of columns; logic analyzer groups,
individual logic analyzer signals, DSO channels, Disassembly, Sample numbers, and Timestamp values.

Columns can be dragged and dropped. Click and drag the column label to where you want the column
displayed. An arrow shows where the column will be placed.

Double-click a column label to open the Column Properties tab.

Add columns by clicking the Add Column toolbar button il

Remove columns by selecting the column label and clicking the Cut toolbar button. You can paste the
removed column to the right of any selected column.

Expand columns to show the individual signals in a group by clicking the + G
Eaz

. Collapse the
individual signals by clicking the -

Marks

Marks are used to make time measurements, locate triggers, and mark specific samples for evaluation.

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta

- to = 100ns
Time) between the two are located on the Delta Time toolbar. = D Cursor v| D Cursor 2 v|
You can add any number of delta time toolbars by clicking the Add Delta Time button at the top
+.
of the Listing window. ol

Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the right side are overview marks. These marks show where marks are located relative to the
entire acquisition. Use overview marks to move throughout the acquisition. For example, move Cursor
1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and select

Cursor 1. You can also click the right mouse button on any overview mark, and then click Go To Mark.
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® Double-click a mark to open the Marks properties tab. You can assign a unique name to the Mark in
the Mark Name field.

®  You can add marks by clicking T (the Add Mark toolbar button). Remove a mark by selecting the
mark and using the Cut toolbar button. When you add or paste a mark, it appears in the center of
the display.

®  You can move to any mark using the Go To toolbar button.

= The system trigger is the reference point for the acquisition.
System trigger @ Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger. The
active system trigger is indicated by a yellow T the reference
system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

The point at which the module triggered. Trigger marks

T

Module trigger = cannot be moved.
The start and end of a module’s data record. These data

Cursors 1 and 2 Moveable marks used for visual reference and for data

— measurements.

T P =

——and =

User mark Usgr-crgated mgrks. Use marks to make specific data easier
to identify and find.

Lock Delta Time check box Click this check box to lock the delta time value. When

you lock delta time, the marks move across the data
simultaneously, maintaining a fixed delta time.

Data Area

m  The Data area can be split vertically by dragging the split box from the left end of the horizontal
scroll bar. This allows you to compare columns.

® Qualification Gaps are indicated with a horizontal gray line above the first data after the gap. Turn
indicator gaps on or off from the Listing Window Properties tab.

m  Glitches are indicated by highlighted text of the complete sample, except for binary radixes. Only the
glitch bits are highlighted in binary. Select the color of highlighted glitch text from the Listing window
properties tab. Select radixes from the Column properties tab.

Enable Glitch storage in the Setup window before acquiring data.

Memory differences and equalities are indicated by highlighted data. You can enable data comparison and
select the color of highlighted data from the Listing window properties tab.

Before you can acquire and compare data, first enable the comparison in the Setup window and define both
the signals to compare and a valid data reference.
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Qualification Gaps

Positions between data samples where one or more samples have not been stored.

Data Differences

Highlighted data shows where there are differences between the two signals or groups being compared.

Data Equalities

Highlighted data shows where there are no differences between the two signals or groups being
compared.

Add Column/Waveform Dialog Box

Use to add a column to the Listing window, or a waveform to the Waveform window:
1. Select the data source and its associated group or signal to add it to the display.
2. Click the Add Data Source button to add a source to the selection box.

To open the Add Column or Add Waveform dialog box from the System window, click the appropriate
data window icon. Then go to the Edit menu and click either Add Column or Add Waveform.

TIP. To quickly add columns and waveforms, right-click in the Listing or Waveform window and select
either Add Column or Add Waveform.

Lock Windows Dialog Box

Overview

Use the Lock Windows dialog box to lock cursors and the display areas of selected data windows. Locking
windows provides an easy method to compare data from two different windows.

Use the Lock Windows dialog box to select how windows are locked together with respect to cursors C1
and C2 and the center screen.

Behavior

To have the cursors and center screen of all locked windows go to the same time stamp position as the
selected reference window, click the No time offsets option button. To have each window’s cursor and
center screen retain its current position, click the Current time offsets option button.
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You can lock Listing, Waveform, Protocol, and Graph windows.

TIP. One way to jump over big time gaps in the Waveform window is to create a Listing window of the
same data, and then lock the two windows together. As you move the cursor through the Listing window,
the cursor in the Waveform window will track and jump over the "dead" space between samples.

To Use

To open the Lock Windows dialog box from the System window, click the Listing, Waveform, Protocol, or
Graph data window icon. From the System menu, click Lock Windows.

Export Data Dialog Box

188

Overview

Use the Export Data dialog box to export data from the current Listing window to an ASCII text file or to a
binary file. You can export the following listing data:

m  All data from the acquisition
® A range of listing data between two selected marks

® A range of listing data between two samples

Behavior

If you choose to export the listing data to a text file, you can click Options to define the format of the data.
The data is saved in a file with the .txt extension.

If you choose TLA Data Exchange the text format is predefined as follows. The first line displays vectors
and the second line contains the column headings Sample, Address, Data, and Timestamp.

If you choose to export the listing data to a binary file, the data is saved in a file with a .tbf (TLA binary
format) extension. Sample numbers and mnemonics groups are not exported; time stamps are listed in
picoseconds and are relative to the start of the acquisition. The binary option is available only when the
data window has a single data source.

To Use

To open the Export Data dialog box, open a Listing window. From the File menu, click Export Data.

Related Topic
Export Data Options Dialog Box (see page 190)

TLA Binary File Format (see page 189)
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TLA Binary File Format

Overview

The TLA Binary File Format is used to export data from Listing windows in binary rather than ASCII
format. You can use this format to export DSO data and MagniVu data in Listing windows, in addition to
the standard listing data.

LA Module Binary Format

The binary data for an LA module is exported as a stream of bytes with the following characteristics:
B The binary data uses big endian fields (the most significant bit is the left-most data bit).

®m  Each group field is zero-padded to the nearest byte.

®m  Sample numbers and mnemonics groups are not exported.

® Time stamp data is seven bytes wide and represents the number of picoseconds since the start of
the acquisition.

B The left-most column in the Listing window corresponds the first exported field of a sample.
®  The first sample in the Listing window appears at the beginning of the exported file.

B MagniVu data follows the same guidelines as regular listing data.

DSO Module Binary Format

The binary data for a DSO module (in a Listing window) is exported as a stream of bytes with the
following characteristics:

®  The binary data uses little endian fields (the most significant bit is the right-most data bit).

®  Each channel is a 16-bit value.

B Sample numbers, mnemonics groups, and time stamp values are not exported.

B The left-most column in the Listing window corresponds the first exported field of a sample.
®  The first sample in the Listing window appears at the beginning of the exported file.

B MagniVu data follows the same guidelines as regular listing data.

B DSO data values are in twos-compliment format.

B The formula used for converting a channel field into a voltage is as follows:

((vertical Range 1in volts / 64512) X channel field) + Vertical offset in volts
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Export Data Options Dialog Box

Overview

Use the Export Data Options dialog box to customize listing data for export. The settings are retained
after you close the dialog box.

To Use

To open the Export Data Options dialog box, open a Listing window. From the File menu, click Export
Data, and then click Options.

1. Choose a field delimiter to separate the listing data columns.

2. Click the Include Unit Character check box to export data with measurement units. If you export data
without unit characters, time stamp values are in picoseconds and analog values are in volts.

3. Click the Fixed Data Radix check box to export data in the specified radix.

4. Click the Use Enhanced Column Headers check box to export group width and radix information in
column headers.

Compare Definition Dialog Box

Before you can compare data, use the Define Compare dialog box to specify the source of the reference
data, the number of samples to compare, and how to align the data. To enable the Compare Definition
dialog box controls, click the Enable Data Compare check box.

A summary of the samples being compared is displayed at the bottom of the dialog box. This area
shows the samples that are being compared in the current acquisition using the current compare range
and alignment settings.

To Use
1. From the toolbar, open the Setup menu and select your module.

. In the Setup window, define a group (see page 22).

2
3. Create a Listing window.
4

. In the toolbar, click the Define Compare button.

Behavior

You can compare data in the following ways:
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m Reference Data Source. Select a reference data source from any of the installed modules or from a
saved setup.

B Compare Data Region. Compare all data between the system under test and the reference data. You can
also compare a range of data with respect to the beginning of memory or around the trigger location.

B Data Source Alignment. Align and compare the data with respect to the beginning of memory or to the
trigger location. You can also specify the number of samples to offset the data.

®  Compare limitations. Compare only the main LA data. You cannot compare glitch data, disassembler
group data, MagniVu data, External Oscilloscope or DSO data.

Repetitive Properties Dialog Box

Overview

Use the Repetitive acquisition features of the logic analyzer to automate repetitive and time-consuming
tasks. For example, you can specify the number of times that you want the logic analyzer to acquire data.
With each acquisition, you can save the data to a file for analysis. You can also set up the logic analyzer to
open a file or execute a program when all of the acquisitions have been completed.

Behavior

Click the Save check box to save the setups or export data to a file. You can overwrite the file with each
acquisition or you can save the data in separate files by entering a starting file suffix number.

During compare operations, you can acquire data until the compare conditions are met. Then click OK to
close the dialog box and save your settings.

The following is an example of such a setup where the acquired data is exported to a file for each
acquisition. When a data-mismatch occurs, the logic analyzer stops acquiring data and exports the data to a
file. The faulty data can now be analyzed by another application.
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Repetitive Properties

Aftes Each Acquisition
[#] Save | Export Data v| from | Listing 1 W :
Ta File: |E:‘-I-1pDncwnerts‘uLED Falt bt | [ Browse,. . I

(%) Save in same fle sach acquisition

) Save in new file each scquisition.  Staing file Sulfic |'|

Stop if Compare vath Beference i | Mot Equs
Stop After | 501 Aoquistions
When Stoppad

[] Open: <Mame of progam or documents

| ok |[ Cancel

Repetitive Properties Dialog Box

NOTE. Click the Enable Data Compare check box, located in the Compare Definition dialog box, to stop

the acquisitions when the compare conditions are met.

After completing the repetitive operation, you can have the logic analyzer open a document or execute an
operation as defined in the Open dialog box. Click Open to access the Open dialog box.

TIP. 1o improve the response time of the logic analyzer during repetitive operations, you can delete
any unnecessary data windows. This allows the logic analyzer to spend time on processing data rather

than redrawing data in data windows.

To open the Repetitive Properties dialog box from the System menu, click Repetitive Properties.

Related Topics
Compare Definition Dialog Box (see page 190)

Export Data Dialog Box (see page 188)

Open Dialog Box (see page 193)
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Open Dialog Box

Overview

Use the Open dialog box to open a document or an application after fulfilling the requirements of a
repetitive operation.

To Use

Enter the path and name of the document or application that you want to open. If you do not know the
path name of the document or the application, click the Browse button to navigate to the document or
application.

m  Use the Arguments list to enter any command line arguments that are required by the application or
document.

B Use the Initial Directory box to specify the default working directory for the application or document.
m  Click the Test Open button to verify the selections for the Open dialog box.

To access the Open dialog box from the System menu, click Repetitive Properties, and then click the
Open button.

Define Search Dialog Box

Overview

Use the Define Search dialog box to search for specific data within the current data window. Search
definitions can search any number of data sources at the same time. By default, searches begin from the
active cursor, but you can specify any cursor or mark to begin the search. All data sources begin searching
at the same point and continue until the number of occurrences specified is found. Neither hidden data
nor suppressed data can be found by the search function. Suppressed data can be identified by gaps in

the sequence numbers.

Behavior
B Module sample numbers and stored time stamps can be searched.

®  All module signals and groups can be searched; each has unique conditions to aid you in searching.
Types are LA signals, LA groups, DSO channels, and disassembly.

B You can search for data differences and data equalities during compare operations.
= You can add an unlimited number of events.

B After adding an event, click the AND/OR button to alternate between logic expressions.
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® The Radix for groups can be set independent from those used in Listing or Waveform windows.
B The polarity state set in the module setup applies to the search values.

m  Searches on numeric disassembly groups with partial invalid bits (indicated by dashes) will match
across the entire unqualified value. Set invalid bits to "don’t care" values (X) for a proper match.

B Searches on numeric disassembly groups that contain all invalid bits always fail.

To Use
To open the Search Definition dialog box, open a data window and click i) in the toolbar.

Click either the & Search Back or the 2 Search Fwd button to begin the search.

Click the Search Options... button to set the action that you want the logic analyzer to take when the
search is successful.

NOTE. You can type the following meta-characters in the value box for text searches.

Character Matches

Zero or more characters

? Any single character

<or> One or more delimiters. A delimiter is any character that is
not: a-z,A-Z,0-9, _ (underscore) or - (dash).

% Opcode mark. This character can only be used in a
disassembly mnemonics column search.

space One or more spaces

\ Makes the next character literal.

Right-click in the Search area to activate a short cut edit menu. The short cut edit menu allows you to
add or delete data sources and events, to enable or disable searches and to cut, copy, or paste. Where you
right-click in the Search area determines which menu selections are active.

Clicking in the Search area will activate a 2 icon. Holding your cursor over the arrow activates the
short cut edit menu.

Related Topics
Column Properties Tab (see page 196)

Waveform Properties (see page 88)

Compare Definition Dialog Box (see page 190)

Search Definitions (see page 195)
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Search Definitions Dialog Box

Overview

Use the Search Definitions dialog box to create new search definitions or load saved searches.

Behavior

Clicking the New button adds a new search to the selected data window. Clicking the Load button opens
the Load Search dialog box where you can select and load searches. Selecting a search, and then clicking
the properties button, opens the Define Search dialog box where you set the criteria for the search.

Related Topic
Define Search Dialog Box (see page 193)

Time Alignment Dialog Box

Use to align the time of data sources. The data source’s alignment is offset by the adjusted time in all data
windows. LA and associated MagniVu (see page 368) data sources are always offset together.

Saved data and current data are time-correlated by aligning their system triggers. You can manually adjust
this alignment using the Time Alignment dialog box.

To open this dialog box, open a data window. From the Data menu, click Time Alignment.

Go To Dialog Box

Use to scroll the data window to a new position by selecting any current mark, column, or waveform.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.

Related Topics
Adding a Mark to a Data Window (see page 137)

Adding a Waveform (see page 118)
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Mark Opcode Dialog Box

Use this dialog box to place an opcode mark into a disassembly analysis. To do so, select an opcode from
the list and click OK. To remove an existing opcode mark, click Undo Mark.

NOTE. Load a support package to use this feature.

About Data Properties

Provides information about the data source used for the active data window.

Column Properties

Use the Column properties tab to format a column in the Listing window.

Click the Column drop-down list to view properties of another column. Note that changing columns
applies changes that you made to the previous column.

Color selection changes the color of text in the column.

Column data can be displayed with user defined foreground and background colors by setting up
the column to use TSF symbol file with color.

The Show Column check box can be used to temporarily remove a column from the display, but
still retain its properties.

Column selection of Sample or Timestamp provides controls for reference points (for example, you may
want to reference all time stamp values to the module trigger point rather than the beginning of data).

Select the radix if the selected column is a data column. If you select Symbolic, controls appear
to aid you in finding the symbol file.

NOTE. Radix and Polarity selections for disassembly mnemonics cannot be changed. Polarity cannot be
changed for any disassembly column.

To open the Column properties tab, open a Listing window and double-click the column label.
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Marks Properties

Use to format any mark in the current data window. You can also enter comments for any mark you
have added.

To open the Marks properties tab, open a data window and double-click the mark.

NOTE. Changing the selected mark applies any changes that you made to the previous mark.

Listing Window Properties

Use to format the current Listing window.

®  Qualification gaps in the Listing window are indicated by a gray horizontal bar above the first data
after the gap.

®m  Data Font Size allows you to select the size of the text within the columns and the column labels.
B Click Acq != Ref to display data differences during data compare operations.

B Click Acq = Ref to display data equalities during data compare operations.

NOTE. To display differences and equalities, define a valid data reference and enable the comparison.

m  Glitches are indicated by highlighted text of the complete sample for all radixes except binary; in
binary radix the actual bits containing the glitches are highlighted.

NOTE. Select Glitches in the Storage box of the Setup window before acquiring data.

B Background allows you to select the color for the data area background.

B Selecting a different color scheme resets the colors shown in the Column tab, Marks tab, and Listing
Window tab to their default settings for that color scheme. Color schemes are defined in the Colors
tab of the Options dialog box.

NOTE. Default colors are set in the Defaults tab of the Application Options dialog box, available from
the System menu.

To display the Listing Window property tab from a Listing window, click in the toolbar, and then
click the Listing Window tab.
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Related Topics
Defaults Tab (see page 378)

Color Tab (see page 377)

Disassembly Properties

Use to select the display format of disassembly groups.
Load a support package for this page to be active.

® If you have more than one disassembler loaded, you can select from all modules that have a
disassembler currently loaded.

®  You can select which disassembled data to display: Hardware, Software, Control Flow, or Subroutine.
Other display options may be available depending on your support package.

B You can highlight lines appropriate for the current selection in the Show list box.

NOTE. The highlight controls are disabled if the Mnemonics column is colored the same as another column.

B You can select whether to continue disassembly analysis across storage qualification gaps in the
acquisition data.

Other selections are support package dependent. Refer to your instruction manual for specific selections
and choices.

To display the Disassembly Properties tab from a Listing window, click in the toolbar, and then

click the Disassembly tab.

Hardware Disassembly

Shows bus cycles in the order they were sampled. The disassembler displays certain cycle type
labels in parentheses.

Refer to the support package manual for a list, and definition of, the labels.

Software Disassembly
Shows only executed instructions.

The displayed information resembles assembly language.
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Control Flow Disassembly

Shows only calls, exceptions, returns, and branches; which are types of instruction that changes the
flow of control.

Subroutine Disassembly

Shows only the first fetch or subroutine call and return instructions.

Error Message Dialog Box

This dialog box displays error messages, usually in relation to disassembly support and symbol table
loading. The following are attributes of the Error Message dialog box:

= Holds up to 100 messages.
B The oldest messages are discarded when the message area fills.

B  The most recent message is at the bottom.

NOTE. Closing the Error Message dialog box discards all messages; minimizing does not.

Define Suppression Dialog Box

The Define Suppression dialog box defines what module samples will be shown. This dialog box defines
how many samples will be shown for only the data sources in this display.

Show Samples Dialog Box

The Show Samples Dialog Box shows preciously suppressed samples to be shown starting with the
current mouse position.

Show by Samples

Making this selection indicates that the selected number of samples will be shown starting from my
current mouse position within the view.
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Show by Mark

Marking this selection causes all samples between the current mouse position and the selected mark to
be shown.

Apply to Mark

Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.

Suppress Samples Dialog Box

The Suppress Samples dialog box suppresses samples from the view.

Suppress the <selection> <number> Samples

Making this selection indicates that the selected number of samples will be suppressed starting from my
current mouse position within the view.

Suppress to Mark <selection>

Marking this selection causes all samples between the current mouse position and the selected mark
to be suppressed.

Apply to all Data Sources in this Data Window

Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.

Sample Suppression Dialog Box

200

Use Sample Suppression to control how many samples are initially made available for display each time
you acquire new data. Sample suppression does not affect the number of samples stored during acquisition.

You can control sample suppression in the following ways:
B Show All acquired samples. Makes all acquired samples visible immediately following acquisition.

®  Show N samples around the trigger. Shows one block of samples with the trigger centered in the block
of samples. All other samples are suppressed.

B Reuse existing sample suppression relative to. Retains the setting currently being used to show data
in the Listing or Waveform window and applies it to newly acquired data. Suppression can be kept
relative to the trigger point or beginning of memory.
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Changes made to the dialog box do not take effect until new data is acquired. Following acquisition, use
the Show or Suppress controls, in the Listing or Waveform windows, to view or suppress additional
data samples.

To access this dialog box, click the Suppress . . . button in the toolbar in the LA Setup window.
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Waveform Window

Use the Waveform window to display and evaluate acquisition data. You may display both analog
waveforms and digital waveforms. Each window contains a data area, a waveform label, marks, and
several toolbars that allow you to measure and manipulate your waveforms:

Waveforms

The following waveforms can appear in a waveform display. Click the buttons for more information on
each type of waveform.

Single-Signal LA Waveforms
Multi-Signal Busform LA Waveforms

Multi-Signal Magnitude LA Waveforms
DSO Waveforms

Sample Waveforms

Overlay Waveform

Time Gaps

Waveforms can be dragged and dropped. Click the waveform label and drag it to where you want to
display the waveform. An arrow shows where the waveform will be placed.

Double-click a waveform label to open the Waveform dialog box.
Add waveforms using the Add Waveform toolbar button.

Remove waveforms by selecting the waveform label and clicking the Cut toolbar button. You can paste
the removed waveform below any selected waveform.

@ iview @ Magnivu T Activity OF value

To quickly display the waveform from an external oscilloscope, click the iView button.

To display MagniVu waveforms click the MagniVu button. To turn the iView or MagniVu display
off, click the button again.

To display the probe activity in the Waveform window, click the Activity button. Click the button again
to turn the probe activity display off.

To display the value of each group at Cursor 1, click the Value button. Click the button again to turn
the value display off.
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Marks

Marks are used to make time measurements, locate triggers, and mark specific waveform events for
evaluation.

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta

&~ [] Cursor | v|t':'|:|l:iur3|:|r27|=1':":|f13

Time) between the two are located on the Delta Time toolbar.

You can add any number of delta time toolbars by clicking the Add Delta Time button at the top of
+

the Waveform window. &

Marks on the top of the window are data area marks. Use moveable data area marks to move within the

data area. You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the bottom of the window are overview marks. These marks show where marks are located
within the entire acquisition. Use moveable overview marks to move throughout the acquisition.

For example, move Cursor 1 to a particular sample as shown in the Cursor 1 readout. Click the Go
To toolbar button and select Cursor 1. You can also use the right mouse button on any overview
mark and click Go To Mark.

Double-click a mark to open the Properties dialog box and display the Marks tab. You can assign a
unique name to the Mark in the Mark Name field.

You can add marks using the Add Mark toolbar button. Remove an added mark by selecting it and
using the Cut toolbar button. When you paste a mark, it appears in the center of the display.

You can go to any mark using the Go To toolbar button.

System trigger The system trigger is the reference point for the acquisition.

="

Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.

The active system trigger is indicated by a yellow T, the
reference system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

Module trigger The point at which the module triggered. Trigger marks
— cannot be moved.

T

Begin data and end data The start and end of a module’s data record. These data

marks cannot be moved.

Eandﬁ
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Cursors 1 and 2 Moveable marks used for visual reference and for data
= measurements.

T R % §

—and ==

User mark User-created marks. Use marks to make specific data

easier to identify and find.

Data Area

B The Data area can be split by dragging the split box from the top of the vertical scroll bar. This allows
you to compare waveforms.

B Several situations can cause long periods of time (Time Gaps (see page 205)) to elapse between
acquired samples.

m  Acquired glitches display directly on the affected waveform. Glitches display as a vertical bar behind
the sample data in the glitch color. Glitches are drawn as if they were behind the waveform. You can
disable the display of glitches and select their color in the Waveform window.

B Memory differences and equalities in logic analyzer waveforms are indicated by different colored text
for each trace. Enable data comparison and select the color of highlighted data from the Waveform
window.

Highlighted data shows where there are no differences between the two signals or groups being compared.

NOTE. Define the signals to compare, define a valid data reference, and enable the comparison in the LA
Setup window before acquiring data and viewing differences and equalities.

Related Topics
Waveform Properties (see page 88)

Waveform Labels (see page 216)

Marks Tab (see page 197)

Symbol Tables (see page 341)

Selecting Objects (see page 206)

Time Gaps

Several situations can cause long periods of time to elapse between acquired samples:

B Qualification gaps in a single LA module record.

m  Acquisition gaps between the last sample in one data source and the first sample in another data source.
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As with any data samples, a horizontal vector is drawn from the last sample before a qualification gap to
the first sample after the gap. If the values of these two samples are different, the transition is drawn at
the sample after the qualification gap.

Qualification gaps within a module are compressed. If there are acquisition gaps when no modules are
acquiring (including reference waveforms), this time is eliminated.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. If
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.

Selecting Objects

Selected Objects

You can select waveform labels, navigation marks, and data window regions in a Waveform or Listing
window. Only one of these elements can be selected at one time; however, several waveforms can be
selected as a single element.

For example, you can select three waveforms or a cursor, but you cannot select a waveform and a cursor
at the same time.

Active Objects

There is a distinction between selected and active. While you can only select one element (or set of
waveforms), there are element types for which one item is active at all times.

For example, there is always one active cursor (C1 or C2) and one active waveform. The active waveform
is the top waveform of a selected set of waveforms. Measurements pertain to this waveform.

Overlay Waveform

206

Overview

Overlay waveforms provide you with the ability to visually compare two or more waveforms by dragging
one waveform over the other. The overlay waveform can contain LA single-signal, DSO, external, and
clock waveforms.

LA waveforms have a horizontal resolution of one pixel per display point. A displayed point has three
possible states: high, low, or transition. When the sample period and time per division are set so that one
pixel is exactly one sample, every displayed sample is either high or low and may show a transition vector.
When the Time/Div is increased, the analyzer stretches out the waveform by padding between the samples.
At slower Time/Divisions, the data is compressed.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.
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Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. You can disable the display
of glitches using the Waveform Window tab, which is located in the Waveform Properties dialog box.

Behavior

For DSO and external waveforms, each horizontal, pixel-wide time slice has either a point or a vertical
line to represent the vertical value of the acquired data sample. If the time per division is fast enough that
each display point represents one or fewer acquired points, the vertical value is represented by a point.

If the time per division is slower and multiple acquired data samples need to be represented within a
pixel width, the vertical value is represented by a vertical line whose length and offset are determined
by the acquired data values.

When the time per division is decreased, waveforms are horizontally expanded, using (sine x)/x
interpolation to create display points between acquired sample points. A vertical value is calculated for
every horizontal time point between the acquired data points.

To Use

You can select whether to display range readouts for the selected waveform, to display all DSO and
external waveforms range readouts, or to not display range readouts at all. You can also select the readout
color. For each waveform, two readouts display the maximum and minimum vertical input voltage
settings. The readouts may contain symbols indicating AC or Ground coupling, 50 Ohms input impedance,
and the bandwidth limit. The ground line is indicated as a horizontal dotted line. The trigger threshold

is indicated with a T and an up arrow if the threshold is above the maximum voltage or a down arrow

if the threshold is below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range set in the DSO setup window.
The entire input voltage range is used to set the default minimum and maximum values of the vertical
range. Set the vertical range values from the Waveform Properties dialog box by clicking the Waveform
tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you can see individual clock tick marks.

Related Topics
Creating an Overlay Waveform (see page 135)
Removing Waveforms from an Overlay Waveform (see page 139)

Waveform Properties (see page 88)
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Sample Waveforms (see page 215)

Overlay Waveform Properties

Overview

The Waveform tab displays overlay waveform properties when you double-click the label of an overlay
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
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Behavior

The following are properties associated with overlay waveforms:
= Overlay Waveform Name: permits you to rename overlay waveforms.

B Waveforms Available lists all of the individual waveforms and overlay waveforms. You can move and
copy waveforms in this list to the Overlay Waveforms list using the Move and Copy buttons. You can
also remove buttons from the Overlay Waveforms list and return them to the Waveforms Available
list using the & button.

m  Overlay Waveforms lists the waveforms currently in the selected overlay waveform group. You can
move and copy waveforms from the Waveforms Available list to this list using the Move and Copy
buttons, respectively. You can also remove waveforms from the Overlay Waveforms list and return
them to the Waveforms Available list using the <& | button.

To Use

To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.
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Related Topics
Waveform Properties (see page 88)

Individual Waveform Properties (see page 209)

Individual Waveform Properties within an Overlay Waveform (see page 211)

Waveform Window Properties (see page 89)

Color Settings (see page 377)

Waveform Options (see page 216)

Measurement Setup (see page 396)

Setting the Overlay Waveform Offset

1. In the System window, click the Waveform window icon.

2. Double-click the desired waveform label to display the Waveform Properties dialog box, and then
click the Waveform tab.

3. Set the desired pixel value in the Offset list box and click the Apply button.

NOTE. Offset can only be specified for waveforms that are members of an overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.
2. Highlight the desired waveform label.

3. Use the vertical scroll bar to set the waveform offset.

Individual Waveform Properties

Overview

The Waveform tab displays individual waveform properties when you double-click the label of a single
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
tab.
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Behavior

The following are properties associated with individual waveforms:

Source. displays the data source of the selected waveform. The source file (or current system), module
name, and signal information are displayed. Depending upon the way the signals were originally added,
the information will be a group-based signal name (for example, Address (31-0)), a single signal name,
or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a merged pair, an S is
prepended to probe-based names. If the module is part of a three-way merge, S and S2 are prepended
to probe-based names. If the module is part of a five-way merge, S, S2, S3 and S4 are prepended to
probe-based names. No text is displayed for multiple waveform selections.

Color. permits the selection of either a fixed waveform color or a waveform color that is the same
as another waveform, which is designed to promote comparison of waveforms. If you are selecting a
fixed color, you can select a color from the list. Select the color scheme using the Waveform window
tab. Select the colors of each color scheme by clicking Options from the System menu and then
clicking the Color tab.

Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

Show Waveform. temporarily hides a waveform without deleting it. This check box determines if the
waveform is visible in the data window. If a waveform is not visible, you cannot search for it.

Use Polarity. enables the display of waveform signal polarity as defined in the Setup window. This
check box is only enabled for LA waveforms.
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® Readouts. determines whether waveform readouts are displayed and their color. Readout options only
display for logic analyzer, DSO and external waveforms.

B Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use

To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics
Waveform Properties (see page 88)

Overlay Waveform Properties (see page 208)

Individual Waveform Properties within an Overlay Waveform (see page 211)

Waveform Window Properties (see page 89)

Color Settings (see page 377)

Waveform Options (see page 216)

Measurement Setup (see page 396)

Individual Waveform Properties within an Overlay Waveform

Overview

The Waveform tab displays the properties of an individual waveform within an overlay waveform, when
you double-click the label of a waveform, from within an overlay waveform, in the Waveform list box.
The following graphic displays the resulting content of the Waveform tab.
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Behavior

The following are properties associated with individual waveforms within an overlay waveform:

Offset. allows you to visually compare two or more waveforms by specifying their vertical position in
the Waveform window.

Source. displays the data source of the selected waveform. The source file (or current system), module
name, and signal information are displayed. Depending upon the way the signals were originally added,
the information will be a group-based signal name (for example, Address (31-0)), a single signal name,
or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a merged pair, an S is
prepended to probe-based names. If the module is part of a three-way merge, S and S2 are prepended to
probe-based names. No text is displayed for multiple waveform selections.

Color. permits the selection of either a fixed waveform color or a waveform color that is the same
as another waveform, which is designed to promote comparison of waveforms. If you are selecting a
fixed color, you can select a color from the list. Select the color scheme using the Waveform window
tab. Select the colors of each color scheme by clicking Options from the System menu and then
clicking the Color tab.

Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

Show Waveform. check box determines if the waveform is visible in the data window. If a waveform
is not visible, you cannot search for it. Use this box to temporarily hide a waveform without deleting it.

Use Polarity. check box enables the display of waveform signal polarity as defined in the Setup
window. This check box is only enabled for LA waveforms.

Readouts. determines whether waveform readouts are displayed, as well as their color. When selected,
the Show readouts when selected check box allows waveform readouts to display only when the
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associated waveform label is highlighted. Note that Readout Options only displays for logic analyzer,
DSO and external waveforms.

B Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use

To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Waveform Properties (see page 88)

Individual Waveform Properties (see page 209)

Overlay Waveform Properties (see page 208)

Waveform Window Properties (see page 89)

Color Settings (see page 377)

Waveform Options (see page 216)

Measurement setup (see page 396)

Multi-Signal Busform LA Waveforms

Busform waveforms can contain group value readouts. If the width between transitions is sufficient, a
value is displayed. If the width is not sufficient, no readout is shown in that segment. The readout is
displayed in the selected radix.

Acquired glitches are displayed directly behind the affected waveform. Glitches are displayed as vertical
lines in the glitch color. Glitches are drawn as if they were behind the waveform and any readouts. You
can disable the display of glitches using the Waveform Window tab, which is located in the Waveform
Properties dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.
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Related Topic
Sample Waveforms (see page 215)

Multi-Signal Magnitude LA Waveforms

214

Overview

In Magnitude mode, the vertical placement of a data point in waveforms represents the numeric value
of the group. By default, the possible range of values (determined by the group width) is scaled to the
selected waveform size.

Behavior

When the time per division is decreased, waveforms are horizontally expanded, using linear interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.

If you compress the waveform, the minimum and maximum values at each display point are displayed to
create a vertical line at each horizontal data point.

To Use

You can change the waveform minimum and maximum values by accessing the Waveform tab, located
in the Waveform Properties dialog box, and clicking the Options button. You can also select the radix
used in cursor measurements.

TIP. To display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set in the Waveform tab of the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms (see page 215)
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Sample Waveforms

You can select sample waveforms in the Add Waveform dialog box. Each module has its own sample
waveform. A sample waveform consists of a row of short vertical marks on the time axis at each display
point that represents an actual acquired sample for the module.

When the display is expanded, points without a sample are empty. When the display is compressed, the
sample waveform looks like a thick horizontal line.

Two time stamp values are displayed at the edges of the sample waveform.
If the sample waveform is the active waveform, the Measurement Bar readouts are empty.

The waveform size is fixed.

Single-Signal LA Waveforms

Single-signal LA waveforms have a horizontal resolution of one pixel per displayed point. A displayed
point has three possible states: high, low, or transition. When the sample period and time per division are
set so that one pixel is exactly one sample, every displayed sample is either high or low and may show a
transition vector. When the Time/Div is decreased, the analyzer stretches out the waveform by padding
between the samples. At slower Time/Divisions, the data is compressed.

For example, if the time per division is set so that two acquired samples must be represented in each
horizontal pixel width and both of the acquired samples in a pixel are high, the displayed sample is high. If
both samples are low, the displayed sample is low. If the two acquired samples are a high and a low, in
either order, the display will be a vertical line representing both samples. At even slower time per division
settings, more acquired samples are represented by each displayed point.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.

Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. You can disable the display
of glitches using the Waveform Window tab, which is located in the Waveform Properties dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by selecting "Color Same
As" on a LA busform waveform, and then setting up the busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms (see page 215)
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Waveform Labels

Overview

Waveform labels serve as handles to mark the waveform location and name of each waveform. The label
allows you to adjust the position and other properties of waveforms.

The waveform name is the logic analyzer group or signal name, the oscilloscope channel name, or the
name for a special waveform type. The name is prepended with the module name when there are multiple
modules, the waveform is included as part of a waveform overlay, and with the file name of the data source
file if the waveform is a reference waveform. If the name will not fit in the label, characters on the left,
which are the most likely to be redundant, are clipped until the name fits in the label.

To Use

You can select and drag one or more waveform labels. When you drag a label, a drop marker indicates
where the label will be dropped. If there are waveforms beyond the top or bottom edge of the data area,
dragging a label past that boundary will scroll the display.

You can change the width of the label area by dragging the border between the label area and the data
area. You can change the height of a label by clicking and dragging its bottom edge. Double-clicking a
waveform label opens the Properties dialog box and displays the Waveform tab, which contains the
settings for that waveform.

Waveform Options

Waveform Options allows you to set waveform characteristics that are specific to a waveform type.

Waveform Limits sets the minimum and maximum values that will be displayed in the selected waveform.

Behavior
B Max Value sets the maximum value displayed in the waveform.
B Min Value sets the minimum value displayed in the waveform.

B For DSO waveforms, Lock to Setup determines if the Max and Min values are reset when the DSO
setup parameters are changed. When checked, the values are reset to the maximum and minimum
values possible with the current range and offset settings. Checked is the default.

® For LA group waveforms, Lock to Setup determines the minimum and maximum values based
on the number of signals in the group. When not checked, you can specify a subset range of the
group min and max.

LA Waveform Style selects the style of displayed LA data. These controls are disabled unless a single LA
group waveform is selected.
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®  Busform displays LA group data as a bus form.
B Magnitude displays LA group data as a graph display (Magnitude mode).

®  Signed data selects whether acquisition data is interpreted as signed or unsigned. Signed data is only
active for magnitude style LA waveforms.

® Draw Interpolation inserts vectors between data points, thereby approximating a magnitude waveform.

To Use

To change waveform options from the System window, click a waveform data window icon, double-click a
waveform label, click the Waveform tab, and then click the Options button.

Related Topics
Setting Waveform Options (see page 125)

Setting the Waveform Style (see page 83)

Setting the Waveform Limits (see page 84)
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Histogram Window

Overview

Use the Histogram window to set up, capture, and display performance analysis data from an LA module
group, counter, or timer. Each Histogram window displays address ranges and the corresponding counts,
percentages, and histogram bars based on the defined ranges and selected data source.

Before you can acquire and display histogram data, first set up the LA module using the LA Setup and LA
Trigger windows. Use the Setup window to set up the groups, sampling, and memory requirements. Use the
Trigger window to set up a trigger program, counters, and timers. You should configure the Setup window
before the Trigger window, because some of the Setup window settings affect Trigger window selections.

Use the New Data Window wizard to create a Histogram window for the first time.

Statistics
The Histogram statistics provide an overview of the data.

®  The number of displayed lines depends on the data source. Statistics for a group use only one line.
Statistics for counters or timers use two lines.

B The Percentages Based On list shows the number of data samples depending on whether you select
All Samples or Matched Samples.

m [f the data source is a counter or timer, the second line lists the minimum, maximum, and average
values of the counter or timer.

Header Control
Use to resize columns, sort ranges, and specify the magnification value for the histogram bars.

m  Resize columns by dragging and dropping the column separators in the Histogram Header Control.

NOTE. Dragging a column separator behind another column separator may hide a column.

B When ranges are displayed as symbols, you can sort the ranges by ascending or descending alphabetical
order by clicking the Range heading.

B When ranges are displayed as bounds, you can sort the ranges by increasing or decreasing lower
bounds by clicking on the Range heading.

B Click the Count heading or the Percentage heading (%) to sort between increasing and decreasing
counts.

®  Change the magnification or the histogram bars by clicking on the bar heading and selecting a new
value from the displayed list.
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Data Area
Displays ranges, counts, percentages, and histogram bars.
B You can resize the data area by turning the toolbar and the statistics on or off.

B You can split the Histogram window horizontally by dragging the split box from the top of the vertical
scroll bar.

m  All ranges are displayed in columns. When ranges are used as a timer, the bounds include a time
unit suffix.

B A clip indicator (<) in a text column indicates that only part of the row can be displayed. To view the
entire row, you can resize the column by dragging the column header.

m  Counts, percentages, and histogram bars are updated as new data becomes available.
B You can sort ranges, counts, and percentages by clicking on the column headers.

B Changing the ranges in the Histogram Properties updates the new ranges with zero counts.

Related Topics
Defining Histogram Ranges (see page 225)

Data Source Property Page (see page 221)

Histogram Range Properties (see page 222)

Histogram Window Properties (see page 220)

All Samples

The total number of samples analyzed that matched a define range and all samples that fell outside
of the defined ranges.

Matched Samples

The total number of samples analyzed that matched a defined range. These samples exclude any
samples outside of the defined ranges.

Histogram Window Properties

Overview

Use the Histogram Window properties tab to change and view the properties of the Histogram window.
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Behavior

m Range Labels control the labels in the Range column in the data area. When the ranges are defined
from a symbol file, select Symbols or Bounds. The Symbols selection is unavailable when the ranges
are not defined in a symbol file. There is no limit to the number of symbolic ranges for histogram data.

m Data Fonts Size selects the size of the data in the Histogram data area. You can change the data font
size as necessary to view the data.

B Radix determines the format of range labels when Range Labels is set to Bounds. The Radix is only
present when the data source is a group or a counter.

B Background selects the color of the data area background.
m  Foreground selects the color of the text in the data area.
m  Bar color selects the color of the histogram bars.

m  Selecting a different color scheme resets the colors shown. Color schemes are defined in the Colors
page of the Options property sheet.

® Data is accumulated until you clear the data.
B You can analyze live data or saved data.
B You can use up to 32 bits of data in an address group.

B You can enable or disable group polarity.

NOTE. Default colors are set in the Defaults page of the Applications Options property sheet, available
from the System menu.

To Use
To display the Histogram Window properties, open a Histogram window, right-click the window and select

Properties, or click (the Property toolbar button), and then click the Histogram Window tab.

Data Source Properties

Overview

Use the Data Source properties tab to display information about the current data source or to select a new
data source for the Histogram window.

Behavior

If you change the groups in the Setup window or if you change counters or timers in the Trigger window,
the histogram data source may become invalid. The data analysis will stop until you define a new data
source or until you restore the current data source.

221



Histogram Window Information Ranges Properties

The Use Polarity box controls whether or not polarities are applied to the group data.

Changing the histogram data source generates new range definitions; existing counts are lost.

To Use

To display the Data Source properties, open a Histogram window, click (the Property toolbar button),
and then click the Data Source tab.

Select the LA module from the drop-down list. (If the data source is not included in the drop-down list,
click Add Data Source to add data from a saved setup.

Click either the Group or Counter/Timer buttons to use for the histogram data. The name of the data is
displayed in the drop-down list next to the buttons. The button selections are active when valid data is
available based on the groups and trigger setups.

Histogram Data Source

A histogram data source consists of histogram data from an LA module. The data can be from a valid
group or from a counter or a timer defined in the Trigger window. DSO modules and MagniVu data
are not allowed as data sources for Histogram windows.

Histogram Group

A group can consist of a single data channel or up to 32 data channels. Groups are defined in the
Setup window.

Ranges Properties
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Overview

Use the Ranges properties tab to define the data ranges for the Histogram window. To define ranges,
specify a data source for the Histogram window.

Behavior
B The Default Ranges button creates default histogram ranges based on the data source.

® The Define Ranges Using list specifies how the ranges will be defined: Linear Generation, Log
Generation, or Symbolic.

® The Symbol File button opens the Load Symbol File dialog box to load a range symbol file when using
symbolic range generation. Use the Symbol File list to select one of the loaded symbol files.
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® The Number of Ranges specifies the number of ranges available with Linear Generation or Log
Generation. When used with Linear Generation, the number or ranges can be changed. The Bound1
and Bound2 controls determine the maximum number of ranges.

B The Radix controls the format of the Boundl and Bound?2 controls. In Log Generation, the Radix also
controls how ranges are generated. Changing the radix also changes the display radix in the Histogram
Window properties tab. The Radix control is not present when the data source is a timer.

B The Boundl and Bound2 controls limit the overall boundaries or size of the ranges. The limits depend
on the data source. When used with a symbol file the bounds are limited by the smallest and largest
symbol file boundaries. When used with linear or log generation, the lowest bound is 0 and the highest
bound is limited by the data source size.

B The Range Size shows the size of a single range when used with Linear Generation.

® Use Time Units to format the timer values.

To Use
To display the Ranges properties, open a Histogram window, click (the Property toolbar button), and
then click the Data Ranges tab.

Related Topics
Defining Histogram Ranges (see page 225)

Load Symbols Options Dialog Box (see page 348)

Linear Generation

The histogram ranges are evenly distributed from the highest range boundary to the lowest range
boundary.

Log Generation

The histogram ranges are distributed over a logarithmic scale.

Symbolic Range Generation

The histogram ranges are defined in a range symbol file. The highest and lowest ranges depend on the
maximum and minimum boundaries for the ranges defined in the symbol file.
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Histogram Scale Dialog Box

Use this dialog box to change the scale (magnification) of the histogram bars for the current Histogram
window. You can change the scale factor from the Histogram window or from this dialog box.

To open the Histogram Scale dialog box from the Histogram window, go to the View menu and click Scale.

Histogram Add Counts Dialog Box

Use this dialog box to add data from an LA module or from a saved setup. Select the data from a module
in the displayed list, or click Add Data Source to add data from a saved setup. Select a group, a counter,
or a timer from the group list.

To open the Histogram Add Counts dialog box from the Histogram window, go to the Data menu and
then click Add Counts.

Export Histogram Dialog Box

Use this dialog box to export Histogram window information to a file. Specify the export file path and the
rows of the histogram information. The exported data will be saved in the specified format. The dialog box
uses any export options specified in the Export Histogram Options Dialog Box.

To open the Export Histogram dialog box from the Histogram window, go to the File menu and then
click Export Histogram.

Related Topics

Exporting Histogram Data (see page 72)

Export Histogram Options Dialog Box (see page 224)

Export Histogram Options Dialog Box
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Use this dialog box to customize the export histogram operation. You can specify file formatting options
and how to export the bounds. You can select the label button if you want to export the bounds as a string
("00-FF") or click the numbers button to export the bounds as two delimited numbers. You can also
include headings with the exported data.

To open the Export Histogram Options dialog box from the Histogram window, click Export Histogram
from the File menu, and then click the Options button.
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Measuring Histogram Data

Overview

There are two basic ways of using the Histogram window to analyze data. One is to provide a graphic
overview of the address activity of software execution. The other is to use counters or timers to measure
specific events.

If you want to use counters or timers to measure events, set up the counters or timers in the Trigger
window. You can then select the data source in the New Data Window wizard when you create a Histogram
window or select the source from the Data Source properties tab for an existing Histogram window.

Viewing Address Activity

To provide an overview of the address activity of a software routine, define a set of ranges (numeric,
logarithmic, or symbolic). Then you can set up the Trigger window to look for data within the defined
ranges. The data is processed and displayed in the Histogram window for the current acquisition.

If you set up the logic analyzer to repetitively acquire data, the sampling errors will decrease over time
as you acquire more data. The resultant data provides a stable display in the Histogram window where
you can view the overall activity of the software.

You can use this method of analyzing data to determine which sections of code are being accessed or not
accessed. You can also determine the time spent in a routine relative to other areas of code.

Measuring Counter or Timer Events

To measure an event, define a starting point, a target event, a counter or a timer, and a stopping point in
the Trigger window. Use the Data Source properties tab to select the counter or timer as the data source
for your analysis. When you acquire data, the Histogram window displays the minimum, maximum,
and average value of the counter or timer data.

Related Topics
Defining Histogram Ranges (see page 225)

Selecting the Histogram Data Source (see page 226)

Defining Histogram Ranges

1. In the System window, click the Histogram data window icon.
2. From the Edit menu, click Properties.

3. Click the Ranges tab in the Properties dialog box.
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. From the Define Ranges Using list, click Linear Generation, Log Generation, or Symbols.

. If using Symbols, select a symbol file.

4
5
6. Select a radix.
7. Specify the bounds.
8

. Click OK.

TIP. Define the data source before you define the ranges.

Click to open the Properties dialog box.

Click Default Ranges to return to the default range settings.

Selecting the Histogram Data Source

In the System window, click the Histogram data window icon.

From the Edit menu, click Properties.

Click the Data Source tab in the Properties dialog box.

Select the new data source from the list or click Add Data Source to add data from a saved data source.

Select the group or a Counter/Timer source if defined in the Trigger window.

Click OK.

AN

TIP. Click = 1o open the Properties dialog box.

Set up the groups in the Setup window and the counters or timers in the LA Trigger window before you
select a histogram data source.
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Source Window

Overview

The Source window displays source code that you wrote, correlated with the executed (disassembled)
code acquired by the logic analyzer and displayed in the Listing window. You can monitor actual code
execution and correlate it directly with your source code statements. The logic analyzer links the Source
and Listing windows, and provides additional tools to help you view the code and data.

Behavior

The Listing window displays an execution trace of the object code derived from the source files. The
relationship between the acquisition data and the specific source is determined by examining the debug
information stored in the executable file that was created by code creation tools such as compilers, linkers
and loaders. The specific file being displayed, the cursor positions, and user-defined marks in the file are
automatically updated as you use the controls in the Source window and the associated Listing window.

The source statements in each of the source files displayed in the Source window have associated address
ranges that define the memory locations occupied by the microprocessor instructions that implement the
statement. The address ranges determine the mapping from samples in the Listing window to statements in
the Source window. The address ranges must be absolute. The Source window does not support code that
is dynamically relocatable. The address group that you use depends on whether you use a disassembler.
The disassemblers typically set up address groups for the specific support package.

Because Source windows interact with associated Listing windows, you may want to display both windows
at the same time. Moving the cursors in the Source window moves the cursors in the associated Listing
window, and moving the cursors in the Listing window moves the cursors in the Source window.

Source Window Structure

The Source window consists of three main components; the Source toolbar, the Source control bar and
the Source data area.

B The Source toolbar provides access for tools to change the appearance of the data area and to search
for data. A Scan Listing field specifies the search direction in the Listing window when you move the
cursors in the Source window.

®  The Source control bar provides means for stepping through data, stepping between marks, and
scrolling through data. These controls directly affect the active cursor in the associated Listing window
and indirectly affect the active cursor in the Source window.

B The source data area displays the contents of the source file. This area is also used to display diagnostic
messages if the Source window is unable to display a source file. When the window displays a source
file, the header displays the path of the file.
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Marks and Cursors

Marks and cursors identify specific statements in source files. Marks consist of horizontal lines and may
include highlighted blocks of text signifying individual source statements.

B Marks you can move are: Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1 and Cursor 2 are located at the top of the
window. The numbers in the readouts indicate the line number position of the cursor in the source file.

® Only one of the two cursors is active at a time. An active cursor appears as a solid horizontal line; an
inactive cursor appears as a dashed line.

B Marks on the left side of the window are data area marks. These marks are in the part of the source file
that is currently visible in the window. Use data area marks to move within the data area.

®  Marks on the right side are overview marks. These marks show where marks are located within the
entire source file. Use overview marks to move throughout the source file.

m  Marks are only visible in the currently displayed source file. Marks and cursors in other source files
are not shown in the overview area.

® Double clicking a mark opens the Marks properties tab. You can assign a unique name to the Mark in
the Mark Name field.

B You can add marks using the Add Mark toolbar button. Remove a mark by selecting it and using the
Cut toolbar button. When you add or paste a mark it appears in the center of the display.

® You can add a mark at a specific source statement by right-clicking the source statement and then
selecting Add Mark Here from the menu. If the line in the source window contains multiple source
statements, you can add marks to the individual statements.

B You can move to any mark, including those is other source files, by using the Go To toolbar button.

B Marks are saved in the Source window with system setups so they can be made available for use
when you load a saved system.

Cursors 1 and 2 Moveable marks used for visual reference and for data
= measurements.

T P = §

——and =

User mark User-created marks. Use marks to make specific data

easier to identify and find.

Related Topics
Listing Window (see page 185)

Moving Through Source Files (see page 229)

Symbol Files (see page 341)
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Symbols Dialog Box (see page 346)

Moving Through Source Files

Overview

You can move through source files from the Source window or from the Listing window. Moving
a cursor in one window will cause the corresponding cursor to move to a corresponding location in
the other window.

Use the Step Forward or the Step Backward buttons to step through source statements in execution order in
the Source window. You can also use the Next Mark or the Previous Mark buttons to jump to the next
or previous executed source statement that has a user-defined mark.

o | S S
] |

Step F orwand Mext Mark
Step Backward Previous Mark

Use the cursor controls in either window to move the cursors. You can also move the cursors in either
window by clicking and dragging the cursor handles or by adjusting the cursor list box controls.

For more information on moving the cursors, click one of the buttons below.

®  Source-Relative Cursor Positioning
® Listing-Relative Cursor Positioning

Behavior

There are situations when you move the cursor in the Listing window to a location where there is no
corresponding source statement. The cursor in the Source window remains at the current location and
changes the color of the Source window to signify an uncorrelated state exists between the Source and
Listing windows. When this happens click the Step Forward or the Step Backward buttons to search for an
executable source line in the Listing window; this correlates the active cursors in both windows.

Clicking the Step Forward or Step Backward buttons forces the Listing window to search for a data sample
that corresponds to the next or previous line of executed source code. The line of executed code may be
in a different source file. If this happens, the Source window will display the required file or prompt

you for a path name. The ability to locate source files depends on the Search Path List and Suffix List
defined in the Source Files properties tab.

Related Topics
Step Forward and Step Backward Buttons (see page 231)
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Next Mark and Previous Mark Buttons (see page 231)

Active Cursor Readout (see page 232)

Source Files Properties (see page 237)

Uncorrelated State

The Source window enters an uncorrelated state when the active Source window cursor is moved to a
statement that was not executed and captured in the acquisition memory. An uncorrelated state also
occurs when the active Listing window cursor is moved to a sample with an address for which there is
no corresponding symbol information in the loaded symbol file.

When the Source window becomes uncorrelated, the window displays text in a different color:
the uncorrelated color. You can change the color of the uncorrelated state in the Source Window
properties tab.

To return the Source window to a correlated state, click the Step Forward or the Step Backward
button in the Source window.

Scan Listing Mode

230

Overview

The Scan Listing box is used to specify which direction to search in a Listing window when you move the
cursor in the Source window.

Behavior

The following options for the Scan Listing field are available:

Later — The Listing window scans samples executed after the sample identified by the active cursor.
Earlier — The Listing window scans samples executed before the sample identified by the active cursor.

Ask — When you change the position of the active cursor in the Source window, the Scan Listing dialog
appears and prompts you to specify the scan direction.

Auto — The Source window automatically selects the scan direction in the Listing window. The scan
direction is based on the relative position of the new and old cursor.

Moving the cursor between statements in the Source window does not necessarily move the cursor in the
same direction in the Listing window. This can happen, for example, if the statement in the new location
was executed both before and after the statement in the old location, such as when the statement is in a loop.
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Step Forward and Step Backward Buttons

Overview

Use the Step Forward and Step Backward Buttons to trace the order of execution of source statements.
Click the Step Forward button to move to the next executed source statement. Click the Step Backward
button to move to the previous executed source statement.

Behavior

When you click the Step Forward or Step Backward buttons, the Source window tells the Listing window
to search forward or backward beginning at the active Listing cursor for the next or previous executed
source statement. When a match is found, the Listing window positions the active Listing cursor to the
matching sample. The Source window converts the address from that sample to a file name and line
number, and then updates the active Source cursor position to the corresponding source statement. The
statement may be located in a source file that is different than the original displayed file. In this case, the
new file is displayed and the cursor is placed on the proper statement.

A single line in the Source window may consist of more than one statement on a single line, for example:
for (i=0; i < NUM_STATES; i++)

The ability of the Source window to discriminate between multiple statements on the same line depends
on the amount of information provided by the code-generation tools. If there is enough information to
identify multiple statements per line, the Source window cursors will include character highlighting to
identify individual statements on a line.

Related Topics
Moving Through Source Files (see page 229)

Next Mark and Previous Mark Buttons (see page 231)

Next Mark and Previous Mark Buttons

Overview

Use the Next Mark and Previous Mark buttons to move the active cursor in the Source window to the next
or previous user-defined mark position (if any marks have been defined). Next and previous refer to the
execution sequence and not to the position of the mark in the window.

Behavior

The Next Mark and Previous Mark buttons operate similarly to the Step Forward and Step Backward
buttons. However, rather than stepping through every executed statement, you can define marks in the
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Source window as breakpoints and then step between marks in execution order to move though the source
code. You can use the Next Mark and the Previous Mark buttons to get around loops or acquired code
that you are not interested in viewing.

When you click the Next Mark or Previous Mark buttons, the Source window tells the Listing window
to search for addresses corresponding to the marked source statements. When a corresponding sample
is found, the Listing window positions it’s active cursor to the matching sample. The Source window
converts the address to a file name and line number, updates the active Source cursor position, and then
displays the corresponding source statement.

If the code generation tools provide column information for symbol files, you can mark individual
statements of multiple statement lines in the source code. You can then use the Next Mark and Previous
Mark buttons to step between the marks and highlight the individual statements.

The Next Mark and Previous Mark buttons are not active if there are no marks defined in the Source
window.

Related Topics
Moving Through Source Files (see page 229)

Step Forward and Step Backward Buttons (see page 231)

Active Cursor Readout

232

Overview

The Source window Active cursor readout displays the address of the source statement at the active
cursor. The address shown is the low address bound of the source statement as indicated by the loaded
symbol file, not the value of the address group in the listing window. The radix of the address is always
hexadecimal. If you position the cursor on a nonexecutable statement, such as a comment or white space,
the address of the next executable statement is displayed.

i |G

Behavior

You can also use the Active cursor readout to jump to a new location in the source file. Enter an address in
this field and the active cursor moves to the corresponding statement. If you enter an address that does not
correspond directly to the address of a source statement, the next statement is used and the address adjusted.

You can copy and paste the readout value into other locations such as in the event portion of the Clause
Definition dialog in the LA Trigger window.
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Source Files Edit Dialog Box

Overview

The Source window uses a single file name to locate the source files. Use the Source Files Edit dialog box
to specify a list of paths to the locations of source files in the file system. You can also specify a list of
source file suffix entries in the Source Files properties tab.

Behavior

The appearance of the dialog box depends on which option (Search Path List or Suffix List) is selected
in the Source Files properties tab. If the Search Path List is selected, the title of the dialog box displays
Modify Search Path List; if the Suffix List is selected, the title of the dialog box displays Modify Suffix
List. The selection box is blank if you clicked Add to access the dialog. If you clicked Edit to access the
dialog, the selection contains the highlighted entry from the Source Files properties tab.

To Use

When you enter the dialog box to add or edit the search path, you can enter a path in the Selection field.
Often the source files will be located on a networked drive. You can click Browse to specify a search path
to the networked drive or to any other directory in the file system.

When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory.

For example, to specify the following path:
C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk in the following is invalid:
C:\MySources\*\*
or

C:\MySources\abc*

NOTE. When you specify a search path or file suffix, make sure that the source file you are looking for
has a unique file name or file suffix. When searching for source files it is possible to load the wrong file if
there is another file with the same name and suffix in the directories specified by the search path. The
Source window loads the first file that matches the search criteria.

To open the Source Files Edit dialog box from a Source window, click the Properties toolbar button, click
Source Files, and then click either Add or Edit.
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Related Topic

Source Files Properties (see page 237)

Source Go To Dialog Box

Use the Source Go To dialog box to move in the source code. Double-click a cursor or mark from the
displayed list to go to the mark in the Source window.

To open this dialog box, open a Source window and click fﬁ

Scan Listing Direction Dialog Box

Use the Scan Listing Direction dialog box to specify the direction to search for samples in the associated
Listing window. This dialog box displays when the Scan Listing field in the Source window is set to Ask
and you move the cursor in the Source window by dragging the cursor, adjusting the cursor line number,
or doing a search.

Click << Earlier to search for samples from the present active Listing cursor position towards the beginning
of data. Click Later >> to search forward from the active Listing cursor.

Related Topic
Scan Listing Mode (see page 230)

Source Window Search Dialog Box
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Overview

Use the Source Window Search dialog box to search for text patterns in the current file or in all source files
identified by the loaded symbol file.

Behavior

When searching for data in multiple files, the search operation follows the order of files as listed in the
Source Window properties tab in the Displayed Source File list. When you search for data in all files and
one or more of the files cannot be found, the Source File Locator dialog box displays asking you to
specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box displays the status
of the search operation. You can allow the search to continue or you can click the Abort button to halt
the search.
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To Use

To open the Source Window Search dialog box, open a Source window and click i .

Enter an ASCII value in the pattern field and click the search direction. The search string can include
leading and embedded white space. Trailing white space is ignored.

Related Topic

Source Window Properties (see page 236)

Source File Locator Dialog Box

The Source File Locator dialog box appears when a source file cannot be located. This may happen
under the following conditions:

®  When you first attempt to create a new Source window

B When you move the active cursor in either the Source window or the Listing window
B When you do a text search

B When you select a different source file while in the Source Window properties tab

This dialog box appears when the Source window searches for source files and is unable to find the files as
specified in the Search Path List and Suffix Lists specified in the Source Files properties tab.

Specify the path of the source file or click Browse to select a path.

In some cases, there may not be an available source file to load. If this happens, you can provide an empty
placeholder file to prevent the Source File Locator dialog box from appearing.

TIP. When specifying the search path use an asterisk (*) as the final component of a search path directory.
For example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character, and the wild card character
may only be used as the last character in the search string. For example, the use of an asterisk is invalid
in the following:

C:\MySources\*\*
or

C:\MySources\abc*
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NOTE. The wild card character may only be used in the source path, and only as the last character in
the search string.

Related Topics

Source Files Properties (see page 237)

Source Files Edit Dialog Box (see page 233)

Source Window Properties

236

Overview

Use the Source Window properties tab to change the appearance and content of the Source window.

Behavior

® Display Line Numbers turns line numbers on or off. Turn the line numbers off if you need more
room to display the source file.

® Font Size selects the size of the displayed text and the line numbers.

m Tab Spacing specifies the spacing between tab columns.

NOTE. You may need to adjust the tab spacing if the highlighting is incorrect. Use the same tab spacing
values as in the editor that you used to create the source files. If you are unsure of the actual setting, you
may need to experiment with tab settings until the highlighting is correct.

m Foreground Color specifies the color of displayed text and line numbers.
® Background Color specifies the color for the data area background.

B Uncorrelated Color specifies the color of the text in the Source window when the active cursor position
in the Source window does not correlate to the active cursor position in the Listing window.

®  Color Scheme sets the colors shown in the Source window. The color scheme can be user-defined
colors, as specified in the Color tab. Access the Color tab by selecting Options from the System menu.

m Displayed Source File lists the source file currently displayed in the Source window. To view the entire
path name of the source file, click the About Data tab. The path name also appears in the source code
column header in the Source window.

To Use

To open the Source Window properties tab, open a Source window and click in the toolbar.
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TIP. You can also double-click the header in the data area to open the Source Window properties tab.

Source Files Properties

Overview
Use the Source Files properties tab to define the location of source files in the file system.

The Source Files properties tab lists the directories to search for the source files in the file system. It also
lists the file suffixes to try attaching to the file names provided by the compiler (used for compilers that
do not include the source file suffix).

Behavior

The Source window uses the file path and file suffix in combination to locate the correct source file. It
searches for the file name in each directory indicated by the file path list in the order specified. If a
file name does not have a suffix, then suffixes from the suffix list are tried until a match is found or all
file path and suffix combinations are exhausted.

B Select Search Path List to specify source file locations; select Suffix List to specify possible file suffixes.
B (Click Add to add items.

B Click Edit to edit the selected items.

B Click Delete to delete a selected entry from the list.

B Check the box at the bottom of the Source Files properties tab to save the file paths and suffixes
as defaults.

When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory.

For example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk is invalid in the following:

C:\MySources\*\*

or

C:\MySources\abc*

Specify the complete absolute (not relative) path name for the file in the Search Path List. Otherwise the
Source window will not locate the source file. Make sure that the source file you are looking for has a
unique file name. When searching for source files it is possible to load the wrong file if there is another file
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with the same name in the directories specified by the search path. The Source window always loads the
first file that matches the search criteria.

The format of the file path information can take the form of a file path, a file path list file, or both. Each
entry is prefaced with either Path: or Path File: to indicate which type of information it contains. For
example:

Path: C:\Program Files\TLA700\Samples\Source Files
Path File: C:\My Documents\filePathList.txt

Note that the file path list can contain numerous file paths, which are searched according to the order in
which the paths appear in the file. In addition, both file paths and file path lists can be listed in the Source
Files tab of the Properties dialog box. In this case, the paths will be searched according to the position of
the entry in the Source Files tab, and according to the order in which the paths appear in the file path list file.

NOTE. When using file path list files to define the location of source files in the file system, either DOS or
UNIX end of line controls are acceptable.

Because some compilers do not include a source file suffix, you may also need to specify the correct file
suffixes in the file suffix list (examples of correct file suffixes are: .c .cpp , and .s). The Source window
always loads the first file that matches the criteria in the file suffix list.

The logic analyzer searches for files using both lists from top to bottom. Therefore, you should place the
most likely search path and file suffix at the beginning of the lists.

To Use

To view the Source Files properties, open a Source window, click in the toolbar, and click the
Source Files tab.

NOTE. The wild card character may only be used in the source path, and only as the last character in
the search string.

Related Topics
Source Files Edit Dialog Box (see page 233)

System Source Files Properties (see page 374)
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Source Window Data Properties

Overview

Use the Data properties tab to specify Source window attributes. You can specify the Listing window, data
source group (Listing window column), and symbol file.

Behavior

When working with disassembled data, the quality of a disassembler ’s fetch prediction and queue tracking
will determine the quality of the source correlation. You should consider using Mark Opcode to fix
any disassembly problems across gaps.

TIP. Load your microprocessor support package and set the Listing window disassembly mode to Software
before you create the Source window. The software disassembly mode filters out non-instruction cycles to
make it easier to view and trace data in the Listing window.

To Use
B Select a Listing window from the list of all currently available Listing windows containing data.

B Select a data source from the selections based on the Listing window. The data source can be data from
an installed module or from a saved data file.

B Select a column (data group) from the selected data source. In most cases, you will want to select a
microprocessor address column. Timestamp columns, Sample columns, and groups without assigned
data signals are not available as data groups for this purpose.

m  Select a symbol file that contains the source code symbols from a list of all loaded symbol files. Valid
symbol files include those that correspond to the data group column (when used with a symbolic
radix). The symbol file can be the executable file that has been compiled and linked for debug or a
TSF format file.

® [f the symbol file has not yet been loaded, click Symbol File to browse and load a symbol file.

To view the Source window Data properties, open a Source window, click in the toolbar, and click
the Data tab.

Related Topic
Tektronix Symbol File Format (TSF) (see page 350)
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Source Window Marks Properties

Use the Marks properties tab to format marks in the Source window. You can also enter comments for
any marks that you have added. Changing a mark in the Source window does not affect the marks in the
Listing window.

To view the Source window Marks properties, open a Source window, click in the toolbar, and click
the Marks tab.

TIP. You can also open this property page by double-clicking a mark in a Source window.

Source-Relative Cursor Positioning

240

Overview

Source-relative cursor positioning refers to updating the Listing window cursor position as a result of
changing the position of the active cursor in the Source window.

Behavior

When you move the Source window active cursor to a new statement, the Source window determines
the address range of the source statement based on information from the loaded symbol file. The Source
window uses the Scan Listing mode setting to determine the search direction in the Listing window.

The Listing window searches the acquisition data for a matching address. When the matching address is
found, the active cursor in the Listing window is moved to the matching sample. If the Source window
cursor is moved to a nonexecutable statement, such as a comment, the address of the next executable
statement is used.

To Use

You can move the Source window cursor directly in the Source window using the following methods:
® Clicking or dragging the cursor handles

m Using the cursor list box controls

B Entering an address in the Active Cursor Readout

® Right-clicking the mouse and selecting Move Cursor 1 (or 2) Here

®m Doing a search
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Listing-Relative Cursor Positioning

Overview

Listing-relative cursor positioning refers to updating the Source window cursor position as a result of
changing the position of the active cursor in the Listing window.

Behavior

When you move the Listing window cursor to a new sample, the active Source window cursor attempts to
move to a corresponding source statement in the Source window. The Source window uses information
from the loaded symbol file to convert the address of the Listing cursor position to a source file name and
statement (line number) location. The Source window then updates the active Source window cursor
position and displays the corresponding source statement.

To Use

You can move the Listing window cursor using the following methods:

®  Clicking the Next Mark or Previous Mark buttons in the Source window

®  Clicking the Step Forward or Step Backward buttons in the Source window
® Directly by using the controls in the Listing window

B Indirectly by locking cursors to another Listing or Waveform window

Tracing the Execution of Source Code

1. In the System window, click the Source data window icon.

2. Click :I (Step Forward) or :I (Step Backward) to move the cursor to the next or previous
executed statement.

3. The cursors in the Source window, and in the associated Listing window, will advance to the next or
previous executed source code statement.

Getting Out of a Loop in a Source Window

This procedure assumes that you have a Source window and a Listing window open.

1. In the Source window, locate the code for the loop.
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2.
3.

Position the cursor on an executable statement outside of the loop.

Right-click the mouse and click either Move Cursor 1 Here or Move Cursor 2 Here (depending on
which cursor is active).

Setting a Trigger from Source Window Data

242

This procedure assumes that you have a Source window and a Listing window open.

1.

7.

In the Source window, position a cursor on the statement of interest so that the address displays in
the Active Cursor Readout.

Select the address in the Active Cursor Readout by double-clicking the left mouse button.

Copy the address to the clipboard by selecting Copy Text from the Edit menu, or by typing the
CTRLA+C key combination.

Open the Trigger window for the LA module.
Click the If-Then button to open the Clause Definition dialog box.

Click Group and paste the address into the group value field by selecting Paste Text from the File menu
or by typing the CTRL+V key combination. The radix for the group value must be set to Hex.

Click OK.

When you start the acquisition, the logic analyzer will be set to trigger on the group address.
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Packet Structure Description Language

Overview

Packet Structure Description Language or PSDL is used for describing and creating protocols. It is based
on the Abstract Syntax Notation One (ASN.1). A complete description of the syntax and notation used can
be found in the International Telecommunication Union X.680 document. For a high level overview on
PSDL syntax and notation, select one of the related topics.

Use PSDL to define packet structures in the Protocol Editor pane of the Protocol Designer Window.
The PSDL files have the .spz protocol file suffixes. For more information on PSDL, click on one of
the links below.

Syntax

Overview

You can use PSDL to edit standard protocols or create your own. The symbols and conventions used in the
PSDL are described in the related topics. PSDL uses Abstract Syntax Notation One (ASN.1).

An ASN.1 item consists of a sequence of characters listed in the ASN.1 Character table.
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ASN.1 Characters

AtoZ atoz Oto9

General rules for ASN.1 items are as follows:

PSDL is case sensitive.

Most items appear on a single line and do not contain white space.

Line length is unrestricted.

Items in production sequences may appear on more than one line.

Items in production sequences may be separated by white space, empty lines, or comments.

Items must be separated from each other by white space, newline, or comment if the following item
begins with a character that is allowed in the preceding item.

For information on the following syntactical items, click one of the related topics.

Related Topics

ASN.1 Types (see page 252)

Length and Value Expressions (see page 261)

Packet Structure (see page 245)
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PSDL Additions to ASN.1 (see page 258)

PSDL Types (see page 258)

Tags (see page 262)

Miscellaneous Commands (see page 262)

Type Definitions (see page 250)

Value Definitions (see page 261)

Packet Structure Definition

PacketDef: DescrList PacketTypeDef TypeValueDefList (see page 250)

DescrList: empty

| Descr DescrList

Descr: DESCRIPTION "::=" cstring
BIT_ORDER "::=" BitDecodeOrder
| DECODING_RULES "::=" EncRules

EncRules: BER
| BASIC_PER_ALIGNED
| BASIC_PER_UNALIGNED

PacketTypeDef: PACKET "::=" typereference

Operators

The assignment operator (::=) defines a type reference (assigning a name to a type definition):

TypeRefName ::= Type

Type can be another type reference or a basic type (such as BYTE HEX, BIT BIN, or
PSDL _SEQUENCE).

The semantic of a type reference is that it can be replaced by its definition. For example, given

TypeRefl ::= BIT_DEC { LENGTH(4) }
TypeRef2 ::= BYTE_DEC { LENGTH(2) }
TypeRef3 ::= PSDL_SEQUENCE {

fieldl TypeRefl,

245



Packet Structure Definition Language (PSDL) Operators

246

field2 TypeRefl,

field3 TypeRef2

}

Packet ::= TypeRef3

The definition of the Packet is equivalent to:
Packet ::= PSDL_SEQUENCE {

fieldl BIT_DEC { LENGTH(4) 1},
field2 BIT_DEC { LENGTH(4) 1},
field3 BYTE_DEC { LENGTH(2) }
}

NOTE. In the above statements, fieldl, field2, field3 are the field names of three components that constitute
the Packet Structure.

The field name is required if the value of a field is to be used in the LENGTH expressions of other fields,
for example:

PSDL_SEQUENCE {

Tength BYTE_DEC{ LENGTH(2) } "Length Field",
data BYTE_HEX { LENGTH(length - 2) } "Data Field"
}

It is a good idea to always specify an internal name. It can be omitted, because the standard ASN.1 syntax
allows it to be omitted.

The expression syntax of LENGTH expressions is:

EXpr: "(" Expr ")"
| Expr "+" Expr
| Expr "-" Expr
| Expr "*" Expr

| Expr "/" Expr
| Expr "%" Expr
| number

| identifier
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| PACKET_LENGTH
| REST_LENGTH
| ALIGN n(n EXpr‘ ll)ll

The "identifier" refers to a field name, PACKET LENGTH is the total length of the frame,

REST LENGTH is the length of the not yet decoded frame, and BYTE HEX { LENGTH(ALIGN(4)) }
tells the decoder to make the field long enough so that it ends on a four byte boundary (for bit strings, the
alignment is counted in bits).

The VALUE expression tells the encoder how to compute the value of a field. For example,
PSDL_SEQUENCE {

dat_len  BYTE_DEC { LENGTH(2) } VALUE(LENGTH(data)),

data BYTE_HEX { LENGTH(dat_Ten) } USER_DATA

}

This specifies that the value of ’dat len’ is the length of the data field. Because you are in a decoding only
environment, you will never have to deal with VALUE expressions.

Control Statements

The syntax for a PSDL tag is as follows:

PsdlTag: ’'[’ offset ’,’ Tagval ']’ or

[’ ABSOLUTE offset ’,’ Tagval ’]’

offset: decimal_value

Tagval: binary_value or hex_value

The units for the offset are bits for binary value and bytes for hex_value.

The offset is relative to the point in the packet data stream that has to be decoded next, unless ABSOLUTE
is specified, which means relative to the start of the frame. Offsets can be negative, therefore it is possible
to match bits before the point in the packet data stream that will be decoded next. The following example

shows PSDL._CHOICE statements:

IpContents ::= PSDL_CHOICE {

[50 ABSOLUTE, ’00000000000000°’B] user_data BYTE_HEX { LENGTH(total_length -
(ih1 * 4)) } USER_DATA "Data",

[50 ABSOLUTE, ’'x’B] frag_data BYTE_HEX { LENGTH(total_length - (ih1 * 4)) }
"Fragment Data"

H

247



Packet Structure Definition Language (PSDL) Loop Statements

In the above structure, if bits 50 through 63 (counting from 0) relative to the start of the frame are all zeros,
then user data is selected, otherwise frag data is selected.

The PSDL_CHOICE statement can be used like an If-Else statement. You cannot refer to fields directly in
PSDL CHOICE:s. In other words, you cannot use field names here.

You can avoid a given number of bytes or bits in a packet being decoded by skipping the bytes or bits in
the packet data stream.

To skip bits or bytes, use the key word NODISPLAY. NODISPLAY means that the field is not shown in
the monitor window. It can be used as follows:

BIT_BIN { NODISPLAY LENGTH(3) }

This skips three bits from the point in the packet data stream that was already decoded, and continues
decoding.

BYTE_HEX { NODISPLAY LENGTH(1l) }

This skips one byte from the point in the packet data stream that was already decoded and continues
decoding.

Loop Statements

248

You can decode fields with loop statements using the UNTIL (*xxxx’H) statement. You can have up to
4 bytes within the UNTIL statement.

Phrase: :=BYTE_ASCII { UNTIL(’ODOA’H) }

This statement tells the compiler to start decoding the packet data from hexadecimal bytes to ASCII
characters until it sees the data ‘0x0D’ immediately followed by ‘0x0A’.

Use the UNTIL statement in PSDL octet/bit strings instead of the LENGTH expression. The UNTIL
statement specifies that the field extends up to the point where the UNTIL pattern matches. The following
example shows a field that extends up to (and includes) the next CR/LF.

BYTE_ASCII { UNTIL(’ODOA’H) }

The UNTIL statement can also be used for PSDL_SETs to specify where the set ends. The following
example shows a set of ElemType fields that end at the first null byte (not part of the set).

PSDL_SET UNTILC’00’H) { [0, 'xx’H] set_elem ElemType }

This can be mixed with a LENGTH expression. For example:

PSDL_SET OF LENGTH(10) UNTILC’00°H) { ... }

This means the set ends either after 10 octets or if a null byte is encountered, whichever happens first.
The UNTIL statement can also be used with a PSDL_SET statement as

HeadSet ::= PSDL_SET UNTIL(’ODOA’H)

{



Packet Structure Definition Language (PSDL) Sample PSDL Program

[0, ’xx’H] param_line ParamLine
b
ParamLine: :=BYTE_ASCII { UNTIL(’ODOA’H) }

The above statement sets a loop for the ‘ParamLine’ field type, which continues until the packet data
equals ‘0x0D’ immediately followed by ‘0x0A’.

Sample PSDL Program

The following sample program and its explanation are intended to give you a high-level overview of a
protocol definition file in PSDL.

For the purposes of this example, assume that the Packet A structure below has two header fields, Address
and Length, followed by the Information field.

Address Length Information
1 byte 2 bytes variable length (rest of frame)

The protocol definition file is shown below.

DESCRIPTION::= "Packet A"
DECODING_RULES: :=BER
PACKET: := PacketA

PacketA::= PSDL_SEQUENCE {

address Address "Pkt_Address",
Tength Length "Pkt_Length ",

info Information " Pkt_Information "
}

Address::= BYTE_HEX{LENGTH(1)}
Length: := BYTE_HEX{LENGTH(2)}

Information::= BYTE_HEX {LENGTH(REST_LENGTH)}

Packet Description

The DESCRIPTION is assigned to the packet description string that specifies the protocol name whose
definition is written and other details such as: RFC details, Standard details, or Version details. The
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description string appears with the protocol filename in various "Protocol Designer" dialog boxes (Open
Protocol dialog, Save Protocol dialog). Refer to Packet Structure Definition below for information
on specifying the description.

Decoding Rules

This is an optional field. The DECODING RULES:s assigned to the type of decoding rules. Refer to
Packet Structure Definition below for information on specifying the description.

Packet Structure Definition
Consider the following line of code:
PACKET: := PacketA

This statement specifies which type in the type definition list defines the packet structure. If this statement
is omitted, the first type definition is considered to be the packet type (in this example the PACKET
statement can be omitted).

Consider the next few lines of code:
PacketA: := PSDL_SEQUENCE {

address Address "Pkt_Address",
Tength Length "Pkt_Length",

info Information "Pkt_Information"

}

In the preceding code, the PacketA structure is defined as having the following three fields: "address",
"length", "info". The address field is of type "Address" with field label "Pkt Address". Similarly, the
length field is of type Length with field label "Pkt Length" and the info field is of type "Information"
with the field label "Pkt Information".

For more information, refer to Protocol Stack, SPZ Files, Packet Structure Overview (see page 266).

Related Topic
Defining a Protocol (see page 268)

Type Definitions

TypevalueDefList:
TypevalueDef
| TypeDefList TypevalueDef

TypevalueDef: TypeDef
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| valueDef (see page 261)

TypeDef: typereference "::=" AsPhType

| pefaultTag

DefaultTag: EXPLICIT TAGS
| IMPLICIT TAGS

| AUTOMATIC TAGS

AsPhType: AsTag (see page 262) AsType (see page 252) Open UserbData (see page 262)

| PhType Open UserbData (see page 262)

CompTypeList: CompType

| CompTypeList "," CompType
CompType: NamedType

| NamedType OPTIONAL

| NamedType DEFAULT value
| COMPONENTS OF SubType
AltTypelList: AltType

| AltTypeList "," AltType
AltType: NamedType
NamedType: PhTag OptIdentifier SubType AttributeList
optIdentifier: identifier
| empty

SubType: AsPhType
OptSizeConstraint:

constraint

| SizeConstraint

| empty
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Type References

Name

The name used for type references is typereference.

Rules

B A type reference consists of one or more letters, numbers, and hyphens.

B The first character must be upper case and a hyphen cannot be used as the last character.

Identifiers

Name

The name used for identifiers is identifier.

Rules

B An identifier consists of any number of letters, digits, or hyphens.
m The initial character is upper case.

B A hyphen cannot be the last character nor be followed by another hyphen.

Empty Item

Name
The name used for empty items is empty.

Rules

® Contains no characters

ASN.1 Types

AsType: AsSequence
| AsSequenceof

| AscChoice

| AsSet

| Assetof
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| AsAnyDefbyCase
| AseEllipsis
| AsTerminal
OptConstraintList

| typereference

OptConstraintList

AsSequence: SEQUENCE "{" CompTypeList "}"
AsSequenceOf: SEQUENCE OptSizeConstraint OF
optIdentifier SubType AttributeList

AsSet: SET "{" CompTypeList "}"

AsSetoOf: SET OptSizeConstraint OF
optIdentifier SubType AttributeList
AsChoice: CHOICE MsgChoiceiInd "{" AltTypeList "}"
OptConstraintList:

empty

| optConstraintList Constraint

AsTerminal: BOOLEAN

| OCTET STRING

| REAL

| AsInt

| AsSEnum

| AsBitStr

| NullType

| ANY DefinedBy

| OBJECT IDENTIFIER

| NumericString

| PrintableString

| TeletexString

| videotexString

| visibleString

| IAS5String
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| GraphicString
| Generalstring
| BMPString

| Universalstring

| UTF8String

AsInt: INTEGER "{" NumberList "}"

| INTEGER

ASEnum: ENUMERATED "{" EnumNumberList "}"

AsBitStr: BIT STRING "{" NamedBitList "}"

| BIT STRING
EnumNumberList: NamedEnumNumber

| EnumNumberList "," NamedEnumNumber

NamedEnumNumber: identifier EnumNumber

EnumNumber: "(" Intval ")"

| empty

NumberList: NamedNumber

| NumberList "," NamedNumber
NamedNumber: identifier NamedNumberval
NamedNumberval: "(" signedNumber ")"

| empty

NamedBitList: NamedBit

| NamedBitList "," NamedBit

NamedBit: identifier "("number ")"

DefinedBy: DEFINED BY identifier

| empty
AsETll4ipsis:

NullType: NULL
Type: BuiltinType
| ConstrainedType

BuiltinType: NullType
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ConstrainedType: Type Constraint

Constraint: "(" ConstraintSpec ExceptionSpec ")"

CconstraintSpec: SubtypeConstraint

ExceptionSpec:
| empty
ExceptionIdentification:
SignedNumber

SubtypeConstraint:

ElementSetSpecs

ElementSetSpecs: RootElementSetSpec
| RootElementSetSpec "," "..."

[ "..." "," AdditionalElementSetSpec
| RootElementSetSpec "," "..." ","
AdditionalElementSetSpec
RootElementSetSpec:

ElementSetSpec
AdditionalElementSetSpec:
ElementSetSpec

ElementSetSpec:

Unions

Unions: Intersections

| UElems UnionMark Intersections

UElems: unions

Intersections: IntersectionElements

| IElems IntersectionMark IntersectionElements

IElems: Intersections
IntersectionElements:
Elements

Elems: Elements
UnionMark:

| UNION

ExceptionIdentification

ASN.1 Types
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IntersectionMark: "A"
| INTERSECTION
Elements: SubtypeETements

| "(" ElementSetSpec ")"
SubtypeElements: Singlevalue
| valueRange

| PermittedAlphabet

| sizeConstraint

Includes: | empty

valueRange: LowereEndpoint ".."
LowereEndpoint: LowerEndvalue

| LowerEndvalue "<"
UpperEndpoint: UpperEndvalue

| "<" UpperEndvalue
LowerEndvalue: value

| MIN

UpperEndvalue: value

| MAX

SizeConstraint: SIZE Constraint
PermittedAlphabet:

FROM Constraint
SingleTypeConstraint:
constraint

valueConstraint: Constraint

| empty

PresenceConstraint:

| empty
Singlevalue: value
value: Builtinvalue

| Referencedvalue

Builtinvalue: Integervalue

UppereEndpoint

ASN.1 Types



Packet Structure Definition Language (PSDL)

| Booleanvalue

| Characterstringvalue
Integervalue: SignedNumber

| identifier

Booleanvalue: TRUE

| FALSE

Characterstringvalue:
RestrictedCharacterstringvalue
RestrictedCharacterstringvalue:
cstring

SignedNumber: number

| "-" number

Referencedvalue:

Definedvalue

ASN.1 Types

Character String Item

Name

The name used for character string items is estring.

Rules

B A cstring consists of any number of graphic symbols and spacing characters.

B A cstring may span more than one line of text.

B Control characters cannot be represented in a cstring.

B White spaces that appear immediately before or after the end of the cstring have no significance.

257




Packet Structure Definition Language (PSDL)

PSDL Additions to ASN.1

Number Item

Name

Rules

The name used for number items is number.

B A number consists of one or more digits.

B The first digit cannot be zero unless the number item is a single digit.

PSDL Additions to ASN.1

AsAnyDefbyCase: ANY DEFINED BY identifier CASE "{" OptCaseList "}"

OptCaselList: CaselList
| empty
CaseList: CaseElement

| CaseList CaseElement

CaseElement: 1IdentOrNum EN TRY SubType

| AseEllipsis
IdentOrNum: 1identifier

| number

PSDL Types
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PhType: PhSequence
| PhChoice

| PhSetLenCnt

| Phsetuntil

| PhTerminal OptConstraintList

PhSequence: PSDL_SEQUENCE "{" CompTypeList "}"
PhChoice: PSDL_CHOICE MsgChoiceInd "{" AltTypeList "}"
PhSetLenCnt: PSDL_SET OF LengthCount "(" Expr ")" optuntil

MsgChoiceInd "{" CompTypeList "}"
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optuntil: empty

UNTIL "(" EndTag ")"

LengthCount: LENGTH

COUNT

Phsetuntil: PSDL_SET UNTIL "(" EndTag ")" "{" CompTypeList "}"

PhTerminal: MAC_ADR

IP_ADR

IPV6_ADR

SPC

SLS

CIC

BCD_STRING "{" Decod LengthSpec "}"

BYTE_HEX "{" offset Decod LengthuntilSpec CommSpec "}"
BYTE_BIN "{" offset Decod LengthuntilSpec CommSpec "}"
BYTE_DEC "{" Reverse Offset Decod LengthuntilSpec CommSpec "}"
BYTE_SDEC "{" Reverse Offset Decod LengthuntilSpec CommSpec "}"
BIT_HEX "{" Decod LengthSpec CommSpec "}"

BIT_BIN "{" Decod LengthSpec CommSpec "}"

BIT_DEC "{" Reverse Decod LengthSpec CommSpec "}"

SESSION_LI "{" Decod "}"

ASN1_TAG "{" Decod "}"

ASN1_LI "{" Decod CommSpec "}"

BYTE_ASCII "{" offset Decod LengthuntilsSpec CommSpec "}"
BYTE_EBCDIC "{" offset Decod LengthuntilSpec CommSpec "}"

BREAK_LAYER

offset: empty

RELATIVE TO END

Decod: empty

NONDISPLAY
NONDEC

BitDecodeOrder
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Reverse: empty

| REVERSE

LengthuntilSpec: LengthSpec
| UNTIL "(" EndTag ")"

LengthSpec: LENGTH "(" Expr ")"

val: hstring
| bstring

| number

| SignedNumber

| cstring

commSpec: empty

| COMMENT " (" cstring ")"

| COMMENT " (" CommList "," cstring ")"
| COMMENT " (" CommList ")"

commList: Comment

| CommList "," Comment

Comment: "[" val "]" cstring

Hexadecimal String Item

Name
The name used for hexadecimal string items is hstring.
Rules

B An hstring consists of any number of the following characters: ABCDEF0123456789,
preceded by a single quote and followed by ‘H.

B White space and newlines are allowed, but within an hstring have no significance.
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Binary String ltem

Name

The name used for binary string items is bstring.

Rules

B A bstring consists of any number of zeros or ones, preceded by a single quote and followed by ‘B.

B White space and newlines are allowed within a bstring, but have no significance.

Value Definitions

valueDef: iddentifier valueNotation

valueNotation: INTEGER "::=" number

| OCTET STRING "::=" hstring

| visibleString "::=" cstring

| OBJECT IDENTIFIER "::=" "{" oObjIdCompList "}"

ObjIdCompList: ObjIdComp

| objIdCompList ObjIdComp
ObjIidComp: identifier Rest
| number

Rest: empty

| "C" Numorid ")"

NumorId: number

| identifier

Length and Value Expressions

EXpI“: ll(ll EXpI" ll)ll

| Expr "+" Expr
| EXpI" n_n
| Expr "*" Expr

| Expr "/" Expr
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Tags

PhTag:

Expr "%" Expr

number

identifier must not contain

PACKET_LENGTH
REST_LENGTH

ALIGN II(II EXpI" ll)ll

"[" Tagoffset ABSOLUTE Tagval "]"

empty

Tagoffset: 1Intval

Tagval: hstring

bstring

AsTag: empty

"[" Tagoffset Tagval "]"

"[" class number "]1" ImplExp]l

Class: empty

UNIVERSAL
APPLICATION
PRIVATE

ImplExpl: empty

IMPLICIT

EXPLICIT

EndTag: hstring

bstring

Miscellaneous Commands

262
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Attribute AttributeList
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Attribute: ShortName

| shortName "/" LongName
| PROTECTED

| MULTIPLE

ShortName: cstring
LongName: cstring
Intval: Sign UnsignedIntval
unsignedIntval: number
BitDecodeOrder: MSBF

| LSBF

MsgChoiceInd: empty

| MSG

Sign: +

| o

| empty

Open: empty

| OPEN

UserData: empty
| USER_DATA

| USER_DATA "(" didentifier ")"

Reserved Words (Ab to Con)

Reserved Words (Ab to Con)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White

space does not occur in these sequences.

ABSENT ABSOLUTE ALIGN

ANY APPLICATION ASN1_LI

ASN1_TAG AUTOMATIC BASIC_PER_ALIGNED
BASIC_PER_UNALIGNED BCD_STRING BER

BIT BIT_BIN BIT_DEC

BIT_HEX BIT_LENGTH BIT_ORDER
BMPString BOOLEAN BREAK_LAYER

BY BYTE_ASCII BYTE_BIN
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BYTE_DEC BYTE_EBCDIC BYTE_HEX

BYTE_LENGTH BYTE_SDEC CANONICAL_PER_ALIGNED
CANONICAL_PER_UNALIGNED CASE CER

CHOICE CiC COMMENT

COMPONENT COMPONENTS CONDITIONAL

Reserved Words (Cou to Max)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

COUNT DECODING_RULES DEFAULT
DEFINED DER DESCRIPTION
DISP_GROUP ENCODING_RULES END

ENTRY ENUMERATED EXCEPT
EXPLICIT FALSE FRAME_BEGIN
FRAME_END FROM GENERIC_TYPE
GROUP GeneralString GraphicString
IA5String INDENTIFIER IGNORE
IMPLICIT INCLUDES INTEGER
INTERSECTION IP_ADR IPV6_ADR
ISO646String LENGTH LSBF
MAC_ADR MANDATORY MAX

Reserved Words (Min to Ta)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

MIN MSBF MSG
MULTIPLE NODISPLAY DONDEC

NUL NumericString OBJECT
OCTET OF OPEN
OPTIONAL OVERLAY PACKET
PACKET_LENGTH POS PRESENT
PRIVATE PROTECTED PSDL_CHOICE
PSDL_SEQUENCE PSDL_SET PrintableString
RANGE REAL RELATIVE
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Reserved Words (To to Wi)

REST_LENGTH REVERSE SEQUENCE
SESSION_LI SET SIZE

SLS SPC STATION
STRING T61String TAGS

Reserved Words (To to Wi)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

TO TRUE TeletexString
UNION UNIVERSAL UniversatString
UNTIL USER_DATA USER_PART_ID
UTF8String VALUE VideotexString
VisibleString WIDTH

Lexical Iltems

Overview

In addition to reserved words there are other lexical items used in PSDL. The conventions and syntax
regarding their usage vary based on the item. Click the name for details on each item.

Lexical item Name

Type references typereference
Identifier identifier

Value references valuereference
Module references modulereference
Empty item empty

Number item number
Character string item cstring

Binary string item bstring
Hexadecimal string item hstring
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Module References

Name

The name used for module reference items is modulereference.

Rules

B A module reference consists of one or more letters, numbers, and hyphens.

B The first character must be upper case and a hyphen cannot be used as the last character.

B A module reference is distinguished from a type reference by the context in which it is used

Value References

Name
The name used for value reference items is valuereference.

Rules

B A value reference consists of any number of letters, digits, or hyphens and is distinguished from
an identifier by the context in which it is used.

Protocol Stack, SPZ Files, Packet Structure Overview

The PSDL programming is similar to ASN.1 programming that defines a protocol definition. The protocol
file has the .spz file extension.

Prerequisites
To write protocol files, you need to be familiar with the following concepts:

B The protocol stack definition to which the packet structure maps; the stack definition should follow
the packet structure.

B  The packet structure that encapsulates the protocols of higher layers

B Knowledge of all fields of the protocols mentioned in the stack and the relation between protocols

Protocol Stacks

A protocol stack is made up of protocols at different layers. The most common four layers in a network
stack are:

® Link Layer
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® Network Layer
B Transport Layer
B Application Layer

Stacks are defined using the protocol layers. Each layer (box) is a protocol. There can be many protocols
in a given layer. For example, transport layer protocols are TCP and UDP, and link layer protocols are
PPP and Ethernet.

RIFP._R1 | DME R1 | SHMP_R1
unP_R1

1

L_T.ﬂ

i

Differences Between Link Layer Packets and Packets at Higher Layers

A link layer packet structure maps an entire protocol stack. The link layer packet header contains the
network layer packet headers. The network layer packets contain the transport layer packet header and the
application header and data.

Other packets (above Link layer) map a part of the stack. For example, a PPP packet is a link layer
protocol that maps the entire stack, and a TCP packet is a transport layer protocol that maps a part of the
stack file (TCP->Telnet, TCP->FTP).

What is Defining a Protocol?

Defining a protocol means writing the protocol packet header definition using PSDL. Each protocol file
in the stack has the .spz extension. For example, a PPP protocol file definition consists of the following
PPP header fields: Flag, Address, Control, and Protocol. Similarly, an Ethernet protocol file definition
consists of the following header fields: SFD, Destination, Source, and Type/Length. A TCP protocol file
definition consists of TCP header fields.

Defining a Protocol Structure

Use a top-down approach to define the packet structure. Note all of the possible packet formats that map
the stack. For example, consider the stack in the last illustration.

The possible packet formats of PPP frames are shown below (the square brackets refer to a packet header
that contains another packet):
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® PPP[IP[UDP[HTTP ]]]. In this example, PPP encapsulates an IP header, which in turn encapsulates
a UDP header. The UDP header encapsulates HTTP.

= PPP[IP[UDP[SNMP]]]
= PPP[IP[TCP[FTP]]]

= PPP[IP [ TCP [ TELNET ]]]
® PPP[IP [ UDP[DNS]]]

m PPP[IP [ UDP [RIP]]]

Start defining the protocol by writing the .spz file in the Protocol Editor.

Related Topic
Defining a Protocol (see page 268)

Defining a Protocol

268

Use the following guidelines to define a protocol:

Describe the protocol

Normally, this will be a single string assigned to the DESCRIPTION keyword using the following syntax:
DESCRIPTION: :=<string>

For example:

DESCRIPTION: :="IP - Internet Protocol, RFC791"

Specify the Decoding Rules
In the next few lines, specify the decoding rule using the DECODING RULES keyword.
DECODING_RULES ::= <rule name>

The rule name can be one of the following: BER, DER, CER, BASIC PER ALIGNED,
BASIC PER _UNALIGNED, CANONICAL PER_ALIGNED, or CANONICAL PER UNALIGNED.

For example:

DECODING_RULES ::= BER
Consider the following stack definition:
Protocol4

Protocol3
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Protocol2
MyProtocol

The bottom-most layer is MyProtocol. A MyProtocol packet encapsulates higher layer protocols in the
data field (the packet header consisting of Protocol2, Protocol3, and Protocol4).

You can start writing a protocol definition for MyProtocol using PSDL.
DESCRIPTION: :="IP - Internet Protocol, RFC791"

DECODING_RULES ::= BER

Hand the Length of the Protocol Packet to the Protocol Layer
To hand the length of the MyProtocol packet to the MyProtocol layer, use the following syntax:
PACKET ::= PSDL_SEQUENCE OF LENGTH "("PACKET_LENGTH")" "{"PacketName"}"

Specify the PacketName. It can be the protocol name with a Packet suffix (for example, HTTP_Packet, or
IP_Packet). The following example uses MyProtocol Packet as the PacketName:

PACKET ::= PSDL_SEQUENCE OF LENGTH ( PACKET_LENGTH ) { MyProtocol_Packet }

Further Define the Packet Using PSDL Structures

Continue defining the packet using the following syntax:

PacketName ::= PSDL_SEQUENCE

g

<field name> <type name> <field Tabel>
nyn

The <field name> variable is a user-defined string starting in lower case letters. This variable is optional
and is used to improve the readability of the specification.

The <type name> variable is a user-defined string for the field type and begins with an upper-case letter.

The <field label> variable is an optional user-defined string (normally the packet field name) that will be
displayed in the field column of the decode view.

For example:

MyProtocol_Packet ::= PSDL_SEQUENCE
{

fieldl Fieldl "Fieldl",

Tength Length "Length",

address Address "Address",

type Type "Type",
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payload payload "Payload"
}

In the example above, MyProtocol Packet is a structure with five components. The first component

is called field1 (starts with a lower-case letter) and denotes the data type field Fieldl (starts with an
upper-case letter). The second component is called length and denotes the data type field Fieldl. Here
the packet decoder takes the data bytes from the packet at the beginning of the packet and relates them
to the defined MyProtocol structure. It takes the first byte at the beginning of the packet, relates it to
Fieldl, the next byte to Length, the next two bytes to Address, and the following nibble to Type. It then
assigns the remaining items to Payload.

Specify the Type and Size of Each Field
Specify the type and size of each field as shown below:

Fieldl ::= BYTE HEX { LENGTH(1)} Length ::= BYTE HEX { LENGTH(1) } Address ::=
BYTE_HEX { LENGTH(2) } Type ::= BYTE_BIN { LENGTH(4) } Payload ::= BYTE _HEX { LENGTH
(REST LENGTH) } USER_DATA

In the above example, Fieldl is a byte-oriented data type (BYTE_*) with the size of one byte. Similarly,
Length and Address are byte-oriented data types with the sizes of one byte and two bytes. Type is a
bit-oriented data type (BIT *) with a size of four bits. The Payload data type is a byte-oriented hex
string within the MyProtocol layer. When you tag the Data field with USER DATA, this indicates that
the contents of the field have to be handed to the next protocol layer.

The line BYTE_HEX { LENGTH (REST_LENGTH) } USER_DATA means hand the rest of the frame to
the next protocol layer (for example, Protocol2).

Note that PACKET LENGTH and REST LENGTH can only be used in length expressions such as:

TypeBla ::= BYTE_HEX {LENGTH(REST_LENGTH) }

Related Topics
Sample PSDL Program (see page 249)

Create New Protocol Files (see page 293)
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Protocol Window

Overview

The Protocol window supports protocol decoding across multiple levels of a stack. Use the Protocol
window to view and evaluate acquisition data. The Protocol window has three panes: Packet View, Decode
View, and Hex View. Each pane displays the acquisition data at different resolution levels. To open a
Protocol window from the Window menu, click New Data Window and then select Protocol from the list.

Acquisition data is typically analyzed one block of samples at a time. This makes the analysis faster and
uses less memory. The range of samples currently analyzed is displayed in a readout in the Packet View
title bar. To change the position and size of the block of samples to analyze, go to the Protocol Framing
Options properties tab (see page 277).

NOTE. Load either a protocol support package into your system or a user-defined framer before you can
add a Protocol window. The Protocol window requires the framing setup from the protocol support
package or user-defined framer to display the protocol.

Packet View

The Packet View displays all the packets of the current acquisition along with the Time stamp information.
Erroneous packets are displayed in red.

Marks

Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time, and mark specific samples for evaluation.

B Add user marks by clicking the “+ button.

m Delete user marks by right-clicking the mark handle, and then selecting Delete from the right-click
menu.

B Marks you can move are Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the mark
handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta Time)
between the two are located at the top of the data area.

®  Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

® The System Trigger mark is fixed, you cannot move it.

®  Marks on the right side are overview marks. These marks show where marks are located relative to the
entire acquisition. Use overview marks to move throughout the acquisition. For example, move Cursor
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1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and select
Cursor 1. You can also click the right mouse button on any overview mark, and then click Go To Mark.

B You can move to any mark using the Go To toolbar button.

Decode View

The Decode View decodes the protocol parameters of the packet selected in Packet View and displays
them line by line. Each protocol parameter size is displayed as well as any comments contained in the
description file associated with the protocol. The protocol stack that is currently in use determines which
protocol parameters are shown.

Hex View:

You can choose one of the following formats to display the packet selected in Packet View in the Hex
View pane:

m Hex

= ASCII

HEX+ASCII

BINARY

If you select an individual protocol parameter in Decode View, the corresponding values are highlighted in
Hex View.

Related Topic
Protocol Design (see page 285)

Compilation Result Pane
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Overview

The Compilation Result pane is where the results of compiling are displayed.

Behavior

Double-clicking an error message in the Compilation Result pane highlights the line with the error in the
Protocol Editor pane.

Related Topic
Protocol Editor Pane (see page 287)
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Frames and Framers

The following information provides high-level answers to questions regarding frames and framers.

What is Framing?

Frames are logical groupings of information sent as data layers. Frames are basically data and control
information that flow between link layer devices and physical layer devices. The cells or packets received
from network layers are transformed into frames by link layer devices and passed on to physical layer
devices. This entire process is known as framing.

What is a Generic Framer?

A generic framer is an application that processes acquired data from the logic analyzer (data and control
information) from any bus that carries packetized data. It works on any type of bus that connects the
link layer and physical layer devices.

What is a Bus-Specific Framer?

A bus-specific framer is an application that processes acquired data from the logic analyzer (data and
control information) from a particular bus that only carries packets. Tektronix supplies framers for the
SPI-3 TX and RX , SPI-4.2 LVDS, and LVTTL TX and RX buses.

What is the Difference Between Generic Framers and Bus-Specific Framers?

Bus-specific framers require their corresponding support packages. The packets created by the bus-specific
framers are exact packets. Generic framers add more information to the packets that need to be decoded
using protocol definition files. As a result, you may not get exact packets if you use a generic framer.

What are the Limitations of the Generic Framer?
The generic framer has the following limitations:

B Scrambling is not supported.

B Fragmentation is not supported.

B Encoded data will be framed "as is."

B Transmit and receive busses cannot be linked.

B Only multiples of 8-bit bus widths are supported.

® In some cases, additional information is added to the packets depending on the specified field
conditions. You can further decode the packet using protocol definition (Protocol Designer).
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When Should You Use the Generic Framer?

When setups do not have associated bus-specific framers, the Define Bus check box in the New Protocol
Window wizard is automatically selected. If a specific framer is available, the Define Bus box is cleared.
However, you can enable the check box even if a specific framer is available.

Use the generic framer when the information (cells, packets, and control words) flowing on a bus is
captured and framed by the logic analyzer. The Protocol window displays the decoded framed packets.

Protocol Filter Setup Dialog Box
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Overview

The Protocol Filter Setup dialog box allows you to selectively filter specific packets from the acquired
data. You can choose to filter all packets based on the protocols and their fields.

Behavior

The filter options are active when you select the Enable Filter check box. This dialog box contains all the
Filter Options: Fields, Operation, Value, and Format. You can select an item from the Fields, identify the
Operation, and specify the Value and the Format.

The Protocol drop-down list shows all the protocols contained in the stack. When you select a protocol,
its fields are listed in the Field box. When you select an item from the Field box, its value (if any),
is displayed in the Predefined Values.

Select the Enable Fields check box to filter the packets based on the specific fields. If you clear the Enable
Fields check box, you can filter the data based on the selected protocol.

You can specify the values in any of the following formats: Decimal, Hex, ASCII or Binary.

To Use

Click *° (the Filter Setup toolbar button) to access the Filter Setup dialog box.

Use this dialog box to define operations and value for the filter. By default, the filter is not enabled. To
enable the filter, select the Enable Filter check box.

Related Topic
Filtering the Protocol Display (see page 284)
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Protocol Properties: About Data Tab

Overview

The Protocol Properties: About Data tab provides information about the data source used for the active
data window.
To Use

From the Protocol window, click the button and then click the About Data tab. This is a read-only tab.

Protocol Window Properties Tab

Overview

The Protocol Window properties tab allows you to view or change the default settings of Protocol window.

Behavior

You can change the background color settings of all three panes and enable or disable the grid lines in
the Packet View pane.

To Use

From the Protocol window, click the button and then click the Protocol Window tab. Click the

Background drop-down list to select a background color. Use the Grid Lines check box to enable or disable
the grid lines in the Packet View and Hex View panes.

Protocol Column Properties

Overview

The Column properties tab allows you to view or change the column settings in the Packet View pane of
the Protocol window.
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Behavior

The drop-down Column list shows all columns from the current acquisition. Select the column that you
want to view or change from the drop-down list. Use the width box to change the width of the selected
column; you can enter a value or use the arrows to change the width.

To hide a column, clear the Show Column selection. The column properties are retained when you want
to display the column again.

You can specify a fixed column color by selecting Fixed in the Color section and then selecting one of the
fixed colors. You can also use the same color as an existing column by selecting Same As in the Color
section and then selecting the column from the drop-down list.

When you select the time stamp column, you can use the Time Stamp Reference selection to set the
reference point for calculating time stamps. The Time Stamp Reference selection is only available for
time stamp column.

To Use
From the Protocol window, click one of the columns and then click button. The selected column

appears in the Column drop-down list. If necessary select the column that you want to update and use the
other settings in the dialog box to change the column width or color.

Protocol Color Properties Tab
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Overview

The Protocol Color Properties tab allows you to view or change the color settings of the protocols in the
Packet and Decode View pane of the Protocol window.

Behavior

The Protocol Color Properties tab lists all the protocols present in the current acquisition and the available
color options. Select a color for each protocol. The selected color is used for display in the Decode View

of the Protocol window. A preview is displayed in the Protocol Properties Color tab. This tab allows you

to set default colors for all the protocols.

To Use
From the Protocol window, click the button, and then click the Color tab. Select the protocol from the

Protocol list. Use the Color for Protocol drop-down list to select the color for the protocol. Click the Set
all to default button to change the color to black for all protocols.
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Protocol Marks Properties Tab

Overview

The Protocol Marks properties tab allows you to view or change the color settings of marks placed in the
Packet View pane. You can also associate a comment for each mark. The Protocol Marks properties tab
lists all the marks and cursors placed in the Packet View. Selecting Show Hairline allows you to enable or
disable the hairline properties.

Behavior

Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time and mark specific samples for evaluation.

To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Marks tab. Use the Marks drop-down list to select a mark. Use the color drop-down list to select
the color for the mark. Enter any comments into the comment text box. Use the Show Hairline check box
to enable or disable the hairline properties of the mark.

Protocol Framing Options Properties Tab

Overview

The Protocol Framing Options Properties Tab allows you to set the range of samples in the acquisition
memory to analyze and frame. This tab also allows you to set bus-specific settings, such as the port address,
bus width, and other settings for the packet data bytes that have to be framed. You can enter framing
options for the framer support provided for the specific communication bus, such as the port address.

Behavior

Analyzing data can be memory intensive. It is best to analyze acquisition data in blocks of approximately
100, 000. Use the Start and Number of Samples settings to specify the ranges of samples to analyze.
You can experiment to find the optimum block size for your situation. The samples are analyzed when
you exit the property sheet.

If the bus definition for acquiring data is user-defined, there are no framing options on the Framing
Options tab.

If you select Frame Across Gaps, the acquisition will not be considered for framing.
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To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Framing Options tab. Enter the port address in the Port Address text box and other options
pertained to the bus-specific framers. Use the Enable Gaps check box to enable and disable gaps.

Protocol Search Dialog Box

Overview

The Protocol Search dialog box allows you to search in the Packet View pane of the Protocol window.

Behavior

This dialog box contains all the Search Options. You can select a protocol from the Protocols drop-down
list. The Search Options are: Fields, Operation, Value, and Format. You can select an item to search for
from the Fields, identify the Operation, and specify the Value and the Format.

You can specify the Value in Decimal, Hex, ASCII, or Binary formats. You can clear the Enable Fields

check box and search on the selected protocol. The search is completed once for each packet of data. If
the search is successful, the packet is highlighted in the Packet View pane and the corresponding packet
information displays in the Decode View pane.

To Use

From the Protocol window, click the ) button to open the Define Search dialog box.

Use this dialog box to define operations and specify the value for the search. Select either <<Back or
Forward>> buttons to search before or after the current cursor position.

Export Protocol Data Dialog Box

278

Overview

The Export Data dialog box allows you to export data to a text file in a location that you choose. You can
choose options that customize what will be exported.

Behavior

Use the Export Data dialog box to export data from the current Protocol window to an ASCII text file. You
can export the following Protocol data:

B All packets from the acquisition
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® A range of packets between two selected marks
B A range of packets between two packet indices

If you choose to export the protocol data to a text file, you can click Options to define the format of the
data. The data is saved in a file with the .txt extension.

To Use

Place the cursor in the Protocol window, and click Data> Export to display the Export Data dialog box.

New Protocol Display Window

Overview

Use this dialog box to create a new Protocol Display window. To access the dialog box from the Window
menu, select New Data Window....

Behavior

Select Data From if you want to use a data source from the current system. If the data source you want is
not listed, click the Add Data Source button to add a data source from the TLA system or logic analyzer
file to the current system. You can also click the Browse button to search for a desired TLA system file.

Select No data to create an empty Protocol Display window.

Checking the Define Bus check box activates the Select Bus dialog box. Use this dialog box when you
want to select a different bus from the data source. You can also create a new bus or modify an existing
bus to meet your needs.

NOTE. If your data source does not have a framer associated with it, the Define Bus check box is
automatically selected. Choose an existing bus or define a new one.

To Use

Specify the data source for your new data window or select No data: Check the Define Bus check box to
define your own bus or clear the check box if you want to use the bus from the data source. Click Next,
and then enter a name for the new Protocol window. Click Finish to create the new window.

Related Topic
Creating a New Protocol Display Window (see page 283)
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Select Bus Page

Overview

The Select Bus page allows you to select a Bus from a list of Available Bus Definitions. You can also
create a new bus or edit an existing bus.

Behavior

Clicking either the New...or Edit... button will activate the Define Bus Dialog Box. Clicking Next
attaches the selected bus to the data source.

To Use

To attach an available bus to your data source, select the bus definition from the list and click Next. If
you want to define a new bus, click New.... To modify an existing bus, select that bus from the list of
available busses, and then click Edit....

Define Bus Dialog Box
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Overview

Use the Define Bus dialog box to modify an existing bus or create a new one. You can select groups from
drop-down lists and then define the data patterns by entering data in the adjacent boxes.

Behavior

The Bus Name text box contains information on a bus that you can edit. For a new bus nter a unique name
in the text box. By default, MyBus displays in the Bus Name text box for a new bus; the text description is
optional. The Field Definition area describes the details of the bus. Use the drop-down lists to define the
field, group name, operation, value, and radix. The Field drop-down list shows all of the groups available
in the Setup window; the group that you select will become the data group of the bus. Use the Group Name
drop-down list to select the group and pattern for the selections for the field selections.

If the packet length is fixed, enter the packet length in bytes in the Packet Length box at the bottom
of the dialog box.

You can enter Binary or Hexadecimal values for Data Valid, Error Condition, Start of Packet, or End of
Packet. You can also use don’t care values.

Fields
B The Data field is a required field.
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®  The Start of Packet (SOP) is an optional selection. Use it to define the SOP condition of the bus. Enter
the data pattern in the Value box. An SOP or EOP condition is expected for packets.

B The End of Packet (EOP) is an optional selection. Use it to define the EOP condition of the bus. Enter
the data pattern in the Value box. When designing the data groups in the Setup window, you need to
maintain the bit and byte order such that the least-significant byte follows the most-significant byte.

B The Data Valid condition is optional and is used for defining the Data Valid condition of the bus.
B The Abort Condition is optional and is used for defining the Abort condition of the bus.

®  The Port Address is optional and only applies to the inbound port address. You can select any group for
the port address. You can enter a mask value for the port address.

® The Port Address Condition is an optional selection. If you enter a port address condition, enter a
port address in the Value box.

To Use

Enter a name and a description for the bus. Use the drop-down lists to define the field, group name, and
operation. If you are comparing the operation against a value, enter the value and the radix. Click the Add
button to add the definition to the list. You can also modify an operation by selecting the operation, making
the change, and then clicking the Modify button.

Stack Definition Pane

Overview

The Stack Definition pane allows you to create or modify protocol stacks and displays the properties of
the selected protocol. A protocol stack is made up of protocols at different layers. There can be many
protocols at a given layer.

Directly below the Stack Definition pane is the Stack Protocol Information pane, which displays the
properties of the selected protocol within the stack.

Behavior

The Stack Definition pane allows you to open, edit, and save protocol stacks as well as adding and deleting
protocols to a stack. In the Stack Definition pane, you can also define and modify relations between
the protocols in a stack.

The Stack Protocol Information pane displays the properties of the selected protocol in the Stack Definition
pane. The application displays properties of the selected protocol classified as name, description, compile
file name with date and time, source file name with date and time, type of relation, and relation parameters.
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Select Stack Dialog Box

Overview

Use this dialog box to select and apply a stack for the current acquisition.

Behavior

The stack that you select has a relationship between the defined protocols. You can select only a single
stack. The stack that you select will be applied to the current acquisition when you click OK. To search for
a stack, enter a stack name in the Search box and then click the Next button.

To Use

From the Protocol window, click Select Stack in the Data menu. Click the stack that you want to use and
then click OK to apply the stack for current acquisition.

Select Stack Page

Overview

Use this wizard page to select a stack from the list of available stacks.

Behavior

Selecting a stack from the list applies the stack to the data source defined in the previous wizard page.

To Use

Select a stack from the list and then click the Next button to continue defining the Protocol window.

Generic Framer Example
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This example shows how the generic framer works for Utopia3 support packages.

Data Acquisition

The logic analyzer acquires the Utopia signals using synchronous sampling. Data and control signals are
acquired on every rising edge of the clock. The control signals are Enb* and SOC. Set up the Data group
and the Control group on the logic analyzer (as described in the following procedure).
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Framing

1.
2.

In the Define Bus dialog box, enter the Bus name, description, and then select the data group.

For the Start of Packet (SOP), select the Control group that contains the SOC and Enb* signals. For
example, if the Control group has the Enb* and SOC signals, enter the value of 01 for the SOP (the
Enb* signal is low and the SOC signal is high to show the start of the cell).

Enter the packet length in bytes. For Utopia the packet length can be 52, 53, 54, or 56. However the
packet length will be fixed for a system.

Acquire the data using the logic analyzer.

The Generic Framer looks for the 01 pattern in the SOP control group. When the pattern is matched,
the framer starts to fill the cells. The data from the present sample is considered as the Start of the cell.

Create your own protocol (for example, Utopia3) and stack using the Protocol Designer for further
decoding of the Utopia3 cells.

A typical Utopia3 cell format consists of the Header with 6 bytes followed by the payload with 48 bytes.
The payload is called SAR (Segmentation and Reassembly) PDU (Protocol Data Unit); it will have
AAL type data.

Limitation

You will be unable to decode beyond SAR PDU. (This limitation also applies to Utopia2 and
Utopia3 support packages and dedicated framers for Utopia2 and Utopia3.)

Setting Up the Protocol Window

Follow these steps to set up the Protocol window: This procedure assumes that a support package is
already loaded on the logic analyzer.

1.
2.
3.

From the Window menu, select New Data Window or click the New Data Window icon in the toolbar.
In the New Data Window dialog box, select the type of data window as Protocol and click OK.

Select Data From, and then select a data source from the list. If the source you want is not listed, click
Add Data Source. Select No data to create an empty window.

If you want to define a bus to attach to the data source, select Define Bus, or clear the check box
to use the bus from the data source.

Select a stack from the predefined list.

Enter a name for the new Protocol window and click the Finish button to view the Protocol window.

Selecting Stacks

Follow these steps to select the stack:
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Eal o

Place the cursor in the Protocol window and click Data > Select Stack.
The Select Stack Dialog Box lists all stack files available in a predefined folder.
Click the stack that you want to apply for the current acquisition.

Click OK to apply the stack for current acquisition.

Filtering the Protocol Display

Follow these steps to filter the Protocol Display:

1.

AU O O

.

Place the cursor in the Protocol window and click Data > Filter Setup to display the Protocol Filter
Setup dialog box.

Enable or disable the filter using the Enable Filter check box.

Select a protocol from the Protocols drop-down list.

Select which fields you want to filter from the Fields text box.

Select the operation to be used to compare field values from the Operation group box.

Specify the value or select predefined values and the format for the selected field. The packets that have
the specified options are filtered and displayed in the Packet View.

Clear the Enable Fields selection to filter the packets based on the selected protocol.
Click OK.

Viewing Decoded Data in a Protocol Window
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Follow these steps to view protocol decoding in a Protocol window:

1.
2.
3.

Acquire data or load a reference memory.
If you already have a stack defined, create a new protocol window.

If you do not have a stack defined, invoke the Protocol Designer window, define the protocols and
compile. If required, use one of the defined protocols from the Add New Protocol dialog boxes under
the stack editor and define the stack.

Apply the stack file to the window and define the framer options. The desired packets from the
acquisition (or reference memory) will be framed and decoded.
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Protocol Setup Window Properties

Overview

The Protocol tab allows you to set up the name, description, and the color of the selected protocol.

Behavior

The Protocol tab displays the current name, description, conditions of protocol relations, and the color of
the selected protocol. You cannot change the conditions of protocol relations in this tab page. You can
select a display color and set the default color. The Preview pane displays a preview of the selected color.

To Use

1. In the Stack Definition pane, right-click the protocol you want to edit. The Protocol right-click menu
appears.

2. From the Protocol shortcut menu, select Protocol Setup... to display Protocol Setup dialog box.

Protocol Relations Properties

Overview

The Relations tab allows you to define and modify relations between protocols in a protocol stack.

Behavior

The relations are viewed from a higher-order level in the protocol stack and are therefore called "on
top of relations".

You can add protocols from the Available Protocols to Current Relations list to create relations between the
protocols. You can define the type of relation as Unconditional, Single Parameter, and Raw Data.

m  Use Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol data
without restriction.

B Use Single Parameter if you want the current protocol to receive data only if a certain parameter of the
carrier protocol accepts one or more values. Enter the exact condition in the Name and Value fields.

B Use Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame to be
checked in the Byte offset, Value and Bit offset fields.
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To Use

1. In the Stack Definition Pane, right-click the protocol you want to define. The Protocol right-click
menu appears.

2. From the Protocol shortcut menu, select Modify Relations.... The Protocol Setup dialog box appears,
displaying the Relations tab.

Stack Definition Display Properties

Overview

The Display properties option allows you to set the foreground color for the protocols. You can also set
the default color.

Behavior

Selecting Set to default will change the foreground color of all the protocols to black.

To Use
1. Right-click in the Stack Definition Pane.
2. Select Display Properties.... The Display Setup dialog box appears.

3. Change the properties as necessary.

Protocol Designer Window
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The Protocol Designer is an Integrated Development Environment (IDE) that combines the functionality
of a protocol and stack editor with a protocol compiler. There are four panes in the Protocol Designer
window. Two of the panes are editors: the Stack Definition pane and the Protocol Editor pane. In the Stack
Definition pane, you can add protocols, define a stack, and create relations between the protocols in a stack.

The Stack Protocol Information pane displays detailed information on a selected protocol including the
relations of that protocol in the stack. The Compilation Result pane displays the results of compiling a
protocol. To open the Protocol Designer window, click the Protocol Designer button on the toolbar.
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NOTE. Tektronix recommends that you create and save new protocols and stacks using the Protocol
Designer tool rather than another editor. You should open and edit existing protocol and stack files using
the Protocol Designer. Avoid editing files directly in the Protocol folder and Stack folder.

Protocol Editor Pane

Overview

The Protocol Editor pane allows you to modify existing protocols or create new ones.

Behavior

Use the Packet Structure Description Language (PSDL) (see page 243) for defining and creating the
protocols.

You can display several protocols in the Protocol editor at the same time. However, you can only edit or
compile one protocol at a time.

When you compile the protocols from the Protocol Editor pane, the results of the compilation are displayed
in the Compilation Result Pane (see page 272).

NOTE. Tektronix recommends that you use the Protocol Editor pane to edit existing protocol or stacks
rather than using other editors.
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Add Protocol Dialog Box

Overview

The Add protocol dialog box allows you to add protocols from the list of compiled protocol files (.tpa).

Behavior

The list displays descriptions for all available protocols. If you select a protocol description, the associated
protocol description file is displayed below the list.

Enter a search string in the Search field to find a certain protocol.

Click Next to search the list for more protocols that match the search string. When you have reached the
end of the list, the search will continue from the beginning.

To Use
1. In the Stack menu, click Add New Protocol... to add protocols to the stack.

2. In the Add Protocol dialog box, select a protocol to add and click OK.

Replace Protocol Dialog Box
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Overview

The Replace protocol dialog box allows you to replace one protocol with a different version of the same
protocol or with a different protocol.

Behavior

The properties (relations and display) of the respective protocols remain the same when replaced with a
different version of the same protocol.

To Use
1. Right-click the protocol you want to replace..
2. From the Protocol shortcut menu, select Replace Protocol... to display the Replace with dialog box.

3. Select the replacement protocol and click OK.
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Save Protocol or Stack Dialog Box

Overview

This dialog box is used to save a stack or protocol file. To access this dialog box from the toolbar in the
Protocol Designer window, select Save, and then choose either Save Stack As... or Save Protocol As....

Behavior

Saving by using a name from the list causes the previously saved file to be overwritten.

To Use

Type the name you want to use to save the Stack or Protocol file and Click Save.

Open Protocol or Stack Dialog Box

Overview

Use this dialog box to open a previously saved stack or protocol. To access this dialog box from the toolbar
in the Protocol Designer window, select Open, and then choose either Stack... or Protocol....

Behavior

When you select an available stack or protocol file and click Open, the selected file displays in the
corresponding editor pane. You can enter a name (either complete or partial) in the Search field and
click Next to search for that file.

To Use

From the Protocol Designer window, click Open and then select either Stack... or Protocol.... Select the
available Stack or Protocol file that you want to open. You can search for the file by typing a name in the
Search text box and then clicking Next.

Delete Protocol or Stack Dialog Box

Overview

Use this dialog box to delete a previously saved stack or protocol. To access this dialog box from the
toolbar in the Protocol Designer window, select Open, and then choose either Stack... or Protocol....
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Behavior

When you select an available stack or protocol file and click Delete, the selected file will be deleted from
the editor pane. You can enter a name (either complete or partial) in the Search field and click Next
to search for that file.

To Use

From the Protocol Designer window, click Delete and then select either Stack... or Protocol.... Select the
available Stack or Protocol file that you want to delete; you can select multiple files and delete them in one
step. You can search for the file by typing a name in the Search text box and then clicking Next.

Import Stack Dialog Box

Overview

Use this dialog box to import a stack exported from another Tektronix logic analyzer or computer.

Behavior

This dialog box operates the same as most Open dialog boxes except that it looks for Stack files with
the .pde file extensions.

To Use
1. Open the Import Stack dialog box, open a Protocol Designer window.
2. From the Stack menu, select Import.

3. Navigate the file system to locate the stack and click Open.

Export Stack Dialog Box
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Overview

Use this dialog box to export an opened stack and all of the protocols that belong to the stack to a .pde file.
You can then use the stack and protocols on another Tektronix logic analyzer or computer.

Behavior

This dialog box operates the same as most Save dialog boxes except that it saves Stack files with the
.pde file extension. The Export selection in the Stack menu is disabled if there is no open stack in the
Protocol Designer window.



Protocol Analysis Add Protocols

To Use

AU o e

Open the Export Stack dialog box, open a Protocol Designer window.

Open a Stack Definition (click the Open button, select Stack, and select an available stack from the list).
From the Stack menu, select Export.

Navigate to the location where you want to save the file.

Enter a file name and enter comments as needed in the comment box.

Click the Save button to export the file to the desired location.

Add Protocols

1.
2.

From the Stack menu, select Add New Protocol... to add protocols to the stack.

In the Add Protocol dialog box, select a protocol to add and click OK.

NOTE. You can search for the protocols that you want to add by using the Search field, and then clicking
Next to find the next occurrence of the search string.

Define Relations Between Protocols

. In the Stack Definition pane, right-click the protocol for which you want to define relations. The

Protocol shortcut menu appears.

In the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,
displaying the Relations tab.

Select the protocols from the Available Protocols list and click Add.

. The Current Relations list displays the added protocols and the existing relations.

To remove any protocol from the Current Relations list, select the protocol, and then click the Remove
button.
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6. In the Type of Relation options do one of the following:

= Select Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol
data without restriction.

= Select Single Parameter if you want the current protocol to receive data only if a certain parameter
of the carrier protocol accepts one or more values. Enter the exact condition in the Name and Value
fields. Enter hexadecimal values preceded by 0x or binary values preceded by Ob.

= Select Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame
to be checked in the Byte offset, Value, and Bit offset fields. Enter hexadecimal values preceded by
0x or binary values preceded by Ob.

7. Click Up or Down to determine the order of the relations, and then click OK.

Go To Protocol Dialog Box

1. Right-click in the Stack Definition pane. The Protocol shortcut menu appears.
2. In the Protocol shortcut menu, select Go to Protocol. The Go to Protocol dialog box appears.

3. From the Go to protocol drop-down list, select the protocol that you want to view, and then click OK.

Delete Protocols

1. In the Stack Definition pane, right-click the protocol you want to remove. The Protocol shortcut
menu appears.

2. In the Protocol shortcut menu, select Remove Protocol to display a message to confirm the deletion.

3. To delete, click Yes. To cancel, click No.

Define Protocol Setup

1. In the Stack Definition pane, right-click the protocol you want to define. The Protocol shortcut menu
appears.

2. In the Protocol shortcut menu, select Setup to display Protocol Setup dialog box.

292



Protocol Analysis Create New Protocol Files

3. In the Protocol tab, do the following:

= Change the name of the protocol in the Name text box, if required.

= Enter a description in the Description text box.

= Use the Color drop-down list to select the foreground color.

Click Default to set the color of the protocol to default.

4. Click OK.

Create New Protocol Files

1. From the Protocol Designer window, click the New toolbar button, and then select Protocol to open a
blank protocol definition file in the Protocol Editor.

2. Define your protocol in PSDL Language (see page 243).

List the description of the protocol. For example: DESCRIPTION::="IP — Internet Protocol,
RFC791"

Specify the decoding rule to be used. For example: DECODING RULES ::=BER

Define the length of each packet in the protocol. For example: PACKET ::=PSDL_SEQUENCE of
LENGTH (PACKET_LENGTH){ PPP_Packet}

Define the sequence. For example: PPP_Packet::= PSDL. SEQUENCE "{" <field name> <type
name> <field label>"}"

Specify the type and size of each variable in the sequence.

NOTE. Tagging the Payload variable with USER _DATA indicates that the contents of that variable are to
be handed to the next protocol layer.

3. Click the Save toolbar button and select Save Protocol As... to display the Save Protocol dialog box.

4. Type a name for the protocol in the Name field and click Save.

5. Click the Compile toolbar button to compile the protocol. After compilation, the Protocol Designer
saves the protocol in .tpa file format.

NOTE. Any errors in the compilation are displayed in the Compilation Result pane.

Type Name

Type name is a user-defined name for the type of a variable. It always begins with an uppercase
character.

293




Protocol Analysis Create New Stack Files

Field Label

The field label is a user-defined, optional name that is displayed in the Field column of the Decode
view. It is usually the same as the packet field name.

Field Name

The field name is a user-defined, optional field that is assigned to increase the specification readability.
The field name always starts in lower case.

Create New Stack Files

A G -

Click the New toolbar button, and then select Stack to display the Stack Definition pane with the Base
layer and stack protocol information.

From the Edit menu, click Add New Protocol to add protocols to the stack.
In the Add Protocol dialog box, select a protocol to add and click OK.

Create (see page 291) or modify (see page 69) relations between the protocols.

The Stack Definition pane displays the protocol and protocol relations.
To save the stack, select Save Stack As From the File menu. The Save Stack dialog box appears.

Type a name for the stack in the Stack Name field, and then click Save.

Replace Protocol Files
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In the Stack Definition pane, right-click the protocol you want to replace. The Protocol shortcut menu
appears.

In the Protocol shortcut menu, select Replace Protocol to display Replace with dialog box.

Select the replacement protocol from the Available Protocols list and click OK.
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Deskew Analysis Window

In the toolbar, click the S/H Analysis button.

Overview

The Deskew Analysis window provides the controls necessary for setting up the Deskew Analysis tool,
displaying the analysis results, and applying the results for use with normal acquisitions. The Deskew
Analysis works independently of the current logic analyzer sampling and trigger program settings. When
you set up and perform the analysis, the current sampling and trigger program settings are not disturbed.
However, you can apply the results to the synchronous sampling selections to improve the ability of
normal acquisitions to find stable data. You can also apply the Deskew Analysis setup and hold violation
settings to the trigger program violation settings.

Behavior

Use the Deskew Analysis window to select the analysis type, initiate analysis, apply analysis results, clear
analysis results, and reset the setup to factory default settings.
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In addition, you can use controls in this window to customize the colors of elements contained in the
results area.
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Toolbar

Click the Define Setup icon, = , to open the Deskew Analysis Setup dialog box to define a new setup or
edit an existing setup. Once you have defined the setup, close the dialog box and then click the Analysis

Type button % - to select an analysis type. To begin the analysis, click the Analyze button. If you want
to apply the results to one of the synchronous sampling modes, click the Apply button. Similarly when
doing a Setup/Hold analysis, you can apply the settings by clicking the Apply button.

Analysis Display Area

The Clock and Scale area displays clock and scale information. A representation of the reference clock 0
point (the point at which the Deskew Analysis reference clock changes) displays on the top, along with a
representation of the analysis range. You can manually set the analysis range from 16 ns before the clock
edge to 8 ns after the clock edge using the controls under the Analysis tab under the Deskew Analysis
Setup Dialog Box (see page 299) (the Clock 0 point is not required as part of the analysis range). The
Clock 0 point enables you to characterize a signal with respect to the reference clock edge. The clock tick
intervals of the displayed search range will reflect the MagniVu resolution of the module being analyzed.

The Analysis Results area displays the Data Valid window or Setup/Hold Violation window analysis
results in graphical format.

Data Valid Window Analysis Mode

In the Data Valid Windows analysis mode, each selected signal is analyzed with respect to the reference
clock edge to determine the regions where the data is stable. This mode determines the transitions between
adjacent MagniVu data samples. If two adjacent samples have the same polarity, they are considered
stable with respect to each other. The Deskew Analysis scans samples throughout the analysis range, two
samples at a time; the results area graphically shows the data valid windows as bars or windows. The bars
or windows appear as elongated eyes. The regions between the data valid windows are regions of invalid
or unstable data (represented by horizontal black lines).

The purpose of the data valid window analysis is to find regions where the data is stable and to pick a
suggested sample point for each analyzed signal. You can then apply the suggested sample points to the
signal setup and hold settings for synchronous sampling by clicking the Apply button in the toolbar.

After making all of the settings in the Deskew Analysis Setup dialog box, click the Analyze button to
start the data valid window analysis. When the analysis is done, the results appear in the Analysis Display
area. The suggested sample points found by the analysis appear as diamond markers. You can readjust the
markers by dragging them or by selecting values to the right of the display area.
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TIP. To set the Deskew Analysis in the data valid window mode, select Data Valid Window Analysis from
the Analysis Type button in the toolbar.

Setup and Hold Violation Window Analysis Mode

In Setup and Hold Violation Window analysis mode, selected signals are collectively analyzed for setup
and hold violations. This analysis mode operates identically to the setup and hold violation trigger
programs that analyze groups for violations. The purpose of the analysis is to determine if the data is
stable in the regions that you analyzed.

The analysis proceeds throughout the defined setup and hold violation window analysis range for each
signal. If any violations are found, they are reported on the entire set of signals being analyzed. Once the
analysis completes, you can apply the range settings to the setup and hold violation trigger settings for
each signal in the application by clicking the Apply button in the toolbar.

You can change the setup and hold violation range values by doing one of the following:

B Manually dragging each setup and hold violation window bar and resizing it to the MagniVu resolution
of the module being analyzed. (Make sure that you select the Setup/Hold Violation Window check box
in the AutoDeskew Properties (see page 301) dialog box so you can drag and resize the window bar.)

®  Selecting values for each signal in the controls to the right of the display area.

m  Using controls in the Deskew Analysis Setup dialog box under the Analysis tab to set the setup and
hold violation range.

You can display graticule lines on both the top and bottom of each group’s results by selecting the Show
Graticule option in the Deskew Analysis Properties dialog box.
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TIP. To set Deskew Analysis in the Setup and Hold Violation Window mode, select Setup/Hold Violation
Window Analysis from the Analysis Type button in the toolbar.

Channel Column

The Channel column displays the group, probe, or user name of the displayed signals. The names depend
on how the signal is selected in the Deskew Analysis Setup dialog box.

Suggested Sample Point Column

For each signal, the Suggested Sample Point column displays the position of the suggested MagniVu
sample found by the Data Valid Window analysis. You can adjust the suggested position for each signal
using the controls for this column. The Deskew Analysis must be in the Data Valid Window analysis
mode to enable and display this column.
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Setup and Hold Columns

For each signal the Setup and Hold column displays the setup and hold analysis range values used for the
Setup and Hold Violation analysis. You can adjust the setup and hold values for each signal using the
controls to the right of the display area.

Deskew Analysis Legend

The legend displays information for the analysis windows. You can use the Deskew Analysis Properties
window to change the color associated with any of the analysis windows. Double-click on the colored
square for any item in the legend to open the Deskew Analysis Properties dialog box.
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Related Topics
Deskew Analysis Properties Dialog Box (see page 301)

Deskew Analysis Setups Dialog Box (see page 302)

Load Deskew Analysis Setup Dialog Box

298

Overview

The Load Deskew Analysis Setup dialog box allows you to load a Deskew Analysis setup from any
saved system setup file. When you select a Deskew Analysis setup, the load operation replaces all the
current Deskew Analysis settings.

Behavior

The operation of the Deskew Analysis Setup dialog box depends on what you select to load. If you select
a module, then the selected setups are added to the module. If you select a setup, then the loaded setup
replaces the one in the Deskew Analysis Setups dialog box.

Use the File Name box to enter the file name containing an Deskew Analysis setup to load or use the
Browse button to browse the file system for a setup. The modules and setup, when found, will be listed in
the Modules and their Setups text box. You can select any setup listed in this box. Once you highlight the
desired setup, you can load the setup by clicking the Load button.

The Modules and their Setups box allow you to highlight a single selection or multiple selections, based
upon the following scenarios:
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B  When you select a setup, the Modules and their Setups box allows you to select only one setup and,
once loaded, it replaces the selected setup.

B When you select a module, the Modules and their Setups box allows you to select multiple setups to
be loaded. This operation loads a copy of the selected setups and adds it to the list of setups for the
selected module.

Click the Load button to load your selected Deskew Analysis setups. The loaded Deskew Analysis setup
either creates a new setup or replaces an existing setup. If the Deskew Analysis setup being loaded uses
groups or signals not included in the module, they are discarded and a message informs you of the setup
revision. When loading, a Deskew Analysis setup will overwrite an existing setup; a message informs you
of the impending change. You can choose to either continue loading the setup or cancel the operation.
Setup naming conflicts are resolved by appending a number to the setup name.

Related Topic
Deskew Analysis Setup Dialog Box (see page 299)

Deskew Analysis Setup Dialog Box

Overview

Use the Deskew Analysis Setup dialog box to edit the settings of a selected setup, add a new setup, and
specify analysis parameters (such as signals and sampling).

Behavior

The Deskew Analysis Setup box displays all module or instrument names and the name of any setups
they contain. Modules that contain one or more setups are listed in < modulename > - <Deskew Analysis
setup name> format.

Click the New Setup button to open the New Deskew Analysis Setup dialog box, which you can use to
specify a new setup. To change the name or description of an existing setup, use the Deskew Analysis
Setups Dialog Box (see page 302).

The Deskew Analysis Mode group box allows you to specify the mode in which the setup will be used.
You can choose between Manual mode and Custom mode.

The Manual mode allows you to define the Signal setups and the Sampling setups in their respective tabs.
In addition, it disables the Deskew Analysis Configurations box, the Deskew Analysis Settings box,
and the Reload Custom Settings button.

The Custom mode derives the settings from the loaded support package if the package includes Deskew
Analysis support (not all support packages have such support). Selecting Custom enables Deskew Analysis
configurations, Deskew Analysis settings and the Reload custom settings button. Custom is disabled unless
a support package with Deskew Analysis support is loaded in the selected module.

The following selections are available when you select the Custom mode:
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®m Reload custom settings
The reload custom settings button reloads the settings from the loaded support package.
B Deskew Analysis configurations

Deskew Analysis configurations lists all of the configurations defined in the loaded support package. You
can create a configuration for each physical configuration of the SUT. If the loaded support package
includes the Deskew Analysis support with multiple configurations, you can select the configuration
from this list.

B Deskew Analysis settings

Deskew Analysis settings lists all of the settings available for the selected configuration. For each
configuration there will be one or more settings. Each setting defines the signals to analyze, a sampling
specification, and a range over which each signal will be analyzed. Using a custom setting allows you
to override the signals to be analyzed, but there is no way to adjust the analysis sampling or the data
valid window analysis range.

Signals Tab

Use the Signal tab to select the signals that you want to analyze and the signals that will have their data
valid window analysis results applied. The data valid window analysis results are applied when you click
the Apply button and specify the settings in the Apply dialog box.

Use the Signals tab to list signals by group, by probe, or by a user-defined name. Then specify the signals
that you want to analyze by selecting the check box associated with each group or signal in the Analyze
column. To specify the signals for which the analysis results will be applied when you click the Apply
button, select the check boxes associated with each group or signal in the Apply column. To select or clear
all Analyze or Apply check boxes, select the check box located next to the Analyze or Apply column title.
By default, when you select an Analyze check box, the related Show check box is selected.

Sampling Tab

Use the Sampling tab to set up the definitions for the Data Valid Window and Setup and Hold Violations
Window analysis. The Sampling tab contains inputs that you use to specify the clock, clock transition
edge, and qualifiers to use for the analysis.

NOTE. When you choose Custom mode, sampling definitions are derived from the support package.
All the controls that normally display on the Sampling tab are hidden. The system displays a message
indicating that the sampling definitions will be handled by the Deskew Analysis setup you selected from
the loaded support package.

Analysis Tab
Use the Analysis tab to specify parameters for Data Valid Window and Setup/Hold Violation analysis.

The Data Valid Window group box contains the Start (Setup) and End (Hold) controls that specify the
beginning and end of the analysis range for all signals. Positive values represent times before the clock
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edge, while negative values represent times after the clock edge. In the Deskew Analysis Manual mode,
the start and end times are applied to all analysis signals and cannot be adjusted on a per-signal basis. In
the Custom mode, these controls are disabled. However, the individual values show the aggregate analysis
range over all signals specified in the loaded custom setting.

Use the Analysis Quality options to control the amount of time that Deskew Analysis uses to perform

the data valid window analysis. Each selection displays the number of samples tested for each pair of
MagniVu bits within the analysis range. For example, if your logic analyzer has 125 ps resolution, the
number of such tests performed over a 24 ns range is 192. The number of samples that are examined
depends on the Deskew Analysis sampling setting. In Deskew Analysis Manual mode using one clock,
the number of acquisition samples examined corresponds to the number of clock edges. In the Custom
mode, the sampling can be very complex such that the number of acquisition samples does not necessarily
correspond to simply looking at a single clock edge.

The Setup/Hold Violation Window group box includes the Start and End controls that specify the setup
and hold violation window analysis range for all signals. Positive values represent times before the clock
edge, while negative values represent times after the clock edge. These controls are not affected by the
Deskew Analysis Custom settings. Use the Stop Analysis Condition options to specify when to stop the
analysis. Select Run to let the analysis continue until you click the Abort button in the progress dialog box.

Deskew Analysis Properties Dialog Box

Overview

The Deskew Analysis Properties dialog box contains controls that affect the display properties of the
Deskew Analysis window.

Behavior

By selecting properties from this dialog box, you control which windows display in the analysis results
area of the Deskew Analysis window, and the colors used to display them. The property selections will not
display in the window if you do not select the check box.

The Show Graticule box allows you to indicate whether to display the graticule and specify the graticule
color. You can also define the following settings for the Deskew Analysis window:

B The Invalid Data Region check box allows you to display the invalid data region using the specified
color.

B The Data Valid Window check box allows you to display the Data Valid Window using the specified
color.

B The Suggested Sample Point check box allows you to display the suggested sample point for each
signal using the specified color.

® The Setup/Hold Violation Window check box allows you to display the Setup/Hold Violation window
for each signal using the specified color.
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® The Current Sample Point check box allows you to display the current sample point for each signal
using the specified color. The actual sample point depends on the current sampling type.

B The Current Sampling Mode group box allows you to select synchronous sampling. The mode you
choose controls the current sample point displayed in the Deskew Analysis window.

Related Topic
Deskew Analysis Window (see page 295)

Deskew Analysis Setups Dialog Box
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Overview

The Deskew Analysis Setups dialog box displays the setups available in all physical modules. You can
also view saved setups that were downloaded from a module that was loaded from another system.

Behavior

You use the Setups group box to manage Deskew Analysis setups. This includes creating, duplicating,
deleting, and renaming setups. The type of setup you highlight in the Setup box (module vs Deskew
Analysis setup) determines the functionality associated with the following toolbar icons. Right-click a
setup to open a menu where you can manage the setups.

Click the New button to open the New Deskew Analysis Setup dialog box. Use this dialog box to create
and name a new setup. When a module or an instrument is highlighted in the Setup box, the new setup is
attached to that module or instrument. When a setup is highlighted, the new setup is associated with the
highlighted setup. You can also use the New Deskew Analysis Setup dialog box to rename an existing
setup.

Click the Load button to open the Load Deskew Analysis Setup Dialog Box (see page 298). Use this
dialog box to load a setup from a saved system file. When a module is highlighted in the Setup box, the
loaded setup is added as a new setup to the selected module or instrument. When a setup is highlighted,
the loaded setup replaces the highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When a setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When a setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module or an instrument is highlighted in the Setup box, clicking the Paste button creates a new
setup from the clipboard contents and attaches it to the selected module or instrument. The logic analyzer
will add an integer to the clipboard setup name; you can change the description as needed. When a setup is
highlighted, clicking the Paste button replaces the highlighted setup with the contents of the clipboard.
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Related Topic
Load Deskew Analysis Setup Dialog Box (see page 298)

Apply Deskew Analysis Results Dialog Box

Overview

The Apply Deskew Analysis Results dialog box allows you to apply the Data Valid Window analysis
results to current sampling mode or the Setup/Hold Violation Window analysis settings to the setup and
hold storage violation or setup and hold event violation trigger settings. You can apply the data valid
window analysis result to only the current sampling mode.

Behavior

The analysis results are applied only to those signals that you select in the Signal Setup tab of the Deskew
Analysis Setup dialog box.

Selecting the Apply Suggested Setup/Hold Window Settings option enables the Sampling Mode box.
Depending on the sampling, the setup and hold alignment values that you specified in the Deskew
Analysis Setup dialog box will be applied to the setup and hold storage violation and event violation. The
suggested sample points are actual MagniVu samples, while the setup and hold alignment values in the
sampling dialog boxes are probe-tip values. Deskew Analysis does the necessary conversion between the
suggested sample points and the setup and hold alignment values. The applied changes will display in
the Deskew Analysis window.

If you select the Four Samples per Clock mode, then the Second Edge Delay group options are enabled.
When you select the Set External Setup/Hold Values, the suggested sample points are used to set the Four
Samples per Clock setup and hold alignment values. The applied changes will display in the Deskew
Analysis window.

When you select Set External Second Edge, the suggested samples are used to set the External Second
Edge Delay values. Deskew Analysis makes the necessary adjustments to the suggested sample point
position to meet the constraints for a second edge delay value if the suggested sample point position
violates those constraints. The applied changes will display in the Deskew Analysis window, but you can
move the suggested sample point positions to meet any constraints.

Selecting the Apply Setup/Hold Violation Settings option disables the Sampling Mode box and Second
Edge Delay group. This option applies setup and hold violation settings. You can adjust the setup and
hold settings on a per-signal basis if they are not consistent with the per-signal alignments of the current
synchronous sampling mode.

Related Topic
Deskew Analysis Setup Dialog Box (see page 299)
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Data Measurements Overview

304

Data measurements can be taken on Waveform and Listing windows.

Overview

You can select the data measurements that you want to take on an active window from a list of available
measurements. Data measurement results are displayed in the Statistics page of the Measurement tab and
updated each time you run an acquisition. You can, however, configure data measurements without the
acquisition data. You can quickly perform counts and averages on your data set. Data measurements can
be exported to a file and saved with your TLA system.

Behavior

When system changes are made that affect the measurement results an icon appears in the Info column
on the Statistics page.

To perform measurement analysis on virtual data, use the Recalc button. Clicking Run does not have any
affect on the measurement analysis results if you are using virtual data.

Changes in the TLA setup or system will effect the data measurements in the following ways:
® [fyou delete a group, the measurement using the group is also deleted.

B [f the active window that had data measurements taken on it is deleted from the system, all the
measurements done on that window are also deleted.

® [f you merge data sources, all measurements taken on that window are removed.
B [f you return to a default setup, all data measurements are removed.

® [oading a TLA data window that had data measurements taken, restores the measurements that were
taken on this window.

®  Data measurements to not include suppressed or filtered samples.

m [f the radix of any group is changed, the results and statistics for measurements done on that group
is also updated.
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m  Measurement results are cleared when the module is turned off and Run is clicked.

B [fthe module is turned on in the System Window, measurement results are updated when you click Run.

LA Measurement Setup

Overview

The Setup page contains the controls necessary to add a new measurement. You can also enable or
disable the measurements listed and specify whether to refresh the measurements results on successive
acquisitions or accumulate results and statistics over multiple acquisitions.

Behavior

The Setup page is affected by the active data window. If no data window is active, then the Measurement
tab is unavailable.

Removing a signal or group from a data window causes the associated measurement to be removed
from the Setup page.

The icons in the Add Measurement group box display measurements that are available to add. You can
create new measurements by dragging and dropping the measurement icons onto the data window display
area. These measurements are then added to the Measurement grid. You can also create measurements by
right-clicking and selecting Add LA Data Measurement from the right-click menu.

For a definition of each measurement, click one of the measurement type buttons:

The Measurements grid contains all the measurements that are added to the active data window.
Selected measurements are enabled. Clearing the Enable check box disables the measurement. When a
measurement is disabled, it will not be computed.

You can rename the measurement in the Name column if you so choose. The Source column reflects the
signal or group on which the measurement is done. You cannot edit the Source column. The Gate column
offers three choices: Display, Cursors, and Full Record for gating. Measurement analysis is immediately
performed whenever this column is changed.

The type of measurement gating determines what samples are used in the measurement analysis.

Gating type Measurement analysis

Full Record—spans across the full memory depth Samples in the full memory depth are used for data analysis.

Display— spans across the visible region Samples in the visible portion of the data window are used
for data analysis.

Cursor— spans between Cursor1 and Cursor2 Samples between Cursor1 and Cursor2 are used for data
analysis.

Measurement analysis is performed when:

B The Gate option on the Setup page is changed.
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® The Gate option is set to Display and you zoom on the active data window.

B The Gate option is set to Display and data is suppressed or suppressed data is shown.

B The Gate option is set to Display and data is filtered.

B The Gate option is set to Cursors and you change the cursor positions on the active data window.

When measurement analysis is in progress, you can abort the analysis by clicking the Cancel button. You
can also recalculate a completed analysis by clicking the Recalc button. This button toggles between
Cancel and Recalc, depending on the state of the analysis.

To Use

Select a measurement by dragging and dropping an icon from the Add Measurement group box to a
data window.

Select the Enable check box from the Measurements grid to enable the measurement. To disable the
measurement, clear the check box. You can also enable or disable all measurements by clicking the Enable
All or Disable All button. You can delete all measurements from the Measurements grid by clicking the
Delete All button, or you can right-click and delete them individually.

The Clear Values button removes the results. If you want to accumulate results over several acquisitions,
select the Accumulate check box. To refresh the results each time the measurements are analyzed, clear
the Accumulate check box.

Data Measurement Statistics
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Overview

This page displays the measurement results and statistics for the active data window. When the active
window changes so will the Statistics page. If the active data window does not have any measurements,
then the Statistics page is empty. The measurements are displayed in the order in which they are added.

For a definition of each available statistic, click here (see page 111):

Behavior

Removing a signal or group from a data window causes the associated measurement result to be removed
from the Statistics page.

None of the columns are editable, but you can auto size the column by clicking the right border.

The Info column indicates that the results are outdated due to TLA system or setup changes. Data can
be outdated for the following reasons:

®  Group definition was changed

B The measurement was aborted while the analysis was in progress
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®  There is no data for analysis

® The results and statistics are cleared

To Use
Click Export to export the data to a file. You can export in either .TXT or .CSV file format.

To refresh outdated results, click the Run button in the TLA System window to acquire new data or click
the RECALC button on the Measurement Setup page to recalculate the measurements on existing data.

Click the Clear Values button to remove all the measurement results and statistics from the Statistics page.

Graph Window

Overview

Use the Graph window to display data in an X-Y graph format. Use this format to identify valid data in
patterns such as tracking the flow of digitized analog values throughout your target system by looking at
data values written to a set of memory addresses.

Axis readout bars provide information on the data in the Graph window. You can customize the readouts
using the Graph Window property page. A legend at the bottom of the graph display provides an overview
of the contents of the Graph window. A progress bar below the legend shows the status of the graph when
it takes time to update the graph data.

Data Series
Graph data is represented by a data series, a collection of related data points plotted in a graph.
®  Each data series in the window can have unique color or patterns.

m  Each data series can have a unique title. You can specify the minimum and maximum data ranges
for the series as well as an offset for each axis.

®m  Add a new data series by clicking the Add Series toolbar button L4,

B Remove a data series by selecting it, and then clicking the Cut toolbar button. You can paste the
removed data series by clicking the Paste toolbar button.

Marks
Use marks to take measurements, locate triggers, and mark specific events for evaluation.

B Marks you can move are cursors X1, Y1, X2, Y2, and any marks you add. The numbers 1 and 2 on
the marks handles denote the X-axis (vertical) and Y-axis (horizontal) cursor marks. Readouts for the
cursors, and the time differences (Delta Time) between the cursors are located at the top of the data area.

B Marks on the top and right sides of the window are data area marks. These marks are in the portion of
the acquisition that is currently viewable. Use data area marks to move within the data area.
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B You cannot move System Trigger, Module Trigger, or Begin and End marks.

B Marks on the bottom and left sides are overview marks. These marks show where marks are located
relative to the entire acquisition. Use overview marks to move throughout the acquisition.

B Double-click a mark to open the Marks properties page. You can assign a unique name to the Mark in
the Mark Name field.

®  You can add marks by clicking T (the Add Mark toolbar button). Remove a mark by selecting the
mark and using the Cut toolbar button. When you add or paste a mark, it appears in the center of

the display.

System trigger

2

Module trigger

T

Begin data and end data

The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

Under some conditions the system trigger associated with a
module’s data might not be displayed in the data window. If
the system trigger was caused by another module, whose
data is not included in the current display, then the system
trigger is not shown. Nevertheless, all time measurements
still relate to that system trigger, even if it is not shown.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.

The active system trigger is indicated by a yellow T; the
reference system trigger is indicated by a gray T.

The point at which the module triggered. Trigger marks
cannot be moved.

The start and end of a module’s data record. These data

marks cannot be moved.

EE

Cursors 1 and 2 Moveable marks used for visual reference and for data
.ELE measurements.

User mark User-created marks. Use marks to make specific data
easier to identify and find.

Click this check box to lock the delta values. When you
lock delta values, the cursors move across the data
simultaneously, maintaining a fixed delta time.

Lock Delta Value check box

® Toolbar Area

Toolbar buttons allow you to customize the Graph window. You can access most of the Graph window
controls directly from the toolbar buttons. Other buttons open either dialog boxes or property pages
where you can supply specific information to adjust the Graph window. If you are unsure of the purpose
of the individual buttons, use the tooltips to identify the buttons.
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Add Series

Ei

Add Mark

i

Cut Copy, Paste
X a3
Go To

2

Properties

=

Automatic Update

5

Hit Frequency Mode

Ry

Persistence Mode
54

Zoom

oy I Q

Abort

Graph Window

Click the Add Series toolbar button to open the Add Series
Dialog Box where you can add a new data series from
different data sources.

Click the Add Mark toolbar button to add a mark to the data
points in the series.

Use these buttons to cut, copy, and paste the individual data
series multiple data series, or marks.

Click the Go To button to open the Go To dialog box so you
can easily go to a mark or data series.

Click the Properties button to open the Graph window
property pages where you can change the properties of the
data or the graph.

Click this button to enable or disable the automatic update
tool. When you select Enable Auto Update, the current
data in the window is automatically updated when new
acquisition data is available.

Click the Hit Frequency toolbar button to display the data
points using the colors defined in the Hit Frequency property
page. The color of the data points depend on the number
of hits.

Click the Persistence toolbar button to retain the previous
graph data along with the current graph data.

You can zoom Graph window data similar to data in a
Waveform window. The horizontal and vertical axis each
has their own zoom controls. Click on one of the zoom
buttons to zoom either in or out. You can also click and drag
the mouse over the area that you want to zoom; when you
release the mouse button, zoomed data will appear in the
center of the Graph window.

Use the Abort toolbar button to stop the processing of data
in the graph. The data series will not be updated. You may
want to abort the data processing if the data takes too long
to process due to size and other reasons.
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= You can add a data series to the graph; add marks; and cut, copy, and paste a data series.

= You can enable automatic updates, the hit frequency mode, and the persistence mode by clicking the
appropriate toolbar buttons.

= Use the zoom toolbar buttons to zoom in and out on the horizontal and vertical axis, or zoom to the
current selection. When you use the zoom buttons, the display centers at the current location.

= Click the Abort toolbar button to abort any updates that may take a long time due to the amount of
memory involved with the graph data.

Graph Window Properties

Overview

Use this property page to change the default appearance of the Graph window.

Behavior

Use the controls in this property sheet to help you do the following tasks:

Display the graph graticule
Specify the color, style, and line thickness of the graticule

Specify the minimum and maximum ranges of the X-axis and Y-axis as well as specifying the values
per division

Label the X-axis and Y-axis

Specify the readout radix

Turn the graph readouts on or off

Specify the color of readouts

Specify the background color of the graph

Enable or disable automatic updates of the graph. (You can also enable or disable the automatic updates
by clicking the toolbar button in the Graph window.)

Series Data Properties

Overview

Use this property page to change the default settings of an individual data series.
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Behavior

Use the Series drop-down list to select the series that you want to display in the Graph window. The text
below the Series List displays the data source (logic analyzer module and slot location). You can change
the title of the series by entering a new title in the Title box. Otherwise, you can use the default name.

The logic analyzer obtains the axis data range values from the selected series. You can adjust these values
or add an offset value to either axis by entering values in the boxes.

You can normalize the data range for each axis. When you normalize the data ranges, you rescale the data
in the ranges. For example, if you normalize all of the X-axis data to 1, all of the data would fall in
proportion to its original values, between 0 and 1. This can be useful when you want to redraw the X-axis
and Y-axis for normalized data series where you want to analyze vector displacement, which uses the
origin of the graph (0,0) as part of the data measurement. The default range values are —1 and 1, but you
can change these values as necessary to meet your needs.

Series Format Properties

Overview

Use this property page to define the appearance of the selected data series.

Behavior

The controls in this property page allow you to select one or more data series where you can specify the
line type and data point type. You can further define the color and thickness of the lines or data points. A
sample image of the selected data series gives a preview of the data series format.

To Use

Select the series that you want to change from the Series List. Click the Series Type drop-down list to
select the series type, straight lines with data points, straight lines without data points, curved lines with
data points, curved lines without data points, or data points only. You can further define the lines as dotted,
dashed, or solid. You can select the type of data points, dots, plus signs (+), or asterisks (*). You can
change the thickness of the lines and marks as well as specify the colors of the lines and data marks.

If you select a series type without data points, the data point elements are disabled. Similarly, if you select
a series type with data points only, the line elements are disabled.

Hit Frequency Properties

Overview

Use this property page to define the colors for hit ranges.
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Behavior

This window uses color schemes to help you determine the frequency of hits. The color schemes are
similar to those used by Tektronix TDS oscilloscopes. For example, if you select a temperature color
scheme, colors move from dark (cool) to bright (hot). Alternately, if you select a spectral color scheme, the
colors move from bright to dark. The colors are fixed when you select a predefined color scheme. If you
select the User-Defined color scheme, you can define your own colors.

The color ranges move from the maximum number of hits to minimum as indicated in the property page. If
you click Invert Colors, the ranges move from the minimum number of hits to maximum.

To Use

Use the drop-down list to select a color scheme. If you select the User-Defined color scheme, you can
define the colors by clicking the color buttons and selecting a color. Use the Default button to return the
colors to their default settings.

After you close the property sheet, click the Hit Frequency button on the toolbar to display the data
points in the graph based on the number of hits.

New Graph Data Window

Overview

Use this page to create a new Graph window and specify the data source for your new window.

To Use

B Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. You can also click the Browse button to search for a desired TLA system file.

m Click No data to create an empty Graph window. After the window displays, you can add data series
from different sources.

Related Topic
Adding a New Series (see page 314)

New Graph Window Select Series

Use this page to specify the X-axis and Y-axis for the new Graph window.

For either axis, you can select one of the following:
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®  Sample Number. Use the drop-down list to select Begin, Trigger, or End.

B Row Number. This selection is the same as the Sample Number but does not include any gaps due
to filtering.

m Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.
B Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the new
window, you can use the Graph Window (see page 307) to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without
creating a new Graph window.

Related Topic
Add Series Dialog Box (see page 313)

New Graph Window name

Enter a name for the new Graph window or use the default name. Then click the Finish button to create
the new Graph window.

Add Series Dialog Box

Overview

Use this dialog box to add a data series to the existing graph from different data sources.

Behavior

The default X-axis and Y-axis data sources depend on the initial graph. You specify these when you create
a new data window using the New Data Window wizard.

You can add a new series from different data sources such as a logic analyzer module or a reference
memory. However, the data source must be from the same Data Source type. For example, you can’t add
an address group to the X-axis if the Data Source type was set up as a sample number. If you want to
change the Data Source type, create a new Graph window through the New Data Window wizard.

The appearance of the dialog box changes depending on the Data Source type. For example, if you defined
the X-axis Data Source type as Row Number, the selection is fixed to that type and is grayed out. If you
defined the X-axis as a group, you can use the drop-down list to select the individual group or click the
Add Data Source button to search the file system for a group.
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To Use

Define the series for each axis and then click the Add Series button to add the series to the Series list. The
series will be displayed in the form of X-axis versus Y-axis. To remove a series from the graph, select
the series in the Series list and then click the Remove Series button.

To access this dialog box, click the Add Series button in the Graph window toolbar.

NOTE. Ifyou have an empty Graph window (a Graph window with no data) and you click the Add Series
toolbar button, you will launch the Axis Type wizard where you can select the data source, define the X-axis
and the Y-axis, before opening the Add Series dialog box.

Graph Window Go To Dialog Box

Overview

Use this dialog box to locate a mark or a series in the Graph window.

Behavior

Use to scroll the Graph window to a new position by selecting any current mark or series. Select Mark
to display a list of all marks related to the Graph window. Select Series to display a list of all series
related to the Graph window.

To Use

Double-click on the desired mark or series in the list. The dialog box closes and displays the mark or series
in the center of the window.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.

Adding a New Series

314

1. In the System window, click the Graph data window icon.
From the Edit menu, click Add Series.

Select the Data Source.

0 » b

If the data source you want is not listed, click Add Data Source to open the Add Data Source dialog box
and browse the file system to locate the data source.

w

Select the series and click Add.
6. Click OK.



Analysis Tools Taking Cursor Measurements

TIP. Click W to add a series.

Taking Cursor Measurements

In the Graph window use the X and Y cursors to take measurements:
1. Move each cursor to the points you want to measure.
2. The measurements are displayed in the cursor readouts.

3. Use Lock Delta Time to lock the cursors together.

Going to a Specific Series

1. In the System window, click the Graph data window icon.

2. Click R in the toolbar of the Graph window to open the Go To dialog box.
3. Select Series to display a list of all series in the Graph window.
4. Double-click the series that you want to see.

The series that you selected will display in the center of the Graph window.

Going to a Specific Graph Window Mark

1. In the System window, click the Graph data window icon.

2. Click G in the toolbar of the Graph window to open the Go To dialog box.
3. Select Mark to display a list of all marks in the Graph window.
4. Double-click the mark that you want to see.

The mark that you selected will display in the center of the Graph window.

Zooming a Graph

The zoom behavior is controlled by the System Options: Preferences (see page 85) settings. The default
setting is to zoom immediately. You can zoom a Graph window three different ways:

B Zoom both the X-axis and Y-axis
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B Zoom the horizontal (X) axis

® Zoom the vertical (Y) axis

To zoom a Graph window using the default zoom setting (immediately), perform the following steps:
1. In the System window, click the Graph data window icon.

2. Click and drag the mouse over the area that you want to zoom. When you release the mouse button, the
Graph window will zoom the area of interest and center it in the window.

Viewing Persistence Data

1. In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property pages.
Click the Series Data tab.
Enter an offset value for the X-axis or Y-axis data range.

Click OK to close the dialog box.

AN A S o

Click the Hit Frequency toolbar button to enable the Hit Frequency mode (button should appear
depressed).

7. Click the Run button to start an acquisition.

The number of hits will increase due the overlapping of data on the same region.

NOTE. The Persistence data will not be visible when you resize the Graph window or scroll data in the
Graph window.

iVerify Window
From the toolbar, click the iVerify button.

Overview

iVerify allows you to generate eye diagrams, or voltage/time graphs, for both individual signals and
groups of signals. Use the controls in the iVerify window to set up iVerify; and to analyze, display,
and perform measurements on the eye diagrams.
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iVerify Toolbar

Click the Define Setups icon , 52 , to open the iVerify Setups dialog box to define a new iVerify setup or
edit an existing setup. Once you have defined the setups, close the dialog box and click the Analyze button
to begin building the eye diagram. The eye diagram will be drawn, based on the eye coloration selections
made in the Eye Coloration tab of the iVerify Properties dialog box.

Click the Measurement icon, “** | to display a list of measurements for the eye diagram. Click a
measurement button to perform a measurement on the eye diagram. Click the button a second time to turn
off the measurement. When the measurements are made, the corresponding cursors are drawn on the eye
diagram. In case of histogram, the cursor is drawn on the eye diagram and the corresponding histogram is
drawn on top or left of the eye diagram, depending on whether it is a horizontal or vertical histogram.

Selecting any measurement from the Measurement icon in the toolbar will overlay the measurement
diagram on the eye diagram and display the corresponding measurement tab.

Measurement Information View

This area of the iVerify window provides general information about the eye diagram. In addition, it
provides information about each measurement on the eye diagram. Measurement information parameters
and measurement results are shown in separate tabs.

®  General tab

When analysis is complete, the General tab displays peak-to-peak information. In addition, it displays
information pertaining to your cursor’s present position over the eye diagram such as the time and volt
value, number of hits, and displays the highlighted signal.

® 4 Point Mask tab

The 4-Point Mask tab displays 4 point mask measurement information, such as the mask coordinate values
and the number of hits for each signal within the 4 point mask.

B 6 Point Mask tab

The 6-Point Mask tab displays 6 point mask measurement information, such as the mask coordinate values
and the number of hits for each signal within the 6 point mask.

B Eye Limit Cursor tab

The Eye Limit Cursor tab displays Eye Limit Cursor measurement information, such as the cursor position
and the eye height and width.

®m  Upper Lower Mask tab

The Upper Lower Mask tab displays upper mask and lower mask measurement information, such as the
upper mask voltage value, lower mask voltage value, the number of hits for each signal in the masking
region, and upper violation and lower violation.

m Slope tab

The Slope tab displays information about the slope measurement such as the upper point coordinates,
lower point coordinates, and slope value.

317



Analysis Tools iVerify Setups Dialog Box

® Horizontal Histogram tab

The Horizontal Histogram tab displays the voltage level of the histogram cursor value. In addition, it
displays information pertaining to the cursor’s present position over the eye diagram, such as the number
of hits for each signal over the time level.

B Vertical Histogram tab

The Vertical Histogram tab displays the time level of the histogram cursor value. In addition, it displays
information pertaining to the cursor’s present position over the eye diagram, such as the number of hits for
each signal at that voltage level.

Display Time and Voltage Ranges

Use the Display Time Range and Display Voltage Range to select the horizontal and vertical display settings
for the eye diagram. These controls do not affect the acquisition of data from the external oscilloscope.

The Min and Max boxes allow you to set the minimum and maximum time value from where iVerify
will plot the data. These boxes allow you to choose start and end points for the eye display from the
data acquired by the external oscilloscope. Use the Min and Max controls to choose the time period of
interest from all data acquired by the external oscilloscope. By default, the external oscilloscope displays
all acquired data.

The Per Div boxes allow you to divide the eye display area into equal horizontal and vertical divisions and
spread the values accordingly.

The Offset box allows you to move the eye diagram to the left or right by the values specified in the Offset
edit controls. You can also use this offset to measure the time between two points.

NOTE. The Min and Max time controls are relative to the clock shown above the diagram display area.

Related Topics
1Verify Properties Dialog Box (see page 322)

1Verify Setup Dialog Box (see page 320)

iVerify Setups Dialog Box
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Overview

The iVerify dialog box displays iVerify setups that are available in all physical TLA7000 Series logic
analyzer modules. You can also view saved iVerify setups that were downloaded from a module that was
loaded from another system.
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Behavior

You can use the iVerify Setups group box to manage iVerify setups. This includes creating, duplicating,
deleting and renaming setups. Right-click an iVerify setup to open a menu where you can manage the
setups.

Click the New button to open the New iVerify Setup Dialog Box. Use this dialog box to create and name a
new 1Verify setup under a selected module. When a module is highlighted in the Setup box, the newly
added iVerify setup is attached to that module.

Click the Load button to open the Load iVerify Setup Dialog Box (see page 319). Use this dialog box
to load an iVerify setup from a saved file. When a module is highlighted in the Setup box, the loaded

setup is added as a new setup to the selected module. When an iVerify setup is highlighted, the loaded
setup replaces the highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When a setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When a setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module is highlighted in the Setup box, clicking the Paste button creates a new setup from the
clipboard contents and attaches it to the selected module. The logic analyzer will add an integer to the
clipboard setup name; you can change the description as needed. When a setup is highlighted, clicking the
Paste button creates a new setup from the clipboard contents and attaches it to the selected module.

Related Topics
Load iVerify Setup Dialog Box (see page 319)

1Verify Setup Dialog Box (see page 320)

Load iVerify Setup Dialog Box

Overview

The Load iVerify Setup dialog box allows you to load an iVerify setup from any saved system setup file.
When you select an iVerify setup, the load operation replaces all the settings. However, when you select a
module, a new iVerify setup is added.

Behavior

The operation of the iVerify Setups dialog box depends on what you select to load. If you select a module
in the iVerify Setups dialog box, you can select multiple setups in their individual setup boxes. If you
select a setup in the Load iVerify Setup dialog box, then the loaded setup replaces the one in the iVerify
Setups dialog box.
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Use the File Name box to enter the file name containing a module setup or use the Browse button to
browse the file system for a setup. The modules and their setups, when found, will be listed in the Modules
and their Setups text box. You can select any setup listed in this box. Once you highlight the desired
setup, you can load the setup by clicking the Load button. The loaded setup either creates a new setup

or replaces an existing one.

If you select a module in the iVerify Setups dialog box, the Modules and their Setups box allows you to
select multiple setups. However, if you select a setup in the iVerify Setups dialog box, then the Modules
and their Setups box allows you to select only one setup.

If you select a setup from the iVerify Setups dialog box, and then select a setup from the Modules and their
Setups box and click the Load button, a system confirmation message displays. Click OK to confirm that
you intend to replace the current setup with the setup you selected in the Modules and their Setups box.

NOTE. An error message displays if the setup you are trying to load uses groups or signals that are not
included in the selected module. Also, an error message displays when you try to load a module without
any saved data.

Related Topic
1Verify Setups Dialog Box (see page 318)

iVerify Setup Dialog Box

320

The iVerify Setup dialog box allows you to edit the settings of a selected iVerify setup or add a new
iVerify setup. In addition, this dialog box allows you to define various analysis parameters through the
respective tabs. Note that only TLA7000 Series logic analyzer modules and related setups display in
the 1Verify Setup dialog box.
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Behavior

Use the Setup Name box to select the modules and the iVerify setups that they contain. Modules that
contain one or more iVerify setups are listed in <modulename > - <iVerify setup name> format.

The Description box allows you to enter a new description for, or change the existing description of, the
loaded iVerify setup. Click the New Setup button to open the New iVerify Setup dialog box, which
you use to specify a new iVerify setup.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

Related Topics
1Verify Setup Dialog Box: Channel Tab (see page 329)

1Verify Setup Dialog Box: Clock/Qualifier Tab (see page 330)

1Verify Setup Dialog Box: Analysis Configuration Tab (see page 327)

1Verify Setup Dialog Box: Inter-Probing Tab (see page 331)
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iVerify Properties Dialog Box

The iVerify Properties dialog box shows the properties of the iVerify Window. These properties include
information about the logic analyzer and external oscilloscope modules, functionality that you use to set eye
diagram colors, and functionality that you use to color the measurement diagrams and set their properties.

Behavior

The contents of the iVerify Properties dialog box are logically organized into three tabs. Click the tabs to
navigate to the contents for each iVerify Properties tab.

Related Topics
About Data Tab (see page 322)

1Verify Window Tab (see page 323)

Eye Coloration Tab (see page 325)

iVerify Properties - About Data Tab
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The About Data tab contains information about both the logic analyzer and the external oscilloscope for
the current acquisition. This information includes the version and quantities of logic analyzer modules

installed in the mainframe, the type of external oscilloscope, signal information, and other configuration
information. Click the tabs in the graphic to navigate to the help contents for each iVerify Properties tab.
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Behavior

The About Data tab contents is read-only information.

Related Topics
iVerify Properties Dialog Box (see page 322)

iVerify Window Tab (see page 323)

Eye Coloration Tab (see page 325)

iVerify Properties - iVerify Window Tab

The iVerify Window tab allows you to color the measurement drawings that are overlaid with the eye
diagram. It also allows you to specify the position and color of the measurement drawings.
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The Show Graticule box allows you to indicate whether to display the graticule and specify the graticule
color. You can also define the following settings for the eye diagram:

m The Background drop-down list allows you to select the background color of the eye diagram.

® The Clock Edge drop-down list allows you to select the color of the clock edge in the eye diagram.
B The Highlight Color drop-down allows you to select the color for the highlighted signal.

m The Line Color drop-down list allows you to select the color of the measurement lines.

The controls that are available in the Measurement group box depend on your Option selection. The
following selections are available:

B 4 Point Mask. The 4 Point Mask option allows you to view or edit the mask coordinate values and the
line color for this measurement in the Measurement group box.

B 6 Point Mask. Selecting the 6 Point Mask option allows you to view or edit the mask coordinate values
and the line color for this measurement in the Measurement group box.

® Eye Limit Cursor. Selecting the Eye Limit Cursor measurement option allows you to view or edit the
time, voltage, and line color for this measurement in the Measurement group box.
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m  Upper/Lower Mask. Selecting the Upper/Lower Mask measurement option allows you to view or
edit the upper and lower mask positions and the line color for this measurement in the Measurement
group box.

m  Slope. Selecting the Slope measurement option allows you to view or edit point 1, point 2, and line
color for this measurement in the Measurement group box.

B Horizontal Histogram. Selecting the Horizontal Histogram measurement option allows you to view or
edit the scale, voltage and line color for this measurement in the Measurement group box.

®  Vertical Histogram. Selecting the Vertical Histogram measurement option allows you to view or edit
the scale, time, and line color for this measurement in the Measurement group box.

Related Topics
1Verify Properties Dialog Box (see page 322)

About Data Tab (see page 322)

Eye Coloration Tab (see page 325)

iVerify Properties - Eye Coloration Tab

The Eye Coloration tab allows you to set coloration for the eye diagram. Click the tabs in the graphic to
navigate to the help contents for each iVerify Properties tab.

You can select a color scheme that controls the colors of the eye diagram or, if you choose the color setting
of User Defined, you can individually set the colors used in the eye diagram.
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The Color Scheme drop-down list shows all the color schemes that you can apply to the eye diagram. A
description of the color scheme selections follows:

Temperature Grading. Using Temperature Grading, the areas of the eye with the highest sample density
appear in warmer colors (red shades), and the areas of lowest sample density appear in cooler colors
(blue shades). Temperature Grading is the default eye diagram color scheme.

Spectral Grading. Using Spectral Grading, the areas of the eye with the highest sample density appear
in blue shades, and the areas of lowest sample density appear in red shades.

Monochrome Gray. The Monochrome Gray color scheme displays the eye diagram in shades of gray.
The areas of the waveform with the highest sample density appear in lighter shades of gray, and the
areas of lowest sample density appear in darker shades of gray.

Monochrome Green. The Monochrome Green color scheme displays the eye diagram in shades of
green. The areas of the waveform with the highest sample density appear in lighter shades of green, and
the areas of lowest sample density appear in darker shades of green.

User Defined. Selecting the User Defined color scheme displays the eye diagram in shades of the color
that you select from the Scheme Definition group box.

Using the color boxes contained in the Scheme Definition group box, you can individually assign colors
that will indicate sample density in the eye diagram. However, this group box is enabled only when you
select the User Defined color scheme.
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Click the Default button to return the eye diagram coloration to the Temperature Grading color scheme,
which is the default color scheme.

Click the Invert Colors button to swap the colors that indicate the highest and lowest sample density.

Related Topics
iVerify Properties Dialog Box (see page 322)

About Data Tab (see page 322)

iVerify Window Tab (see page 323)

iVerify Statistical Analysis Dialog Box

Overview

The iVerify Statistical Analysis dialog box displays information regarding measurements that you
performed. This dialog box numerically represents the contents of the measurement data contained in the
iVerify window.

You can select the measurements to be performed from the toolbar of the iVerify window or by selecting
Data > Measurements from the iVerify menu bar.

Behavior

The i1Verify Statistical Analysis dialog box content is read-only information. You can save the statistics to
a text file by clicking the Save As button and then saving the file in a desired location.

Related Topics
1Verify Window (see page 316)

1Verify Properties Dialog Box (see page 322)

iVerify Setup Dialog Box: Analysis Configuration Tab

Use the Analysis tab to select the necessary settings for the external oscilloscope which will be used for
analysis. This tab allows you to set up the time and voltage settings, and time limit for analysis.

The Horizontal Range group box contains Min and Max controls that you set to affect the frequency
horizontal scale parameters in the external oscilloscope.
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The values that you enter in the Min and Max fields are rounded as necessary to the closest horizontal
scale, which is between -40s and 40s.

The Horizontal Range group box contains a read-only Resolution box that internally calculates and
displays the horizontal resolution for both the given number of clocks and horizontal scale.

The Vertical Range group box contains controls that affect the voltage range for the oscilloscope signals.
The Range box allows you to select from predefined voltage ranges for the external oscilloscope signals. If
you select the range setting of User Defined, you can then use the Min and Max controls to specify

the minimum and maximum voltage limits for the external oscilloscope. Otherwise, these controls are
read-only. The values that you enter in the Min and Max fields are rounded as necessary to the closest
vertical scale, which is between 5 V and -2.5 V.

The Approximate Stop Condition group box contains the After control, which allows you to limit the
time that the iVerify takes to perform analysis.

The Oscilloscope Acquisition Mode group box allows you to use the FastAcq acquisition mode of the
oscilloscope if it is available on the external oscilloscope.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.
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Related Topics
1Verify Setup Dialog Box (see page 320)

1Verify Setup Dialog Box: Channel Tab (see page 329)

1Verify Setup Dialog Box: Clock/Qualifier Tab (see page 330)

iVerify Setup Dialog Box: Inter-Probing Tab (see page 331)

iVerify Setup Dialog Box: Channel Tab

The Channels tab allows you to select both the signals that you want to analyze and the signal data that
will display in the eye diagram, which is located in the iVerify window.

Use the Channels tab to list signals by group, by probe, or by name. Then specify the groups or signals that
you want to analyze by selecting the check box associated with each group or signal in the Analyze column.
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To specify the groups or signals for which the analysis results will be displayed in the eye diagram, select
the check boxes associated with each group or signal in the Apply column. By default, when you select an
Analyze check box, the related Show check box is selected.
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NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message displays.

Related Topics
1Verify Setup Dialog Box (see page 320)

1Verify Setup Dialog Box: Clock/Qualifier Tab (see page 330)

iVerify Setup Dialog Box: Analysis Configuration Tab (see page 327)

1Verify Setup Dialog Box: Inter-Probing Tab (see page 331)

iVerify Setup Dialog Box: Clock/Qualifier Tab
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Use the Clock and Qualifier tab to set up the clock signal and qualifier signal and the edge that will be routed
to the oscilloscope for analysis. Any of the signals displayed can be selected as a clock signal or qualifier.

The Channels to be Used as Clock group box contains a Select list which you use to arrange the signals
that display in the clock list.
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If you choose By Probe, the clock list will display all signals regardless of whether they are part of a group
that is defined in the LA Setup window.

If you choose By Name, the clock list will display only the signals that have been assigned custom names
in the LA Setup window.

Select the reference clock edge by clicking the clock edge icon until it displays your preference: rising edge
or falling edge. Then select the signal to be used as a clock that is routed to the oscilloscope for analysis.

Select the Select Qualifier check box when you want to send a qualifier to the oscilloscope along with the
clock signal. When this check box is selected, the analysis of signals selected in the iVerify setup occurs in
the oscilloscope only if the qualifier is valid in the same timeframe.

The Channels to be Used as Qualifier functions similarly to the Channels to be Used as Clock group
box. Select the high or low condition of the qualifier by clicking the qualifier edge icon until it displays
your preference: high level or low level. Then select the signal to be used as a qualifier that is routed to
the oscilloscope for analysis.

NOTE. If you have a five-module setup, you cannot select any status bits.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

1Verify Setup Dialog Box (see page 320)

1Verify Setup Dialog Box: Channel Tab (see page 329)

1Verify Setup Dialog Box: Analysis Configuration Tab (see page 327)

1Verify Setup Dialog Box: Inter-Probing Tab (see page 331)

iVerify Setup Dialog Box: Inter-Probing Tab

The Inter-Probing tab displays optimum analog routing information that you make between the logic
analyzer and external oscilloscope to achieve analysis results for the selected signals. The logic analyzer
modules that are displayed on this tab depend upon the signal selections that you made in the Channels tab
of the iVerify Setup dialog box.
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Behavior

The Inter-Probing tab is a read-only tab.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

Related Topics
iVerify Setup Dialog Box (see page 320)

iVerify Setup Dialog Box: Channel Tab (see page 329)

iVerify Setup Dialog Box: Clock/Qualifier Tab (see page 330)

iVerify Setup Dialog Box: Analysis Configuration Tab (see page 327)
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Microprocessor and Bus Support Package Basic Operation

Microprocessor and bus support packages are used to disassemble data from microprocessor and bus based
systems. For information on a specific support package, refer to the documentation that came with the
support package.

The support can be used to perform timing analysis.

To acquire and display timing data, you need to change the sampling selection and trigger program. The
support includes a saved system setup file to view data in a Waveform window.

Related Topics
Sampling (see page 14)

LA module Trigger Window (see page 143)

Load Support Package

Loads the selected support package onto the selected logic analyzer module. The destination module must
have sufficient signal width for the support package to load.

From the File menu, click Load Support Package.

Group Definitions for Microprocessor and Bus Support

Each support package contains group definitions. Many supports have groups defined for: Address, Data,
and Control signals, and additional groups defined for other signals. If you want to know which signal is in
what group, refer to the signal assignment tables in the support instruction manual.

Microprocessor and Bus Support Package Triggering

All the Trigger window selections available with your analyzer are also available with the support
package. However, if the support package displays exception cycle types, the cycle types are computed
and cannot be used to control triggering.

A control group symbol table, which includes special symbols for triggering, is supplied with many
support packages.

You can trigger on pattern or range symbol values. However, only the = and Is Not operators in the Clause
definition dialog box can use pattern symbol values. All operators can use range symbol values.
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Disassembly Display Formats

Four different display formats offer optional selections to modify the way disassembled data is displayed.
This makes it easier to analyze data.

The display formats are: Hardware, Software, Control Flow, and Subroutine. Other display options may
be available depending on your support package.

To select a disassembly display format:

1. Open a Listing window.

2. From the View menu select Properties.
3. Click the Disassembly tab.
4

. Go to the Show box and select the display format.

Saved System Timing Format File

In the Waveform window, every signal shows as a waveform, and groups show as busforms.

The support package includes a saved system setup file that you can use to view data in the Waveform
window. To load this file, do the following:

1. Go to the File menu and select Load System.
2. Click Browse.
3. Move through the directory structure as follows:
C:\Program files\TLA700\Supports\(support package folder)\timing.tla

4. Click Yes or No to indicate whether or not you want to save your current system.

NOTE. A message may appear stating that the configuration of the file does not match your configuration.
Click OK and follow the directions in the Load System Options dialog box, or click Help in the dialog box
for more information.

5. Click the waveform data icon after it appears in the System window to view the timing file.

Custom Sampling

When your instrument has a support package loaded, a custom sampling tab is available in the LA Setup
window. The name of the support package appears on the tab label.
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Use Custom sampling to select sampling options associated with the support package. It gives special
access to the advanced sampling features of the logic analyzer to track the complex behavior of a digital
device or bus protocol. The available selections vary with each support package. Custom sampling can
enable and disable a variety of microprocessor-specific clock cycle types (such as DMA cycles). For
additional, information see the instructions that accompanied your support package.

Clocking Problems

If you have clocking problems check the following:

B A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your connections.

B The system under test is powered on and running. Verify the system is not halted.
®m  Custom is the sampling selection in the Setup window.

B Connections between the acquisition module and the probe adapter are correct. Check for activity in
the Signal Mapping area of the Setup window.

The clock and probe connections between the interface housings and probe adapter are correct (module
name, clock, section names, and signal numbers match), are properly oriented, and are fully engaged.

The connections between the interface housings and acquisition module probe cables have matched color
labels, matched slot numbers, and are properly keyed.

The connections between the acquisition module probe cables and probe connectors have matched color
labels, matched slot numbers, and are properly keyed.

m  The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem try the following:
Reload the support package to restore the analyzer to a default state.

If there are loading problems, remove one or more of the protective sockets from the probe adapter. These
sockets might add enough additional capacitance or delay to your system under test to affect it.

If the analyzer is still not performing correctly after trying these solutions, there might be a problem with
your system under test. Perform timing analysis on your system to ensure the signals are valid when the
probe adapter samples them.

Incorrect Data

If the data acquired is obviously incorrect, check that:

B The correct support application is loaded into the system.
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® [f the microprocessor has an internal instruction cache, you should disable it. The support product
instruction manual contains information on when and how to disable the instruction cache.

B Custom Sampling is selected in the Setup menu.
m The connections between the acquisition module and the probe adapter are correct:

® The clock and 17-channel probe connections between the interface housings and probe adapter are
correct (module name, clock, section names, and signal numbers match), are properly oriented, and
are fully engaged.

B The connections between the interface housings and acquisition module probe cables have matched
slot numbers, and are properly keyed.

B The connections between the acquisition module probe cables and probe connectors have matched
slot numbers, and are properly keyed.

B The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem, try reloading the support package to restore the analyzer
to a known state.
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Extended Diagnostics Properties

Use to run extended diagnostics for the following purposes:
® Incoming inspection. Run these diagnostics when first receiving the analyzer.
®m  Functional procedure. Run these diagnostics after the analyzer or module has been repaired.

B Suspected problem. Run these diagnostics if you think your analyzer is not performing correctly.

NOTE. Disconnect all probes from the analyzer before running the diagnostics.

Test Name
This column has an indented hierarchical structure.
All Modules, All Tests — Runs all tests in the list.

TLA700 System — Selects all mainframe tests.

Last Result

This column shows the pass or fail result of the most recent test. When a test is running, the word
"Running" displays until the test is complete and results show. When a series of tests is running and

an individual test is complete, results are displayed and the next test is executed. The result Unknown
indicates that a particular test is in question. Run the diagnostic again. If Unknown appears again, contact
your local Tektronix service representative.

Fail Count

This column shows the number of times a test has failed since the RUN button on this page was clicked.
This count is mainly used when the run mode is set to Continuous. One Time and Until Fail run modes
always display a count of one. All values are cleared when you click the RUN button.

Contact Technical Support for questions regarding diagnostic test results.

To Use

To open the Extended diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Extended Diagnostics.
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Related Topics

Running Extended Diagnostics (see page 133)

Troubleshooting Triggering

338

Overview

If the logic analyzer does not trigger, you should check the following:

Check that your target system is powered on.
Check the System window to verify that required modules are turned on.

If the module has correctly sampled data, acquired the specified events, triggered, but has not stopped,
the module probably has not acquired enough additional data to fill acquisition memory. Click Stop
to manually stop the acquisition, and then change the Module Memory Depth (see page 27) (reduce)
or Trigger Position (see page 151) (increase).

LA Triggering

The following conditions apply to the logic analyzer only:

Check the Status Monitor for a clock warning. If the logic analyzer does not receive a synchronous
clock, the Status Monitor displays the following message: External Clock Source Idle.

Check for signal activity at the probe tip. If there is no activity, check the probe connections.

Check the clock signal to ensure that the logic analyzer actually receives clock data. Problems with
the clock signal can impact setups using synchronous sampling, custom sampling (microprocessor
support packages only), or storage qualification.

Similar to the previous item, check clock qualifier signals and clock equations.
Check the threshold voltages.

If the logic analyzer is correctly sampling data and the data events have occurred, but the trigger
program did not generate a trigger, check the trigger program itself. The trigger program might not be
reaching the state that generates the trigger. Use the Status Monitor to track trigger program progress
and identify the state in which trigger progress stops.

Check the complexity of your trigger program. If your trigger program is too narrowly defined,

or over-specified, the trigger program might not acquire the desired data or might not trigger. A
less-specific trigger program might acquire the desired data and also verify that you have set up the
proper sampling and threshold levels.
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Oscilloscope Triggering
The following condition applies to the oscilloscope module only:

B Check the trigger Mode setting. If Mode is set to Normal, and the data does not meet the trigger
conditions, the module will not trigger. (Conversely, if Mode is set to Auto, the module will trigger
after a set length of time, even if the specified data does not occur.)

Arming or Intermodule Triggering
The following conditions apply only if you are using arming or intermodule triggering:

® Internal signal logic function. If your trigger depends on setting an internal signal, and that signal has
been set to Wired-And, all modules in the system must set the signal or it cannot assert.

® [fany modules are turned off, check that the trigger program is not waiting for input from an inactive
module.

First Transition Indication Problems

m  Because the logic analyzer does not clear the first transition indication, check that the modules always
show a first transition indication (even if there are no probes attached).

B To avoid triggering on a false first transition indication, set the first state to " If Anything, Go to Next
State." This will use a state, but it ensures that you do not trigger on a false transition indication.

Related Topic
Troubleshooting LA Power Trigger Programs (see page 104)
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Symbol Files

Overview

Symbol files are files of alphanumeric symbol names and associated data values. Symbol files are used to
map a group value to a text string and/or color. For example, a symbol file could map an address group
value to a function name. This is faster and easier to interpret than a numeric value.

Behavior

The logic analyzer uses two kinds of symbol files: Pattern Symbol Files and Range symbol files. The
range symbol files can contain Function Symbols (see page 343), Variable Symbols (see page 344), Source
Code Symbols (see page 345), and Color Symbols (see page 354). The following table shows the types
of symbol files and the windows in which they are commonly used.

Window Pattern Range symbol files

?ﬁ’:;bd Functions Variables Source code Color
Listing Yes Yes Yes Yes Yes
Waveform Yes Yes Yes Yes Yes
Histogram No Yes Yes No No
Source No No No Yes No
Trigger Yes Yes Yes Yes No

Often, the application software will define symbols for you. For example, when you load a microprocessor
support package, a symbol file is also loaded (typically, to the control group). These symbols represent
data values that correspond to bus cycle types.

Symbol files work like look-up tables. For example, if the address of a printer I/O port is F734BC, you
can define a pattern symbol, printer-port, corresponding to that value for use in the Trigger window.
Then, in the If/Then Clause dialog box, you can specify the symbol name as the word recognizer value
and cause the module to trigger when printer-port (F734BC) appears on the address bus. You can also
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specify symbolic display radix for the address group and the symbol name printer-port will be displayed in
the Listing window every time F734BC appears on the address bus.

Symbol Value Width

Overview

Symbol values are limited to a width of 32 bits. If your application uses groups wider than 32 bits (for
example, in the Trigger window), you could experience some unexpected results when using symbols
with those groups.

Behavior

For triggering purposes, if the symbols are wider than 32 bits, zeros are added to the most-significant bits.
In pattern symbols, don’t cares (Xs) are added to the most significant bits. Refer to the tables below for
examples on how the Trigger window handles symbols wider than 32 bits.

Pattern example Value Symbol
32-bit example FFFFAB23 10-3
40-bit example (32-bit with padding XXFFFFAB23 10-3

for most-significant bits)

Range example Lower bound Upper bound Symbol
32-bit example FFFF0055 FFFFACO0 Sym 12
40-bit example (32-bit with 00FFFF0055 00FFFFACO00 Sym 12
padding for most-significant

bits)

Range Symbol Files
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Overview

Range symbols define a range of 32-bit addresses represented by a contiguous set of integers, marked
by specific lower and upper bounds. The types of range symbols are: Function Symbols (see page 343),
Variable Symbols (see page 344), Source Code Symbols (see page 345) (source), and Color Symbols

(see page 354).

Behavior

The various range symbols may overlap each other. When overlaps occur, and the logic analyzer needs
to convert a numeric value to a symbol, it may need to choose between the symbols. The logic analyzer
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assigns a preference order to symbol types with function symbols having the highest precedence, followed
by variable symbols, and then source symbols. Color symbols are looked up separately and may overlap
with any of the other types.

Most TLA applications will typically not display source symbols when function symbols are present
because of the preference rule (source symbols are covered or overlapped by function symbols). There
may be situations when you prefer the source symbols. You can then use the Load Symbols Options dialog
box to specify that function symbols should not be read when loading the symbol files.

Pattern Symbol Files

Pattern symbols consist of data patterns of up to 32 bits. Each bit in a pattern symbol can be 0, 1, or X
(don’t care). Pattern symbols are used when a group of signals define a logical state. Each pattern symbol
may also have a color associated with it.

For example, a microprocessor has a set of pins that indicate the type of bus cycle in progress. A
memory-read cycle is indicated when the RD~ and MREQ~ pins are 0 (logic low) and the BUSAK~ and
M1~ pins are 1 (logic high).

You can define a pattern symbol name called mem-read that corresponds to bit pattern 1100 and mark all
memory read bus cycles in the Listing window. For other bus cycles the logic state of these pins is also
important and you can define different bit patterns for each cycle type.

Function Range Symbols

Overview

Function range symbols define the beginning and ending addresses where instructions that implement a
function (subroutine) are located in memory.

Functions are composed of multiple source statements. The address range of a function symbol can overlap
a set of ranges defined by one or more source symbols. A partial range file with functions is shown below:

#+ Function
# Symbol Name Low High
#

dispTlayBanner 006035ba 00603675
buildMenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

Behavior

The first line tells the file reader that the following symbols represent functions.
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The next two lines are comments used as headers.

The symbol name can contain up to 220 ASCII characters. However, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.

Variable Range Symbols

344

Overview

Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory. Variable symbols can also be overlapped by either function or source symbols. A partial
range file with variables is shown below:

#+ variable
# Symbol Name Low High
#

menu 00000100 00000102
userMenul 000004c0 000004c?2
binBits 000004d4 000004d6

Behavior

The first line tells the file reader that the following symbols represent variables. If this line is not included,
the file reader will assume that the symbols represent functions rather than variables.

The next two lines are comments used as headers.

The symbol name can contain up to 220 ASCII characters; however, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds. If the variable is a single byte in memory, the
lower and upper bound values are equal.
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Source Range Symbols

Overview

Source symbols are similar to function range symbols, except that the address range for a source symbol
describes the location of the instructions that implement only one source statement. Source symbols also
contain the following information that defines the location of the source code associated with a symbol:

B Source file name

®  Source line number

B An optional column range

A partial range file with source symbols is shown below:
#+ Source stoplite

# Line Low High Beg End Symbol Name

# === === === S=ssmssmsmsmssms—

27 006043ec 006043ef
35 006043f0 0060435

25
23
30

stoplite_27_25
stoplite_35_23
47 006043f6 006043ff stoplite_47_30
48 00604400 00604409
49 0060430a 00604413
50 00604414 0060441d

51 0060441e 00604427

30
30
30

stopTlite_49_30
stoplite_50_30

o O o o o o o

#
#
#
30 # stoplite_48_30
#
#
#

stoplite_51_30

Behavior

The first line tells the file reader that the following symbols represent source code. The first line also
specifies the name of the source file (stoplite). If this line is not included, the file reader will assume that
the symbols represent functions rather than variables and source symbols. Each set of symbols for a unique
source file must be introduced with an initial source directive to specify the file name for the symbols.

The next two lines are comments used as headers.

The line number specifies the line of the source file containing the source statement. Line numbers are
always expressed in decimal.

The Low and High columns describe the lower and upper bounds. The bounds represent the range of
addresses occupied by the instructions that implement a single source code statement. The radix of the
bound is defined in the file header. The value of the bounds can range from 0x00000000 to OxFFFFFFFF.
The bounds are inclusive; the specified range includes both bound values, as well as all addresses between
the bounds. If the source symbol is a single byte in memory, the lower and upper bound values are equal.
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The Beg and End columns are optional. When present, they define the beginning and ending column
position for the source statement. This makes it possible to define the exact location of the statement
on the line.

The symbol name appears as a comment at the end of the line. The file reader ignores the symbol name
because it is a comment. When the logic analyzer exports range symbol files, the symbol name is a
concatenation of the symbol file name, line number, and column number (if present). This is the symbol
value that the logic analyzer displays for addresses that fall within the lower and upper bound for a
source file.

Symbols

Symbols simplify tasks, such as setting up triggers or identifying specific values within the data. When
you program a trigger or view data, it is cumbersome to remember which numeric group values correspond
to particular machine instructions or code modules. The logic analyzer makes this task more manageable
by allowing you to assign symbolic names or mnemonics to group values.

For example, assign the symbol WRITE to the control bus event that causes the target system to write to
a memory location. Then, if you want to trigger when a write cycle occurs, enter WRITE in the trigger
program in place of the actual data value. You can also choose to have WRITE appear in the Listing
window for quick identification of the instruction.

Symbols Dialog Box

346

Overview

Use the Symbols dialog box to provide an overview of all currently loaded symbol files. With this dialog
box you can:

B Display symbol status and content information of currently loaded symbol files
B Load symbol files

® Reload symbol files

® Unload symbol files

= Export symbol files

Status Information
The following status information is available for each currently loaded symbol file:

m Last Loaded - Describes the last time the file was loaded into the TLA application software. It also
includes error and warning messages associated with the last load.
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® File Modified - Displays the time the file was last modified. It also displays a message if the file might
need to be reloaded (such as when the file is modified after it was first loaded).

B Format Loaded - Displays the format of the loaded file.

B Can Be Unloaded - Describes if the file can be unloaded or if the file is currently in use. Symbol files
can only be unloaded if no data windows or setups are using them.

Content Information
The following content information is displayed:

= Symbol Type - Shows whether the file is a pattern symbol file or a range symbol file. If the file is a
range file, this field also lists the types of symbols loaded.

m Total Symbols - Shows the number of symbols loaded from the file.

®  Total Source Files - Lists the number of source files referenced by source code symbols loaded from
the file.

B Range - Lists the minimum and maximum address values and offset information.

Behavior

Click Load to load a new symbol file. You do not need to load all symbol files with the Symbols dialog
box. Symbol files can be loaded through other windows. You can also display information on all symbol
files currently used by the logic analyzer by selecting any loaded symbol file.

NOTE. When you load a symbol file, the symbols are placed in memory. Because symbol files consume
memory, you should unload unused symbol files to keep memory available for your main application.

Click Unload to unload a symbol file from the application software.

NOTE. The Unload button is inactive when the loaded symbol file is in use.

Click Export to save the current file as a TSF-format symbol file. You can view the exported symbol file
with applications such as Wordpad. You can then edit the symbol file by saving it under a new name and
using a text editor, such as Wordpad, to make any changes. Save the edited file in ASCII format. You
can then load the edited symbol file.

To Use

To open the Symbols dialog box from the System menu, click Symbols.
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Related Topic
Load Symbols Options Dialog Box (see page 348)

Load Symbols Options Dialog Box

348

Overview

Use the Load Symbols Options dialog box to specify options for range symbol files before loading them
into the system. You can specify any of the following symbol file formats (check with your Tektronix
representative for a complete listing of available formats): OMF51, OMF86, OMF166, OMF286/386,
COFF, IEEE695, and ELF/DWAREF or ELF/STAB.

In addition to the above formats, you can also use the Tektronix Symbol file Format (see page 350) if your
code generation tools do not operate on any of the listed formats.

Behavior

Select one or more of the symbol types to load. If you want to use the symbol file with the Source window,
be sure to include the Source Code as the symbol type.

The Bound 1 and Bound 2 fields define the range of symbol addresses that will be loaded. You can enter
any hexadecimal values from 0 through FFFFFFFF. Values outside of these limits are ignored.

NOTE. If the lower bound of an overlapping range symbol is within the Bound 1 and Bound 2 limits and
the higher bound is not, the entire symbol will be valid. However, if the higher bound is within the Bound 1
and Bound 2 limits and the lower bound is not, the entire symbol will be ignored.

Select either Default Offset or Custom Offset to apply an offset to the symbol values. If you select Default
Offset, the default offset is read from the source file and applied to each symbol in the file. If you select
Custom Offset, you can add or subtract the specified offset value to each symbol in the file as it is loaded.
You can choose any 32-bit hexadecimal value from 0 to FFFFFFFF.

When you enter bound values, enter the values without an offset value. If your application adds an offset,
subtract the offset value before you enter the bound values.

To Use

To open the Load Symbols Options dialog box from the System menu, click Symbols and then click the
Load button. Then select a symbol file and click Options.

Related Topic
Symbol Files (see page 341)
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OMF51 File Format

This format holds symbolic information and executable images for an 8051 or equivalent
Mmicroprocessor.

OMF86 File Format

This format holds symbolic information and executable images for an 8086 or equivalent
microprocessor. It is also used for code intended to run on 80286, 80386, or higher-level
microprocessors in real or 8086-compatible mode.

OMF166 File Format

This format holds symbolic information and executable images for the Siemens (Infinion) C166 or
microprocessor family, or compatible microprocessor.

OMF80286 and OMF80386 File Formats

These formats hold symbolic information and executable images for 80286, 80386, or equivalent
microprocessors. They are also used for executable images intended to run on the 8086 or other
microprocessors in the 80x86 families.

COFF File Format

The Common Object File Format (COFF) contains a number of variations and extensions, such as
ECOFF, XCOFF, and COFF2.

This flexibility enables the file format to be used with a wide variety of different microprocessors.
Some code-generation tool vendors also extend this format in nonstandard ways that may make their
files unreadable by Tektronix Logic Analyzers.

IEEE695 File Format

This object file format refers to the IEEE69S5 specification. This format is used primarily by compilers
for a wide variety of Motorola microprocessors, as well as Motorola-compatible microprocessors
from other vendors. This format provides for the inclusion of column information in source symbols,
but not all compilers use this capability.
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ELF/DWARF and ELF/STABS File Formats

Elf is an object file format used primarily with PowerPC microprocessors. The Dwarf 1, Dwarf 2 and
Stabs names refer to the format of the portion of an EIf file that contains debug information. This
format provides for the inclusion of column information in source symbols, but not all compilers use
this capability.

NOTE. Although Dwarf 1 and Dwarf 2 debug formats are able to support symbol values in excess of
32 bit resolution, the Logic Analyzer will use only the least significant 32 bits. The logic analyzer will
issue a warning if any symbols exceeding 32 bits in size are encountered while loading the symbol file.

Exporting Symbol Tables

Use this export dialog box to export symbol tables in the TSF format. The TSF format is ASCII, which
makes it more suitable for display and modification. The exported file can also be reloaded if desired.

Related Topic
Symbols Dialog Box (see page 346)

TLA Symbol File Format Overview

350

The logic analyzer can extract range symbol information directly from object files.

Users whose code generation tools do not generate some file formats can use TLA Symbol File (TSF)
format (a text format). The logic analyzer uses the TSF format when it exports symbol files. The logic
analyzer can also read files in this format.

TLA symbol files consist of alphanumeric symbol names and associated data values. The files contain a
header line and lines defining the symbol names and values. Fields on a line are separated with white space
(blank spaces or tabs). The formats for the pattern symbol files and the various range symbol files differ; if
you need to use pattern symbols and range symbols, use separate files.

Both TLA range and pattern symbol files have a .tsf file name extension (filename.tsft).

The first few lines of a TSF symbol file are typically comment lines describing when and how the file was
generated.

# TLA Symbol File
# Created on Friday, May 29, 1998 at 09:52:03
# From file: "c :\quickstart\tla7qgs.x"

All lines in a TSF file that begin with a number sign (#) character are treated as comments, unless the very
next character is a plus sign (+). The plus sign signifies a file reader directive. The number sign character
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can also initiate a comment on the end of a symbol definition or other uncommented lines. All text between
the number sign and the end of the line is treated as a comment and ignored.

Related Topics
TLA Symbol File Format - TSF Headers (see page 351)

TLA Symbol File Format - TSF Pattern Symbols (see page 352)

TLA Symbol File Format - TSF Range Symbols (see page 353)

TLA Symbol File Format - TSF Headers

A TSF header identifies the file format version to potential file readers. It specifies whether the file contains
pattern or range symbols, the radix used to specify symbol values, and an optional offset amount to be
added to each symbol value (for range symbol files).

The TSF Header is a file directive, which means that the following information begins with the special
character combination of a number sign character followed immediately by a plus sign (#+). This is not
a comment line. The special character sequence is used to mark instructions to the file reader; these
instructions are called file directives.

The following examples show sample file headers for a pattern symbol file and a range symbol file. The
first two lines are comments included for readability; they are not required as part of the file header.

# TSF Format Type Display Radix File Radix
#
#+ Version 2.1.0 PATTERN HEX HEX

# TSF Format Type Display Radix File Radix Offset
#
#+ Version 2.1.0 RANGE HEX HEX 00000000

The File Format Version number contains three fields. The first two fields are the format major and minor
version numbers. The logic analyzer will only read TSF files where the major and minor version number
of the file is less than or equal to that of the TLA TSF symbol file reader. The third field denotes minor
format changes, which do not impact the file reader.

The File Format Version number is followed by a key word, PATTERN or RANGE, which signifies the
type of symbols found in the file. TSF files can contain either type of symbols, but no single file can
contain both. The header specifies the type for all symbols in the file.

The Display Radix field sets the default radix that will be used to display the numeric symbol value. For
range symbol files, this field must be one of the key words: HEX, DEC, OCT, or BIN. For pattern symbol
files, only the key words HEX, OCT, or BIN are allowed.
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The File Radix field specifies the radix used by the symbol values in this file. Like the Display Radix
field, the File Radix field must be one of the key words: HEX, DEC, OCT, or BIN for range symbol files,
or HEX, OCT, or BIN for pattern symbol files.

The Offset field specifies an offset value and is applicable only to range symbol files. The offset value is
specified in the radix indicated by the File Radix field. This offset value will be added to the lower and
upper bounds of each range symbol that is read from the file. The offset is a 32-bit value, so it can have
any value between 0x00000000 and OXxFFFFFFFF. If the sum of the offset and a range symbol bound value
exceeds the 32-bit limit of OXFFFFFFFF, the overflow bit is discarded. Negative offsets are specified

by using a twos complement value for the offset.

Related Topics
TLA Symbol File Format Overview (see page 350)

TLA Symbol File Format - TSF Pattern Symbols (see page 352)

TLA Symbol File Format - TSF Range Symbols (see page 353)

TLA Symbol File Format - TSF Pattern Symbols

352

Each pattern symbol in a TSF pattern file consists of two fields. The first field is the symbol name, and
the second is the symbol pattern. The symbol name is a sequence of ASCII characters of up to 220
characters in length, although it is impractical to display symbol values much longer than 32 characters.
Symbol names longer than 220 characters will be truncated during loading. The characters in a symbol
name can be any character with an ASCII value between 0x21 (the exclamation point character, !) and
0x7E (the tilde character, ~). You can use symbol names with embedded spaces by enclosing the Symbol
Name in double quotes.

# Symbol Symbol Optional Foreground
# Name Pattern and Background Color
#
NUL X0000000

SOH X0000001 @red @yellow
STX X0000010

"ETX 0x03" X0000011

The symbol pattern consists of numerals in the radix specified by the File Radix field in the header, and Xs
signifying don’t-care values. The number of bits represented by each character position in the pattern
depends on the selected radix. For a HEX radix, each character represents 4 bits. For an OCT radix, each
character represents 3 bits; for a BIN radix, each character represents one bit.

Symbol order in a TSF pattern file is important. When selecting the symbol to display for a particular
value, the logic analyzer scans the list of pattern symbols from top to bottom. It selects the first symbol for
which all non-don’t-care bits of the symbol match the corresponding bits of the target symbol.
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Related Topics
TLA Symbol File Format Overview (see page 350)

TLA Symbol File Format - TSF Headers (see page 351)

TLA Symbol File Format - TSF Range Symbols (see page 353)

TLA Symbol File Format - TSF Range Symbols

There are four different types of range symbols:

®  Function (see page 356)

m  Variable (see page 359)

B Source (see page 356)

m Color (see page 354)

Each of these types define a range of 32-bit addresses associated with some entity.

Function range symbols define the beginning and ending addresses where instructions that implement a
function are located in memory.

Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory.

Source range symbols are similar to function range symbols, except that the address range for a source
symbol describes the location of the instructions that implement just one source statement. (Source
symbols also contain file name, line number, and an optional column range that define the location of the
source code associated with the symbol.)

Color range symbols define a display color for any value that falls within a range.

Each of the types of range symbols appears in a separate section of the file. Each section begins with a file
directive indicating the type of symbols that follow. The sections may appear in any order, and can be
broken up and separated by other sections if necessary.

The first section might be variables, followed by functions, then followed by another variable section.
Each section is also optional, however some logic analyzer applications are will not use the symbol file
if the appropriate type of symbols are not present. For example, the source window will only correlate
with a listing window if the symbol file contains source symbols.

Range symbol names follow the same rules as pattern symbol names. The symbol name is a sequence
of ASCII characters of up to 220 characters in length, even though it is impractical to display symbol
values much longer than 32 characters.

Symbol names longer than 220 characters will be truncated during loading. The characters in a symbol
name can be any character with an ASCII value between 0x21 (the exclamation point character, !) and
0x7E (the tilde character, ~). You can use symbol names with embedded spaces by enclosing the Symbol
Name in double quotes.
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Range symbol address ranges can overlap. This overlap sometimes produces unexpected results. When
overlaps occur, and the logic analyzer needs to convert a numeric value to a symbol, it must choose
between the overlapping symbols. When choosing between overlapping symbols, the logic analyzer
assigns a precedence order to the symbol types. Function symbols have the highest precedence, followed
by variable symbols, and then source symbols.

Related Topics
TLA Symbol File Format Overview (see page 350)
TLA Symbol File Format - TSF Headers (see page 351)

TLA Symbol File Format - TSF Pattern Symbols (see page 352)

TSF Range Symbols - Color

354

Color range symbols define the beginning and ending group values where a color is displayed. Any
group value in the acquisition falling within this range will be shown in the defined color. The value
range of a color symbol can overlap with the set of ranges defined by one or more Function, Variable,
or Source symbols. In many instances, a Color symbol will use exactly the same range bounds as a
Function or Variable symbol.

A partial range file with colors is shown below:
#+ Color

# Color Low High

#
@magenta 006035ba 00603640
@yellow @navy 00603541 00603675
@default @green 006036e6 0060372f

The first line tells the file reader that the following symbols represent colors. The next two lines are
comments used as headers. The first color name specifies the foreground color, and the second optional
color name specifies the background color. The available color names (keywords) are:

@bTack, @blue, @cyan, @lime, @magenta, @red, @yellow, @white, @navy, @teal,
@green, @purple, @maroon, @olive, @gray, and @silver.

The special color name @default gives the default text coloring specified by choosing a color in the Column
tab of the Listing Window Property Sheet or the Waveform tab of the Waveform Window Property Sheet.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.

There is a different TSF symbol file syntax for adding color to range and pattern symbol files. For pattern
symbol files, color is an attribute of existing pattern symbols. It is placed on the same line as the rest of the
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symbol, and to the right of the pattern definition. For range symbol files, color symbols are added in a
separate section of the symbol file, just like Function, Variable, and Source symbols. This allows the color
information to be independent of the other defined range symbols.

A partial TSF Pattern Symbols file is shown below:
# Symbol Name Pattern Color

#

NUL X000 0000

SOH X000 0001 @blue

STX X000 0010 @white @red
SBZ X000 0100 @default @teal

Each Pattern symbol in a TSF Pattern file consists of three fields. The first field is the Symbol Name, the
second is the Symbol Pattern, and the third is Symbol Color.

The Symbol Color specification may contain zero, one, or two color keywords. If only one color is
given, it specifies the foreground color of the data. If two colors are given, they specify the foreground
color followed by the background color.

To supply a background color, provide a foreground color. If you want to use the group’s defined color
from the Column or Waveform Property Page, you can use @default as the foreground color.

In addition to specifying the colors by name, you can also specify the color symbols using the RGB
hexadecimal format. For example the earlier example of the partial range file with colors is shown below
using the RGB format:

#+ Color
# Color Low High

#

@FFOOFF 006035ba 00603640

@FFFFO0 @000080 00603541 00603675

@default @008000 006036e6 0060372f

Similarly the partial TSF Pattern Symbols file using RGB is shown below:

# Symbol Name Pattern Color

#

NUL X000 0000

SOH X000 0001 @OOOOFF

STX X000 0010 @ FFFFFF @FFO000
SBz X000 0100 @default @008080
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Related Topics
TLA Symbol File Format - TSF Range Symbols (see page 353)

TSF Range Symbols - Function (see page 356)
TSF Range Symbols - Variable (see page 359)
TSF Range Symbols - Color (see page 354)

TSF Range Symbols - Function

The file directive "#+ Function" introduces the function symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent functions, as opposed to variables or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ Function

# Symbol Name Low High
#
displayBanner 006035ba 00603675
buildmenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

Function symbols consist of three fields: the symbol name, the lower bound, and the upper bound.

The lower and upper bound values are each 32-bit values, defined by numerals in the radix specified by the
File Radix field in the file header. These values define the lower and upper limits of the range of addresses
occupied by the instructions that implement a function. Both values are inclusive, which means that the
specified range includes both of the bound values, as well as all of the addresses between them.

Related Topics
TLA Symbol File Format - TSF Range Symbols (see page 353)
TSF Range Symbols - Variable (see page 359)

TSF Range Symbols - Source (see page 356)
TSF Range Symbols - Color (see page 354)

TSF Range Symbols - Source

The file directive "#+ Source" introduces the source symbol section of a TSF range file. The file directive
tells the file reader that the following symbols represent source statements, as opposed to functions or
variables. The source file directive must be followed by a file name, which specifies the name of the source
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file containing the following source statements. Each new set of symbols for a unique source file must
be introduced with an additional source file directive to specify the file name for those symbols. If no

symbol type file directive is given, the function symbol type is assumed.

#+ Source stoplite

# Line Low High Beg End Symbol Name

#

27
35
47
48
49
50
51
52
56
59
60
61
59
59
71
74
77
80
83
87
71
84

006043ec
00604310
00604316
00604400
0060440a
00604414
0060441e
00604428
00604432
00604438
0060443a
00604446
0060444e
00604450
00604456
00604458
00604460
00604468
00604470
0060447c
00604484
0060448e

006043ef
0060435
006043ff
00604409
00604413
0060441d
00604427
00604431
00604437
00604439
00604445
0060444d
0060444f
00604455
00604457
0060445f
00604467
0060446f
0060447b
00604483
0060448d
00604490

o O O O O o o o o o o

0

35 39 # stoplite_59_35
19 34 # stoplite_59_19

o O O o o o o

0

25
23
30
30
30
30
30
30
17
18
37
33

37
35
36
36
43
34
37
29

HOH O OH OH W OH W OH OH W W

#
#
#
#
#
#
#

#

stoplite_27_25
stoplite_35_23
stoplite_47_30
stoplite_48_30
stoplite_49_30
stopTlite_50_30
stoplite_51_30
stoplite_52_30
stoplite_56_17
stoplite_59_18
stoplite_60_37
stoplite_61_33

stoplite_71_37
stoplite_74_35
stoplite_77_36
stopTlite_80_36
stoplite_83_43
stoplite_87_34
stoplite_71_37
stoplite_84_29

The source symbols section consists of five fields for each source statement: line number, lower address
bound, upper address bound, beginning column value, and ending column value.

Source symbols do not have a name in the same sense as function or variable symbols, because there is
no name associated with each of the executable statements in a source file. Instead, a source symbol
has a file name, specified in the source directive, and a line number. The line number specifies the line
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of the source file that contains the source statement. Line numbers are always in decimal, regardless
of the file radix in the header.

The lower and upper bound values for a source symbol are similar to those of function and variable
symbols. For source symbols, these bounds represent the range of addresses occupied by the instructions
that implement a single source statement.

The bound values are defined in the file radix specified in the header and can range in value from
0x00000000 to OxFFFFFFFF. The lower and upper bound addresses are inclusive, just like other symbols.
A source symbol for an instruction occupying a single memory location has matching lower and upper
bound values.

The beginning and ending column fields of a source statement are optional. When present, and non-zero,
they define the beginning and ending column position for the source statement.

The beginning and ending column values define the location of the statement in the line. This is especially
useful when there are multiple statements on a single line, because it makes it possible to define a separate
symbol for each statement. When the column information is not present, or is set to zero, the symbol is
assumed to correspond to the entire line.

Only a few compilers generate column information, but when the information is present in the symbol file,
the logic analyzer uses the column information to provide highly accurate source code correlation. The
example source symbols on the previous page show typical column values.

In most cases only one of the column values is non-zero. This is because those lines contain only one
statement, and the compiler specified only the column at which the statement ended. Some compilers
specify only the beginning column position for such lines, in which case the beginning value would
be non-zero and the ending value zero.

Note that there are three symbols corresponding to line 59 of the file. Line 59 of the original source
file contains the following statement:

for (i = 0; i < NUM_STATES ; i++)

This one line contains three separate statements. The first statement is the initialization (i = 0), the second
statement is the test (i < NUM_STATES), and the third statement is the increment (i++).

Although all three statements appear on the same line, each generates a separate set of instructions, and
the symbols in the example define unique address ranges for each. This enables the Source window to
accurately indicate which of the three statements on the line is associated with any given address.

Each of the source symbols in the example includes a comment at the end of the line showing a symbol
name. Since this is a comment, it is ignored by the symbol file reader, and is optional. When symbol files
are exported by the logic analyzer, they contain comments that show the derived symbol name created by
the logic analyzer itself. The name is a concatenation of the symbol file name, line number, and column
number (if present). This is the symbol value that the logic analyzer will display for addresses that fall
within the lower and upper bounds of a source symbol.

Related Topics
TLA Symbol File Format - TSF Range Symbols (see page 353)

TSF Range Symbols - Function (see page 356)
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TLA Symbol File Format - TSF Range Symbols (see page 353)

TSF Range Symbols - Color (see page 354)

TSF Range Symbols - Variable

The file directive "#+ Variable" introduces the variable symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent variables, as opposed to functions or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ variable
# Symbol Name Low High
#

menu 00000100 00000102
userMenul 000004c0 000004c2
binBits 000004d4 000004d6

Variable symbols consist of three fields: the symbol name, the lower bound, and the upper bound. Variable
symbols are just like function symbols except that they define the address range occupied by a variable
instead of function. The lower and upper bound values of a variable symbol are inclusive, meaning

that they are themselves a part of the range. For variables occupying only a single byte in memory, the
lower and upper bound values are equal.

Related Topics
TLA Symbol File Format - TSF Range Symbols (see page 353)

TSF Range Symbols - Function (see page 356)

TSF Range Symbols - Source (see page 356)

TSF Range Symbols - Color (see page 354)

System Window

From the System window you can access all other setup windows, trigger windows, and data windows.
The System window also shows the analyzer configuration, arming, and triggering relationships.
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Logic Analyzers

An icon represents each installed instrument. Inside each
icon are specific controls where you can do the following Logic LTI B
tasks: Analyzer Slots 1-2
. o o ) =
B QOpen the properties tab by double-clicking an open A i f
area inside the icon. O0ff] Setup| Trig
= QOpen the logic analyzer Setup window by clicking the |L& 1

Setup button.

= Open the logic analyzer Trigger window by clicking the
Trigger button.

B Turn the logic analyzer on or off by clicking the On/Off
button.
®  Name the logic analyzer by entering text in the text box.

Click the logic analyzer to see which data windows contain
data for the logic analyzer.

Active Logic Analyzer

The logic analyzer highlighted by the pointer in the System window is the active logic analyzer.

Identifying Modules

If you are unsure which physical module an icon represents, double-click the icon to open its System
Properties dialog box. The System Property dialog box lists information about the module, including the
mainframe slot number in which the module is installed.

Disabling Modules
To disable a module, click the module’s On/Off button.

When you disable a module, first verify that no other trigger program is dependent on the module’s output.

Data Windows

An icon represents each data window. You can use the New Data Window dialog box to create Histogram
or Source windows or other windows. To create a new data window click F in the toolbar.

NOTE. You can change the default data window for logic analyzer in the Defaults property page. From the
System menu, select Options and click the Defaults tab to display the Defaults tab.
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Inside each data window icon are specific controls where
you can do the following:

i
= Open a data window by clicking its icon located above I

the text box. ListingT

B QOpen the Properties dialog box to access the product's
properties tabs by double-clicking the mouse in an open
area close to the icon.

m  See which data windows are associated with a logic
analyzer (or data window), by clicking the logic analyzer
(or data window text box). White arrows appear, linking
the logic analyzers and data windows.

Renaming a Window

You can rename the window by selecting the current window label and typing over it. Window names
must be unique and the window name is limited to the space available.

Triggering and Arming Relationships

A logic analyzer that is programmed to cause a system

; ’ | ; I ainframme

trigger has a trigger indicator symboli on the right edge LEm |

of the logic analyzer icon. A black arrow from one logic _ o

analyzer to another indicates one module is programmed Logic TR o | Digital NN
. - Analyzer Slots 1-2 Dzcilloscope Skt -4

to arm another through the first module’s trigger program.

The example shows a logic analyzer module arming the oin] S8 o0l =2 i

DSO module. C0Off| Setup|  Trig C0ff| Setup|  Trig

L& 1 D501

Context Menu

You can right-click the mouse in different parts of the System window to display a menu that contains a list
of useful tasks such as opening or displaying properties for the trigger, setup, and data windows.

Related Topics
Triggering other Modules from an LA (see page 103)

Arming other Modules from an LA (see page 103)

Armed Module

An armed module is a module that begins running its trigger program once it has received an arm
signal from another module. This allows the armed module to run its trigger program when a
condition is met in the other module’s trigger program.
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New Listing/Waveform Data window

System Trigger (Trigger All Modules)

The system trigger is an overriding command that causes all modules to acquire their post trigger
data, regardless of whether they have been armed or have fulfilled their own trigger conditions.

The system trigger is the primary data acquisition reference point. In data windows, timing and
location information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the instrument.

Trigger Program

The trigger program is a series of conditions, similar to software code that defines the data you want
to capture and view. The trigger program also specifies actions that are expected when conditions
(data events) are true.

The trigger program filters acquired data to find one or more specific data events. The trigger
program can accept signals from other modules or signals from external test equipment through the
external System Trigger In or the External Signal In connectors. Similarly, the trigger program
can also send signals from the module to external equipment through the System Trigger Out and

the External Signal Out connectors.

New Listing/Waveform Data window

362

Use this dialog to create a new Listing or Waveform window. Click one of the following selections to
specify the data source for your new data window:

Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. You can also click the Browse button to search for a desired TLA system file.

Click No data to create an empty Listing or Waveform window. After the window displays, you can
add columns or waveforms from different sources.

Click Same columns/windows as active data window to add the columns or waveforms from the
active window to your new data window.

Click MagniVu columns/waveforms based on the active data window to view MagniVu data (higher
resolution) of the same columns or waveforms as the active window.

Related Topic

Adding a Waveform (see page 118)
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New Data Window Name

Enter a name for the new data window or use the default name. Then click the Finish button to create
the new data window.

Name Data Window Dialog Box

Use to specify a new name for a data window. This dialog box displays when you attempt to name a
data window that is not unique.

Load System Options Dialog Box

Use to load part of a saved system file into the current system. This is useful when you need to use
portions of a saved system file with the current system. A saved system consists of one or more modules,
data windows, and links to data sources in other TLA files. A saved module consists of the module’s
setup and trigger settings as well as data.

Load System Options 2]X

Cirag modules n the saved system onto deswed modules i the cusrent
zyztem. Feference data sources and data wandows in the saved system will

alzo e loaded.
Protocod]

JTLIHRE LA o ¥
e o | i o |
[ [

L& 1 DE0 1

Current Sustern
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From a saved module file, you can load any of the following:
B An LA module trigger program

B A module setup and trigger program

B Saved data from the module

From a saved system file, you can load any of the following:
® Any previously listed module choices

= Full system setup, including data windows

® Saved data from one or more modules

Behavior

The Load System dialog box is automatically opened when you perform a Load System and the saved
system file does not match the current logic analyzer configuration (and both systems contain at least
one module).

When necessary, the analyzer adjusts the following setup parameters to match hardware limits:
B Memory depth

m Trigger position. Relative position is maintained

®m  Sample period

If you try to load a module that is not compatible with the saved module, the cursor changes to a no drop
shape. The following might cause the saved file to be incompatible:

® The width of the current module is less than the width of the saved module.

® The module type is not the same. Use a saved DSO module for a DSO, and a saved logic analyzer
module for a logic analyzer.

If you load a saved system with a different module configuration than your current system, the logic
analyzer displays a dialog box similar to the following:
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The zaved suztem configuration does nat match the current
gyztem configuration.

Madules in the zaved systemn will be mapped ta modules in the
current system as shown below. Any modules in the saved
gystem that are not mapped will not be loaded. Any modules in
the cumrent zuztem that aren't mapped to will be defaulked and
dizabled.

Prezz OF. ta load with theze mappings. Press Load Options ta
[oad with wour own mappings.

LA 1 [Slotz 3-4) will not be loaded. ”
L& 2 [Slatz 5-6] will be loaded anto [Slats 8-3].

LA 3 [Slotz 7-8) will not be loaded.

0S50 1 [Slatg 3107 will not be loaded.

LAy 4 [Slotz 17-12] will not be loaded.

TDSR104B [GRIB 1 Miew) will nat be loaded. b

| (1] 4 | [ Load Options

Click OK to accept the suggested configuration. If you click Cancel, the logic analyzer displays the Load
System Option dialog box. Use this dialog box to load specific modules from the saved system.

NOTE. Ifyou load a setup that you saved with suppressed samples, the suppressed samples are not present
in the setup.

An unmerged module can be loaded into a merged module. The master of the merged pair must have a
width equal to or greater than the unmerged module. A merged module can be loaded into a merged
module, provided the master and slave of the destination has a width equal to or greater than the master
and slave of the saved pair.

To Use

To open the Load System Options dialog box:

1. Go to the File menu from any window.

2. Select Load System.

3. Select a TLA system file. The Options button becomes active when a system file is selected.
4. Click Options.

To load a saved module, drag the module icon from the top of the Load System Options dialog box to
a module icon at the bottom of the dialog box.

NOTE. The module icon does not move,; however the cursor changes shape to indicate a drag function.
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Related Topics
Saving a System (see page 78)

Merge Modules Properties (see page 372)

Status Monitor Dialog Box

366

To open the Status Monitor dialog box, click the Status button on the toolbar.

i

The Status Monitor is used to determine the status of your acquisition while it is running.

The Run animation control indicates when the system is in the acquisition mode by changing from
to when the Run button is clicked.

When you hover your mouse pointer over the icon, a tool tip box provides you with the acquisition
status of your installed modules as shown below.

M Status Monitor

System Statuz: [dle

todule Mame Statuz

L& Idl=
DS01 Idl=
CSA7154 Daone

The Status Monitor dialog box contains a summary area at the top that lists a one-line summary of each
module installed.

The Status Monitor dialog box shows the following:

®  Status of the acquisition: Idle, Waiting for Trigger, or Triggered.
m The Start Time of the acquisition.

B The name of the module.

B The status of memory for all modules during acquisition is shown on the left of the status dialog
box. Blocks are filled in to the left of the T (trigger position). Blocks are filled to the right of the T
after the module is triggered.

B The number of repetitive acquisitions when in Repetitive mode.
m  The trigger state of the logic analyzer module trigger program that is executing.

B The number of samples remaining to be filled in memory.
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®  The value of each logic analyzer counter and timer when appropriate. Only shown for logic analyzer
modules.

B The state of the module’s intermodule output signal, shown as Sig/Arm Out.
m  The status of data comparison during logic analyzer memory compare operations.

B  Clock warning when the logic analyzer senses no clock activity. If this message appears, check for a
missing clock signal or for an error in the sampling setup.

The Status Monitor dialog box is resizable.

Related Topic
About Data Properties (see page 196)

External Signal Selection

When using the External Signal In and External Signal Out functions, select an internal signal.
m  Select None to prevent signals from being sent or received at the external connector.

®m  Select 10 MHz clock to send a 10 MHz clock signal to the External Signal Out connector. This signal
will be available continuously at the connector until explicitly disconnected by changing the External
Signal Out selection in the Signals tab.

NOTE. The 10 MHz clock signal is interrupted briefly during the following actions: Load System, Default
System, diagnostic execution, and calibration.

®  Select Signal 1-4 to assert External Signal Out when the specified signal is true. Signals 1 and 2
are high-speed, ECL rate signals, and are usually the preferred choice for both internal and external
signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and 2, but operate at
the slower TTL-rate.

Signals 1 and 2 162 MHz maximum
62.5 MHz maximum (at External Signal Out connector)
Signals 3 and 4 12.5 MHz maximum

Internal Signal Selection

Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both
asynchronous and synchronous signal applications. Signals 3 and 4 are functionally equivalent to signals 1
and 2, but operate at the slower TTL rate.
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Signals 1 and 2 162 MHz maximum (internal)
62.5 MHz maximum (at External Signal Out connector)
Signals 3 and 4 12.5 MHz maximum

Selection Dialog Box

Use the Selection dialog box when you want to do one of the following tasks:

B Add a data source from a TLA system or module file to the current system. Click Browse to search for
the required file.

B [oad a data window from a TLA system file.

B Load a module setup onto a selected module in the current system.

B Load triggers. Click Browse to select a trigger from your modified trigger list.

B Load a trigger setup onto a selected logic analyzer module in the current system.

B Load a search definition onto a selected data window in the current system. Click Browse to select
a previously saved search definition.

MagniVu Data

368

Overview

MagniVu data is the result of asynchronous digital oversampling architecture. This data is automatically
acquired whenever you perform an acquisition. This means that, even if you specify synchronous
acquisition, you can view the asynchronous resolution data at any time without having to reacquire.

Behavior

MagniVu acquisition rates differ based on the module that you have. If you are using a TLA7000 Series
logic analyzer module or a TLAS000B Series logic analyzer, your acquisition rate is selectable, based
on your MagniVu Storage Rate (see page 172), and is constrained by both PowerFlex and the current
maximum acquisition rate for main memory.

Related Topic
Adding MagniVu Data to a Listing or Waveform Window (see page 75)
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System Trigger (Trigger All Modules)

The system trigger is an overriding command that causes all modules to acquire their post trigger data,
regardless of whether they have been armed or have fulfilled their own trigger conditions.

The system trigger is the primary data acquisition reference point. In data windows, timing and location
information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the analyzer.

High-Level Language support

You can correlate the High-Level Language (HLL) source code that you wrote with the disassembly
listing, showing how the code was executed on your target system, and then acquired by the logic analyzer.
The correlation is based on symbolic information that is extracted from your object file or load module.
You can configure the logic analyzer to access your source files.

You can step through each executed source statement in the Source window and view the results in
a correlated Listing window.

You can set user-defined marks as break points within the code and then trace the execution of the code
between the marks.

The following file formats are supported: OMF51, OMF86, OMF166, OMF286/386, IEEE695, COFF,
ELF/DWARF and ELF/STABS.

In addition to the file formats listed below, Tektronix also provide the Tektronix Symbol File Format (TSF)
(see page 350), a text format. For information on any other file formats, contact your local Tektronix
representative.

Start-Up Properties

Use to select which system to open after you power on the analyzer. You are presented with the following
choices:

Last System file opened in previous session. The TLA application automatically loads at start-up the
last saved system file that you explicitly loaded.

Default System. The TLA application loads the default setups for all modules at start-up.
Saved System. The TLA application loads a saved system file that you specify at start-up.
The default system also consists of the following:

m  Default setups for all modules.

B Default settings for internal signals specified in the System Configuration dialog box.
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B One data window for each module. A Waveform window is created for each DSO module. A data
window of the default type, as specified in the Defaults tab, is created for each logic analyzer module.
Only data sources from the physical modules in the current system are included.

m  All usable modules are on.

To open the Start-Up tab from the System menu, click Options and then click Start-Up.

Related Topic
Defaults Properties (see page 378)

Power-On Diagnostics Properties
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Overview

Use to view the results of the power-on diagnostics. The Test Name column lists the mainframe, slot
number and name of installed modules, and specific tests.

Behavior

If any test failed, the Power-On Diagnostics page opens as the first active window and the first failed test is
highlighted. If a test fails you can either select the Extended Diagnostics tab and rerun the test, or dismiss
this page by clicking the Close button. If you dismiss this page, the application finishes loading.

NOTE. Mainframe power-on diagnostics only run when the system powers on.

If a module is not recognized, the module type area is filled in with any available information or the
word Unknown is displayed.

To Use

To open the Power-On Diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Power-On Diagnostics.

Related Topics
Running Extended Diagnostics (see page 133)

Contacting Tektronix )
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Self Calibration Properties

Overview

Use to run calibration procedures on installed modules, either individually or as merged pairs. You should
run these procedures after repair and at least once a year for the logic analyzer module. The DSO module
requires self-calibration if the ambient operating temperature has changed more than 5 °C since the

last calibration or once a week if the vertical settings of 50 mV full scale or less are used. A warning
message to calibrate appears if ambient temperature goes out of tolerance. Perform self-calibration after
a 30-minute warm up.

NOTE. Merged modules must be calibrated individually and as a set.

Status list

The following is a list of status messages:

= Running. The calibration procedure is being executed. The text blinks to indicate progress.
E Calibrated. The module calibrated successfully.

®  Fail. The module did not calibrate. Contact your local Tektronix service representative.

m No Calibration Required. The module either does not need to be calibrated or it does not have
any self-calibration functions.

® Unknown. Try to calibrate again. If the module has the same status, contact your Tektronix service
representative.

To Use

To open the Self Calibration tab from the System menu, click Calibration and Diagnostics, and then
click Self Calibration.

Related Topics

Power-On Diagnostics Properties (see page 370)

Extended Diagnostics Properties (see page 337)

Calibrating Modules (see page 59)

Contacting Tektronix )
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Mainframe Properties

Use this information when you contact Technical Support.

To open the Mainframe tab from the System menu, click System Properties and then click Mainframe.

Modules Properties

Shows information about modules installed in the analyzer.
1. From the System menu, click System Properties.

2. Click the Modules tab.

Module Specifics Properties

Provides information about a selected module. You use this information when contacting Technical
Support.

1. From the System menu, click System Properties.

2. Click the tab of the module for which you want information.

Merge Modules Properties

Overview

You can merge up to five logic analyzer modules to increase width. Merged modules function as a single
unit and the data it acquires is automatically time-correlated. This is useful when analyzing buses or
devices with a high count. Some microprocessor supports require merged modules.

Behavior

Modules must be physically connected and in the same mainframe before they can be merged by software.
Modules must be adjacent and connected as described in the user manual. Only modules that have been
physically connected and are capable of being merged are shown in the Merge Modules tab with a merge
button. Refer to Merging Modules (see page 53) for the rules on merging modules.

The state of the button indicates whether the modules are currently merged, as shown:
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.System Configuration
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To Use

To open the Merge Modules tab from the System menu, click System Configuration and then click Merge
Modules. To merge or unmerge modules, click the merge button between the module icons.

Related Topics

Merging Modules (see page 53)

Self Calibration Properties (see page 371)

Merged Module Synchronous Sampling (see page 27)

Preferences Properties

Use the preference properties page to specify user preferences, such as hiding the Status bar, displaying
confirmation messages, specifying click and drag zoom behavior, or showing the Easy Setup dialog. These
settings cannot be modified anywhere else in the application.
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To access user preferences from the System menu, click Options to display the Options dialog box.
Then click the Preferences tab.

System Source Files Properties

374

Overview

The System Source Files tab defines the default location of source files for new Source windows. The
settings you specify in this tab will be the default settings used to locate source files when you first create a
Source window. You can specify a list of directory paths and a list of possible file suffixes.

Behavior

When specifying the search path, you can use an asterisk (*) as the final component of a search path
directory. For example, if you specify the following path, C:\MySources\*, the MySources directory and
all directories (one-level deep) within MySources will be searched. However, you cannot use the asterisk
as a general-purpose wild card character. For example, the use of an asterisk in C:\MySources\*\* or
C:\MySources\abc* is invalid.

Specify the complete absolute (not relative) path name for the file in the Search Path List. Otherwise the
Source window will not locate the source file. Make sure that the source file you are looking for has a
unique file name. When searching for source files it is possible to load the wrong file if there is another file
with the same name in the directories specified by the search path. The Source window always loads the
first file that matches the search criteria.

NOTE. This tab is similar to the Source Window Source Files tab. The information that you supply in this
property page will be used as default settings for new Source windows. The information that you supply
for the Source Window Source Files tab is only used for the current Source window.

To Use

To open this page from the System menu, click Options and then click Source Files.

B Select Search Path List to specify source file locations.

m  Select Suffix List to specify possible file suffixes. The default suffixes are .c and .s.
m Click Add to add items.

®  Click Edit to edit the selected item.

B Click Delete to delete a selected item from the list.

Related Topic

Source Window Source Files Properties (see page 237)
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Signals Properties

Signals Properties

The logic analyzer has four internal signals that you can use to set up trigger conditions between modules,
or to send or receive signals external to the logic analyzer. Use the Signals tab in conjunction with the
module trigger programs to configure these signals for your application. The trigger programs and
external signal input determines when the signals occur. The Signals tab specifies signal characteristics.
To configure signals for your application from the System menu, click System Configuration, and then

click the Signals tab.
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Internal Signals

All logic analyzer modules can set and clear any of the four internal signals. The DSO can set but not
clear any signal. The logical output of these signals can be used as an event in other trigger programs.
You can also connect the internal signals to the External Signal In and External Signal Out connectors
on the mainframe, so that you can use an external signal as a trigger event or send a signal out when a

trigger condition is met.

Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling, take care
that the signals are correctly set and cleared, and that the trigger programs for all modules are compatible
with regard to signal usage. Also, correctly set the internal signal attributes in the Signals tab of the

System Configuration dialog box.

Internal signaling is done through trigger actions specified in the Clause Definition dialog box and the

DSO Trigger tab.
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NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and
set signals. You can test for a set signal (for example, If Signal X Is True), but unless you have designated
an external signal for this purpose, you will be unable to set the signal when using the arming feature.

External Signals

The logic analyzer can send and receive signals external to the logic analyzer using the mainframe External
Signal In and External Signal Out connectors. Use the External Signal In function to include a signal from
your system under test or other test equipment as part of the trigger program. Use the External Signal Out
function to send a signal to the system under test or other test equipment from a trigger program.

The connection from the module to the external connector is made by one of the four internal signals.
Designate which internal signal is to be used for this purpose.

The external signal connectors are located at the rear of the portable mainframe and at the front of the
benchtop mainframe. The external signals all operate at TTL voltage levels.

The polarity for External Signal In is always set to Low TRUE. You have a choice of low or high true for
External Signal out. For a high true signal, clear the selection Low TRUE.

Signal Logic Function

To use internal signals, select which internal signal logic function is appropriate for your trigger program.
Signals 1 and 2 (high speed) can only be asserted by one module each. For signals 3 and 4 the modules
can be wired-OR or wired-AND. Selecting the OR function means that any module can assert the signal.
Selecting AND means that all modules must set the signal for it to be asserted. The same logic applies to
clearing signals.

System Trigger Connectors

The System Trigger In/Out Connectors group box contains readouts that reflect the current state of the
System Trigger In and System Trigger Out connectors. You can also set the threshold for the System
trigger in connector.

NOTE. Only modules that are on can send arming or internal signals.

To Use

To open the Signals tab from the System menu, click System Configuration and then click Signals.

Related Topics
Clause Definition Dialog Box (see page 163)

DSO Trigger Settings (see page 385)

External Signal Selection (see page 367)
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Internal Signal Selection (see page 367)

Color Properties

Use to create, remove, and modify color schemes.
1. Select an Element you want to change from the list and then select a color from the color matrix.

2. Click Save As to enter a new name for your scheme or click OK in the Save Scheme dialog box to keep
the existing name and redefine the defaults for it.

NOTE. You cannot redefine or remove factory defaults.

The following table describes each element.

Element Name

Description

Data Background

Default background color for a data window's data area

Data Foreground

Default text color for the data in a data window

DSO Waveform

Default color for DSO waveform data

LA Waveform

Default color for logic analyzer waveform data

LA — MagniVu Waveform

Default color for logic analyzer MagniVu waveform data

Trigger Default color for trigger marks
Cursor 1 Default color for cursor 1
Cursor 2 Default color for cursor 2
Mark Default color for user marks

Compare: Acq = Ref

Default color for highlighting equalities between acquisition
data and reference data

Compare: Acq != Ref

Default color for highlighting differences between acquisition
data and reference data

Glitch

Default color for glitches

Waveform Readouts

Default color for DSO ground, volts readout, trigger level,
magnitude readouts and busform readouts

Graticule

Default color for the graticule in a Waveform window

Highlight

Default color for disassembly highlighting in a Listing and
Source window

Histogram Bar

Default color for bars in a Histogram window

Uncorrelated Source

Default color for uncorrelated text in a Source window

A default color scheme can be assigned for new data windows from the Defaults tab, which is located in

the Options dialog box.
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From the System menu, you can access the Color settings by clicking Options and then clicking the
Color tab.

Related Topic
Defaults Tab (see page 378)

Software Properties

Shows what TLA software is installed in the analyzer.
1. From the System menu, click System Properties.

2. Click the Software tab.

Defaults Properties

Use to specify defaults used throughout the application. The settings you enter here will be the default
settings used when creating new data windows.

To access these settings from the System menu, click Options and then click the Defaults tab.

Save Color Scheme Dialog Box

Use to save a new color scheme set in the Color tab of the Options dialog box.

To open this dialog box from the System menu, click Options, click the Color tab and then click Save As.

Related Topic

Color Properties (see page 377)

Presets Properties

Use the Options Presets to view and modify preset names and values. The presets are used as list entries
in list box controls for selecting trigger thresholds, vertical range, vertical offset, and probe thresholds.
You can modify all preset names and values. Preset names are limited to 12 characters. You can return all
preset names and values to the factory settings by clicking Reset All. If you enter a value that is out of
the range shown below, the value is set to the nearest in-range value.

To change options presets from the System menu, click Options and click the Presets tab.
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Tools Properties

Overview

The Tools tab of the Options dialog box allows you to define up to 16 external applications (or tools) that
may be launched from within the TLA application.

These tools can be associated with any program that runs under the Windows operating system or any type
of document that Windows knows how to open. When a tool is defined here, it is automatically added

to the Tools sub-menu of the System menu in the TLA menu bar. Also, a toolbar button for each tool

is added to the TLA Toolbar.

Once a tool has been defined, you can run the program by choosing its name from the Tools menu or
clicking on its toolbar button.

To Use
®  Click the Add button to add a new tool.

®  Click the Edit button to edit the properties of the selected tool, including its Menu Name, Command,
Arguments, Initial Directory, and Run Minimized status.

m Click the Delete button to delete a selected tool from the list.
®  Click the Move Up arrow button to move the selected tool up one position in the list.
B Click the Move Down arrow button to move the selected tool down one position in the list.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools tab.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties
(App Options) dialog box for the commands to work.

Related Topic
Tool Properties Dialog Box (see page 379)

Tool Properties Dialog Box

Overview

Use the Tool Properties dialog box to specify the properties of an external tool.
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To Use

Specify the name of the tool in the Menu Name box. This is the name that is displayed in the Tools menu.
Placing an ampersand before a letter in the tool name makes that letter an accelerator key.

Enter the path and name of the document or application that you want to open in the Command box. You
can click the Browse button to open a Windows file browser to help find the application. If a document is
entered here, the executable to open the document is found based on its registered Windows file type. For
example, a document with a .txt extension is opened with Notepad.

Use the Arguments box to enter any command line arguments that are required by the application.
Use the Initial Directory box to specify the default working directory for the application.

Click Run Minimized to specify that the application will run in a minimized window.

Click the Test Run button to launch the tool with the current dialog settings.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools
tab. Click the Add button, or select the tool you want to modify and click the Edit button.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties
(App Options) dialog box for the commands to work.

Related Topic
Tools Properties (see page 379)

General Purpose Data Window Shortcuts

To

Press

Switch data windows

CTRL+Tab

Scroll data up 10 pages

Shift+Page Up

Scroll data down 10 pages

Shift+Page Down

Scroll data to the top of the window

Shift+Home

Scroll data to the end of the window

Shift+End

Move active cursor up one page

CTRL+Page Up

Move active cursor down one page

CTRL+Page Down

Move active cursor to top of the data CTRL+Home

Move active cursor to end of the data CTRL+End

Move active cursor up 10 pages CTRL+Shift+Page Up
Move active cursor down 10 pages CTRL+Shift+Page Down
Move active cursor to the top of data CTRL+Shift+Home
Move active cursor to the end of data CTRL+Shift+End

The movement shortcuts follow these general rules:
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®  Arrows with no modifier keys scroll the data

m  Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement

Related Topics

Listing Window Shortcuts (see page 383)

Waveform Window Shortcuts (see page 382)

Source Window Shortcuts (see page 384)

Histogram Window Shortcuts (see page 385)

Menu Shortcut Keys (see page 381)

Menu Shortcut Keys

Menu Shortcut Keys

You can use the following shortcut keys for manipulating menus, editing windows, and moving around

in data windows.

File Menu

To Press
Return the system to the default setups CTRL+D
Load a saved system CTRL+O
Save a system setup CTRL+S
Print the active window CTRL+P
Edit Menu

To Press
Cut a selected item to the clipboard CTRL+X
Copy a selected item to the clipboard CTRL+C
Paste items from the clipboard CTRL+V
Undo edit CTRL+Z
Data Menu

To Press
Search backward CTRL+B
Search forward CTRL+F
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System Menu

Waveform Window Shortcuts

To Press
Display the Status Monitor CTRL+M
Run or Stop CTRL+R
Window Menu

To Press
Create a new data window CTRL+N

Related Topics
Waveform Window Shortcuts (see page 382)

Listing Window Shortcuts (see page 383)

Histogram Window Shortcuts (see page 385)

Source Window Shortcuts (see page 384)

General Purpose Data Window Shortcuts (see page 380)

Waveform Window Shortcuts

382

To Press

Go to next Sample Suppression change CTRL+0

Go to previous Sample Suppression change CTRL+9

Go to next trigger CTRL+T

Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL+1

Move Cursor 2 to center of window CTRL+2

Zoom in CRTL+I

Zoom out CTRL+U

Add a mark CTRL+K

Add a waveform CTRL+W

Scroll data left 50 pixels Shift+Left arrow

Scroll data right 50 pixels Shift+Right arrow
Move active cursor left five pixels CTRL+Left arrow
Move active cursor right five pixels CTRL+Right arrow
Move active cursor left 50 pixels CRTL+Shift+Left arrow
Move active cursor right 50 pixels CTRL+Shift+Right arrow

The movement shortcuts follow these general rules:
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®  Arrows with no modifier keys scroll the data
m  Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts (see page 383)

Menu Shortcut Keys (see page 381)

General Purpose Data Window Shortcuts (see page 380)

Listing Window Shortcuts

Listing Window Shortcuts

To Press

Go to next Sample Suppression change CTRL+0

Go to previous Sample Suppression change CTRL+9

Go to next trigger CTRL+T
Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL+1

Move Cursor 2 to center of window CTRL+2

Add a mark CTRL+K

Add a column CTRL+L

Scroll data up 10 samples Shift+Up arrow
Scroll up 10 lines Shift+Up arrow

Scroll data down 10 samples

Shift+Down arrow

Scroll down 10 lines

Shift+Down arrow

Move active cursor up one sample

CTRL+Up arrow

Move active cursor up one line

CTRL+Up arrow

Move active cursor down one sample

CTRL+Down arrow

Move active cursor down one line

CTRL+Down arrow

Move active cursor up 10 samples

CRTL+Shift+Up arrow

Move active cursor up 10 lines

CRTL+Shift+Up arrow

Move active cursor down 10 lines

CTRL+Shift+Down arrow

Move active cursor down 10 samples CTRL+Shift+Down arrow

The movement shortcuts follow these general rules:
m  Arrows with no modifier keys scroll the data
®  Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement
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Related Topics
Waveform Window Shortcuts (see page 382)

Histogram Window Shortcuts (see page 385)

Source Window Shortcuts (see page 384)

General Purpose Data Window Shortcuts (see page 380)

Menu Shortcut Keys (see page 381)

Source Window Shortcuts

To Press

Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL#1

Move Cursor 2 to center of window CTRL+2

Add a mark CTRL+K

Step Forward CTRL+H

Step Backward CTRL+J

Scroll data up 10 lines Shift+Up arrow

Scroll data down 10 lines Shift+Down arrow
Move active cursor up one line CTRL+Up arrow
Move active cursor down one line CTRL+Down arrow
Move active cursor up 10 lines CRTL+Shift+Up arrow
Move active cursor down 10 lines CTRL+Shift+Down arrow

The movement shortcuts follow these general rules:
B Arrows with no modifier keys scroll the data
B Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts (see page 383)

Waveform Window Shortcuts (see page 382)

General Purpose Data Window Shortcuts (see page 380)

Menu Shortcut Keys (see page 381)
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Histogram Window Shortcuts

To Press
Scroll up 10 ranges Shift+Up arrow
Scroll down 10 ranges Shift+Down arrow

The movement shortcuts follow these general rules:
B Arrows with no modifier keys scroll the data

®m  The Shift key provides 10 times the movement

Related Topics
Listing Window Shortcuts (see page 383)

General Purpose Data Window Shortcuts (see page 380)

Menu Shortcut Keys (see page 381)

DSO Trigger Settings

Overview

The DSO Trigger tab contains all controls for setting DSO trigger events and actions. Threshold changes
are recognized and executed immediately during acquisitions. Execution of all other controls is delayed
until the next acquisition.

Behavior

Use Mode to select whether the DSO waits for a trigger (Normal) or forces a trigger after a set length of
time has passed without a trigger (Auto).

Use Action to select what happens when a trigger is recognized. The trigger event either triggers the DSO,
triggers all modules, triggers and sets a signal, or triggers and arms another module.

Action Target selects the event or the condition Trigger Action will act on:
m Trigger & Set Signal. A Set Signal action allows you to set signal 1, 2, 3, or 4.

B Trigger & Arm. An Arm action allows you to arm other installed modules. The default is the module
in the lowest-numbered slot that can be armed.

Use Trigger position to set the amount of data in the data record that occurs before the trigger.

Use Event Type to select the type of event the DSO will recognize as a trigger.
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Related Topic
System Trigger and Reference System Trigger Relationship (see page 165)

Select Status Bits Type Dialog Box

Use the Select Status Bits Type dialog box to select the logic analyzer’s status bits for additional triggering
and data display.

Depending on your logic analyzer module, you can select one or more status bits for triggering and display.
The status bits of a module (or master module in a merged set) are available for use in the Signal Mapping
area of the LA Setup window. In most cases, you can use the status bits like any other signal bit such as
comparing data, naming signals, and assigning the bits to a group.

However, because the status bits are not real data signals, you cannot access certain properties of the status
bits such as thresholds, iCapture, and multiplexed (demux) sampling.

The available status bits depend on the logic analyzer module.

Saved Triggers

Overview

When saving from the Easy Trigger tab, use the Save dialog box to save your TLA file, which contains
trigger state information as well as information about the currently selected Easy Trigger program. If you
do not use an Easy Trigger program as the basis of your modified trigger design, but instead use the Power
Trigger tab to develop your trigger program, only a TLA file with the state information is saved.

To Use

Saving your trigger program requires that you specify both a file name and the name of the folder where
you would like your customized trigger programs to reside. In addition, you can enter comments about
trigger program construction or functionality.

To open the Save dialog box from the File menu, click Save Trigger. You can alternatively open the Save

dialog box by clicking the FTbutton from the toolbar.

Sampling and Digitizing a Signal

Overview

Acquisition is the process of sampling the input signal, digitizing it, and assembling it into a waveform
record. The order and method of accomplishing these functions is different in the LA and DSO modules.
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Logic Analyzer

The logic analyzer converts incoming data into binary using a comparator with a user-selectable threshold
voltage.

If the incoming signal is above the threshold voltage, the signal is converted to a one. If the incoming
signal is below the threshold voltage, the signal is converted to a zero.

il 11 11 1 Digital values
(.

Threshold vollege ——————F————Ff————— et

Input signal =C ’L'F Ot
00 IJ CI IJ [}

SEIITIFIlEhC.H:IEill|||||||||||||||

After digitizing the incoming data, the logic analyzer samples it at regular intervals. The sampled and
digitized points are stored in memory along with the corresponding timing information.

Oscilloscope

The oscilloscope converts incoming data into 8-bit digital values.
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After digitizing the incoming data, the oscilloscope samples the voltage levels at regular intervals. The
sampled and digitized points are stored in memory along with the corresponding timing information.

Intermodule Interactions and Time Correlation

Each module has its own setup, trigger, and sampling functions. (Logic analyzer modules can include
microprocessor support as part of their setup.) Each module also acquires and stores its own data.

Acquisition

When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring
data individually, according to their trigger programming. You also have the option of setting the logic
analyzer to operate in repetitive mode, in which the modules acquire data and update the data windows
continually until you manually stop the acquisition.
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Triggering

Modules readily communicate with one another by means of their trigger programs. You can specify
functions such as the following:

® Trigger all modules (system trigger)
B One module arms another

B Modules respond to events declared by another module (internal signals)

Analysis

After the modules have captured and stored data, you can view the data in a Listing or Waveform
window. All data is time-correlated in the display, regardless of its source. Due to the precise time stamp
information stored with the data and the tightly-integrated communication between modules, the logic
analyzer interleaves data acquired from various sources. Because time stamp information is always stored
with the data, you can also compare saved data and current data with no loss of accuracy.

MagniVu data is also time-correlated with regular data. Because MagniVu data is always present, you can
easily compare a normal acquisition with the MagniVu counterpart.

Related Topics
Trigger Programs (see page 181)

MagniVu Data (see page 388)

High Speed Timing

388

The logic analyzer provides high-speed timing support through MagniVu data. The MagniVu data is stored
in a separate memory that is parallel to the main memory. All data from the sampler goes directly to the
MagniVu memory. The MagniVu memory also works like a circular buffer.

Unlike the acquisition memory, the MagniVu memory does not qualify data storage through the trigger
function block. Like normal acquisition data, MagniVu data can be displayed in the Listing or Waveform
windows.

MagniVu data is continuously acquired on all signals at the fastest sample rate possible for your LA model.
Some LA models allow you to adjust the trigger position. (See the following table.)

Instrument Sample rate Trigger position
TLA7000 Series module 125 ps with 16 Kb depth adjustable
TLA5000B 20 ps adjustable
Related Topic

Adding MagniVu Data to a Listing or Waveform window (see page 75)
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Listing Data Concepts

In many cases, you will use the logic analyzer to observe the data flow in the target system. The data
recorded by the logic analyzer can be displayed in a listing format, as shown:
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Listing data is a table of sequential operations performed by the target system. In the Listing window, each
data sample is displayed sequentially. Because each data sample includes time stamp information, it is a
straightforward process to display acquisitions from multiple data sources. Samples from all specified
data sources are interleaved in chronological order. For clarity, each line in the table represents a single
data sample from a single data source.

You control the presentation of the data by selecting the display radix of the columns. You can also
make other format selections such as font size, color, and column width. You can use filters to display
specific data.

You can expand or collapse the Group column to display the individual signals. You can also add
individual signals.

You can include data acquired by the external oscilloscope in the Listing window. As with any module, the
data samples from the oscilloscope are time-correlated with the other data and appear on separate lines.
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Waveform Data Concepts

390

You can use the logic analyzer to observe the timing relationships between signals by displaying the
recorded signal activity as a series of waveforms in the Waveform window. The following figure shows
waveform data from a logic analyzer.
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Waveform window

Each waveform is initially displayed in a separate track, but all waveforms are time-aligned horizontally
and displayed in the same time scale. The inclusion of time stamp information with the stored data samples
makes it easy to display time-correlated acquisitions from multiple data sources.

You control the horizontal scale of the acquired data in the display. (You do not, however, change setup
parameters by changing settings in the waveform display.) You can change the signal group radix,
waveform color, and waveform height. Like the Listing window, you can also use filters to display
specific data.

When viewing logic analyzer data, you can view the data as individual signals. You can also display the
logic analyzer data in groups of signals known as busforms. Use the busforms to display when data changes
with respect to clock or control signals. Another method of displaying logic analyzer data is to overlay
waveform signals. Use overlay waveforms to visually compare two or more waveforms at the same time.

When you are interested in displaying the value of a group of signals over a period of time, you can use
magnitude mode. For example, using magnitude mode, you can view the signals connected to a 16-bit
digital counter. The magnitude waveform appears as a sawtooth waveform as the counter values increase
from the minimum value (00) to the maximum value (FF).
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LA Versus DSO Module and External Oscilloscope Waveforms

A logic analyzer waveform appears to have zero-length rise and fall times. This is because the logic
analyzer is recreating the waveform from the samples stored in memory, which are either a one or a zero.

No electronic signal is perfectly digital in nature; there is always some analog component. Consider a
fast-rising pulse with ringing on the front edge, or glitches that can occur in a noisy circuit.

If you suspect problems caused by analog signal characteristics, such as signal voltages higher or lower
than specified voltage levels or slow transition times, you should use a DSO module or an external
oscilloscope to observe the voltage characteristics of the signal.

Related Topic
Sampling Resolution (see page 391)

Sampling Resolution

The accuracy of the waveform recreated from the sampled data depends on the sample rate used to record
the incoming signals.

This is due to the fact that the waveform recreated by the logic analyzer is based on the sampled signals
stored in memory. If the sample rate is too low the recorded data will produce an inaccurate display.

Example 1: Slow sample clock
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Related Topic

Signal Resolution and Signal Duration (see page 392)
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Signal Resolution and Signal Duration

There is an important relationship between the Sampling Resolution (see page 391) of the recorded
signal and the duration in terms of elapsed time.

Because the depth of the acquisition memory sets the total number of samples that can be recorded by the
logic analyzer, increasing the sample rate provides better signal resolution but reduces the duration of the
acquired signal. A faster sample rate will record a smaller portion of the signal, but with higher resolution.

It is important to remember that by using the MagniVu (see page 368) data feature, you can view
high-resolution data centered around the logic analyzer trigger. This allows you to zoom in on the data
while still maintaining visibility of a more extended signal duration.

Displaying Waveforms

Waveforms are rarely displayed in a one-to-one ratio between the sample points and pixels. Waveforms
are usually displayed in a compressed or expanded format.

As a general rule:
B Waveforms are compressed when the time per pixel is greater than the time per sample.
B Waveforms are expanded when the time per pixel is less than the time per sample.

For compressed DSO waveforms, the display shows the lowest and highest points that occupy a given
pixel column joined by a vertical line.

For expanded LA waveforms, the display points between the actual sample points are calculated.

For expanded DSO waveforms, Sin(x)/x interpolation computes the display points between the actual
values acquired.

Autoset (DSO Module)

Autoset automatically chooses the DSO setup values, based on the input signal at the time you click
Autoset. If you move the probe to another signal, click Autoset again to reset the setup values.

Autoset works best on repetitive signals that have 0 Volt offset. If the Autoset setup does not display the
waveform as you want it, you can change the setup manually.

Autoset sets up all input signals, the horizontal, and the trigger regardless of which Autoset button
is clicked.

Autoset makes the following selections automatically.

Vertical range: A setting that does not clip the waveform

Sample period: Period of the input signal divided by 100
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Input coupling: DC

Vertical offset: 0.0v

Bandwidth: Full

Trigger level. Center of the input signal range
Trigger type: Edge

Trigger slope: Positive

Trigger coupling: DC

Trigger action: Trigger (module)

NOTE. If an acquisition is in progress, Autoset displays the Finishing Acquisition message box. Autoset
uses Init @ 50% to adjust the trigger level to the center of the input signal range. Autoset does not alter
any acquisition data or windows until the next acquisition.

To use Autoset from the System window, click the DSO Setup button, and then click the Autoset button.

DSO Module Horizontal Settings

Horizontal settings control the rate at which the data is sampled and the amount of data acquired.

The sample period sets the interval between successive samples in a waveform record. Choose a sample
period that is fast enough that the waveform will not be aliased, and slow enough to provide the waveform
record length that you need. For best fidelity of repetitive waveforms, you should set the sample period to
at least five times that of the waveform.

Memory depth sets the total number of data samples to be acquired. If you do not need to use the full
memory depth to acquire data, select a smaller memory depth to get faster acquisitions.

To open the horizontal page from the System window, click the DSO Setup button, and then click the
Horizontal tab.

Related Topic
Autoset (see page 392)

DSO Module Vertical Input Channel Settings

Overview

Channel settings adjust the vertical input parameters.
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394

The vertical input voltage range control sets the attenuator full-scale voltage. If the range is selected from
the list, it forces an offset value into the Offset control. You can select from the list of standard presets by
clicking Options from the System menu, and then clicking the Presets tab.

Resolution

For best vertical resolution, set the range slightly larger than the expected input signal. Autoset
automatically sets the range for best vertical resolution on signals with 0 offset.

Offset

The vertical input voltage offset is the offset voltage applied to the input signal. If the attached probe can
be offset, it is applied at the probe tip. Otherwise, offset is applied at the BNC. If Range is changed
using the preset list, Range also sets the Offset.

Bandwidth

Bandwidth is the range of frequencies that can be acquired and displayed accurately. Your bandwidth
selection sets the upper limit of frequencies that will be acquired and displayed. Bandwidth filters reduce
unwanted noise and aliasing, but can substantially change waveform fidelity.

m  Select the 20 MHz filter to set the upper limit of frequencies that are acquired to 20 MHz. The 20 MHz
filter does not provide complete anti-aliasing protection at slower sample rates.

®m  Select the 250 MHz filter to set the upper limit of frequencies that are acquired to 250 MHz.

m  Seclect the Full bandwidth for best fidelity of signals with high frequency components. The Full
bandwidth filter passes the full analog bandwidth.

Coupling

Coupling selects how the input signal is coupled to the vertical input channel.

m Use DC coupling to see the entire waveform (both AC and DC components).

B Use AC coupling to view only the AC components of the waveform (DC components are blocked).

B Use GND coupling to display a zero-volt waveform.

Signal Name

The Signal Name you enter becomes the new name for the waveform when it is displayed.

Termination

Select the vertical termination impedance appropriate for the input signal.
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NOTE. Termination is at the BNC connector, not the probe tip. Input signal and vertical range and offset
are limited by 50 W termination.

Probe Calibration

Probe calibration optimizes the signal path for this probe/channel/module combination.
Execute Probe Cal if any of these conditions have occurred:

B The ambient temperature has changed more than 5 degrees Celsius.

®  The DSO notifies you that the probe is not calibrated.

®  More than 1 month has passed since the probe was calibrated.

To open a vertical channel setting page from the System window, click the DSO Setup button, and then
click a vertical channel tab.

Related Topics
Calibrating Probes (see page 59)

Autoset (see page 392)

DSO Module Setup

Before acquiring and displaying a waveform, first set up the DSO. Use the DSO Setup window to set the
vertical, horizontal, and trigger parameters manually, or use Autoset for a quick, automatic setup based on
the input signal.

NOTE. You cannot change setup parameters by changing the data display. Once you acquire data, you
can manipulate the display, but that will not change the input settings used to acquire the data. Return
to the DSO Setup window to alter input settings.

To open the DSO Setup window from the System window, click the DSO Setup button.
Click the following selections for more information:

®  Autoset

m DSO Vertical Input Channel Settings
B DSO Horizontal Settings

DSO Trigger Settings
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DSO Measurement Setup

396

Overview

DSO Measurement Setup

Use the Measurement Setup dialog box to select the measurements that will be performed on the DSO
or external oscilloscope waveforms and to select the new measurement setup parameters. Click the
Measurement Setup button in the Waveform Properties dialog box to access the Measurement Setup

dialog box.
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B Available Measurements lists all of the available measurements that are supported on the DSO
waveform. When you select an available measurement, a graphic and a brief description of the
measurement are displayed beneath the Available Measurements list box. The following table lists

the available measurements and provides a description of each.

m  Selected Measurements displays up to three DSO waveform measurements that you select. You can
modify the list of selected measurements using the Add >> and Remove << buttons.

B Base-Top Determination allows you to select the method for determining the base and top for a selected
measurement: automatic, histogram, or min-max. The default setting is automatic, which lets the logic
analyzer choose between histogram and min-max for the waveform under test.
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DSO Measurement Setup

m  The Reference Levels group box enables you to select either absolute or percentage-based reference
levels for the measured waveform. After selecting the type of waveform reference level, you can either
set the High-, Low-, and Mid-Reference levels or elect to use the defaults.

B The Gating group box enables you to select the gating method for the measured waveform. You can
select the entire waveform, window boundaries, or cursors to be used as the gating limits.

Available measurements

Description

High

The value used as 100% whenever high-reference,
mid-reference, or low-reference values are needed, such as
in fall time or rise time measurements. This method can be
calculated using either the min/max or histogram method.

Low

The value used as 0% whenever high reference, mid
reference, or low reference values are needed, such as
in fall time or rise time measurements. This value can be
calculated using either the min/max or histogram method.

Amplitude

This voltage measurement is the high value less the low
value measured over the entire waveform or gated region.

Maximum

This voltage measurement is the maximum amplitude. It is
typically the most positive peak voltage and is measured
over the entire waveform or gated region.

Minimum

This voltage measurement is the minimum amplitude. It is
typically the most negative peak voltage and is measured
over the entire waveform or gated region.

Peak to Peak

This voltage measurement is the absolute difference
between the maximum and minimum amplitude over the
entire waveform or gated region.

Positive Overshoot

This voltage measurement is measured over the

entire waveform or gated region and is expressed as:
Positive Overshoot = (Maximum - High) +
AmpTitude x 100%

Negative Overshoot

This voltage measurement is measured over the entire
waveform or gated region and is expressed as:

Negative Overshoot = (Low — Minimum) + Amplitude x
100%

Mean

This voltage measurement is the arithmetic mean over the
entire waveform or gated region.

RMS

This voltage measurement is the true Root Mean Square
voltage over the entire waveform or gated region.

Rise Time

This timing measurement is the time required for the leading
edge of the first pulse in the waveform or gated region to
rise from the low reference value (default = 10%) to the high
reference value (default = 90%) of the final value.

Fall Time

This timing measurement is the time required for the falling
edge of the first pulse in the waveform or gated region to fall
from the high reference value (default = 90%) to the low
reference value (default = 10%) of the final value.
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Available measurements

DSO Measurement Setup

Description

Positive Width

This timing measurement is the distance (time) between the
mid reference (default = 50%) amplitude points of a positive
pulse. The measurement is made on the first pulse in the
waveform or gated region.

Negative Width Measurement

This timing measurement is the distance (time) between the
mid reference (default 50%) amplitude points of a negative
pulse. The measurement is made on the first pulse in the
waveform or gated region.

Period The time required to complete the first cycle in a waveform
or gated region. Period is the reciprocal of frequency and is
measured in seconds.

Frequency This timing measurement is a measure of the first cycle in a

waveform or gated region. Frequency is the reciprocal of
the period; it is measured in Hertz (Hz) where one Hz is
one cycle per second.

Positive Duty Cycle

This timing measurement is the ratio of the positive pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Positive Duty Cycle = (Positive Width) +
Period x 100%.

Negative Duty Cycle

This timing measurement is the ratio of the negative pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Negative Duty Cycle = (Negative Width) +
Period x 100%.

Area

Area is a voltage-over-time measurement. The
measurement is the area over the entire waveform or gated
region expressed in volt-seconds. The area above the
common reference point is positive and the area below the
common reference point is negative.

Cycle Area

The voltage over time measurement. The measurement is
the area over the first cycle in the waveform or the first cycle
in the gated region expressed in volt-seconds. The area
above the common reference point is positive and the area
below the common reference point is negative.

Cycle Mean

This voltage measurement is the arithmetic mean over the
first cycle in the waveform or the first cycle in the gated
region.

Cycle RMS

This voltage measurement is the true Root Mean Square
voltage over the first cycle in the waveform or the first cycle
in the gated region.

Burst Width

This timing measurement is the duration of a burst and is
measured over the entire waveform or gated region.
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Reference levels Description

High Reference This defines the high reference level of a waveform; the
default level is 90%. This reference level is used with the
Low Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.

Mid Reference This defines the middle reference level of a waveform; the
default value is 50%. This reference value is primarily used
for making measurements between edges such as pulse
widths. To change this level, touch the control and then set
the level with the multipurpose knob.

Low Reference This defines the low reference level of a waveform; the
default level is 10%. This reference level is used with the
High Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.

Related Topics
Waveform Options (see page 216)

Setting Up Waveform Measurements (see page 126)

Removing Selected DSO Waveform Measurements (see page 127)

Oscilloscope Waveforms

Overview

Oscilloscope waveforms have a horizontal resolution of one display point per pixel width. Each horizontal,
pixel-wide time slice has either a point or a vertical line to represent the vertical value of the acquired data
sample. If the time per division is fast enough that each display point represents one or fewer acquired
points, the vertical value is represented by a point. If the time per division is slower and multiple acquired
data samples need to be represented within a pixel width, the vertical value is represented by a vertical line
whose length and offset are determined by the acquired data values.

Behavior

When the time per division is decreased, waveforms are horizontally expanded, using sine x/x interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.
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To Use

You can select whether to display range readouts. You can also select the readout color. For each
waveform, two readouts show the maximum and minimum vertical input voltage settings. The readouts
may contain symbols indicating AC or Ground coupling, 50 Ohms input impedance, and the bandwidth
limit. The ground line is indicated as a horizontal dotted line. The trigger threshold is indicated with a
T and an up arrow if the threshold is above the maximum voltage or a down arrow if the threshold is
below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range. The entire input voltage range
is used to set the default minimum and maximum values of the vertical range. Set the vertical range
values using the Waveform Options dialog box. You access it from the Waveform Properties dialog box
by clicking the Waveform tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you can see individual clock tick marks.

Related Topics
Waveform Options (see page 216)
DSO setup (see page 395)

Sample Waveforms (see page 215)

Logic Thresholds

Logic Threshold sets the voltage level that determines whether input signals are high or low (1 or 0). You
can select from a list of presets and Init @ 50%.

The list for each signal contains presets from Options, Presets, Logic Threshold. The default threshold
value is the midpoint of the vertical range of the trigger signal. The minimum and maximum threshold
values are the Vertical Offset +/- the Vertical Range of the trigger signal. The probe type, the vertical
range, and the trigger coupling all affect the threshold value.

Init @ 50% sets the threshold value to the midpoint of the trigger signal.

Probe Calibration

400

Overview

The Probe Calibration dialog box controls all DSO probe calibration cycles and directs you to perform any
necessary steps. You can calibrate all attached probes or only the probe on the selected channel.

You can start a calibration cycle, view the progress of calibration, and see the results of calibration. Once
calibration starts, the calibration cycle of a single probe cannot be stopped. After a calibration cycle
completes, you can see the status of probe calibration.



Reference Probe Calibration

Behavior

Instructions direct you to attach probes to the calibration fixture and the input channel.
Channel status shows the current probe and its calibration status.

®  Channel number shows the channel number of the probe.

B Probe Calibration Status shows the calibration status for attached probes.
Calibrate Chan starts probe calibration for the selected channel.

Calibrate All starts probe calibration for all channels that can be calibrated. To stop calibration when
calibration for the current probe is complete, click Abort.

To Use

To open the Probe Calibration dialog box from the System window, click the DSO Setup icon, click a
channel tab and then click the Probe Cal button.

Related Topic
Calibrating Probes (see page 59)
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Symbols and Numbers

$ character, 166
63-Sample Blocks, 25
63-Sample Blocks mode, 162

A

about data, 196
accelerator keys, 382
Acquisition, 366
gaps, 205
memory status, 366
sample, 299
storage, 151
Acquisition mode, 25
Acquisition options, 25
Acquisition overview, 57
Active cursor readout, 232
Active module, 359
Activity, 366
Add Column/Waveform Dialog
Box, 187
Add Protocol Dialog Box, 288
Add Protocols, 291
Add Transition dialog box, 159
Add Word dialog box, 160
Adding, 314
data source to an active Listing
window, 73
data source to an active
Waveform window, 135
histogram data from another
source, 226
MagniVu data to a Listing or
Waveform window, 75
mark to a data window, 137
new graph, 314
Opcode Mark, 114
reference data to a Listing
window, 113
reference data to a waveform
window, 132
state to a trigger program, 93
waveform, 118

Advanced trigger, 149
Alignment of time, 195
Analog multiplexing, 55
assigning data signals via the
iConnect Analog Feeds
dialog box, 29
changing signal routing, 67
setting up, 55
signal routing from the logic
analyzer, 48
signal routing to the
oscilloscope, 49
specifying physical
connections, 51
Analog outputs, 29
analog routing, 331
Analog signal routing from the
logic analyzer, 48
analyze data, 225
Apply Deskew Analysis Results
dialog box, 303
Applying filters to data
windows, 35
Argument and command
entry, 379
Tool Property dialog box, 379
Arming, 375
a module using an LA
module, 154
interaction, 375
other modules from an LA
module, 103
ASN.1 Types, 252
additions to PSDL, 258
PSDL, 252
Asynchronous, 368
digital oversampling, 368
Asynchronous sampling, 14
Autoset
DSO, 392
serial analyzer, 45
average, 306
Axis Type Wizard, 64
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B

Background color, 123
Background color for Listing
window, 197
Base signal, 18
Binary file format, 189
Bus support triggering, 333
Bus-specific framers, 273
Busform, 129
displaying LA data as a
busform, 216
selecting the radix of busform
readouts, 85
waveforms, 213

C

Calibrating, 59
modules, 59
probes, 59
Calibration, 371
DSO probes, 59
probe calibration (DSO
module), 400
self calibration
properties, 371
when using a three way
merge, 371
Change detect, 157
Changing
color, 197
data series range, 87
defaults, 86
graphs, 87
If/Then clauses, 93
position of cursors, 77
signal routing, 67
start-up defaults, 86
waveform properties, 120
window properties, 68
zoom options, 85
Channel Activity Indicators, 46
Channel change
triggering on, 101
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Channel settings
DSO, 393
Channel-lane assignment
serial analyzer, 46
chart, 307
Choosing system to open at
startup, 369
Clause
defining If/Then or Else
If/Then, 163
Clock, 391
fast sample clock
example, 391
serial analyzer, 46
signal out, 375
slow sample clock
example, 391
SUT, 46
clock warning, 338
Code loop, 241
COFF file format, 348
Collapse signals, 139
Color, 378
background, 123
change of marks, 197
graticule, 123
properties, 377
scheme for active data
window, 122
selecting the active data
window, 122
tab, 377
Coloring data, 118
Column, 196
Add Column/Waveform
dialog box, 187
changing properties, 275
going to a specific
column, 115
properties, 196
selection, 195
showing and hiding, 275
tab, 196
Columns in a Protocol
window, 271
Comment Lines, 40
Compare
limitations, 190
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Compare Definition Dialog
Box, 190
Comparing data, 62
Compilation Result Pane, 272
Conditional storage, 150
Configuration, 378
mainframe, 372
software, 378
Configure, 4
Configuring external and internal
signals, 375
Connect, 3
Connections, 3
Connectors, 375
mainframe, 375
Contacting Tektronix, 2
Control Lines, 41
Control statements, 247
PSDL, 247
Controlling whether a waveform
is visible, 121
count measurement, 105
Counters, 97
problems, 104
triggering an LA module on
counter values, 97
Create New Protocol Files, 293
Create New Stack Files, 294
Creating
custom color schemes, 60
overlay waveform, 135
symbol files, 115
cursor position, 240
cursor readout, 232
Cursors, 227
Cursors locked together in
different data windows, 187
Custom color schemes, 60
Custom sampling, 334
Customer feedback, 2
Cycle marking, 196

D

Data, 132
compare, 190
determining the data
source of the selected
waveform, 84
examining the listing data, 11
font size, 197
incorrect after
acquisition, 335
MagniVu, 368
measurements setup, 110
name, 363
points, 205
properties, 196
searching on selected data, 12
triggering on group data
values, 100
value triggering, 100
viewing sample data, 11
when to store, 95
data area, 9
Data Samples, 219
data series, 313
data source, 225
determining, 84
measuring, 225
properties, 221
time alignment, 195
Data sources, 190
Data storage
serial analyzer, 46
Data Valid Window, 301
Data window
creating a New Data
window, 279
locked, 187
New Data Window name, 363
System window, 359
Decimal values, 153
signed, 153
Decode View, 271
Default setup, 369
default system, 369
Defaults, 86
changing, 86
properties, 378
tab, 378



Define Bus dialog box, 280
define compare, 190
define filters, 33
Define protocols, 292
Define Search Dialog Box, 193
Define Snapshot dialog box, 165
Define Suppression dialog
box, 199
Defining, 268
compare parameters, 60
data to search for, 193
histogram ranges, 225
If/Then clauses in a trigger
program, 93
multiple transition
recognizers, 94
protocol with PSDL, 291
source data to search for, 82
Definition of MagniVu data, 368
Delete Protocol or Stack Dialog
Box, 289
Delete Protocols, 292
Delimiter, 43
When exporting data from a
Listing window, 71
Delta, 129
time measurements, 129
volts measurements, 128
waveform measure-
ments, 129
Deskew Analysis, 295
Properties, 301
Setup, 299
Setups, 302
Window, 295
Deskew panel, 16
destination signal, 29
Detecting violations, 161
Determining acquisition
status, 366
Developing custom color
schemes, 60
Diagnostics, 337
Digital signal routing, 66
from a logic analyzer
output, 66
to an oscilloscope input, 66
Digitizing a signal, 386

Disabling modules, 359
Disassembler, 114
adding opcodes, 114
Disassembly, 334
display formats, 334
properties, 198
selecting display formats, 334
tab, 198
using microprocessor and bus
support packages, 333
Displaying
disassembled data, 198
DSO data, 141
glitches, 120
graticules, 124
magnitude, 125
marks in a data window, 138
violations in a waveform
window, 122
waveform readouts, 120
waveforms, 392
Dragging marks, 137
Drawing Style dialog box, 311
DSO, 59
Autoset, 392
calibrating probes, 59
compressed waveform
format, 392
cursors, 141
displaying DSO data, 141
expanded waveform
format, 392
horizontal settings, 393
setting up, 395
storing DSO data, 141
trigger settings, 385
vertical, 393
waveforms, 399
DSO probe, 59
DSO trigger, 385
dual channel measurements, 112
Dwarf file format, 348

E

EasyTrigger, 183
library, 183
list contents, 183
program list, 183

Index

Edit Protocol Files, 68
Edit Relations Between
Protocols, 69
Edit stack files, 69
Editing, 70
Editing a Tool on the Tools
Menu, 70
editing symbol files, 70
Elf/Dwarf file format, 348
Elf/Stabs file format, 348
Enhanced column headers, 190
Entering a symbol plus an offset
in a trigger, 175
Error Message Dialog Box, 199
Event target value limit, 105
event type, 169
Examining a waveform, 9
Example, 11
viewing a magnitude
waveform, 11
Executing an operation after an
acquisition, 58
Expand signals, 138
Export, 278
protocol data, 71
Export data, 188
Export Data dialog box, 188
Export Data Options Dialog
Box, 190
Export Histogram dialog box, 224
Export Histogram Options dialog
box, 224
Export Stack Dialog Box, 290
Exporting, 350
data from a Listing
window, 71
group width and radix
information, 190
historgram data, 72
protocols, 290
signal setups, 37
stacks, 290
symbol tables, 350
Extended Diagnostics, 337
External oscilloscope, 48
communication, 47
setup window, 47
External Signal Selection, 367
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External signals, 146
EyeFinder, 295
EyeScan, 316

F

Feedback to Tektronix, 2
feeds, 29
File, 348
format, 348
Filters, 284
applying, 35
copying, 112
creating, 113
dialog box, 32
loading, 76
opening, 113
protocol, 284
Filters dialog box, 33
Force Main Prefill, 171
Format, 196
column, 196
file, 334
listing window, 389
TLA Data Exchange, 188
Formatting
disassembled data, 198
Listing window, 197
Framers, 273
Frames, 273
full screen, 9
Function range symbols, 343
Functional procedure, 337

G

Gaps, 205
time, 205

General purpose data window
shortcuts, 380

Generic Framer Example, 282

Generic framers, 273
limitations, 273
usage, 273

Getting out of a loop in a Source
window, 241

Glitch
detect (LA), 161

glitch detection, 161
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Glitches, 185
in a Listing window, 115
LA, 185
triggering an LA module, 96
Global storage, 140
note on using transitions, 140
Go to (moving to a mark), 76
Go To dialog box, 195
Go To Protocol Dialog Box, 292
Going to a specific column, 115
Going to a Specific Graph Window
Mark, 315
Going to a specific mark, 138
Going to a Specific Series, 315
GPIB, 48
Graph Window, 307
adding data series, 64
creating, 312
labeling, 87
properties, 87
Graticule, 89
selecting the color, 123
showing, 89
graticule display, 373
Group
color, 35
data range triggering, 100
effects on data source, 221
radix, 166
ranges, 104
triggering an LA module, 102
Group cards, 28
Group definitions
bus supports, 333
microprocessor and bus
support, 333
microprocessor supports, 333
Group width information, 190
exporting, 190
Grouping signals, 28
Guidelines for merging
modules, 53

H

Hardware order, 153
Height, 88

Hex View, 271

High Speed timing, 388

High-Level Language
support, 369
Highlight controls, 198
Highlight Signal dialog box, 28
Highlighting
disassembled data, 198
lines, 198
signals, 28
Histogram, 225
data page, 62
defining ranges, 225
exporting data, 72
options page, 62
selecting data source, 226
Histogram window, 221
color selection, 220
data area, 220
font size, 220
Histogram add counts dialog
box, 224
Histogram data source, 221
Histogram scale dialog
box, 224
Histogram window
shortcuts, 385
property page, 220
radix, 220
Hit Frequency Properties, 311
HLL support, 369
Horizontal
scale (time per division), 142
setting up the DSO, 126
settings(DSO), 393
host name, 8
Hot keys, 384

I
iCapture, 29
iConnect Analog Feeds dialog
box, 29
Identifying modules, 359
IEEE695 file format, 348
[f/Then clause
changing an, 93
import, 36
Import signal setups, 38
Import Stack Dialog Box, 290
Incoming inspections, 337



Incorrect data after
acquisition, 335
Individual waveform
properties, 209
Individual waveform properties
within an overlay
waveform, 211
Information, 196
about current data, 196
about installed software, 378
about modules, 372
about the mainframe, 372
Information Lines, 43
Input
DSO settings, 393
Installed software informa-
tion, 378
inter-probing, 331
intermodule interaction, 387
Intermodule signals, 375
Internal, 367
signal selection, 367
signaling, 154
Internal signals, 375
configuring, 375
triggering an LA module, 98
iVerify, 318
Setup dialog box, 320
Setups dialog box, 318
Statistical Analysis dialog
box, 327
iVerify measurement
properties, 322
iVerify Properties, 322
About Data tab, 322
Eye Coloration tab, 325
iVerify Window Tab, 323
iVerify Properties dialog box, 322
Eye coloration, 322
iVerify Setup dialog box Channel
tab, 329
iVerify Setup dialog box
Clock/Qualifier tab, 330
iVerify window, 316
iView external oscilloscope
setup window, 47

J

jitter, 107
Jumping over "dead" space
between samples, 187

K

Key, 383
shortcut, 383
Keystroke Entry field, 28

L

LA
module memory depth, 27
module setups, 54
trigger actions table, 168
trigger events, 167
trigger resources, 169
triggers, 145
waveforms, 213

LA Busform, 129

LA channels
selecting for an LA trigger

channel event, 95

LA module
arming, 103
merging, 53

LA Probe Signals/Names
table, 18

LA Setup window, 13

LA versus DSO module
waveforms, 391

Labeling a graph, 87

Labels, 216

LAN, 5

Language, 369
high-level language (HLL)

support, 369

Length and Value Expres-
sions, 261
PSDL, 261

Lexical Items, 265
PSDL, 265

Limits, 216

Linked cursors, 187

Listing data concepts, 389

Index

Listing window, 383
adding a data source, 73
adding reference data, 113
properties, 197
showing glitches, 115
showing qualification
gaps, 114
tab, 197
use, 185
Listing-relative cursor
positioning, 241
Listing/Waveform data page, 362
Load, 333
support package, 333
system options, 363
Load Deskew Analysis Setup
dialog box, 298
Load iVerify Setup dialog
box, 319
Load Symbols Options dialog
box, 348
Loading
a MagniVu data source to
a Listing or Waveform
window, 75
a saved module, 73
a saved system, 72
an LA module with saved
trigger settings, 74
filters, 34
merged modules, 363
part of a saved system, 363
portions of a saved system, 73
saved data to an active Listing
window, 73
saved data to an active
Waveform window, 135
source code symbol
information, 75
the timing format file, 334
Lock delta time, 129
Lock windows, 187
Lock Windows dialog box, 187
Locking windows, 136
Logic analyzer, 131
measurements, 131
trigger window, 143
Logic thresholds, 378
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Logic thresholds for a DSO, 400
Loop, 241
Loop statements, 248
PSDL, 248
Lower threshold, 378

Magnitude, 216
Magnitude mode, 390
Magnitude waveform
viewing, 11
MagniVu, 168
data, 368
data source to a Listing or
Waveform window, 75
LA trigger action table, 168
signal resolution/signal
duration relationship, 392
storage rate, 172
trigger position, 173
Main window, 359
Mainframe, 372
properties, 372
Making graticules visible, 124
Making violations visible in a
Waveform window, 122
Mark, 196
next and previous, 231
opcode, 196
selection, 314
Mark Opcode dialog box, 196
Marking cycles, 196
Marks, 114
properties, 197
tab, 197
Marks in a data window, 137
adding, 137
Marks in a Protocol window, 271
max, 111
Measurement Setup, 305
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Measurements, 126
count, 105
data, 305
jitter, 107
min/max, 108
multiple, 129
on DSO data, 396
on LA data, 305
time, 109
Measuring, 127
delta time, 129
delta volts, 128
histogram data, 225
time, 129
voltage, 127
Memory, 90
selecting depth, 90
storing DSO data, 141
Memory depth, 90
for an LA module, 90
LA, 27
most effective use of, 90
Menu shortcut keys, 384
Merged module synchronous
sampling, 27
Merged modules, 372
loading, 363
note on calibration, 371
properties, 372
Merging LA modules, 53
Meta-characters, 193
Microprocessor and bus support
package basic operation, 333
Microprocessor support, 333
triggering, 333
min, 108
Miscellaneous PSDL
commands, 262
Modify, 377
color schemes, 377
location of cursors using the
overview mark bar, 76
search path list, 233
suffix list, 233

Module, 372
active, 359
arming using an LA
module, 154

disabling, 359

identifying, 359

merged, 372
Module specifics properties, 372
module trigger, 146
Modules, 59

calibrating, 59

merging, 53

properties, 372

triggering from an LA, 103
More waveforms, 118

Moving
cursors, 76
marks, 137

to a mark (Go To), 76

to a specific column, 115
Multi-signal

busform LA waveforms, 213

magnitude LA

waveforms, 214

waveforms, 213
Multiple acquisitions, 58
Multiple Samples per Clock

Trigger Programs, 173

N

Name
waveform, 216

Name Data Window dialog
box, 363

network, 6

Network preferences, 5

network properties, 8

Next Mark and Previous Mark
buttons, 231

0]

Object file format, 348
Object selection, 206
offline, 3
Offset, 378
entering a symbol plus an
offsetin a LA trigger, 175



OMF166 file format, 348
OMF286 file format, 348
OMF386 file format, 348
OMFS51 file format, 348
OMF&G6 file format, 348
On Run control
serial analyzer trigger
window, 177
Opcode, 196
Opcodes, 114
adding, 114
Open dialog box (repetitive
properties), 193
Opening, 58
a document after an
acquisition, 58
a document or program after
an acquisition, 58
a saved data window, 135
Operators, 245
PSDL, 245
Options, 81
collapse signals, 139
expand signals, 138
powering on and off, 9
setting waveform
options, 125
Organizing signal groups, 22
outputs, 29
Overlapping symbols, 348
Overlay waveform, 135
properties, 208
setting the offset, 209
Overview mark bar, 76

P

Packet structure definition, 245
PSDL, 245
Packet Structure Description
Language, 243
Packet View, 275
column properties, 275
Pattern Generator, 88
Run Properties dialog box, 88
Pattern symbol, 117
file header, 117
files, 343
PG Run Properties dialog box, 88

Placement of system triggers, 148
Placing marks in a data
window, 137
Polarity, 88
of LA signals, 18
population, 306
Positioning the trigger, 95
Postscript, 77
Power on and off options, 9
Power-On Diagnostics, 370
PowerTrigger, 159
detail, 149
properties, 149
tab, 149
tab overview, 149
troubleshoot, 104
Preferences properties, 373
Preprogrammed LA triggers, 183
Presets, 378
Presets tab, 378
Prime signal, 18
Print dialog, 77
Printing, 188
Probe
calibration (DSO), 400
signal grouping, 28
status (DSO), 400
problems, 335
sampling, 335
triggering, 175
programming tips for triggering
an la module, 151
properties, 88
column, 196
graph window, 87
network, 8
protocol, 285
protocol display, 275
protocol framing, 277
protocol, 293
create new, 279
exporting, 290
importing, 290
saving, 289
Protocol Designer window, 286
Protocol Editor pane, 287
Protocol Filter Setup Dialog
Box, 274

Index

Protocol information pane, 281
Protocol properties, 277
protocol relations, 291
Protocol Search Dialog Box, 278
Protocol Setup window, 285
Protocol stacks, 289
importing, 290
Protocol window, 271
Define Bus dialog box, 280
frames and framers, 273
generic framer example, 282
properties, 275
Select Bus page, 280
Select Stack dialog box, 282
PSDL, 263
ASN.1 additions, 258
ASN.1 types, 252
control statements, 247
defining a protocol, 268
length and value
expressions, 261
lexical items, 265
loop statements, 248
miscellaneous
commands, 262
operators, 245
overview, 266
packet structure, 245
reserved words, 263
sample program, 249
spz file extensions, 266
syntax, 243
tags, 262
type definitions, 250
types, 258
value definitions, 261

Q

Qualification gaps, 185
showing, 197
showing in a Listing

window, 114

R

Radix, 166
Radix of column, 196
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Radix information, 190
exporting, 190
Range, 100
recognition problems, 104
recognition triggering, 100
recognizers, 153
recognizers and hardware
order, 153
symbol file header, 117
symbol files, 342
range recognizers, 151
Range symbols, 344
Function, 343
Source, 345
Variable, 344
Ranges properties, 222
Readout radix, 85
Readouts, 216
displaying, 120
Reference, 386
digitizing a signal, 386
sampling a signal, 386
Reference clock
serial analyzer, 46
Reference data, 132
adding to a Listing
window, 113
Reference system trigger, 165
Release notes, 1
remote, 3
Removing
data from a Listing or
Waveform window, 139
LA signals, 18
selected DSO waveform
measurements, 127
waveforms from an overlay
waveform, 139
Removing a Tool from the Tools
Menu, 70
Renaming, 359
a window, 359
Repeating acquisitions, 58
Repetitive acquisition data, 79
saving, 79
repetitive acquisition mode, 57
Repetitive mod, 57
Repetitive operations, 193
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Repetitive Properties Dialog
Box, 191
Replace Protocol Dialog Box, 288
Replace protocol files, 294
Reserved words, 263
PSDL, 263
Routing a signal from a logic
analyzer output, 66
Routing a signal to an oscilloscope
input, 66
Rules for merging modules, 53
Running, 133
extended diagnostics, 133
multiple acquisitions, 58

S

Sample
suppression, 90
waveforms, 215
Sample Signal setup file, 38
Sample Suppress dialog box, 200
Samples + Glitches, 25
Samples + Violations, 25
Sampling, 335
a signal, 386
asynchronous, 14
custom, 334
LA setup window, 13
merged module external, 27
problems, 335
resolution, 391
support package, 334
synchronous, 14
Save
color scheme, 378
dialog box, 78
module, 78
system, 78
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trigger, 74
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search, 6
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setup window, 43
Status arca, 44
trigger events, 178
trigger tool bar, 177
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Setup and hold triggering, 92
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Setup Properties, 285
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logic analyzer, 13
serial analyzer, 43
Setups, 72
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saving, 54
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importing, 38
Signals
selecting, 95
Signals in and out, 154
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Single channel
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single run acquisition, 57
Single-run mode, 57
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triggering on an LA, 99
Software, 378
properties, 378
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